HYDRUS

User Manual
Version 2

Software Package for Simulating
the Two- and Three-Dimensional Movement
of Water, Heat and Multiple Solutes
in Variably-Saturated Media

January 2011, PC-Progress, Prague, Czech Republic
© 2011 J.SimUnek and M. Sejna. All rights reserved







The HYDRUS Software Package for Simulating
the Two- and Three-Dimensional Movement
of Water, Heat, and Multiple Solutes

In Variably-Saturated Media

User Manual

Version 2

M. Sejna’, J. Siminek? and M. Th. van Genuchten®

May 2011

'pC-Progress, Prague, Czech Republic
“University of California Riverside, Riverside, CA
Department of Mechanical Engineering, Federal University of Rio de Janeiro, Brazil

© 2011 J. Simanekand M. Sejna. All rights reserved.






Table of Contents

LI o] (0] O] 1 1=] o | £SO 3
I o) o =TSRSS 9
LEST OF TADIES ...ttt b et bt ne e 17
ADSTFACT ... bbb bbbttt b b 19
Introduction to the HYDRUS Graphical User Interface...........ccccocoevveieinineinense e 23
1. Project Manager and Data Management ...........cccoceveiiereiesereeeseresesese e seesesnes 27
2. Projects Geometry INfOrmation .........cccooieiiiiiiii e e 33
3. FIOW PAFAMETEIS ...t bbbttt bbb 39
T Y/ - 11 T o 00T LSS UPRR 39
3.2, INVEISE SOIULION ..ottt bbb 40
3.3, TIME INFOrMALION ..oveiiiiiecie et sa e sr et 44
B O TV i o1V 11 (0] 1= 4 o] o PSR 46
T T 1 (=] =V 4 o] (O 1 (=] o - VO ST URRR 48
3.6.  SOIl Hydraulic MOGEL ...........ccviieiieeece et 51
3.7, Water FIOW Parameters ... ...ccooiiiiiieiiesiesie ettt sttt 53
3.8.  Neural NetWork PrediCtions .........ccocooeiiieiininisieie e 57
3.9.  Anisotropy in the Hydraulic CONAUCTIVILY ........ccceeiiiiiiniiiieecee e 58
I8 O o [N (- I 1] o0 o OSSR 59
3.11.  Solute TransPOrt PArameterS........ccoiiieiieiieie e sieeie st ee e see e sae e e e nee e 64
3.12.  Solute REACLION PAraMELEIS. .......ccueiiiiiiieiiesiisiesieeeeie et 65
3.13. Temperature Dependence of Solute Transport Parameters..........cccccceevvevieeiieiiieeninns 69
3.14. Water Content Dependence of Solute Transport Parameters...........cccoccevveveivereennnn, 70
3.15.  Solution Compositions for the UNSATCHEM Module............ccoooeiiniiiinniiceee 71
3.16. Chemical Parameters for the UNSATCHEM Module ............ccocvvviiiiiiiininenceen, 72
3.17.  Heat Transport PAramELEIS .........ooiiiiiiaiieriiesiee ettt e e sbeesnneenee s 73
3.18. Root Water Uptake MOEl ..........cccoeiiiiiiiiiice s 75
3.19. Root Water Uptake ParametersS...........coiieiiiieiienienie et 77
3.20. ROOt DiStribution PArameters.........ccooeiiieiiiiiisieiesie e 80
3.21. Time Variable Boundary CoNditioNS .........ccccoveiieiiiiinieniee e 82
3.22.  ConStructed WELIANGS ..........oiiiiiieieieie e 84
4. Geometry of the TranSPOrt DOMAIN........c.ooiiiiiiieiiee e 95



4.1.

4.2.

4.3.
44.

4.5.
4.6.
4.7.

BOUNCANY ODJECLS. ....cviiiiieie e et e 95

A.1.1. POINES ¢ttt bbbttt bbb 98
4.1.2. Lines and POIYIINES ..o 101
4.1.3. ArcS and CirCIES.......ccouiiiiiiiie s 102
4.1.4. CUrves and SPIINES........coiiiiiieiei e 105
4.1.5. Common Information for a Graphical Input of ObjectS........c..ccccevvvvriirennne. 107
4.1.6. Translate, Copy, Rotate, Mirror, Stretch, and Skew Operations................... 108
4.1.7. Additional OPErationS.........cccceiiierverieiieieeresee e see e e ee e e ae e sre e e 111
SUITAICES ..ttt et b ettt et b e e bt s e et e e beene e be e b e nneenns 112
4.2.1. General DefiNItIONS. ..ot s 112
4.2.1.1. Planar SUIMACES........ccciuiiieriiiie it 114
4.2.1.2. CUIVEd SUIMACES .....c.eiiiiiiiiieieieie et 115
4.2.1.3. Partial SUIMACES ......ccoiiiiieecie e 117

4.2.2. Steps to Define a Two-Dimensional Domain..........ccccccevveveiieneevesieseennnn, 117
4.2.3. Several notes on rules for correct definition of the Geometry....................... 118
O S ) T g F= L @] o] T £ OSSP 119
4.2.5. Check and Repair GEOMELIY. .......cccuiuiiiiiieiesie e 122
(@] 0101 0T 1SS 115
N3 T0] 1T KOS URTR P 124
4.4.1. 3D-Layered — Hexahedral SOlIdS..........ccccoveviiiiniiie e 124
4.4.2. 3D-Layered — General SOIAS. ........ccccooiiiiiiiiieniee e 125
4.4.2.1. Division of a Solid into ColuMNS. ........cccvvviiiiiiiiee s 129
4.4.2.2. Division of a Solid into GeO-Layers........cccceeieerviieneenesieseeins 129
4.4.2.3. Individual specification of different Thicknesses of Geo-Layers at
different ThiCKNess VECIOIS. ......ccviiiiieiieieneseee e 129

4.4.2.4. Stepsto Define a 3D-Layered Domain. ........c.cccevvevvevvesesnennennnns 130

4.4.3. 3D-General SOHAS. .....c.ooeiiieieiieiee e 130
TRICKNESS VECTOTS. ...ttt bbbttt bbbt 133
Intersections of Surface and SOHIAS..........cccoiiiiiiiii 137
AUXITTATY ODJECES ..vveuiiieie ettt ra et e s e raeaeeneesneeeeas 137
O R B [ 1=T 0 ] o] TP PSR PPTRR 139
A.7.2. LADEIS ... s 140
4.7.3. BItMAPS (TEXIUIES) ...viiueiiieeiieeieestiesieeie sttt tee sttt be e sreenreenee e 141



A7 4. CrOSS-SECTIONS. ..ceeeeeieieeeeeeeeeeeee ettt e et ettt et ettt e eeeeeeeeteeeerereeerereeeeeereeeaeeeeeees 142

A.7.5. IMESN-LINES ..ottt 142
4.7.6. BaCKgrouNd LAYEIS .......coviiieieiieniieie sttt 144
4.8.  Other Notes 0N ODJECLS ....ccueciiiieiicie et nns 147
4.8.1. ODJECt NUMDEIING ..c.viiieiiieiieeie sttt 147
4.8.2. Relations among ODJECES ......cc.ccverieriiiiiiieie e 147
4.8.3. References among Objects and Convention for Writing a List of Indices.....147
4.9.  Import Geometry from a Text File ... oieiiieie e 147
4.10. Import Geometry from a DXF File .......coooiiiiiiiie s 150
4.11. Import Geometry from a TIN File.......ccooiiiiiiieie e 150
FINIte EIEMENT IMESN ...ttt 151
5.1.  Finite Element MeSh GENerator............ccouiiiieiinienie e 151
5.2.  Structured Finite Element Mesh Generator.........c.ccooceviiiiieeiesieniee e 151
5.3.  Unstructured Finite Element Mesh Parameters ..........c.ccocvvvivieneneneneneneseseenens 154
5.4.  Finite Element Mesh RefiNEMENt ..........coov i 160
5.4.1. Finite Element Mesh Refinement for MeshGen2D ..........cccocveieniiiniinnnnns 160
5.4.2. Finite Element Mesh Refinement for Genex/T3D .......ccccvvvviiieniieneeicceee, 163
5.5.  Unstructured Finite Element Mesh Generator MeshGen2D ..........c.ccococviciniinnnnnne 166
5.6.  Finite Element Mesh STatiStICS.........cueiieiiiiiiiee s 170
5.7.  Finite Element MeSh SECHIONS........ccccveiririiiiririeirese e 171
Domain Properties, Initial and Boundary Conditions............ccocceveienieninnenie e 173
6.1.  Default DOMaiN PrOPerti€S.......ccoiviiiiiieiiiieiiesesieeseesie e sie e sae e saesrae e eneesnaenee s 173
6.2, INILIAL CONUITIONS ..ot ne s 174
6.3.  Boundary CONUITIONS .......ccveveiierieeieseesie e se e ee e ee e sre e saeeaesreesreeneesnaeneeas 177
6.3.1. Time-Variable Head/FIuxX 1 BCS .......ccccoiiiiiiieieiie e 178
6.3.2. Special Boundary CoNditioNS ..........cccccueiverieiieeneeiesiese e sie e e e 179
6.3.3. Triggered Irrigation.........cccoiuiiiiieiie e s 182
R S B To - U] (T o o] o F=] =TSSR PRSTRSS 183
6.5.  Defining Properties on Geometric ODJECTS.......cccviviiieiiiie e 186
6.5.1. Materials on GEOmMEtriC ODJECES......c.ccvveiveieiiere e 188
6.5.2. Observation Nodes on Geometric ODJECES........cccvvereereiiie i 191
6.5.3. Initial Conditions on Geometric ODJECTS ........ccvveieieeri e 192
6.5.4. Boundary Conditions on Geometric ODJeCtS........ccovveiiiiiiiiiienieceecc e 193



6.5.5. Additional Notes on Properties at Geometric ODjects .........cccccevvvvieercnnnnne. 194

7. GraphiCal OULPUL........ooiieie et et e e e e be e e sneesreenee e 194
7.1, Results — Graphical DiSPIay .........ccooeiieiiiiiiieesee e 195
7.1.1. Displayed Variables..........ccccceiieieiieiiesr e 196

7.1.2. DiSplay OPLIONS ....ccueieiiiieiieie ittt 201

7.1.3. Edit Isoband Value and Color Spectra..........cccooveveiienvcieiieie e 202

7.2.  Results — Other INfOrmation...........coueiieiiiii i 208
7.2.1. CONVEITTO ASCHI ... 211

8. Graphical User Interface COMPONENTS ........ocviiiiiiiierieiie et 213
8. L. VIBW WINUOW ..ttt bbbttt 213
8.1.1 Scene and Viewing COMMANGS ........c.ccueruirierierienieseesiesee e 213

8.1.2 Grid and WOrK Plane ...........cccuviiiiiiiiiieiee et 214

8.1.3  StretChing FaCIOrS........coiiiiiieiiesie et s 215

8.1.4. Rendering MOdel .........ccovviiiie e e 216

8.1.5. Selection and Edit COMMANGS .........ceiieriiiiiiieieeieeee e s 216

8.1.6. POP-UP MENUS ...ttt nnne e 217

8.1.7. Drag and DIOP......cceeiiiieiiiie sttt st e 218

818, SECLIONS ...ttt bbbttt bbb 218

8.2, NAVIQALOE BAIS... ..ottt ee s 221
8.3, BT BAIS oot 223
ST S o o] | o= USSR PRSPPI 228
8.5, HYDRUS MENUS......eiiuieiiiiieiiaiesieieie sttt sttt sttt be st sesbe st esesbeste e ene s s 232
9. Miscellaneous INTOrMATION..........cciiiiiiie e e e 253
0.1, Program OPLIONS .....cccueieeieeieseesieeieseesteeseestaesaeseesseessesseesseesesseessaesesseessesssessenssens 253
9.2,  HYDRUS License and ACHIVALION..........ccccuririierieiie et 257
9.2.1. Brief Description of HYDRUS ACtIVatioN.........cccccoveiiereiieieeie e 257

9.2.2. Detailed Description of HYDRUS ACHIVALION ........c.oooveiiiieiieienieieeecee e 257
9.2.2.1.  ON-LiN@ ACHIVALION .....c.ooviiiiiiieiieieie s 260

9.2.2.2. Activation by E-mail.........cccooiiiiiiiiiiii e 262

9.2.3. Detailed Description of HYDRUS AcCtivation ............cccccveverivenesiiesieene e 268
0.2.3.1.  On-Line DeaCtiVatiON .........ccceiieieiieniieie e 269

9.2.3.2. Deactivation by E-mail............cccooovriiiiiiiiiec e 270

0.2.4. EXtending ACLIVALION ........ciiiiiiieiieie et 271



0.3, PrINT OPLIONS. ... itieieeie ettt ettt bbb bbb e et esre et 272

9.4.  Print Preview and Copy to the Clipboard Commands ...........cccceeevvereiieeresiiesieeninns 273
0.5, COOrdINALE SYSIEIMS. .. .eiitieiieiie ittt ettt sttt bbbt eesbeestesneesreenee s 274
9.6. DOS Window During CalCulations.............ccccivereiiieiieenesie e se e se e 275
9.7.  Running Computational Modules Outside of GUI or in a Batch..............ccccovevennee. 276
0.8, VIUEO FHIS .. bbbt 277
0.9, ADBOUL HYDRUS. ... ..ot be e ee e nraeaneas 279
RETEIEINCES ... bbb bbbt bt e b e bbb bbb e ne e 281






Figure 1.
Figure 2.
Figure 3.
Figure 4.
Figure 5.
Figure 6.
Figure 7.
Figure 8.
Figure 9.

Figure 10.
Figure 11.
Figure 12.
Figure 13.
Figure 14.
Figure 15.
Figure 16.
Figure 17.
Figure 18.
Figure 109.

Figure 20.
Figure 21.
Figure 22.
Figure 23.
Figure 24.
Figure 25.
Figure 26.
Figure 27.
Figure 28.

Figure 29.

List of Figures

The HYDRUS Graphical User Interface (the main Window)..........ccccoocevvereniennnnnns 24
The project Manager with the Project Groups tab. .........ccccoevvevenienicic e 27
The Project Manager with the Projects tab. ... 28
The Project Information dialog WINAOW. .........cceoeiiriieieiie e 30
General description of the HYDRUS Project Groups. ........ccccceuvereererienseenieseeseeneeas 30
The Domain Type and Units dialog window (with 3D preview). .........cccccceveveieivennns 33
Domain Type and Units dialog window (with 2D axisymmetrical preview). ............. 34
Examples of rectangular (top) and general (bottom) two-dimensional geometries. .....35
Example of a hexahedral three-dimensional geometry. .........cccvvvviiinnenienieenenieee 36
The Rectangular Domain Definition dialog WindOW. .........ccccceveiiiiiiiieiicicceseee 36
The Hexahedral Domain Definition dialog WINAOW. ..........cccoviiiiiiniinieneiieseeas 37
The Main Processes dialog WINAOW. ........ccccveiieiieiieiieie e 39
The Inverse Solution dialog WINAOW. ........cccoiiiiiiiiiieie e 40
The Data for Inverse Solution dialog WINAOW. ..........ccceeeviieiieieiicicee e 41
The Time Information dialog WINAOW. .........ccceoiirririniiiiee e 44
The Output Information dialog WINAOW. .........cceevveiiiiciiscce e 46

The Iteration Criteria dialog WINAOW. .........cccuiiiiiiiiiiieie e 48
The Soil Hydraulic Model dialog WINAOW..........cccovveiierieiieie e 51
The Water Flow Parameters dialog window for direct (top) and inverse (bottom)

01 00] ] 1= o TSSO 53
The Rosetta Lite (Neural Network Predictions) dialog window. .............ccccevveiiennns 57
The Edit Local Anisotropy dialog window for two-dimensional applications............ 58
The Tensors of the Anisotropy dialog WINAOW...........cceviiiiiiniieniiiiie e 58
The Solute Transport dialog WINAOW...........ccueiveiiiieiieie e 59
The Solute Transport dialog window for the UNSATCHEM module. ............cccc.e.... 63
The Solute Transport Parameters dialog WiNdOW. ..........ccccvveiveiieiiieineie e 64
The Solute Reaction Parameters dialog WINAOW. ..........cccoooiiiniininiinie e 65
The Solute Reaction Parameters dialog window for the UNSATCHEM module.......68
The Temperature Dependent Solute Transport and Reaction Parameters dialog
WITTOOW. ..ottt ettt bbbt b bt et et ettt b et e b e n e 69
The Water Content Dependent Solute Reaction Parameters dialog window. ............. 70



Figure 30.
Figure 31.
Figure 32.
Figure 33.
Figure 34.

Figure 35.

Figure 36.
Figure 37.
Figure 38.
Figure 39.
Figure 40.
Figure 41.
Figure 42.
Figure 43.

Figure 44.
Figure 45.
Figure 46.
Figure 47.

Figure 48.
Figure 49.
Figure 50.
Figure 51.
Figure 52.
Figure 53.
Figure 54.
Figure 55.

Figure 56.
Figure 57.

The Solution Compositions dialog window for the UNSATCHEM module. ............. 71
The Chemical Parameters dialog window for the UNSATCHEM module.................. 72
The Heat Transport Parameters dialog WINAOW............ccooeiiriinieniniiie e 73
The Root Water Uptake Model dialog WINAOW. .........ccccoeiieieiiiesicin e 75
The Root Water Uptake Parameters dialog window for the stress response function of
Feddes et al. [1978] (left) and van Genuchten [1985] (right).........cccccevviverieerneiene. 77
The Root Water Uptake Parameters dialog window for the solute stress response
function based on the threshold model (left) and S-shape model of van Genuchten
[L985] (FIGNL). ettt sttt ne et e e neenens 78
The Root Distribution Parameters dialog WiNdOW............ccccovveveiiiinein e 81
The Time Variable Boundary Conditions dialog Window. ............cccccveviiinneniieneennns 82
The Constructed Wetland Model (CW2D) Parameter | dialog window...................... 86
The Constructed Wetland Model (CWM1) Parameter | dialog window...................... 89
The Constructed Wetland Model (CW2D) Parameter Il dialog window. ................... 90
The Constructed Wetland Model (CWM1) Parameter 11 dialog window.................... 92
A base surface showing several basic geometric ObJects........ccccvvvveviieiiiieiicieiienns 98
The Edit Bar during the process of defining graphically a new point (left) and a new
LT (T 1 USSR 99
The Edit Point dialog WINAOW. ........ccueiiiiiiiiiiiieeese e 100
Different ways of adding Parametric POINS 0N & CUIVE. ......cccovvvvevveieceerie e 101
The Edit Curve dialog WINAOW. ........cc.oiiiiiiiiiiiieese e 102
The Edit Bar during the process of defining graphically a radius for a new arc (left) or
A NEW CIFCIE (FGNL). c.eee e s 103
The New Line (Arc) dialog WINAOW. .......ccccevueiiiiieieiieseee e 104
The New Line (Circle) dialog WINAOW. ........ccooiiiiiiiiiieniee e 105
Edit Bar during the process of defining graphically a spline.......c...cccccooeviviivinenne 106
Snap to a point (left) and snap to a curve (NMght). .......ccooeeeieenenie e 107
The Translate - Copy dialog WINAOWS. ........cccciviiiiiiiiieieee e 108
The Rotate (left) and Mirror (right) dialog WINAOWS. .........coovveiiriiniinniienee e 109
The Stretch (left) and Skew (right) dialog WINAOWS...........ccccovevveieiiienecic e, 109
The Manipulation Options dialog window. The bitmaps indicate connecting lines between
points, surfaces between lines, and solids between surfaces. .........cccccovcvveeeiiieeeciiiineenns 110
The Insert Point on Curve dialog WINAOW...........cccoiriiiiiiieese s 111

The warning issued when Surfaces cannot be created automatically and must be
defined ManUaITY ..o s 113



Figure 58.

Figure 59.
Figure 60.
Figure 61.

Figure 62.

Figure 63.
Figure 64.
Figure 65.
Figure 66.

Figure 67.
Figure 68.
Figure 609.

Figure 70.
Figure 71.
Figure 72.
Figure 73.

Figure 74.
Figure 75.
Figure 76.
Figure 77.
Figure 78.
Figure 79.

Figure 80.
Figure 81.

Edit Bar during the process of defining graphically a surface (left) and the General tab
of the Edit Surface dialog Window (Fight). ........cccveveiieiiieieciece e 113
A solid showing the base SUMACE. ..o 114
Solid showing separate vertical COIUMNS. ..........cccoeviiieii e 114
A solid with its base surface in the XZ plane and thickness vectors in the Y direction.
.................................................................................................................................... 115
FE-Mesh for a solid with its base surface in the XZ plane and thickness vectors in the
Y ITBCTION. ...ttt bbb 115
Examples of Curved Surfaces (Rotary, Pipe, B-Spline, and Quadrangle Surfaces)..116
The Integrated Tab of the Edit Surface dialog Window. ...........cccceeevvievviiinieieenenn, 119
An example of Internal ODJECTS. .....ccuviiiiiiie e 120
An example of an Upper Surface definition using Internal Curves and Thickness
A =To1 (o] £ T OO UPRPTP 121
The Repair Domain Definition dialog Window. ..........cccocvevevievieeiesiecece e 122
The New Opening dialog WINAOW. .........coiiiiiiiiiinieiie e 123
The Edit Bar during the process of graphically defining a Hexahedral Solid.

Definition of a Base Surface on the left and a Thickness on the right....................... 124

The Edit Bar during the process of graphically defining a Solid by extruding a Base
Surface. Selection of a Surface (left) and definition of a Thickness Vector (right). .125

The 3D-Layered Solid dialog window; the General, Geo-Layers, and Thickness
PrOfIIES TaADS. ... e e 127
The 3D-Layered Solid dialog window; the FE-Mesh Tab for single and multiple
Fo =] £ TR TURUPURTROTPR 128
Examples of 3D-General Solids. Top - formed by Planar Surfaces, bottom — formed
DY CUNVEA SUMTACES. ....cveeieiiie ittt ettt e 131
Edit Bar during the process of graphically defining a Thickness Vector. ................. 134
The Thickness dialog WINAOW. .........cc.oiiiiiiiiiiiiinie e 134
A solid with several thiCkness VECTOIS. .........ccvviiiiiini s 135
FE-Mesh for the Solid inN FIQUIE 76. ........uoiiiiiiieieece e 135
Missing internal curves in the base SUrface. ..........cccocvvveiiereiic s 136

Consequence of missing an internal curve in the base surface on the FE-Mesh of the
L0 WIS [ = To -SSP 136

The Edit Intersection dialog window (for two Surfaces (left) and two Solids (right).137

An example of an Intersection of two Surfaces and a resulting Partial Surface and
INEEISECTION CUIVE. ..ttt sttt b e b sreeste e e 138

11



Figure 82.

Figure 83.
Figure 84.

Figure 85.
Figure 86.
Figure 87.
Figure 88.
Figure 89.
Figure 90.
Figure 91.
Figure 92.
Figure 93.
Figure 94.

Figure 95.
Figure 96.
Figure 97.
Figure 98.
Figure 99.

Figure 100
Figure 101

Figure 102.
Figure 103.
Figure 104.
Figure 105.

Figure 106.

Figure 107.

Edit Bar during the process of graphically defining a Dimension. Selection of two
definition points, the distance of which is to be labeled (left) and the dimension type
[T ] 1 TR P TSP 139
The Edit Comment dialog WINAOW. .........cccveiriiiiieie e 140
The Edit Bar during the process of graphically defining a Comment. Selection of the
Comment Position, Comment Text, Font and Color (left) and Offset (right). .......... 141
The Edit Bitmap dialog WINAOW. .........ccveiiiiiiiiiiiese e 141
The Cross-Section dialog WINAOW. .........c.ccveieiiiiiee e 142
The Mesh-Line dialog WINAOW. ........c.oiiiiiiiiiiiiiesee e 143
The Fluxes across Mesh-Line dialog Window. ..........ccccoeveveiieieeic s 143
An example of the Background Layer. ..........ccoooiiiiiiiniiiese e 145
The New Background Layer dialog WiNAOW. .........ccccceevveieiieneeie e 145
The Import Geometry from a DXF File dialog Window. ...........cccooeiiiiiinieniennene 150
The Rectangular Domain Discretization dialog Window............ccccceevevveveiiieieennenn 152
The Hexahedral Domain Discretization dialog WINdOW............cccoeerieniiinniniennnnne 153
The FE-Mesh Parameters dialog window (the Main Tab for 3D-Layered (left) and
3D-General (right) GEOMELITES)......eieiiiieieeie et 154
The FE-Mesh Parameters dialog window (Tab Stretching). .......cccccoceviviiiiieieennenn, 155
The FE-Mesh Parameters dialog window (Tab MG Options).........cccceveveveeieenennnnne 156
The FE-Mesh Parameters dialog window (Tab Options). ........cccceeevvierveresieesnennenn 158
The FE-Mesh Parameters dialog window (Mesh Section Tab).........ccccceviiiiicnenne. 159
The New FE-Mesh Refinement dialog window for the MeshGen2D module with four
different types of refinements (applied to a Point, a Line with a given FE-size or the
number of Points, and t0 @ SUIMACE). .......ccviveiiee e 161
e Example of FE-Mesh Refinements (top) and FE-Mesh (bottom).
. Circular (left) and rectangular (right) refinements around a node. ............c.cev..... 163

Refinement on a line (by defining either the size or the number of finite elements

1 L0] 1o I N 1 1<) USSR 164

Refinements on a surface (left) or solid (right)........ccccooviiiniiiin e 164

The FE-Mesh Refinement dialog window for the Genex/T3D module with six
different types of refinements (applied to a Circular or a Rectangular Point, a Line
with a given FE-size or a number of points, to a Surface, and to a Solid).............. 166
Example of mesh stretching using a stretching factor of 3 in the x-direction. .......... 169
The FE-Mesh Information dialog window for a two-dimensional problem (top) and
a three-dimensional problem (DOttOM).........ccooiiiiieiii e 170
The FE-Mesh Sections dialog WINAOW. ..........cccoevevieieiieniece e 172

12

124



Figure 108.
Figure 109.
Figure 110.
Figure 111.
Figure 112.

Figure 113.

Figure 114.
Figure 115.
Figure 116.
Figure 117.

Figure 118.

Figure 119.
Figure 120.
Figure 121.
Figure 122.
Figure 123.
Figure 124.

Figure 125.
Figure 126.

Figure 127.

Figure 128.
Figure 129.
Figure 130.
Figure 131.
Figure 132.
Figure 133.
Figure 134.
Figure 135.

The Default Domain Properties dialog WindOw. ..........c.ccovveeiiiinneenenieneeesee e 174
The Water Flow Initial Condition dialog Window. ...........ccccevvevevivenesiieseece e 175
The Temperature distribution dialog WINAOW............cccovriiiniiiniieee e 176
The Import Initial Condition dialog WIiNdOW. ..........ccccceeveviieiiiie e 177
The Time-Variable Head/Flux 1 BCs tab of the Boundary Condition Options dialog
WINJOW. 1.ttt bbbttt bbbt enes 179

The Triggered Irrigation tab of the Boundary Condition Options dialog window. 183

The Stochastic Distribution of Scaling Factors dialog window............c.c.ccccveveenee. 184
The Stochastic Parameters dialog WINAOW. ..........ccccueveiiriieninie e 185
An example of the transport domain defined using three components S1, S2, and
31 e SSRSEPSPRSRS 186
The upper part of the Edit Bar, which displays defined materials and commands for
various actions With materialS. ..........coceoi i 188
The Set Materials dialog WINAOW. .......cc.ccovviiieiiiieiiece e 189
The transport domain with materials specified on geometric objects..................... 189
The Sort Property Objects dialog WiNAOW. ..........ccccoveveiienieenicie e 190
The Edit Materials dialog WINAOW..........ccuiiiiiiiiiiieceeeee s 191
The Observation Node dialog WINAOW. ........c.cccoeeiieiiiieriee e 192
The Edit Pressure Head (left) and Concentration (right) Initial Conditions dialog
WINJOW. 1.ttt bbb bbbt e bbbttt enes 193
The Edit Water Flow Boundary Condition dialog Window. ...........ccccceeeveeicnennne. 194
The "Results - Graphical Display" part of Data Tab of the Navigator Bar for the
standard (left), Unsatchem (centre), and Wetland (right) modules..............c.......... 199
The "Results™ part of the View Tab of the Navigator Bar with the display of various
Alternative VariabIes. .........oouiiieiie et 200
The Display Options dialog WINAOW. .........cccerviieiieiesie e 201
The Edit Isoband Value and Color Spectra dialog window............cccccocevveiinnnee. 202
The use of intermediate ISOIINES. .......c.coviiiiiiiie s 203
The Color dialog WINAOW. .......coouiiiiiieieiieseee e 204
Adjusting scale in the Edit Isoband Value and Color Spectra dialog window. ......205
The use Of the CUSTOM SCalE..........ooiiiiiiee s 206
The COlOr SMOOTNING. ...vveiiiieciece e e 207
The Convert to ASCII dialog WINAOW. .......ccccoviiiiiiieiiiieiecee s 211

13



Figure 136.
Figure 137.
Figure 138.
Figure 139.
Figure 140.
Figure 141.
Figure 142.

Figure 143.

Figure 144.
Figure 145.
Figure 146.
Figure 147.
Figure 148.
Figure 149.
Figure 150.
Figure 151.
Figure 152.
Figure 153.
Figure 154.
Figure 155.
Figure 156.

Figure 157.
Figure 158.

Figure 159.
Figure 160.
Figure 161.
Figure 162.
Figure 163.
Figure 164.

x-y graph dialog window displaying pressure heads in observation nodes. ........... 208

The Grid and Work Plane dialog WINAOW. ..........cccooveieiiieniieircie e 214
The View Stretching Factors dialog WINAOW...........cooceiiiiieniiin i 215
The Rendering part of the View Tab of the Navigator Bar. ..........ccccccccvvvervnnnnen. 216
The Pop-up Menu from the VIew WINAOW. .........cccooueieriiiinniiie e 218

Options for Generation of Geo-Sections and FE-Mesh Sections dialog window. .219

Selected Navigator Bars (Data Tabs on the left and in the middle, the View Tab
(o 0T (L= T PSS 222

Selected Edit Bars (from left to right) for Material Distribution in Domain
Properties, Water Flow Boundary Conditions, Pressure Head Initial Conditions, and

Water CONteNt RESUILS. ......cceiiieiiiie e 223
The Color Scale Display OptionS MENU........c.coveieieeieeieseese e 227
Selected Edit Bars (for Domain Geometry and FE-Mesh). ........c.ccociveviiniiiinnne 227
The Toolbars dialog WINAOW. ........c.coiveiiiieiieic e 228
The Customize Toolbars dialog WINAOW. ...........cccovieiiiiinieiie e 228
The HYDRUS Menus | (File, Edit, and VIEW)........ccoiviieriierieie e 232
The HYDRUS Menus 11 (Insert, Calculations, and Results). .........ccccoceveerenennne. 233
The HYDRUS Menus Il (Tools, Options, Windows, and Help)..........ccccceevenenee. 233
The Program Options dialog window (the Graphics Tab).........cccooeveniiniiincnenne. 253
The Program Options dialog window (the Program Options Tab)...........ccccceeueeee. 254
The FE-Mesh Options dialog window (the Program Options Tab)..........cccccceeeee. 255
The Program Options dialog window (the Files and Directories Tab).................. 256
The HYDRUS Authorization Status dialog window (Tab Status). ..........cccccceeenee. 258
Warning issued when attempting to make changes to the Authorization Status while
not running HYDRUS with administrator privileges.. .......c.cccooevviieiiinneniiesieennns 259

The HYDRUS Authorization Status dialog window (Tab Add-on Modules)........ 259
The HYDRUS License and Activation dialog window (Tab History of Activation).

................................................................................................................................. 260
The Online Activation dialog WINAOW. ..........ccccviiiiieieiieseeee e 261
Window requesting confirmation of entered parameters..........cccccvevveverivereennnn 262
The Activation by E-mail dialog window (Tab Step 1)......cccccevvvieiinieninieieee, 273
The Activation by E-mail dialog window (Tab Step 2)......cccccceevvveveniieseeresiee 264
Email with the HYDRUS Activation Request in OUtlooK.............ccccovveviiienennnns 265
Window inquiring if the user wants to enter the Activation Code.............cccue.n..... 266

14



Figure 165.
Figure 166.
Figure 167.
Figure 168.
Figure 169.
Figure 170.
Figure 171.
Figure 172.
Figure 173.
Figure 174.
Figure 175.
Figure 176.

The Activation by E-mail dialog window (Tab Step 3)......cccccvvvvieeiiniieneeieneeee 267

Window confirming successful HYDRUS authorization. ..........c.cccceeviveiieieennnne, 267
Window reporting a failure of HYDRUS authorization. ..........c.cccoceiviiiiiniennnnne 268
The Online Deactivation dialog WINAOW. ...........cccevveieiiieiieeie e 269
Window confirming successful online deactivation of HYDRUS. ........................ 269
The HYDRUS Deactivation dialog WINAOW............cecveierveneeiie e 270
Window confirming successful deactivation of HYDRUS by email. .................... 271

The General, Picture, and Legend tabs of the Print Options dialog window.......... 272

The Coordinate Systems dialog WINAOWS. ...........ccooeeiiiiiniiniiie e 274
The Create Video File dialog WINAOW. .........cccccvvieiieiiieseece e 277
Result of commands Print Preview or Copy to the Clipboard.............cccoccoeniennenn 273
The About HYDRUS dialog window (the Program tab (top) and the Authors tab
(o100 1 ) RS URURORTRRPRRTIN 279

15



16



Table 1.
Table 2.
Table 3.
Table 4.
Table 5.
Table 6.
Table 7.

Table 8.

Table 9.

Table 10.

Table 11.
Table 12.
Table 13.

Table 14.
Table 15.

Table 16.

Table 17.
Table 18.
Table 19.
Table 20.
Table 21.

Table 22.

List of Tables

Commands in the Project Manager..........cccovieieiieiieiie et 29
Data types for the objective function (Inverse Problem). ........ccccccooeviveveiieiieeneciee 42
Definition of the column X in Fig. 14 based on Data Type (Inverse Problem). ............ 42
Definition of the column Y in Fig. 14 based on Data Type (Inverse Problem).............. 43
Time INformation Variables. ... 45
Time Step Control VariabIes. .........ccvoieiieiicie e 50

Soil hydraulic parameters for the analytical functions of van Genuchten [1980] for
twelve textural classes of the USDA soil textural triangle according to Carsel and
ParriSh [L988]......ccueiiiiiiiie et bt ns 55

Soil hydraulic parameters for the analytical functions of van Genuchten [1980] for
twelve textural classes of the USDA textural triangle as obtained with the Rosetta
Lite program [Schaap et al., 2001]. ....c.ccoveiieieiieiiee e 55

Soil hydraulic parameters for the analytical functions of Brooks and Corey [1964] for
twelve textural classes of the USDA soil textural triangle according to Carsel and

ParriSh [L988]......cceiiiiiiiie ettt bbb e 56
Soil hydraulic parameters for the analytical functions of Kosugi [1996] for twelve
textural classes of the USDA soil textural triangle. ... 56
Comparison of CW2D and CWMZ1 COMPONENTS. ......ccvereeiiverieiieseerieeiesieesieseessaenneas 84
Comparison of CW2D and CWML PrOCESSES. .....cevveervrrreriieeieseesieesieseesieesiesseesseeneens 85
Kinetic parameters in the CW2D biokinetic model [Langergraber and Simunek,
1400 ) ST PSR 87

Kinetic parameters in the CWML1 biokinetic model [Langergraber et al., 2009]. ......88

Temperature dependences, stoichiometric parameters, composition parameters and
parameters describing oxygen transfer in the CW2D biokinetic model [Langergraber
and SIMUNEK, 2005].......iiiiiieieeie e et s re et sre e 91

Temperature dependences, stoichiometric parameters, composition parameters and
parameters describing oxygen transfer in the CWML1 biokinetic model [Langergraber

BL AL, 2000]. .ttt ne e e 93
Definition of terms related to geometry deSign. ........ccovvereriienieninee e 96
Definition of terms related to boundary discretization. ...........cccccvveviveieiiievrsiesiennns 167
Finite element mesh sections generated in different HYDRUS versions. ................... 171
Definition of commands used to manipulate Property Objects. .........cccccevveieiivennne 187

Standard variables displayed in the View Window of the Results tab (Results -
(C Vo g oL DT o] 1Y) OSSR 196

Alternative variables that can be displayed in the View Window of the Results tab.197

17



Table 23.
Table 24.
Table 25.
Table 26.

Definition of various concentration modes (for linear sorption model). ................... 198
Graph options in the HYDRUS interface. .......cccccovvvievieeieiiece e 209
HYDRUS MENU COMMANTS. .....veiiieiieiieiie sttt sttt sne e 234
Brief description of HYDRUS menu COMMAaNGS..........ccovvereerieneeseeieseeseseesaeseens 241

18



Abstract

Sejna, M., J. Simanek, and M. Th. van Genuchten, The HYDRUS Software Package for Simulating
Two- and Three-Dimensional Movement of Water, Heat, and Multiple Solutes in Variably-
Saturated Media, User Manual, Version 2.0, PC Progress, Prague, Czech Republic, 284 pp., 2011.

This report documents version 2.0 of the Graphical User Interface of HYDRUS, a software
package for simulating water, heat, and solute movement in two- and three- dimensional variably
saturated media. The software package consists of the computational computer program, and the
interactive graphics-based user interface. The HYDRUS program numerically solves the Richards
equation for variably saturated water flow and advection-dispersion equations for both heat and
solute transport. The flow equation incorporates a sink term to account for water uptake by plant
roots. The heat transport equation considers transport due to conduction and convection with
flowing water. The solute transport equations consider advective-dispersive transport in the liquid
phase, as well as diffusion in the gaseous phase. The transport equations also include provisions for
nonlinear nonequilibrium reactions between the solid and liquid phases, linear equilibrium reactions
between the liquid and gaseous phases, zero-order production, and two first-order degradation
reactions. In addition, physical nonequilibrium solute transport can be accounted for by assuming a
two-region, dual-porosity type formulation which partitions the liquid phase into mobile and
immobile regions. Attachment/detachment theory, including filtration theory, is additionally
included to enable simulations of the transport of viruses, colloids, and/or bacteria.

HYDRUS may be used to analyze water and solute movement in unsaturated, partially saturated, or
fully saturated porous media. The program can handle flow regions delineated by irregular
boundaries. The flow region itself may be composed of nonuniform soils having an arbitrary degree
of local anisotropy. Flow and transport can occur in the two-dimensional vertical or horizontal plane,
a three-dimensional region exhibiting radial symmetry about the vertical axis, or a fully three-
dimensional domain. The two-dimensional part of this program also includes a Marquardt-
Levenberg type parameter optimization algorithm for inverse estimation of soil hydraulic and/or
solute transport and reaction parameters from measured transient or steady-state data for two
dimensional problems. Details of the various processes and features included in HYDRUS are
provided in the Technical Manual [Simznek et al., 2011].

The main program unit of the HYDRUS Graphical User Interface (GUI) defines the overall
computational environment of the system. This main module controls execution of the program and
determines which other optional modules are necessary for a particular application. The module
contains a project manager and both the pre-processing and post-processing units. The pre-
processing unit includes specification of all necessary parameters to successfully run the HYDRUS
FORTRAN codes, grid generators for relatively simple rectangular and hexahedral transport
domains, a grid generator for unstructured finite element meshes for complex two-dimensional
domains, a small catalog of soil hydraulic properties, and a Rosetta Lite program for generating soil
hydraulic properties from soil textural data. The post-processing unit consists of simple x-y graphics
for graphical presentation of soil hydraulic properties, as well as such output as distributions versus
time of a particular variable at selected observation points, and actual or cumulative water and
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solute fluxes across boundaries of a particular type. The post-processing unit also includes options
to present results of a particular simulation by means of contour maps, isolines, spectral maps, and
velocity vectors, and/or by animation using both contour and spectral maps.

Version 2.0, which includes the 3D-Professional Level of HYDRUS, includes many new features as
compared to version 1.0. New features and changes in the HYDRUS GUI:

1)
2)

3)
4)

5)
6)

7)

8)
9)

Supports for complex general three-dimensional geometries (Professional Level).

Domain Properties, Initial Conditions, and Boundary Conditions can be specified on
Geometric Objects (defining the transport domain) rather than on the finite element mesh.
Import of initial conditions from existing HYDRUS projects even with (slightly) different
geometry or FE mesh.

Import of various quantities (e.g., domain properties, initial and boundary conditions)
from another HYDRUS projects even with (slightly) different geometry or FE mesh.
Support of ParSWMS (a parallelized version of SWMS_3D).

Support of UNSATCHEM (a module simulating transport of and reactions between
major ions).

The Mass Balance (Inverse) Information dialog window enables to display texts larger
than the capacity of the Edit window.

Root distribution can be specified using GUI parallel with the slope for hillslopes.
Display of results using Isosurfaces.

10) Support of a new CWM1 constructed wetland module [Langergraber et al., 2009].

New features and changes in the HYDRUS in the computational modules:

1)
2)
3)
4)
5)
6)
7)

8)
9)

New initializations conditions for solute transport (initial conditions can be specified in the
total solute mass and nonequilibrium phases can be initially equilibrated).

Various new boundary conditions (e.g., gradient, surface drip, subsurface drip, and seepage
face with a specified pressure head boundary conditions).

Triggered Irrigation - irrigation is triggered by the program when the pressure head at a
particular observation node drops below a specified value.

HYDRUS calculates and reports surface runoff, evaporation and infiltration fluxes for the
atmospheric boundary.

Water content dependence of solute reactions parameters using the Walker’s [1974] formula
was implemented.

A new option to consider root solute uptake, including both passive and active uptake
[Simiinek and Hopmans, 2009].

The Per Moldrup’s tortuosity models [Moldrup et al., 1997, 2000] were implemented as
an alternative to the Millington and Quirk [1960] model.

An option to use a set of Boundary Condition records multiple times.

Executable programs are about 1.5 - 3 times faster than in the standard version due to the
loop vectorization.

10) Options related to the fumigant transport (e.g., removal of tarp, temperature dependent

tarp properties, additional injection of fumigant).

11) A new CWML constructed wetland module [Langergraber et al., 2009].
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This report serves as a User Manual and reference document of the Graphical User Interface of
the HYDRUS software package. Technical aspects such as governing equations and details about
the invoked numerical techniques are documented in a separate Technical Manual.
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Introduction to the HYDRUS Graphical User Interface

The past several decades or so has seen an explosion of increasingly sophisticated numerical models
for simulating water flow and contaminant transport in the subsurface, including models dealing
with one- and multi-dimensional flow and transport processes in the unsaturated or vadose zone
between the soil surface and the ground water table. Even with an abundance of well-documented
models now available, one major problem often preventing their optimal use is the extensive work
required for data preparation, numerical grid design, and graphical presentation of the output results.
Hence, the more widespread use of multi-dimensional models requires ways which make it easier to
create, manipulate and display large data files, and which facilitate interactive data management.
Introducing such techniques will free users from cumbersome manual data processing, and should
enhance the efficiency in which programs are being implemented for a particular example. To avoid
or simplify the preparation and management of relatively complex input data files for two- and
three-dimensional applications, and to graphically display the final simulation results, we developed
an interactive graphics-based user-friendly interface HYDRUS for the MS Windows 95, 98, NT,
ME, XP, Vista, and 7 environments. The interface is connected directly to the computational codes.
The current version 2.0 of the HYDRUS graphical user interface represents a major upgrade of
version 1.0, which itself was a complete rewrite of the version 2.0 of HYDRUS-2D that expanded
capabilities of HYDRUS-2D to three-dimensional problems. Version 2, which includes the 3D-
Professional Level of HYDRUS, includes many new features as compared to version 1.0. In
particular, it includes support for complex general three-dimensional geometries and an option to
specify various domain properties, and initial and boundary conditions on geometric objects, rather
than directly on the finite element mesh.

In addition to information given in this user manual, extensive context-sensitive on-line help is
made part of the graphical user interface (GUI). By holding the F1 button or clicking on the Help
button while working in any window, the user obtains information about the window content. In
addition, context-sensitive help is available in every module using the "SHIFT+F1" help button. In
this mode, the mouse cursor changes to a help cursor (a combination arrow + question mark), which
a user can use to select a particular object for which help is needed (e.g., a menu item, toolbar button,
or other features). At that point, a help file will be displayed giving information about the item on
which the user clicked. Except for the computational modules that are written in FORTRAN, the
entire GUI is written in C++.

The HYDRUS Graphical User Interface (Fig. 1) is the main program unit defining the overall
computational environment of the system. This main module controls execution of the program and
determines which other optional modules are necessary for a particular application. The module
contains a project manager and both the pre-processing and post-processing units. The pre-
processing unit includes specification of all necessary parameters to successfully run the HYDRUS
FORTRAN codes (modules H2D_CALC, H2D_CLCI, H2D_WETL, H2D_UNSC, and/or
H3D_CALC), grid generators for relatively simple rectangular and hexahedral transport domains, a
grid generator for unstructured finite element meshes appropriate for more complex two-
dimensional domains, a small catalog of soil hydraulic properties, and a Rosetta Lite program for
generating soil hydraulic properties from textural information. The post-processing unit consists of
simple x-y graphs for graphical presentation of the soil hydraulic properties, distributions versus
time of a particular variable at selected observation points, as well as actual or cumulative water and
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solute fluxes across boundaries of a particular type. The post-processing unit also includes options
to present results of a simulation by means of contour maps, isolines, isosurfaces, spectral maps, and
velocity vectors, and/or by animation using both contour and spectral maps.
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Figure 1. The HYDRUS Graphical User Interface (the main window).

Figure 1 shows the main window of the HYDRUS graphical user interface, including its main
components such as the Menu, Toolbars, the View Window, the Navigator Bar, Tabs, and the
Edit Bar. These terms will be used throughout this user manual. The text below provides a
detailed description of all major components of the graphical user interface. At the end of this
user manual a list is given of all commands accessible through the menu (Table 25), as well as a
brief discussion of the action taken with particular commands (Table 26). More detailed
descriptions are available through the on-line help.

Work for a new project should begin by opening the Project Manager (see Chapter 1), and giving a
name and brief description to the new project. Next the Domain Type and Units dialog Window
(Figs. 6 and 7) appears (this window can be also selected from the Pre-processing Menu). From this
point on the program will navigate users through the entire process of entering input files. Users
may either select particular commands from a menu, or allow the interface to lead them through the
process of entering input data by selecting the Next button. Alternatively, clicking the Previous
button will return users to the previous window. Pre- and post processing commands and processes
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are also sequentially listed on the Data Tab of the Navigator Bar. Green arrows on the Edit Bar
always direct users to subsequent or previous input processes for a particular command. Many
commands and processes can be alternatively accessed using either the Toolbars and Menus, or the
Navigator and Edit Bars.
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1. Project Manager and Data Management

A Project Manager (called by the command File->Project Manager, Figs. 2 and 3) is used to
manage the data of existing projects, and helps to locate, open, copy, delete and/or rename desired
projects or their input or output data. A Project represents any particular problem to be solved by
HYDRUS. The project name, as well as a brief description of the project (Fig. 4), helps to locate a
particular problem. Projects are represented by a file project name.h3d2 (the final 2 refers to
version 2 of HYDRUS; extension h3d was used with version 1.0) that contains all input and output
data when the Temporary Working Directory option (Fig. 4) is used. It contains only the input data
when the Permanent Working Directory option is selected. HYDRUS input files (used by the
computational modules) are extracted from the project_name.h3d2 file into a working subdirectory;
output data created by the calculation module are sent into the same folder. When saving a project,
output files (created by the computational modules) are also included into the project_name.h3d2
file (when the Temporary Working Directory option is used). The input and output files can be
either permanently kept in the external working directory, or are stored in this folder only during
calculations (Fig. 4, the radio buttons Temporary — is deleted after closing the project and
Permanent — result files are kept in this directory). The location of the external working directory is
specified in the Project Description (Fig. 4) and the Program Options dialog window (Fig.

Il Project Manager g
Project Groups | Projects
Current Project Group
Name: 3D_Tests
Description:
Directory: CAUSSL\HYDRUS3D\3D_Tests
MName Description Path 2
20 _Tests Two-Dimensional Examples ChusshHydrus3D\Projects\2D_Tests
20_tests CusshHydrus3D\2D_Tests
30_Tests Three-Dimensional Examples ChusshHydrus3D\Projects\3D_Tests
3D_Tests CAUSSL\HYDRUS3D\3D_Tests
Demos CAUSSL\HYDRUS3D\Demos
Direct1 CAUSSL\HYDRUS3D\Projects\Directl
Tutorials Chussh\Hydrus3D\Tutorials
=
New l ’ Edit ] ’ Remove ] ’ Set Current ]

Figure 2. The project Manager with the Project Groups tab.
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Figure 3. The Project Manager with the Projects tab.

The Project Manager gives users considerable freedom in organizing their projects. The projects
are grouped into Project Groups (Fig. 2), which can be placed anywhere in accessible memory (i.e.,
on local and/or network hard drives). Project Groups serve to organize projects into logical groups
defined by a user. Each Project Group has its own name, description, and pathway (Figs. 2 and 5).
A Project Group can be any existing accessible subdirectory (folder). HYDRUS is installed
together with two default Project Groups, 2D _Tests and 3D_Tests, which are located in the
HYDRUS3D folder. The 2D_Tests and 3D_Tests Project Groups contain test examples for two- and
three-dimensional problems, respectively. We suggest that users create their own Project Groups
(e.g., the My _2D_Direct, My 2D_Inverse, and My _3D_Direct Project Groups), and keep the
provided examples intact for future reference. Projects can be copied with the Project Manager
only within a particular Project Group. Users can copy projects between Project Groups (or share
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their HYDRUS projects with colleagues and clients) using standard file managing software, such as
Windows Explorer. In that case one must copy only the project_name.h3d2 file (when the radio
buttons Temporary — is deleted after closing the project is used, Fig. 4). When temporary data are
kept permanently in the working directory (i.e., the radio button Permanent — results files are kept
in this directory is selected, Fig. 4), the working directory must be copied together with the
project_name.h3d2 file.

In addition to a Name and a brief Description of a Project, the Project Manager also displays
dimensions for a particular problem (Type: the dimensions are either 2D or 3D, and the geometry is
either Simple (S), Layered (L), or General (G), see Section 2), what Processes are involved (W —
water flow, S — solute transport, T — heat transport, R — root water uptake, Inv — Inverse problem),
the size of the project (MB), when the project was created (Date) and whether or not the Results
exist (Fig. 3). The Project Manager can also display a preview of the Project’s geometry (see
the check box Show Project Preview in Fig. 3). Commands of the Project Manager are listed in
Table 1.

Table 1. Commands in the Project Manager.

Group Command Description
Project Group New Registers a new Project Group in the Project Manager.
Edit Renames the selected Project Group, and changes its description
and/or location.
Remove Removes registration of a selected Project Group from the Project
Manager.
Set As Current  Sets a selected Project Group as the active Project Group.
Close Closes the Project Manager.
Project New Creates a new project in the current Project Group.
Copy Copies a selected project within the current Project Group.
Rename Renames a selected project.
Delete Deletes a selected project.
Open Opens a selected project.
Close Closes the Project Manager.
Convert Converts projects created by earlier HYDRUS versions (i.e., either
HYDRUS-2D or version 1.0 of HYDRUS (2D/3D)).
Calculate Calculates selected HYDRUS projects. This command allows

users to calculate multiple selected projects simultaneously.

Options Description

Show Project Preview Provides a preview of the geometry of a particular project in the
bottom left corner of the Project Manager.

Show Old Projects Shows projects created using earlier HYDRUS versions, i.e.,

either HYDRUS-2D or version 1.0 of HYDRUS (2D/3D).
Start on Project Groups Page  Opens the Project Manager at the Project Groups Tab.
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The commands New and Rename from the Project Tab of the Project Manager dialog window
(Fig. 3) call the Project Information dialog window (Fig. 4), which contains the Name and
Description of the project, as well as information about the Project Group (name, description, and
pathway) to which the project belongs. It also contains information whether or not the input and
output data are kept permanently in an external directory (the radio buttons Temporary — is
deleted after closing the project and Permanent — result files are kept in this directory, Fig. 4).

r

Froject
M ame: D' escription:
Fuirrow Wiater flow from furmow to a drain
Froject Group: D' escription:
20_Tests Two-Dimenzional Examples Froject Manager
Fath:

ChugzPHYDRUS3D 2 0NEamplesh2D_Testsh,

Wiorking Directany:
ChugshHYDRUS3D 2008 emph~HypdrusaD_2sshFurrow

@ Temporary - exists anly when the project iz open q@u
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ext...

Figure 4. The Project Information dialog window.

X

New Project Group

Project Group

Name: 30 _tests
Description: Examples of three dimensional proklems
Directory: ChussliHydrus3DV30_Tests - Browse

Figure 5. General description of the HYDRUS Project Group.

Projects created by the previous versions of HYDRUS (e.g., HYDRUS-2D) can be imported into
the current version of HYDRUS using two ways:
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A. Individual projects can be converted using the command File->Import and Export->Import
HYDRUS-2D Project. This is done by first creating a new Project, and then selecting the
above command and browsing for the location of a project created with a previous version of
HYDRUS-2D. The input data of the older project are then converted into the new HYDRUS
format. Results of the older project can then be viewed using the new version of HYDRUS,
while projects can be modified or recalculated as needed.

B. Multiple HYDRUS-2D projects (or HYDRUS projects created by earlier versions of
HYDRUS) can be converted simultaneously using the Convert command of the Project
Manager. One first creates a HYDRUS Project Group for a folder in which the HYDRUS-2D
projects are located and selects the Show OIld Projects option at the Project Tab of the
Project Manager. One then selects projects to be converted and clicks the Convert command.
HYDRUS in this way creates HYDRUS projects and stores all input and output files in the
project_name.h3d2 files.

Input data can be edited either using the HYDRUS graphical user interface (this modifies directly
the project_name.h3d2 file) or the input data can be modified manually. In such case, HYDRUS
input files need to be stored in the working external directory (sent there by the command File-
>Import and Export->Export Data for HYDRUS Solver), and then can be imported back into the
HYDRUS project_name.h3d2 file using the command File->Import and Export->Import Input
Data from *.In Files.

The Working Directory is a folder into which the program stores temporary data. Each open
project has its own Working Directory, where the program stores, for example, input files for
computational modules, and where computational modules write the output files. When saving a
project, data from the Working Directory are copied into the main project file project_name.h3d2.
When the project is closed, the Working Directory is deleted. Only when a user selects the option
“Permanent — result files are kept in this directory” (Fig. 4) is the Working Directory not deleted
after closing the project, in which case the temporary data are not copied into the main project file.
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2. Projects Geometry Information

In the first dialog window that a user encounters after creating a new project, he/she needs to
specify whether the flow and transport problem occurs in two- or three-dimensional transport
domains. Geometry type is selected in the Domain Type and Units dialog Window (Fig. 6 and
7). In this dialog window, users specify the Type of Geometry, the 2D Domain Options, the
Length Units, and the size of the Initial Project Group (the approximate size of the transport
domain).

Type of Geometry: This section allows a user to choose between simple geometries having a
structured finite element mesh (i.e., 2D-Simple (Parametric) and 3D-Simple (Parametric)), or
more general geometries having an unstructured finite element mesh (i.e., 2D-General (Boundary
Rep.), 3D-Layered, and 3D-General (Boundary Rep.)). Available options depend on the level of
authorization (purchased License). Only simple geometries 2D-Simple (Parametric) and 3D-
Simple (Parametric) are available for HYDRUS Levels 2D-L.ite and 3D-L.ite, respectively. 2D-
General (Boundary Rep.) is available for the 2D-Standard Level, 3D-Layered for the 3D-
Standard Level, and 3D-General (Boundary Rep.) for the 3D-Professional Level.

Domain Type and Unit |m—tS |
Type of Geometry General 30 domain
) . defined by boundary sufaces. - -
1 20 - Simple [Parametric]
1 20 - General (Boundamy Rep.)
130 - Simple [Parannetric] e
1 30 - Layered
@ 30 - General (Boundary Rep.]
20-Dromain Options
2 2D - Harizantal Plane =7
20 -Wertical Plane 522
20 - Awizyrometrical Wertical Flow
nitz Model Frecizion and Fesolution
Length: Epsilon = 0.00018| [m]
Standard [recommended)
Edit Properties oh Geometric Objects
[T] Edit domain properties, initial and boundary conditions on geometric objects
| mitial "W ork space
# Y z
beir; -5.000 0.000 5,000 [m]
M a: 30.000 10.000 15.000  [m] R@g
[ 5t Wiew Stretching Factors &utomatically
[7] Display *Workzpace Outline Frefone

Figure 6. The Domain Type and Units dialog window (with 3D preview).
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Daomain Type and Umnit Lul
Type of Geomety General 20 domain ak
30 - Simple (Farametic] defined by boundary curves. m
@ ZD - General [Boundary Fep.] _
3 Help
3D - Simple [Parametric] ,.rj
3D - Layered
3D - General [Boundamw Rep.]
20-Domain Ophions
20 - Horizontal Plane #
20 - Vertical Plane =2
@20 - Awisymmetrical Yertical Flow
Urits M odel Precision and Resolution
Lenagth: | m - Epzilan = 0.00019] [ra]
| Standard [recommended)
Edit Froperties on Geometric Dbjects
Edit domain properties, initial and boundary conditions on geometric objects
Initial \workzpace
kS by z
kin: -5.000 0.000 £.000  [m]
LTS 30,000 10.000 15.000  [m] q@h
Set View Stretching Factors Automatically
Dizplay Workspace Outline | P |

Figure 7. The Domain Type and Units dialog window (with 2D axisymmetrical preview).

There are two types of two-dimensional transport domains (Surfaces, see also Section 4.2)
depending upon the selection made in the Domain Type and Units dialog window (Fig. 6 and 7):

e 2D-Simple (Parametric): This type of solid has a Rectangular Shape and is defined by
its basic dimensions. Rectangular domains are defined by three straight lines, one at the
bottom of the domain and two at the sides, whereas the upper boundary may or may not be
straight. Nodes along the upper boundary line may in that case have variable x- and z-
coordinates. However, the lower boundary line must always be horizontal (or have a
specified slope), while the left and right boundary lines must be vertical. The flow region is
then discretized into a structured triangular mesh. Examples of simple rectangular
geometries are shown in Figure 8 (top).

e 2D-General (Boundary Rep.): This type of Surface is defined by a set of Boundary
Curves see Section 4.2). Examples of general two-dimensional geometries are shown in
Figure 8 (bottom) and Figure 42.

There are three types of three-dimensional transport domains (Solids, see also Section 4.4)
depending upon the selection made in the Domain Type and Units dialog window (Fig. 6 and 7):
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dimensional objects are formed by boundary

its basic dimensions. The base can have a certain slope in the X and Y dimensions (Fig.

9). Hexahedral domains must have similar properties as rectangular domains, i.e., vertical
planes at the sides, a horizontal (or with a specified slope) plane at the bottom boundary, and
with only the upper boundary not needing to be a plane. An example of a simple hexahedral
3D-Layered: This type of solid is defined by the Base Surface (see Section 4.2) and one

or more Thickness Vectors (see Section 4.5).
Professional version. 3D-General Geometries can be formed from three-dimensional

3D-General (Boundary Rep.): This type of solid is defined using a set of surfaces that
objects (Solids) of general shapes. Three

3D-Simple (Parametric): This type of solid has a Hexahedral Shape and is defined by
fully form its boundaries. This type of geometries is available only in the 3D-

three-dimensional geometry (i.e., 3D-Simple) is given in Figure 9.

surfaces, which can be either Planar surfaces or Curved surfaces (Quadrangle, Rotary,
Pipe, or B-Spline).
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Figure 8. Examples of rectangular (top) and general (bottom) two-dimensional geometries.



Figure 9. Example of a hexahedral three-dimensional geometry.

2D-Domain Options: Two-dimensional flow and transport can occur in a horizontal or vertical
plane, or in an axisymmetrical quasi-three-dimensional transport domain. When a three-
dimensional axisymmetrical system is selected, the z-coordinate must coincide with the vertical
axis of symmetry. A typical example of the selected 2D or 3D geometry is shown in the preview
part of the dialog window.

The simple geometries are defined in the Rectangular (Fig. 10) or Hexahedral Domain Definition
(Fig. 11) dialog windows for two-dimensional and three-dimensional problems, respectively. In
each of these windows, users need to specify the vertical and horizontal dimensions of the transport
domain, as well as a possible slope of the base of the domain in different directions (if applicable;
a is in the x-direction and £ is in the y-direction). The preview in the middle of the dialog
window of a simple example showing all geometry parameters should help users in specifying
their desired transport domain (Dimensions and Slope).

Rectangular Domain Definition E|

Dimenzions K

L | 1000.00] [om] r x "1
! =1 : = _

Lz: 20000 [cm]

Slope

N 200l Lxu\

Previous ...

Figure 10. The Rectangular Domain Definition dialog window.
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Hexahedral Domain Definition

Dimenzions K

Lw: 1000.00 [cm]

Ly: [ 100000 [cm] o l"’l\-w\‘ B

Lz: 200,00 [cm] SR S
ssesess A
Slope T SER Se =

o 0.0a| [*]

B 0.00] [

Figure 11. The Hexahedral Domain Definition dialog window.

In the Domain Type and Units dialog Window (Figs. 6 and 7) users also select the geometry
Units to be used throughout the application (mm, cm, m) and the size of the Initial Project
Group. When units are changed during specification or after reading the input data, then all
input variables are automatically converted into the new units.

Initial Project Group: This part of the dialog allows users to define the initial dimensions of the
graphical view window.

Model Precision and Resolution: Epsilon is a minimum resolution recognized when defining
geometric objects. Epsilon is by default defined as R/100,000, where R is a domain radius, i.e., a
radius of a circle/sphere circumscribing the domain. Epsilon is used, for example, for evaluation
of positions of two points. If their distance is less than Epsilon, then the two points are replaced
by a single point. A user-defined epsilon may lead to unstable behavior of the program and it is
intended only for advanced users who may need it for special purposes. A correct functionality
of geometrical calculations and generation of FE-meshes is not guaranteed for user-defined
epsilons.

Edit Properties on Geometric Objects: When the check box "Edit domain properties, initial
and boundary conditions on geometric objects"” is checked, users can specify various properties
and conditions on the Geometric Objects (See Section 6.5 "Defining Properties on Geometric
Objects™ for details), rather than only on FE-Mesh, as available in Version 1.0 of HYDRUS. This
option will be by default "On™ for new projects, and it is "Off" for projects converted from
Version 1.0. Users can turn this option "Off" and continue defining various properties on FE-
Mesh, as they have been used to. Users can turn this option "On" for projects converted from
Version 1.0 of HYDRUS. However, they will then lose their original definitions and will have to
specify them again on Geometric Objects.
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3. Flow Parameters
3.1. Main Processes

In the Main Processes dialog window (Fig. 12), users specify the processes to be simulated, i.e.,
water flow, multiple solute transport, heat transport, and/or root water uptake. The major ion
chemistry module [UNSATCHEM; Simiinek and Suarez, 1994] can be used instead of the
standard solute transport module. Since there is currently no technical manual describing the
two-dimensional version of the UNSATCHEM module, users are referred to the HYDRUS-1D
manual [Simiinek et al., 2008], which provides all relevant information about this module.

The program automatically considers transient water flow when the “water flow” option is
selected. Otherwise the code tries to calculate steady-state flow from the specified initial and
boundary conditions. The success of such calculations depends on the complexity and/or
nonlinearity of the problem. If unsuccessful, then a model run with constant boundary conditions
and long simulation time may be required.

If the solute transport, heat transport or root water uptake options originally considered in an
existing project are switched off by the user, the program issues a warning that all data related to
these processes will be lost. If this loss is undesirable we recommend that users first copy the
input data of the current project to a new project before switching off the solute transport, heat
transport and/or root water uptake options.

For two-dimensional problems a user can also select if a Direct or Inverse problem is to be

solved. Inverse problems involve the estimation of selected parameters from available
experimental data.

Main Processes

.....................

Solute Transport
[ ] Major lan Chemistry

Cancel

Help

Heat Transpart
Boot water Uptake

7" w

[ 1lrverse Solution 7 -
Frevious ..

Figure 12. The Main Processes dialog window.
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3.2. Inverse Solution

HYDRUS implement a Marquardt-Levenberg type parameter estimation technique (Simtinek
and Hopmans, 2002) for inverse estimation of soil hydraulic (Hopmans et al., 2002) and/or
solute transport and reaction (Simtnek et al., 2002) parameters from measured transient or
steady-state flow and/or transport data. The Inverse Solution dialog window (Fig. 13) appears
only when the Inverse Problem in the Main processes dialog window (Fig. 12) is selected.
Users select which parameters (the soil hydraulic, solute transport and reaction, and/or heat
transport parameters) are to be optimized (Estimate ...) from the specified experimental data.

One also selects the method of Weighting of Inversion Data in the objective function. Users
can choose between no weighting, weighting by mean ratios, or weighting by standard deviations.
When no weighting is selected, one needs to supply weights for particular data points in the Data
for Inverse Solution dialog window (Fig. 14). When weighting by mean ratio or weighting by
standard deviation is selected, then the code calculates either the means or the standard
deviations of the different data sets (e.g., water contents, pressure heads, concentrations, ...) and
adjusts the weights proportionally. These internal weights can still be multiplied by weights from
the Data for Inverse Solution dialog window (Fig. 14).

Inverse Solution

E stimate ... N
Sail Hydraulic Parameters
Solute Transpart Parameters

Cancel

Help

.

Concentration Type

") Resident Concentrations
(") Log. Resident Concentrations
() Outflow Concentrations

() Cumulative Concentration Flus
() Total Resident Concentration

YWieighting of |nversion D ata
(%) Mo Intemnal Weighting
) weighting by Mean Flatio
() weighting by Standard Deviation

Other Parameters

b & Murmber of [terations: 10 pr=—
axk .
Murmber of Data Paints in the =

Obiective Function; 281

Previous ...

lig

Figure 13. The Inverse Solution dialog window.
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The objective function for the inverse estimation of solute transport parameter can be defined
using different types of concentrations. Available Concentration Types are: a) the resident
concentration in the liquid phase, b) a log-transformation of the resident concentration in the
liquid phase, c) the outflow (flux) concentration, d) the solute concentration flux, e) the
cumulative concentration (solute) flux, and f) the total resident concentration. The total resident
concentration includes concentrations in the sorbed and nonequilibrium phases.

The maximum number of iterations for the inverse solution is also specified in this dialog
window. If one selects zero number of iterations then only the direct simulation is carried out.
However, users can still enter measured data, in which case the code compares results of the
direct simulation with the measured data.

Data for Inverse Solution E|
s Ny Type Position Wieight ~ -_Ear'u:el
1 1 -47 B1 1 2 1
2 A -43.8 1 2 1
K] 10 -43.15 1 2 1
4 15 -A7.07 1 2 1 .
Add L
4] 20 3577 1 2 1
5 o5 245 1 2 1
v an -13.52 1 2 1
] i3] -17.48 1 2 1
3 4n -15.33 1 2 1
10 45 -15.43 1 2 1
11 50 -14.03 1 2 1
12 55 1317 1 2 1
13 B0 1242 1 2 1
14 B5 1264 1 2 1
15 70 136 1 2 HES
[ ] Show list boses [not recommended for large data files) Erevious ...

Figure 14. The Data for Inverse Solution dialog window.

In the table Data for Inverse Solution (Fig. 14) one specifies the measured data that will be
analyzed during the parameter optimization process. Many different types of data can be used to
define the objective function that will be minimized for this purpose. How the values in the X
and Y columns are interpreted depends on the Type and Position values. Weight is the weight
associated with a particular data point. The following information can be included into the
objective function:
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Table 2. Data Types for the objective function (Inverse Problem).

Type Data Point
0 Cumulative boundary fluxes across a specified boundary
1 Pressure head measurements at selected observation point(s)
2 Water content measurements at selected observation point(s)
3 Boundary flux across a specified boundary
4 Concentration or temperature measurements at observation point(s)
5 h(6) measurements; soil water retention data
6 K(h) measurements; hydraulic conductivity data point
7 Prior knowledge of parameter «
8 Prior knowledge of parameter n
9 Prior knowledge of parameter &
10 Prior knowledge of parameter &,
11 Prior knowledge of parameter K

Depending upon the value of parameter Type, the first column (X) contains the following
information:

Table 3. Definition of the column X in Fig. 14 based on Data Type (Inverse Problem).

X Type
Time 0,1,23,4
Pressure head 5,6
Dummy variable 7,8,9,10, 11

Depending upon the value of parameter Type, the second (Y) and fourth (Position) columns
contain the following information:
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Table 4. Definition of the column Y in Fig. 14 based on Data Type (Inverse Problem).

Y Type Position
Cumulative boundary flux across a specified 0 Code for the specified boundary”
boundary
Pressure head 1 Observation node number
Water content 2 Observation node number
Averaged water content of the entire flow domain 2 0
Averaged water content of the subregion 2 Negative subregion number
Concentrations/temperatures 4 Observation node number
Concentrations for the second solute 4 Negative observation node
number
Total amount of solute in the entire flow domain 4 0
Boundary flux across a specified boundary 3 Code for the specified boundary”
Water content 5 Material number
Hydraulic conductivity 6 Material number
Particular parameter 7-11 Material number

"1 — constant pressure head or flux boundary; 2 — seepage face; 3 — variable pressure head or flux boundary 1; 4 —
atmospheric boundary; 5 — drains; 6 — free or deep drainage boundary; 7, 8, and 9 — variable pressure head or flux
boundaries 2, 3, or 4, respectively.
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3.3. Time Information

The Time Information dialog window (Fig. 15) contains information associated with the Time
Discretization, the Time Units, and the implementation of Boundary Conditions.

Time Informatio
Time Unitz Time Dizcretization
) Seconds Initial Tirme [day]: an
O Minutes Final Time [day]: 270
' Houwrs Initial Time Step [day]: Q.05
@ Days b inimum Time Step [day]: 1e-006
O Years b gmirmum Time Step [day]: e
Boundary Conditionz
Time- ariable Boundary Conditions
Murmber of Time-\ ariable Boundary Becords: a0
Murnber aof times to repeat the zame zet of BC recaords: B

==

Cancel

@

Previousz...

Figure 15. The Time Information dialog window.

Boundary Conditions

Time-Variable Boundary Condition - The Number of Time-Variable Boundary Records and
time-dependent boundary conditions must be specified when this box is checked. The boundary

conditions otherwise are assumed to be constant in time.

The same set of boundary records can be repeated number of times (Number of times to repeat
the same set of BC records) (periodically) with a time period tPeriod=tAtmLast-tInit, where
tinit is the Initial Time and tAtmLast is the time of the last specified time record. Note that

tMax< tInit +n*tPeriod.
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Table 5. Time Information variables.

Time Units Time units [T] to be used throughout the application (years, days,
hours, min, sec). When units are changed during or after data entry,
then all input variables are converted automatically into the new
units.

Initial Time Starting time [T] of the calculation.

Final Time Final time [T] of the calculation.

Initial Time Step

Initial time increment, At [T]. The recommended value for the initial
time step depends on the type of simulation and boundary conditions
used. When simulating a process that starts with a large initial
pressure head or concentration gradient at the boundary (e.g.,
ponded infiltration or a sudden change of boundary concentration),
use a small value of the initial time step (e.g., 1 s). When simulating
a long term process with variable boundary conditions (e.g., seasonal
or multiyear simulation), start with a larger time step (e.g., 15 min).
This is because this initial time step is used whenever time variable
boundary conditions significantly change (e.g., the water flux
changes by 25% or more). If needed (if there is no convergence for
Atinit), the program will still use a smaller time step than Atj,;;, but
starting with larger Ati,i; leads to more efficient calculations. In
general smaller initial time steps must be used for soil with more
nonlinear soil hydraulic properties (e.g., course textured soils) and
larger initial time steps can be used for soil with less nonlinear soil
hydraulic properties (e.g., loam).

Minimum Time Step

Minimum permitted value of the time increment, Atmin [T]. The
minimum time step must be smaller than a) the initial time step, b)
interval between print times, and c) interval between time-variable
boundary condition records. Always specify a small minimum
allowed time step, on the order of 1 s. This value may never be used,
but it provides the code with flexibility when it may be needed, e.g.,
when there is a sudden change in boundary fluxes and HYDRUS
may not converge with larger time steps.

Maximum
Step

Time

Maximum permitted value of the time increment, Atmax [T]. This is
relatively unimportant parameter and a large value may be specified.
Since HYDRUS automatically selects its optimal time step, there is
usually no need to constraint that. The only time when there is a
need to constrain the time step is likely for cases when HYDRUS is
asked to generate internally intra-daily variations in temperature, or
in evaporation and transpiration fluxes. Then there is a need to have
time step smaller (e.g., 1 h) so that these daily variations can be
properly modeled.
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3.4. Output Information

The Output Information dialog window (Fig. 16) contains information governing output from
the computational module of HYDRUS.

Output Information . |

%)

Frint Options Pririt T irmes
[] T-Lewvel Infarmation _ 24 4 v
e
1 (RS
[ Intersal Output 2 1
3 2
4 :
Screen Qutput
= ] a5
[ ] Press Enter at the End LT el g 10
. v 15 q@u
Subregions for Masz Balances 5 50
MHumber of Subregions: 1 3 3
10 |
L/ Previous. .

Figure 16. The Output Information dialog window.

In the Print Options part of the dialog window, one decides whether certain information
concerning mean pressure heads and concentrations, mean water and solute fluxes, cumulative
water and solute fluxes, and time and iteration information is printed at each time step (T-Level
Information), after n time steps (Every n time steps), at a certain defined time interval (Interval
Output), or if the information is sent to the screen during the calculations (Screen Output). When
the simulation ends users are by default asked to hit the Enter key of the keyboard to return to the
GUI from the computational window. This action can be disabled by unchecking the Hit Enter at
the End check box.

T-Level Information This check box decides whether certain information concerning mean
pressure heads and concentrations, mean water and solute fluxes,
cumulative water and solute fluxes, and time and iteration information, are
to be printed at each time step, after n time steps, or only at preselected
times (Print Times) or Time Intervals.

Interval Output Users can specify whether or not information concerning mean pressure
heads and concentrations, mean water and solute fluxes, cumulative water
and solute fluxes, and time and iteration information is to be printed at a
regular Time Interval.
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Screen Output Check box to decide whether or not information about the simulation run
is to be printed to the screen during execution of the HYDRUS
computational code. We recommend to check this box for direct problems,
but not for inverse problems.

In the Print Times part of the dialog window one specifies the number of Print Times (Count)
at which detailed information about the pressure heads, water contents, concentrations,
temperatures, fluxes, and the soil water and solute balances will be printed. Clicking on the
Default command button will cause the print times to be distributed evenly between the initial and
final time. Clicking on the Default (log) command button will cause the print times to be
distributed evenly between the initial and final time on the log scale. This option is enabled only
for larger times.

Finally, in the Subregions part one selects the number of regions for which a mass balance will
be evaluated and printed to the Balance.out output file.
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3.5. Iteration Criteria

The Iteration Criteria dialog window (Fig. 17) contains information related to the iterative
process that is used to solve the Richards equation. Because of the nonlinear nature of the
Richards equation, an iterative process must be used to obtain solutions of the global matrix
equation at each new time step. For each iteration a system of linearized algebraic equations is first
derived and then solved using either Gaussian elimination or the conjugate gradient method. After
solving the matrix equation, the coefficients are re-evaluated using this solution, and the new
equations are again solved. The iterative process continues until a satisfactory degree of
convergence is obtained, i.e., until for all nodes in the saturated (unsaturated) region the absolute
change in pressure head (water content) between two successive iterations becomes less than some
small value determined by the imposed absolute Pressure Head (or Water Content) Tolerance.
The first estimate (at zero iteration) of the unknown pressure heads at each time step is obtained by
extrapolation from the pressure head values at the previous two time levels.

lteration Criteria

X]
Iteration Criteria
I amiriumn Murmber of [berations: 1
Water Content Tolerance: 0.0005
Frezzure Head Tolerance [cm]: IR

Time Step Contral

Lower Optimal Iteration B ange: 3
Upper Optimal teration B ange: K
Lawer Time Step Multiplication Fachar: 13
Upper Time Step Multiplication Eackar: 07

Internal Interpolation Tables

Lovwer Limit of the Tengion Interval [om): 1e-006

Upper Limit of the Tenzsion |ntereal [om): 10000

|mitial Conditiorn

%) In Prezsure Heads

) Inwiater Contents Previous...

Figure 17. The Iteration Criteria dialog window.

In the Iteration Criteria part of the dialog window, one specifies the maximum number of
iterations during one time step, and the water content and pressure head precision tolerances.
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Max. Number of Iterations Maximum number of iterations allowed during any time step while solving
the nonlinear Richards equation using a modified Picard method. The
recommended and default value is 10. It is usually not helpful to use a
larger value than 10. If HYDRUS does not converge in 10 iterations,
then there is a relatively small probability that it will do so during more
iteration. Even if it does, it is much more efficient to reduce the time step
and attempt to find the solution with a smaller time step, which is done
automatically by the program when It is reached.

Water Content Tolerance  Absolute water content tolerance for nodes in the unsaturated part of the
flow region [-]. When the water contents between two successive iterations
during a particular time step change less than this parameter, the iterative
process stops and the numerical solution proceeds to the new time step. Its
recommended and default value is 0.001.

Pressure Head Tolerance  Absolute pressure head tolerance for nodes in the saturated part of the flow
region [L]. When the pressure heads between two successive iterations
during a particular time step change less than this parameter, the iterative
process stops and the numerical solution proceeds to the new time step. Its
recommended and default value is 1 cm.

Information specified in the Time Step Control part of the dialog window is related to the
automatic adjustment of the time step during calculations. Four different time discretizations are
introduced in HYDRUS: (1) time discretizations associated with the numerical solution, (2) time
discretizations associated with implementation of boundary conditions, (3) time discretizations
associated with data points used in the inverse problem, and (4) time discretizations which provide
printed output of the simulation results (e.g., nodal values of dependent variables, water and solute
mass balance components, and other information about the flow regime).

Discretizations 2, 3, and 4 are mutually independent; they generally involve variable time steps as
described in the input data file (Time-Variable Boundary Conditions, Fig. 37 and Output
Information, Fig. 16). Discretization 1 starts with a prescribed initial time increment, At. This time
increment is automatically adjusted at each time level according to the following rules:

a. Discretization 1 must coincide with time values resulting from time discretizations 2, 3,
and 4.

b. Time increments cannot become less than a preselected minimum time step, Atmi,, nor
exceed a maximum time step, Atmax (i.€., Atmin < At < Atpay).

c. If, during a particular time step, the number of iterations necessary to reach convergence
is <3, the time increment for the next time step is increased by multiplying At with a
predetermined constant >1 (usually between 1.1 and 1.5). If the number of iterations is
>7, At for the next time level is multiplied by a constant <1 (usually between 0.3 and
0.9).

d. If, during a particular time step, the number of iterations at any time level becomes
greater than a prescribed maximum (usually between 10 and 50), the iterative process
for that time level is terminated. The time step is subsequently reset to At/3, and the
iterative process restarted.
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We note that the selection of optimal time steps, At, during execution is also influenced by the
adopted solution scheme for solute transport.

Table 6. Time Step Control variables.

Lower Optimal Iteration | When the number of iterations necessary to reach convergence
Range for water flow is less than this number, the time step is
multiplied by the lower time step multiplication factor (the
time step is increased). Recommended and default value is 3.
Upper Optimal Iteration | When the number of iterations necessary to reach convergence
Range for water flow is higher than this number, the time step is
multiplied by the upper time step multiplication factor (the
time step is decreased). Recommended and default value is 7.
Lower Time Step | If the number of iterations necessary to reach convergence for
Multiplication Factor water flow is less than the lower optimal iteration range, the
time step is multiplied by this number (time step is increased).
Recommended and default value is 1.3.

Upper Time Step | If the number of iterations necessary to reach convergence for
Multiplication Factor | water flow is higher than the upper optimal iteration range, the
time step is multiplied by this number (time step is decreased).
Recommended and default value is 0.7.

Internal Interpolation Tables. At the beginning of a numerical simulation, HYDRUS generates
for each soil type in the flow domain a table of water contents, hydraulic conductivities, and
specific water capacities from the specified set of hydraulic parameters. Values of the hydraulic
properties are then computed during the iterative solution process using linear interpolation
between entries in the table. If the pressure head h at some node falls outside the prescribed
interval (h,s, hy), the hydraulic characteristics at that node are evaluated directly from the
hydraulic functions (i.e., without interpolation). The above interpolation technique was found to
be much faster computationally than direct evaluation of the hydraulic functions over the entire
range of pressure heads. Interpolation using tables can be avoided by setting h, and hy both to
zero. Then the soil hydraulic properties are always evaluated directly from the hydraulic
functions (i.e., without interpolation). Output graphs of the soil hydraulic properties will be given
also for the interval (h,, hy).

Lower limit of the | Absolute value of the lower limit [L] of the pressure head interval for
tension interval which a table of hydraulic properties will be generated internally for
each material.
Upper limit of the | Absolute value of the upper limit [L] of the pressure head interval for
tension interval which a table of hydraulic properties will be generated internally for
each material.

Finally, in the Initial Conditions part of the dialog window, a user specifies whether the initial
conditions for the water flow calculations are to be specified in terms of the pressure head or
water content.
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3.6. Soil Hydraulic Model

In the Soil Hydraulic Model dialog window (Fig. 18) users select the Hydraulic Model to be
used to describe the soil hydraulic properties, and specify whether or not Hysteresis is to be
considered during the calculations.

Soil Hydraulic Model [X]

Hydraulic kodel

(%) van Genuchten - Mualem
[ ] with Asir-Entry Walue of -2 cm
nOelp

() Modified van Genuchten

() Brooks-Corey

() E.osugi [log-nomal]

() Dual-porosity [Dumer, dual van Genuchten - Mualem)

() Dual-porogity [mobile-immobile, water ©. mass transfer]
() Dual-porosity [mobile-immobile, head mazs ranzfer]

Hysteresis

(%) Mo Hysteresis
() Hysteresiz in Retention Curve

() Hysteresis in Fetention Curve and Conductivity

() Hysteresiz in retention curve [no pumping, Bob Lenkard] Mext ...

liig

Previousz ...

Figure 18. The Soil Hydraulic Model dialog window.

Hydraulic Model: The code allows users to select six types of models for the soil hydraulic
properties: a) the van Genuchten-Mualem model [van Genuchten, 1980], b) the van Genuchten-
Mualem model with an air-entry value of -2 cm, c¢) the modified van Genuchten type equations
[Vogel and Cislerova, 1988], d) the equations of Brooks and Corey [1964], e) the lognormal
distribution model of Kosugi [1996], and f) a dual-porosity model [Durner, 1994]. Additionally,
user can select two dual-porosity nonequilibrium flow models with mass transfer between the
mobile and immobile zones assumed to be proportional to either g) the water content or h) the
pressure head [Simiinek et al., 2003]. For a detailed description of these models, see the technical
manual of HYDRUS. Two other approaches (a dual-permeability model and look-up tables) are
not available in the current version of HYDRUS.
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Hysteresis: When the van Genuchten model is used, either a) a non-hysteretic description (No
Hysteresis), b) a hysteretic description only in the retention curve (Hysteresis in Retention
Curve), or c) hysteretic descriptions in both the retention curve and the hydraulic conductivity
curve (Hysteresis in Retention Curve and Conductivity) can be used. When hysteresis in the soil
hydraulic properties is assumed, users must specify whether the initial condition is associated
with the main wetting (Initially Wetting Curve) or main drying (Initially Drying Curve)
retention curve. The HYDRUS code incorporates hysteresis by using the empirical model
introduced by Scott et al. [1983]. This model was also employed by Kool and Parker [1987],
who modified the formulation to account for air entrapment. While relatively simple to
implement, the above model has been found to suffer sometimes from a so-called pumping effect,
in which the hysteresis loops can move to physically unrealistic parts of the retention function.
As an alternative, we also incorporated in HYDRUS the hysteresis model of Lenhard et al.
[1991] and Lenhard and Parker [1992] that eliminates pumping by keeping track of historical
reversal points (Hysteresis in Retention Curve, no pumping, Bob Lenhard).
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3.7. Water Flow Parameters

Parameters for the soil hydraulic models are specified in the Water Flow Parameters dialog
window (Fig. 19).

In all models (i.e., Brooks and Corey, 1964; van Genuchten, 1980; Vogel and Cislerova, 1988;
Kosugi, 1996, and Durner, 1994), 6; (Qr) and & (Qs) denote the residual and saturated water
contents, respectively; Ks (Ks) [LT™?] is the saturated hydraulic conductivity, and | is a pore-
connectivity parameter. The parameters « (Alpha) [L™'] and n [-] are empirical coefficients
affecting the shape of the hydraulic functions.

The modified van Genuchten model has four additional parameters: &, (Qa) — a water content
smaller or equal to 6, 6, (Qm) — a water content larger or equal to &, Ky (Kk) [LT™] - the
unsaturated hydraulic conductivity at water content &, and & (QK) — the water content associated
with Ky.

Water Flow Parametel Ll

I aterial Properties for water Flow

Mumber of Materials: 3 Modek van Genuchten [1980] - Mualem

bd at MHame arf] Oz [-] Alpha[1/cm] n[-] K.z [cmdday] 1] - Help
1 |Loam 0.078 0.43 0.036 1.56 24,96 05
2 |Sand 0.045 0.43 0145 2.68 128 05
3 |5ilt modified 0.034 046 001g 1.37 g2 05 -

Soil Catalog | Loam v] [ Neural Network Prediction | [C] Temperature Dependence

Water Flow Parameters - Inverse Solution - Material 1

I aterial Properties For ‘W ater Flow m

Mumber of M aterials: 1 Model van Geruchten [1980] - Mualem
Gr -] s [-] Alpha h Kz | Help
Initial E stimate 0.034 046 0me 1.37 G 05
Mirirum Y alue 0 I I 1.05 I
b aximum Y alue 0 I I 3 I 0
Fitted 7 O Cl L] [
Mest ..
Soail Catalog: | Silt w [ Meural Metwark Prediction ] []:Temperature Dependence

Figure 19. The Water Flow Parameters dialog window for direct (top) and inverse (bottom)
problems.
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Durner’s [1994] model has three additional parameters: w, (W2), & (Alpha2) [L™], and n, (n2),
where w, is the weighting factor for the second overlapping region, and «, and n, are empirical
parameters for the second region.

The hysteretic model has also three additional parameters: &, (QsW) — the saturated water
content of the main wetting branch, s, (AlphaW) [L™'] - the shape parameter of the main wetting
branch, and Kg, (KsW) [LT™] - the saturated hydraulic conductivity associated with the main
wetting branch (in case hysteresis also occurs in the conductivity function).

Temperature Dependence: Check this box if the hydraulic properties are considered to be
temperature dependent. Using capillary theory, the influence of temperature on the soil water
pressure head is then quantitatively predicted from the influence of temperature on surface
tension, while the influence of temperature on the hydraulic conductivity is predicted from the
influence of temperature on viscosity and the density of water.

Soil Catalog: The hydraulic parameters of selected soils were included into a catalog from which
users can make selections. The van Genuchten parameters were taken from Carsel and Parrish
[1988] (Table 7), the Brooks and Corey parameters are from Rawls et al. [1982]. Rawls et al.
(1982) used multiple linear regression to estimate the Brooks and Corey parameters from a large
database of some 2540 soil horizons. Their regression equations were subsequently used also by
Carsel and Parrish (1988), but the results were further manipulated statistically to get van
Genuchten parameters probability density functions (superficially, the van Genuchten parameters
are the same or closely related to the BC parameters, such as n=lambda+1). Hence the Carsel
and Parrish (1988) parameters were statistically derived from the Rawls et al. (1982) estimates;
they were not fitted independently to the Rawls database. Some caution is needed when using
these parameter values since they only represent very approximate averages for different textural
classes. The soil hydraulic parameters in the catalog for the Kosugi’s model were obtained by
fitting retention curves generated using the Carsel and Parrish [1988] parameters for the van
Genuchten’s [1980] model using RETC.

The following soil textural classes are represented in the soil hydraulic catalog:
Sand
Loamy Sand
Sandy Loam
Loam
Silt Loam
Sandy Clay Loam
Clay Loam
Silty Clay Loam
Sandy Clay
Silty Clay
Clay

Neural Network Prediction: The program uses pedotransfer functions (PTFs) based on neural

networks [Schaap et al., 2001] to predict van Genuchten’s [1980] water retention parameters and
the saturated hydraulic conductivity (Ks) based on textural information (see Section 3.8 below).
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When the parameter estimation option is selected, then users have to provide initial estimates of the
optimized soil hydraulic parameters, specify which parameters are to be optimized (check
appropriate checkboxes), and provide parameter constraints for the optimization. Entering zeros
(the default values) for the minimum and maximum values signifies that the parameters are
unconstrained.

Table 7. Soil hydraulic parameters for the analytical functions of van Genuchten [1980] for
twelve textural classes of the USDA soil textural triangle according to Carsel and Parrish [1988].

Textural class & 6 a n Ks
[L°L7] [L°L7] [cm™] [-] [cm d]

Sand 0.045 0.430 0.145 2.68 712.8
Loamy Sand 0.057 0.410 0.124 2.28 350.2
Sandy Loam 0.065 0.410 0.075 1.89 106.1
Loam 0.078 0.430 0.036 1.56 24.96
Silt 0.034 0.460 0.016 1.37 6.00
Silty Loam 0.067 0.450 0.020 1.41 10.80
Sandy Clay Loam 0.100 0.390 0.059 1.48 31.44
Clay Loam 0.095 0.410 0.019 1.31 6.24
Silty Clay Loam 0.089 0.430 0.010 1.23 1.68
Sandy Clay 0.100 0.380 0.027 1.23 2.88
Silty Clay 0.070 0.360 0.005 1.09 0.48
Clay 0.068 0.380 0.008 1.09 4.80

Table 8. Soil hydraulic parameters for the analytical functions of van Genuchten [1980] for
twelve textural classes of the USDA textural triangle as obtained with the Rosetta Lite program
[Schaap et al., 2001].

Textural class & 23 a n Ks
[L°L7] [L°L7] [cm™] [-] [cm d]

Sand 0.053 0.375 0.035 3.18 643.
Loamy Sand 0.049 0.390 0.035 1.75 105.
Sandy Loam 0.039 0.387 0.027 1.45 38.2
Loam 0.061 0.399 0.011 1.47 12.0
Silt 0.050 0.489 0.007 1.68 43.7
Silty Loam 0.065 0.439 0.005 1.66 18.3
Sandy Clay Loam 0.063 0.384 0.021 1.33 13.2
Clay Loam 0.079 0.442 0.016 1.41 8.18
Silty Clay Loam 0.090 0.482 0.008 1.52 11.1
Sandy Clay 0.117 0.385 0.033 1.21 11.4
Silty Clay 0.111 0.481 0.016 1.32 9.61
Clay 0.098 0.459 0.015 1.25 14.8
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Table 9. Soil hydraulic parameters for the analytical functions of Brooks and Corey [1964] for
twelve textural classes of the USDA soil textural triangle according to Rawls et al. [1982].

Textural class & 23 a n Ks
[L°L7] [L°L7] [cm™] [-] [cm d™]

Sand 0.020 0.417 0.1380 0.592 504.0
Loamy Sand 0.035 0.401 0.1150 0.474 146.6
Sandy Loam 0.041 0.412 0.0682 0.322 62.2
Loam 0.027 0.434 0.0897 0.220 31.7
Silt 0.015 0.486 0.0482 0.211 16.3
Silty Loam 0.015 0.486 0.0482 0.211 16.3
Sandy Clay Loam 0.068 0.330 0.0356 0.250 10.3
Clay Loam 0.075 0.390 0.0386 0.194 5.52
Silty Clay Loam 0.040 0.432 0.0307 0.151 3.60
Sandy Clay 0.109 0.321 0.0343 0.168 2.88
Silty Clay 0.056 0.423 0.0292 0.127 2.16
Clay 0.090 0.385 0.0268 0.131 1.44

Table 10. Soil hydraulic parameters for the analytical functions of Kosugi [1996] for twelve
textural classes of the USDA soil textural triangle.

Textural class & 23 a n Ks
[L°L7] [L°L7] [cm™] [-] [cm d™]

Sand 0.045 0.430 303.7 0.383 712.8
Loamy Sand 0.057 0.410 12.47 0.950 350.2
Sandy Loam 0.065 0.410 27.42 1.26 106.1
Loam 0.078 0.430 101.8 1.80 24.96
Silt 0.034 0.460 510.6 2.48 6.00
Silty Loam 0.067 0.450 325.9 2.30 10.80
Sandy Clay Loam 0.100 0.390 80.89 2.04 31.44
Clay Loam 0.095 0.410 666.3 2.81 6.24
Silty Clay Loam 0.089 0.430 2853. 3.26 1.68
Sandy Clay 0.100 0.380 1129. 3.41 2.88
Silty Clay 0.070 0.360 140538. 4.49 0.48
Clay 0.068 0.380 103815. 4.67 4.80

Note that in Version 2, each material can have a name (e.g., Material 1, Sand, Clay). When soil
hydraulic parameters are assigned using the Soil Catalog, the names of textural classes will
appear in the Name column. These names will then appear throughout the HYDRUS GUI, e.g.,
at the Edit Bar or in the Sort Property Object window.
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3.8. Neural Network Predictions

The HYDRUS code was coupled with the Rosetta Lite DLL (Dynamically Linked Library) (Fig.
20), which was independently developed by Marcel Schaap at the U.S. Salinity Laboratory

(mschaap@ussl.ars.usda.gov) [Schaap et al., 2001]. Rosetta implements pedotransfer functions
(PTFs) which predict van Genuchten’s [1980] water retention parameters and the saturated
hydraulic conductivity (Ks) in a hierarchical manner from soil textural class, the soil textural
distribution, bulk density and one or two water retention points as input. Rosetta has its own help
features containing all relevant information and references. Rosetta provides soil hydraulic
parameters for the analytical functions of van Genuchten [1980] for twelve textural classes of the

USDA textural triangle (Table 8).

k¥ Rosetta Lite v. 1.1 (June 2003)

Select Model

() Textural classes

Input

Textural Class
Sand [24]
Silt[32]

Clay [*2]

BD [gricm3]
TH33 [cm3fom3]

TH1500 [cm3/cm3]

()% Sand, Siltand Clay (35C)

(®) %2Sand, Silt, Clay and Bulk Density (BD)

an
45
2h
1.35

() SSCBD+ water content at 33 kPa (TH33)

() Same + water content at 1500 kPa (TH1500)

Cutput
Thetar [cm3fcm 3] 0.0737
Theta = [cm3fcm3] 0.4291
Alpha [1/cm] 0.0073
n[] 15577
ks [crmfday] 1423
[ Helpl l | Fredict H Accept l [ Cancel l

Figure 20. The Rosetta Lite (Neural Network Predictions) dialog window.
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3.9. Anisotropy in the Hydraulic Conductivity

For two-dimensional problems users may need to specify the principal components of the
anisotropy tensor, K;" and K", together with the angle w, between the principal direction of K" and
the x-axis of the global coordinate system for each element (Fig. 21).

Edit Local Anisotrophy g|
Local Anigotrophy - Angle and Components
MHumber of Selected Elemants:
kire: [GEYS

Angle: 0 [ |0 | [0 |
Specity All Components

Simultaneously hin: [ETS
Compaonent 1: |1 | |1 | |1 |
Component 2: |'| | |1 | |1 |

[ ok | [ Cancel l l Help l

Figure 21. The Edit Local Anisotropy dialog window for two-dimensional applications.

This has been simplified for three-dimensional problems where user can specify one or more
Tensors of Anisotropy (Fig. 22), which may be assigned to different parts of the transport domain.
The anisotropy tensor is defined by three principal components, K;* (ConAX), K5* (ConAY), and
Ks* (ConAZ), and six coefficients ajj that represent the cosine of angles between the ith principal
direction of the tensor K” and the j-axis of the global coordinate system (i.e., Cos(X-x), Cos(Y-y),
Cos(Z-y), Cos(X-y), Cos(X-z), Cos(Y-2)).

Tensors of Anisotropy El

Tenzors of Anizatropy for Hydraulic Conductivity
Murnber of Tensors of Anizotropy: | 1 | [ Update ]
Aniz | Cornded Condy | Cont | Cosf<w] | Coslv-y] | Cosl£-z] | Cosl¥-y] | Cosf<-z] | Coslv-z] | Help
1 1 1 1 1 1 1 1] i 0w

Previous ...

Figure 22. The Tensors of the Anisotropy dialog window.
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3.10. Solute Transport

Basic information needed for defining solute transport problem are entered in the Solute
Transport dialog window (Fig. 23). In this window users specify the Space and Time
Weighting Schemes, the Iteration Criteria (for nonlinear problems), and additional Solute
Information such as mass units, pulse duration (if applicable), and number of solutes.

Solute Transport

Time weighting Scheme Space Weighting Scheme
(%) Galerkin Finite Elements -
= C I
(%) Crank-Micholzon Scheme () Upstream 'Weighting FE
(3 Implicit Scheme () GFE with Artificial Dispersion
Solute Information
Mumber of Salutes: 17 b azs Units: g
Pulze Duration [hour]; 24 Stability Criterion: a

Temperature Dependence of Parameters
[]*ater Content Dependence of Parameters
[] Attachment/Detachment Concept [virus, bacteria tranzpart] [ Filtration Theary

(®) Millington & Quirk () Maldrup

[teration Criteria [for Monlinear Adsorption anly]

Abzolute Concentration Taolerance: ]
Relative Concentratin T olerance: ]
M awimurm Mumber of [terations: 1

|mitial Conditions

() In Liquid Phase Concentrations [Mass_solute/Volume_water]

() In Total Concentrations [Mass_soluteAolume_zoil] Mest ...

lilig

Previous ...

Figure 23. The Solute Transport dialog window.
a) Time Weighting Scheme

The Time Weighting Scheme defines the temporal weighing coefficient, &, used in the numerical
solution of the transport equation. The temporal weighting coefficient is equal to 0.0 for an
explicit scheme, 0.5 for a Crank-Nicholson time-centered implicit scheme, and 1.0 for a fully
implicit scheme. The structure of the final set of linear equations [G] {c} = {g}, obtained after the
spatial and temporal discretization of the governing advection-dispersion equation, depends upon
the value of the temporal weighing factor, & The explicit (¢=0) and fully implicit (e=1) schemes
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require that the global matrix [G] and the vector {g} be evaluated at only one time level (the
previous or current time level). The other two schemes require evaluation at both time levels. Also,
the Crank-Nicholson and implicit schemes lead to an asymmetric banded matrix [G]. By contrast,
the explicit scheme (&=0) leads to a diagonal matrix [G] which is much easier to solve (but generally
requires much smaller time steps).

The Crank-Nicholson centered scheme is recommended in view of solution precision. The fully
implicit scheme also leads to numerical dispersion, but is better in avoiding numerical instabilities.
The explicit scheme is most prone to numerical instabilities with undesired oscillations (and is
currently disabled).

b) Space Weighting Scheme

HYDRUS provides three options for the Space Weighting Scheme, i.e., the regular Galerkin
Finite Elements formulation, the Upstream Weighting Finite Elements formulation, and the
Galerkin Finite Elements formulation with Artificial Dispersion.

While the Galerkin Finite Elements formulation is recommended in view of solution precision,
Upstream Weighting is provided as an option in HYDRUS to minimize some of the problems with
numerical oscillations when relatively steep concentration fronts are being simulated. For this
purpose the second (flux) term of advective-dispersive equation is not weighted by regular linear
basis functions, but instead using nonlinear functions [Yeh and Tripathi, 1990]. The weighing
functions ensure that relatively more weight is placed on flow velocities of nodes located at the
upstream side of an element.

Additional Artificial Dispersion may be added also to stabilize the numerical solution and to
limit or avoid undesired oscillations in the Galerkin finite element results. Artificial dispersion is
added such that a Stability Criterion involving Pe.Cr (the product of the Peclet number and the
Curant number) [Perrochet and Berod, 1993] is satisfied. The recommended value for Pe.Cr is
2.0.

¢) Solute Information

Number of Solutes Number of solutes to be simulated simultaneously or involved in a
decay chain reaction.

Pulse Duration Time duration of the concentration pulse. Concentrations (flux or
resident) along all boundaries, for which no time-variable
boundary conditions are specified, are then set equal to zero for
times larger than the "Pulse Duration”. When the Fumigant option
is active, this variable is used instead to define Time of Tarp
Removal.

Mass Units Units to be printed to the output files or displayed in various
graphs. Mass units have no effect on the calculations.
Concentration units in general should be given in [ML™], where M
is Mass Units specified in the Solute Transport dialog window
(Fig. 22) and L is Length Units specified in the Domain Type
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Stability Criterion

Use Tortuosity Factor

Temperature Dependence

and Units dialog window (Fig. 6). However, since the
concentration variable appears in each term of the governing solute
transport equations (Eq. 3.1 and 3.2 of the Technical Manual), it is
possible to use different length units than those used to define
geometry and fluxes (e.g., geometry may be specified in meters
while concentrations are given in mg/cm?®). In such case the solute
fluxes (cq) will then be in units of ML L,T™ where L. is the
length unit (e.g. cm) used to define concentrations and L4 the
length unit defining geometry and fluxes (e.g., m). Similarly the
solute mass (c&V) obtained by integrating solute over the transport
domain will be in units of ML.®L,% Similar adjustments of units
need to be done for other variables that involve both concentration
and length units.

Product of the dimensionless Peclet and Curant numbers (Pe.Cr).
This criterion is used either to add artificial dispersion in the
Galerkin Finite Elements with Artificial Dispersion scheme or to
limit the time step (leading to lower Courant numbers for a given
Peclet number) for the Galerkin Finite Elements scheme.

Check this box when molecular diffusion coefficients in the water
and gas phases are to be multiplied by a tortuosity factor according
to the formulation of either Millington and Quirk [1991] or
Moldrup et al. [1997, 2000].

Check this box if the solute transport and reaction parameters are
assumed to be temperature dependent.

Water Content Dependence Check this box if the solute reaction parameters are assumed to be

Attachment/Detachment

Filtration Theory

Wetland Module

water content dependent [Walker, 1974].

Check this box if the solute is assumed to be subject to
attachment/detachment to/from the solid phase. This process is
often used in simulations of the transport of viruses, colloids, or
bacteria.

Check this box if the attachment coefficient is to be calculated
from filtration theory.

Check this box if the Wetland module is to be used. The Wetland
module (for two-dimensional problems only) was developed to
model biochemical transformation and degradation processes in
subsurface flow constructed wetlands. In the wetland module two
biokinetic model formulations can be chosen: (1) the biokinetic
model as described in CW2D [Langergraber and Simunek, 2005,
2006] and (2) the CWM1 (Constructed Wetland Model #1)
biokinetic model [Langergraber et al., 2009]. In CW2D aerobic
and anoxic transformation and degradation processes for organic
matter, nitrogen and phosphorus are described, whereas in CWM1
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aerobic, anoxic and anaerobic processes for organic matter,
nitrogen and sulphur.

Fumigant Module Additional options related to fumigant transport (e.g., tarp removal,
temperature dependent tarp properties, additional injection of
fumigants) can be used with this module.

d) Iteration Criteria

The advection-dispersion solute transport equation becomes nonlinear when nonlinear adsorption is
considered. Similarly as for the Richards equation, an iterative process must then be used to obtain
solutions of the global matrix equation at each new time step. During each iteration a system of
linearized algebraic equations is derived and solved using either Gaussian elimination or the
conjugate gradient method. After inversion, the coefficients are re-evaluated using the initial
solution, and the new equations are again solved. This iterative process continues until a satisfactory
degree of convergence is obtained, i.e., until at all nodes the absolute change in concentration
between two successive iterations becomes less than some concentration tolerance (defined in
HYDRUS as the sum of an Absolute Concentration Tolerance and the product of the
concentration and a Relative Concentration Tolerance (the recommended and default value is
0.001)). The Maximum Number of Iterations allowed during a certain time step needs to be
specified (recommended value is 10). When the Maximum Number of Iterations is reached
then the numerical solution is either (a) terminated for problems involving transient water flow
or (b) restarted with a reduced time step for steady-state flow problems.

e) Initial Conditions

Initial Conditions can be specified either using liquid phase concentrations in units of mass of
solute [M¢] per volume of water [McL,] or using total concentrations in units of mass of solute
per volume of soil [McLs]. In the latter case the liquid phase concentration is calculated from
the total concentration depending on the distribution coefficients (e.g., Kq, or Henry’s constant)
between different phases.

Rather then specifying directly the initial values of the nonequilibrium phase concentrations (e.g.,
concentrations in the immobile water for the dual-porosity models or concentrations kinetically
sorbed to the solid phase for the two-site sorption models, or for concentrations associated with
the solid phase for the attachment/detachment models), users can specify that the nonequilibrium
phase concentrations are initially at equilibrium with the equilibrium phase concentrations. Initial
conditions need to be then specified only for the liquid phase concentrations, and the
nonequilibrium phase concentrations are calculated by HYDRUS.

The UNSATCHEM Module

When the UNSATCHEM module is used, basic information needed for defining solute transport
problem are entered in the Solute Transport dialog window displayed in Figure 24 (instead of
Figure 23, which is used for the standard solute transport module). In this window users specify
again the Space and Time Weighting Schemes, and additional Solute Information such as
mass units. Note that all concentrations in the UNSATCHEM module are either in meg/L (in the
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liquid phase) or meg/kg (in the solid phase) (meg=mmol;). The pulse duration is not used in
UNSATCHEM and the number of solutes is fixed to 8 (i.e., the number of considered major
ions: Ca**, Mg®*, Na*, K*, Alkalinity, SO4*, CI', and an independent tracer). The number of
solution, adsorbed, and precipitated concentration combinations is specified when simulating the
transport of major ions in the UNSATCHEM module. This value represents the maximum
number of (solution, adsorbed, and precipitated) concentration combinations, which can be used
to specify the initial and boundary conditions.

Since there is currently no technical manual describing the two-dimensional version of the

UNSATCHEM module, users are referred to the HYDRUS-1D manual [Simiinek et al., 2008],
which provides all relevant information about this module.

Solute Transpori

3
Time *eighting Scheme Space "Weighting Scheme
(%) Galerkin Finite Elements
(*) Crank-Micholson Scheme () Upstream “Weighting FE
() Implicit 5cheme () GFE with Autificial Dizpersion =

Idnits and Stabiliy

kazs Units:
Stahility Criterian: I1ze Tartuazity Factar

Composition
MHumber of Solution Concentration Combinations: 2
MHurnber af Adzorbed Concentration Cambinations: 1

Humber of Precipitated Concentration Combinations: |1

Brevious ...

Figure 24. The Solute Transport dialog window for the UNSATCHEM module.
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3.11. Solute Transport Parameters

Soil and Solute Specific Transport Parameters are specified in the Solute Transport
Parameters dialog window (Fig. 25).

Solute Transport Parameters E|
Soil Specific Parameters Solute Specific Parameters
Mat | BulkD. | DispL. | Disp.T. Fract. | Thimoh, Sal Difuz. /. Difuz. G.
1 15 05 01 1 i 1 I ]
2 158 0h 0.1 1 i}

Previous ...

Figure 25. The Solute Transport Parameters dialog window.

The following Soil Specific Parameters (left part of the dialog window) are specified for each
soil material:

Bulk.d. Bulk density, p [ML?]

Disp.L. Longitudinal dispersivity, D, [L]

Disp.T. Transverse dispersivity, Dt [L]

Frac Dimensionless fraction of adsorption sites classified as type-1 sites, i.e., sites with

instantaneous sorption when the chemical nonequilibrium option is considered [-].
Set this parameter equal to 1 when equilibrium transport is considered. Frac
becomes the dimensionless fraction of adsorption sites in contact with mobile water
when the physical nonequilibrium option is considered [-]. In that case Frac
should be set equal to 1 when all sorption sites are in contact with mobile water.

Thimob The immobile water content. Set equal to 0 when the physical nonequilibrium
option is not considered.

The following Solute Specific Parameters (right part of the dialog window) are specified for
each solute:

Diffus.W Molecular diffusion coefficient in free water, Dy, [L*T™]
Diffus.G Molecular diffusion coefficient in soil air, Da [L*T™]
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3.12. Solute Reaction Parameters

The Solute Reaction Parameters and concentrations for Boundary Conditions are specified in the
Solute Reaction Parameters dialog window (Fig. 26). Each solute has its own Solute Reaction
Parameters dialog window.

Reaction Parameters for Solute - 1

Boundary Conditionz N

cBrndl | cBnd2 | cBrd3 | cBndd4 | cRoot el cBhd? Ak d Cancel
1 1 0 0 0 1] 1] 1] 0 0

Help

.

Reachion Parameters

b at k.d Hu Beta Henn SinkL1 Sink51
1 1] 1] 1 1] 1] 1]
£ »

Previous ...

Figure 26. The Solute Reaction Parameters dialog window.

The following Solute Reaction Parameters are specified for each soil material:

Kd Adsorption isotherm coefficient, ks [M™L?]

Nu Adsorption isotherm coefficient, 7 [M™L°]

Beta Adsorption isotherm exponent, 3 [-]

Henry Equilibrium distribution constant between liquid and gaseous phases, kg [-]

SinkL1 First-order rate constant for dissolved phase, z4, [T™]

SinkS1 First-order rate constant for solid phase, s [T™]

SinkG1 First-order rate constant for gas phase, 14 [T

SinkL1' First-order rate constant for dissolved phase, " [T™], as part of a solute decay
chain

SinkS1' First-order rate constant for solid phase, u* [T™], as part of a solute decay chain

SinkG1' First-order rate constant for gas phase, 14" [T™], as part of a solute decay chain

SinkWO0 Zero-order rate constant for dissolved phase, %, [ML>T?]

SinkS0 Zero-order rate constant for solid phase, %, [T™]

SinkGO0 Zero-order rate constant for gas phase, % [ML>T?]
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Alpha

First-order rate coefficient for one-site or two-site nonequilibrium adsorption,
mass transfer coefficient for solute exchange between mobile and immobile liquid
regions, o[T™]

When the Attachment/Detachment Model (Fig. 23) is used, then some parameters listed above
are replaced with different parameters needed for the attachment/detachment model:

D_Sail

iPsi2

iPsil
SMax?2

AttachSolid2
DetachSolid2

SMax1
AttachSolid1

DetachSolid1l

Diameter of the sand grains, d; [L]. Note that HYDRUS allow only one value
(for all materials) and that this value is used only in the Depth-dependent
blocking function (iPsi=4) developed by Bradford et al. [2002], which was
developed for homogeneous laboratory column. It is less clear have is should be
used in multi-layered systems (for other than the first layer). Also note that this
blocking function depends on a vertical spatial coordinate. This means that one
needs to specify the origin of the function, i.e., the inflow and inter-material
interfaces. HYDRUS allows doing this for up to 2 materials using the cBnd
vector as described in the help.

Type of blocking on the second sorption sites:

= 0: No blocking.

= 1: Langmuirian dynamics.

= 2: Ripening.

= 3: random sequential adsorption model.

= 4: depth dependent blocking coefficient.

Same for the first sorption sites.

Parameter in the blocking function for the second sorption sites (Smax for
blocking options (1), (2) and (3), and b for (4)).

First-order deposition (attachment) coefficient, ko [T™], for the second sorption
sites.

First-order entrainment (detachment) coefficient, kqy [T™], for the second
sorption sites.

Parameter in the blocking function for the first sorption sites.

First-order deposition (attachment) coefficient, ko [T™], for the first sorption
sites.

First-order entrainment (detachment) coefficient, kq [T™], for the first sorption
sites.

When Filtration Theory (Fig. 23) is used to calculate the attachment coefficient, then the
following parameters must be entered instead:

D_Soil
D_Virus

SMax?2

Stick. Eff2
DetachSolid2

Diameter of the sand grains, d. [L].

Diameter of the particle, d, (e.g., virus, bacteria) (e.g., = 0.95 um or 0.95e-6 m)
[L].

Parameter in the blocking function for the second sorption sites (Smax for model
(1)).

Sticking efficiency, a [-], for the second sorption sites.

First-order entrainment (detachment) coefficient, ky [T™], for the second
sorption sites.
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SMax1
Stick. Effl
DetachSolid1l

Parameter in the blocking function for the first sorption sites.

Sticking efficiency, a [-], for the first sorption sites.

First-order entrainment (detachment) coefficient, kg [T™], for the first sorption
sites.

Boundary Conditions:
Concentrations for time-independent Boundary Conditions are also specified in this dialog

window.

cBnd1

cRoot

cWell

cBnd7

CAtm

Value of the concentration for the first time-independent boundary condition [ML™].

Set equal to zero if no time-independent boundary condition is specified. The same
for cBnd2 through cBnd4

Value of the concentration for the fifth time-independent boundary condition [ML
%]. If water uptake is considered then cRoot is automatically used for the maximum
concentration of water removed from the flow region by root water uptake. When
zero is specified, then all solute is left behind in the soil and only a solute-free
solution is being taken up. When the concentration is lower than cRoot, all solute
is taken up. When the concentration is higher than cRoot, the excess solute stays
behind. Set equal to zero if no fifth time-independent boundary condition and no
solute uptake by roots is considered.

Value of the concentration for the sixth time-independent boundary condition [ML
%]. If internal sources are specified, then cWell is automatically used for the
concentration of water injected into the flow region through internal sources. Set
equal to zero if no sixth time-independent boundary condition and no internal
sources are specified.

Concentration of the incoming fluid for a volatile type boundary condition at the
soil surface [ML]. Set equal to zero if no volatile boundary condition is specified.

Concentration above the stagnant boundary layer, gam [ML?], for a volatile type
boundary condition. Set equal to zero if no volatile boundary condition is being
specified.

Thickness of the stagnant boundary layer, d [L], for a volatile type boundary
condition. Set equal to zero if no volatile boundary condition is being specified.

When the parameter estimation option is selected, then users have to provide initial estimates of the
optimized solute transport parameters, specify which parameters are to be optimized (select
appropriate checkboxes), and provide parameter constraints for the optimization. Zero values for
minimum and maximum values signify that the parameters are unconstrained. The Solute
Transport and Reaction Parameters dialog window for the inverse problem is not further shown

here.
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Figure 27. The Solute Reaction Parameters dialog window for the UNSATCHEM module.

The UNSATCHEM Module

When the UNSATCHEM module is used, the Solute Reaction (and transport) Parameters are
specified in the Solute Reaction Parameters dialog window displayed in Figure 27 (instead of
Figure 26, which is used for the standard solute transport module). The following Soil Specific
Parameters are specified for each soil material:

Bulk.d.
Dw
Disper.L.
Disper.T.
CEC
Calc.SA
Dol.SA
DOC
K[Ca/Mg]
K[Ca/Na]
K[Ca/K]

Bulk density, p [ML?]

Molecular diffusion coefficient in free water, Dy, [L*T™]
Longitudinal dispersivity, D, [L]

Transverse dispersivity, Dt [L]

Cation exchange capacity, CEC [meg/kg]

Calcite surface area [m%/dm°]

Dolomite surface area [m*/dm?]

Dissolved organic carbon [mmol/dm?®]

Gapon constant for exchange of calcium and magnesium
Gapon constant for exchange of calcium and sodium
Gapon constant for exchange of calcium and potassium
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3.13. Temperature Dependence of Solute Reaction Parameters

Several of the diffusion (Dw, Dg), zero-order production (%, %, ), first-order degradation (g,
s’y g, th Hs, and ), and adsorption (ks, kg, S, 1, @) coefficients may be strongly dependent
upon temperature. HYDRUS assumes that this dependency can be expressed by the Arrhenius
equation [Stumm and Morgan, 1981]. This equation can be expressed in the general form

A_T+A
a, :arexp[m_y}
RuT T+

where a; and ar are values of the coefficient being considered at a reference absolute temperature
T/ and absolute temperature T#, respectively; R, is the universal gas constant, and E, [ML*T*M™]
is the activation energy of the particular reaction or process being modeled.

The activation energy characterizing the temperature dependence of the solute transport and
reaction parameters is entered in the dialog window shown in Figure 28.

When the Fumigant option is active, the fifth variable (normally reserved for the Frendlich
exponent) is used to enter the activation energy for the resistance of surface tarp.

Temperature Dependent Solute Transport and Reaction Parameters |

X

Farameters Q
Sinkiater] SinkSolicl SinkGasi SinkiWatar] SinkSaolidl! SinkGasl' Cancel
1 1213 8117 i
2 51213 51171 0 Help
3 R1213 81171 i}
£

t

Ll

Previous ..

Figure 28. The Temperature Dependent Solute Transport and Reaction Parameters dialog

window.
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3.14. Water Content Dependence of Solute Reaction Parameters

The water content dependence of degradation coefficients is implemented using a modified
equation of Walker [1974]:

#(6) = 11,(6,)min 1(5]

r

where g is the values of a particular coefficient (rate constant) at the reference water content 4,
4 1s the value of this coefficient at the actual water content &, and B is a solute dependent
parameter (usually 0.7). The reference water content, &, which may be different for different soil
layers, is calculated from the reference pressure head, h;, which is considered to be constant for a
particular compound. The solute dependent exponent, B, and the reference pressure head, h,, are
entered in the Water Content Dependent Solute Reaction Parameters dialog window shown
in Figure 29.

Water, Content Dependent Solute Reaction Parameters

Parameter 1 [B]
Saol | SinkWwater] | SinkSolid! SinkGasl | SinkMwaterl' | SinkSolidl' | SinkGas!'
1 0 0 0 0 0 0
2 0 0 0 0 0 0
3 1 0 0 0 0 0
< >
Farameter 2 [h_ref [cm]]
Sol | Sinkw ater] SinkSaldl SinkGasz SinkMaterl' | SinkSalidl' Sinkzas1"
1 0 0 0 0 0 0
2 0 0 0 0 0 0 : :
3 0 0 0 0 0 0 | Mext.. |
< >

Figure 29. The Water Content Dependent Solute Reaction Parameters dialog window.
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3.15. Solution Compositions for the UNSATCHEM Module

The set of solution, adsorbed, and precipitated concentration combinations for the
UNSATCHEM module is specified in the Solution Compositions dialog window (Fig. 30).
These (solution, adsorbed, and precipitated) concentration combinations can be used to specify
the initial and boundary conditions. The number of solution, adsorbed, and precipitated
concentration combinations is specified in the General Solute Transport Information window
(Fig. 24). Solution Concentrations need to be specified for all major ions: Ca**, Mg?*, Na*, K*,
Alkalinity, SO,%, CI', and an independent tracer; Adsorbed Concentrations for all cations: Ca®*
Mg®*, Na*, and K*; and Precipitated Concentrations for all solids that UNSATCHEM can
consider: calcite, dolomite, gypsum, nesquohonite, hydromagnesite, and sepiolite. Solution
Concentrations need to be specified in meg/L (L = liter), and Adsorbed Concentrations and
Precipitated Concentrations in meg/kg (meg=mmol,).

Solute Compositions

Solution Concentrations [meg/L]

Sal Ca 5[] MHa K. Ak, S04 Cl Tracer Cancel
1 263 1.05 255 0.0& 233 203 1.94 1
2 122 9.EE 7.5 027 E5 221 N1 1] Help

Adzorption Concentrations [megdka]

Ads Ca kg Ma K.
1 50 20 9 1

Precipitated Concentrations [meqka)

Prec Calcite Gypaum Dolomite Huydrakdg MHezgoh Sepiolite
1 500 200 1] 1] 0 1]

Previousz ..

Figure 30. The Solution Compositions dialog window for the UNSATCHEM module.
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3.16. Chemical Parameters for the UNSATCHEM module.

The following chemical parameters and selections for the UNSATCHEM module are specified
in the Chemical Parameters dialog window (Fig. 31):

- Whether the kinetic or equilibrium model for the precipitation and dissolution of calcite
and dissolution of dolomite is to be used (the Kinetic Precipitation/Dissolution check
box).

- Whether the silica content in the solution is to be calculated based on the solution pH, or
whether the effect of pH is to be neglected (the Silica in Solution (pH Dependency) check
box).

- The Critical lonic Strength, i.e., the ionic strength, below which the extended Debye-
Hickel equation is used to calculate ion activity coefficients. Pitzer virial-type equations
are used above this value.

- The Maximum Number of Iterations allowed during any time step between the solute
transport and chemical modules. When the maximum number of iterations is reached then
the code proceeds to the new time level. The recommended value (if the iterative approach
Is to be used; from our experience) is 5. Set equal to one if no iteration (we recommend this
non-iterative approach) is required (this, in general, leads to significantly lower
computational time without significantly altering the results in most cases).

- Whether the hydraulic conductivity is to be modified depending on the solution chemistry
using the McNeal [1968] semi-empirical approach (the Conductivity Reduction due to
Chemistry check box).

Chemical Parameters

Chemizal Parameters 0

K.inetic Precipitationd/Dizsalutior Cancel

[15ilica in Solution [pH dependency] Help

05 Critizal lanic Strength [Debye- Huckel *
i Pitzer eguations)

1 Maxirmurn Mumber of lterations

Conductivity Beduction due to Chemizty

ligili).

Previous ...

Figure 31. The Chemical Parameters dialog window for the UNSATCHEM module.
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3.17. Heat Transport Parameters

Information needed for defining heat transport problem is entered in the Heat Transport dialog
window (Fig. 32). In this window users specify Heat Transport Parameters and temperatures for
the Boundary Conditions.

Heat Transport Parameters 2

Boundary Conditions

TBoundl TBound2 TBound3 TBound4 TEounds Thiell
1 1] 0 1] 1] 0 ]
Heat Tranzport Parameters 1
Temperature Amplitude: 5 C et Default Yalure
S i Heat Capacities
Time interval far one temp. cocle: 1
T hermal Conductivity: Loam w
Heat Tranzport Parameters 2
b at Solid Org.h. Dizp L. Dizp.T. b1 b
1 057 1] 4] 1/1.56728E+016| 2 53474E+016
% >

]

Cancel

III%

Help

Previous ..

Figure 32. The Heat Transport Parameters dialog window.

The following Heat Transport Parameters (bottom part of the dialog window) are specified for
each soil material:

Solid

Org.M.
Disp.L.
Disp.T.

bl
b2
b3
Cn
Co

Volume fraction of solid phase, &, [-]

Volume fraction of organic matter, &, [-]
Longitudinal thermal dispersivity, A, [L]
Longitudinal thermal dispersivity, Ar [L]

Coefficient b; in the expression for the thermal conductivity function [W/L/K]
Coefficient b, in the expression for the thermal conductivity function [W/L/K]
Coefficient bs in the expression for the thermal conductivity function [W/L/K]
Volumetric heat capacity of the solid phase, C, [J/L¥/K]
Volumetric heat capacity of organic matter, C, [J/L¥/K]
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Cw Volumetric heat capacity of the liquid phase, C,, [J/L¥/K]

Boundary Conditions:
Temperatures for Boundary Conditions with time-independent boundary conditions are also
specified in this dialog window.

TBoundl Value of the temperature for the first time-independent boundary condition [K]. Set
equal to zero if no time-independent boundary condition is specified. The same for
TBound?2 through TBound4

TWell Value of the temperature for the sixth time-independent boundary condition [K]. If
internal sources are specified, then TWell is automatically used for the temperature
of water injected into the flow region from sources in the transport domain. Set
equal to zero if no sixth time-independent boundary condition and no internal
sources are specified.

The boundary condition at the soil surface may be approximated using a sinus wave with the
maximum one hour after noon and the minimum one hour after midnight as follows:

T =T,+ Acos| 2z (ﬂj
24

where Ty is the average temperature at the soil surface [K], A is the Temperature Amplitude at
the soil surface [K], and p is the Time Interval for completion of one sine wave temperature
(usually 1 day, the default value). The second part of the sine term is included to set the
maximum temperature at 1 p.m.

Default values for the parameters in the Thermal Conductivities of three textural classes (sand,
loam and clay) are provided by HYDRUS [Chung and Horton, 1987]. Default volumetric heat
capacities for the solid phase, organic matter, and liquid phase are also given (Set Default
Volumetric Heat Capacities).

When the parameter estimation option is selected, then users must provide initial estimates of the
optimized heat transport parameters, specify which parameters are to be optimized (check
appropriate checkboxes), and provide parameter constraints for the optimization. Zero values for
the minimum and maximum values signify that parameters are unconstrained. The Heat
Transport Parameters dialog window for the inverse problem is not further shown here.

Notice that thermal conductivity and volumetric heat capacity parameters have units of [Wm™K"
11 and [Im>K™], respectively. These units, when converted to basic Sl units are [ML*T“K™] and
[MLTK™], respectively, and thus contain time to the negative second or third power, which needs
to be taken into account during any time conversion.
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3.18. Root Water Uptake Model

Users may select a particular Water Uptake Reduction Model and a Solute Stress Model in
the Root Water Uptake Model dialog window (Fig. 33).

Root Water and Solute Uptake Model E|

“wWater Uptake Reduction Model
(%) Feddes
I Cancel
O 5.Shaped
Critical Stress Indes: 1

Solute Strezs Maodel

(Mo Solute Stress
(%) Additive Maodel

) Multiplicative Model

Active Solute Uptake Model
Active Solute Uptake

0.2 tichaeliz-tenten Constant

0.01| birnimumn Concentration for Uptake

1 Critical Stress Index for Active
Solute Uptake

Mest ...
FReduced Potential Solute Uptake =

due to Reduced water Uptake Previous ..
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Figure 33. The Root Water Uptake Model dialog window.

a) Water Uptake Reduction Model

Either a water stress response function suggested by Feddes et al. [1978] or an S-shaped function
suggested by van Genuchten [1985] can be used to reduce the potential root water uptake to the
actual water uptake rate (Fig. 34). Root water uptake with compensation can be simulated when
the Critical Stress Index is smaller than one (see the Technical Manual; Simiinek et al. [2010]).

b) Solute Stress Model

The effect of salinity stress on the root water uptake can be either neglected (No Solute Stress) or
considered using the Additive or Multiplicative models, i.e., salinity stress is either added to
water stress, or uptake reduction due to water stress and salinity stress are multiplied. When the
multiplicative model is used for salinity stress, one can use either the Threshold Model [Maas,
1990] or an S-Shaped Model [van Genuchten, 1985] (Fig. 35).

75



c) Active Solute Uptake Model

Total root nutrient uptake is determined from the total of active and passive nutrient uptake.
The partitioning between passive and active uptake is controlled by the a priori defined
concentration value cRoot (Fig. 26). Passive nutrient uptake is simulated by multiplying root
water uptake with the dissolved nutrient concentration, for soil solution concentration values
below cRoot. Passive nutrient uptake is thus zero when cRoot is equal to zero. One must
therefore specify the maximum allowed concentration, cRoot, in the passive root solute uptake
term. When zero is specified, all solute is left behind in the soil (there is no passive root solute
uptake) and only solute free solution is taken up. When the concentration is lower than cRoot, all
solute is taken up (unlimited passive root solute uptake). When the concentration is higher than
cRoot, additional solute stays behind.

As the Active Nutrient Uptake is obtained from the difference between plant nutrient demand
(the Potential Solute Uptake Rate [ML™?T™] needs to be specified) and Passive Nutrient
Uptake, the presented model thus implies that reduced passive nutrient uptake is compensated
for by active nutrient uptake. Active nutrient uptake is simulated using Michaelis-Menten
kinetics (the Michaelic-Menten constant and a Minimum Concentration for Uptake need to
be specified). In addition, the proposed root uptake model includes compensation for active
nutrient uptake, in a similar way as used for root water uptake (using the Critical Stress Index).

Reduction in root water uptake will decrease passive nutrient uptake, thereby increasing active
nutrient uptake proportionally. In other words, total nutrient uptake is not affected by soil water
stress, as computed by the proportion of actual to potential root water uptake. This is not realistic
since one would expect that plant nutrient requirements will be reduced for water-stressed plants.
For that reason, the uptake model includes additional flexibility, by reducing the potential
nutrient demand (Potential Solute Uptake Rate), in proportion to the reduction of root water
uptake (see the last check box Reduce Potential Solute Uptake due to Reduced Water
Uptake).

Active solute uptake is implemented only for a single solute (not for multiple solutes). Details

about the root water and solute uptake can be found in the Technical Manual or Simiinek and
Hopmans [2009].

76



Parameters for the water and salinity stress response functions are specified in the Root Water

3.19. Root Water Uptake Parameters

Uptake Parameters dialog window (Fig. 34 and Fig. 35, respectively).

Root Water Uptake Parameters

Feddes' Parameters

FO -10
FOpt -25
FzH -200
FL -800
Fa -8000
2H 0.5
rZL 0.1
Databaze

k.

Cancel

Help
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Root Water Uptake Parameters

S5-Shape Parameters

P&0: 800
P3: 3
P le+010

3

K.
Cancel

Help

.
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Figure 34. The Root Water Uptake Parameters dialog window for the water stress response

The Root Water Uptake Parameters for the water stress response function suggested by
Feddes et al. [1978] (Fig. 34, left) are described in detail in the HYDRUS technical manual.
Water uptake in this model is assumed to be zero close to saturation (i.e. wetter than some
arbitrary “anaerobiosis point” P0). Root water uptake is also zero for pressure heads less (more
negative) than the wilting point (P3). Water uptake is considered optimal between pressure heads
Popt and P2, whereas for pressure heads between P2 and P3 (or PO and Popt) water uptake

function of Feddes et al. [1978] (left) and van Genuchten [1985] (right).

decreases (or increases) linearly with pressure head.

PO
POpt

P2H

P2L
P3

r2H

Value of the pressure head [L] below which roots start to extract water from the soil.
Value of the pressure head [L] below which roots extract water at the maximum

possible rate.

Value of the limiting pressure head [L] below which roots cannot longer extract water
at the maximum rate (assuming a potential transpiration rate of r2H).

As P2H, but for a potential transpiration rate of r2L.

Value of the pressure head [L] below which root water uptake ceases (usually taken at
the wilting point).

Potential transpiration rate [LT™] (currently set at 0.5 cm/day).
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r2L Potential transpiration rate [LT™] (currently set at 0.1 cm/day).

The above input parameters permit one to make the variable P2 a function of the potential
transpiration rate, T, (P2 presumably decreases at higher transpiration rates). HYDRUS currently
implements the same linear interpolation scheme as used in several versions of the SWATRE code
(e.g., Wesseling and Brandyk, 1985). The interpolation scheme is defined in the manual.

A database of suggested values for different plants for the Feddes et al. [1978] model is provided
in HYDRUS based on studies by Wesseling [1991] and Taylor and Ashcroft [1972].

The Root Water Uptake Parameters for the S-shaped water stress response function as
suggested by van Genuchten [1985] (Fig. 34, right) are as follows:

P50 The coefficient, h50, in the root water uptake response function associated with water
stress [L]. Root water uptake at this pressure head is reduced by 50%.

P3 The exponent, p3, in the root water uptake response function associated with water
stress [-]; its recommended and default value is 3.

We have additionally included a parameter PW, i.e., pressure head at the wilting point [L], below
which transpiration stops.

Root Water Uptake Parameters E| Root Water, Uptake Parameters E|

Converzion to prezsuredozmohic head

Conwerzion to prezsuredosmotic head

Threshold Model 5-Shape Parameters

Dzm. Coeff. Ozm. Coeff.
1 |1 1 |0
Databaze q@ﬁ Q@E
N ——

Figure 35. The Root Water Uptake Parameters dialog window for the solute stress response
function based on the threshold model (left) and S-shaped model of van Genuchten [1985] (right).

The Root Water Uptake Parameters for the Threshold Model [Maas, 1990] of the salinity
stress response function (multiplicative) (Fig. 35, left) are as follows:

Threshold Value of the minimum osmotic head [L] (the salinity threshold) above which root
water uptake occurs without a reduction.
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Slope Slope of the curve determining the fractional root water uptake decline per unit
increase in salinity below the threshold.

The Root Water Uptake Parameters for the S-Shaped Model [van Genuchten, 1985] of the
salinity stress response function (multiplicative) (Fig. 35, right) are as follows:

P3 The exponent, p, in the root water uptake response function associated with salinity
stress [-]. The recommended value is 3.

cb0 The coefficient, h50, in the root water uptake response function associated with
salinity stress [L]. Root water uptake at this osmotic head is reduced by 50%.

Both salinity stress response functions require a coefficient (Osmotic Coefficient) that transforms
concentrations into equivalent osmotic pressure heads (Fig. 35). The osmotic coefficients should
be negative for the additive model (to be added to negative pressure heads) and positive for the
multiplicative model. Note that this conversion needs to be made mainly when one uses the
Additive Model. That is because then one needs to add pressure heads (i.e., units of m or cm)
and osmotic heads (calculated from concentrations, which likely have units of dS/m). If one uses
the Multiplicative Model then one does not need to use this conversion, and can keep Osm.
Coeff equal to one, since a) both water stress and salinity stress response functions can have their
own units, and b) both the Threshold Model parameters (specified above) and selected
concentrations units are likely already the same (e.qg., units of EC (dS/m)).

A database of suggested values for different plants for the threshold-slope salinity stress model
is provided based on the work by Maas [1990]. The database for the threshold model provides
suggested values based on the electric conductivity of the saturation extract EC, in dS/m. These
values are converted internally in the GUI into the electric conductivity of soil water (at the field
capacity) as follows: EC,, ~ ke * EC., where k. is approximately 2 [Skaggs et al., 2006].
Consequently, the threshold value of Maas [1990] is multiplied by 2 (k.) and the slope is divided
by 2. A user is responsible for converting these values in the regular HYDRUS further to the
osmotic pressure in the head units [L] or concentration units used in your project. For guidance,
see Egs. 13.3 and 13.4 in Maas [1990].

The threshold-slope salinity stress model is implemented in the standard HYDRUS solute
transport model as R=1-0.01(c—-c;)s , while in the UNSATCHEM module as

R=1+(h, —h,;)s", where cr is the concentration threshold, hr is the osmotic head threshold, s
is the slope in HYDRUS and s is the slope in UNSATCHEM.
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3.20. Root Distribution Parameters

The spatial distribution of the roots can be specified using the Root Distribution Parameters
dialog window (Fig. 36). The following two- and three-dimensional root distribution functions
are implemented in HYDRUS [Vrugt et al., 2001, 2002]:

g g

o

where Xn, Ym, and Z, are the maximum rooting lengths in the x-, y-, and z- directions [L],
respectively; x, y, and z are distances from the origin of the plant (tree) in the x-, y-, and z-
directions [L] respectively; px [-], py [-], pz [-]. X" [L], y* [L], and z" [L] are empirical parameters
(X', y*, and z_ are in Fig. 36 indicated as Depth of Maximum IntenS|ty or Radlus of Maximum
Intensity; parameters py, py, and p, are assumed to be zero for x> X, y>Yy, 2>z, respectively
[Vrugt et al., 2002]), and b(x,z) and b(x,y,z) denote two- and three-dimensional spatial
distribution of the potential root water uptake [-]. See Vrugt et al. [2001, 2002] for different
configurations of the normalized spatial distribution of potential root water uptake rate. The
equations above are given and used in absolute coordinates, i.e., they are independent of any
actual selection in GUI. The x and y coordinates are identical to x and y coordinates for the
geometry of the transport domain. The only exception is that the beginning of the z coordinate
for the root distribution starts at the highest located node of the entire transport domain (again
independent of any actual selection).
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Root Distribution Parameters

Wertical Distribution

M astimum Roating Depth

Depth of b asimurn |ntensity

Parameter Pz

Harizontal Distribution - # [F]

Specify Parameters for Honzontal Digtribution
b agirnum Footing Radiuz

Badiuz af Maximum Intenzity |30

Parameter Px

Harizontal Distribution -

Specify Parameters for Honzontal Digtribution

[ Ok H Cancel ]

Figure 36. The Root Distribution Parameters dialog window.
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3.21. Time Variable Boundary Conditions

The Time Variable Boundary Conditions dialog window is shown in Figure 37.

Time Variable Boundary Conditions B
Time Precig. Evap. Transp. hCritA War Fll “arH-1 ~

1 )| 0 0 016 15000 0 0
2 92 0.07 0 018 15000 0 0
3 93 n.o2 0 013 15000 0 0
4 94 0 0 nz 15000 0 0 Add Line
5 95 0 0 0.28 15000 0 0
8 % 0.07 0 0.1 15000 0 0
7 97 0.29 0 0.08 15000 0 0
8 98 0.44 0 014 15000 0 0
9 99 0.2 0 0.11 15000 0 0
10 100 0.29 0 011 15000 0 0
11 101 032 0 011 15000 0 0 q@q
12 102 0.49 0 0.11 15000 0 0w

< > L Dewt.. |
Linear interpolation of time hetween the initial and final time

1 Surface area associated with transpiration

Figure 37. The Time Variable Boundary Conditions dialog window.

The following variables are specified in the Time Variable Boundary Conditions dialog
window:

Time Time for which a data record is provided [T].

Precip Precipitation rate [LT™] (in absolute value) (applied to the atmospheric boundary).

Evap Potential evaporation rate [LT™] (in absolute value) (applied to the atmospheric
boundary).

Trans Potential transpiration rate [LT™] (in absolute value).

hCritA Absolute value of the minimum allowed pressure head at the soil surface [L]

(applied to the atmospheric boundary).

Var.Fl1 Drainage flux [LT™] across the bottom boundary, or another time-dependent
prescribed flux boundary condition (positive when water leaves the flow region);
set to zero when no time-dependent flux boundary condition is specified. Same for
Var.FlI2, Var.FI3, or Var.Fl4. The Var.Fl4 value is used for internal time-variable
nodal flux sinks or sources (if they exist).

Var.H-1 Groundwater level [L] (usually negative), or other time-dependent prescribed head
boundary condition; set equal to zero when no time-dependent head boundary
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TVall

TVal2

CVall

CVal2

Cval3

condition is specified. Same for Var.H-2, Var.H-3, or Var.H-4. The Var. H-4 value
is used for internal time-variable nodal pressure head sinks or sources (if they exist).

The first time-dependent temperature [K] that can be used for nodes with time
variable boundary conditions (atmospheric BC, variable head/flux BC) (is not
specified when heat transport or time variable boundary conditions are not
considered).

The second time-dependent temperature [K] that can be used for nodes with time
variable boundary conditions (is not specified when heat transport or time variable
boundary conditions are not considered).

The first time-dependent solute concentration [ML™] that can be used for nodes
with prescribed time variable boundary conditions (atmospheric BC, variable
head/flux BC) (not specified when solute transport is not considered). This column
should be used preferably only for the atmospheric boundary, because the
concentration value is adjusted based on values of precipitation and evaporation
as follows: cVall=Precip/(Precip-Evap)*cVall. The cVall is adjusted to be zero
when Evap > Precip. Similar adjustments are not done for cVal2, and other
concentration values.

The second time-dependent solute concentration [ML] that can be used for nodes
with prescribed time variable boundary conditions (atmospheric BC, variable
head/flux BC) (not specified when solute transport is not considered).

The third time-dependent solute concentration [ML™] that can be used for nodes
with prescribed time variable boundary conditions (atmospheric BC, variable
head/flux BC) (not specified when solute transport is not considered).

The last three entries are entered for each solute.

The table in Figure 37 can be edited by manually adding or deleting lines. The table has a capacity
for about 32,000 records (depends on the number of columns). When a longer time record is to be
simulated, then one needs to directly edit the Atmosph.in input file in the working directory using
any standard software, such as MS Excel. The manually modified Atmosph.in file then needs to
be imported back into the HYDRUS project_name.h32d file using the command File->Import and
Export->Import Input Data from *.In Files. Data for the Time Variable Boundary Conditions
can be prepared in any spreadsheet software and then copied into the table using Windows paste
hot keys (i.e., Ctrl+V).

The total number of atmospheric data records is given in the Main Time Information dialog
window (Fig. 15).
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3.22. Constructed Wetlands

Two biokinetic model formulations can be chosen: (1) the biokinetic model as described in
CW2D [Langergraber and Siminek, 2005, 2006] and (2) the CWM1 (Constructed Wetland
Model #1) biokinetic model [Langergraber et al., 2009]. In CW2D aerobic and anoxic
transformation and degradation processes for organic matter, nitrogen and phosphorus are
described, whereas in CWM1 aerobic, anoxic and anaerobic processes for organic matter,
nitrogen and sulphur. Comparisons between CW2D and CWM1 components and processes is
given in Tables 11 and 12, respectively. Details about both modules can be found in the above
referenced literature.

Parameters for constructed wetlands are entered in the Constructed Wetland Model

Parameters | and Il dialog windows for the CW2D (Fig. 38 and 40, respectively) and CWM1
(Fig. 39 and 41, respectively) modules.

Table 11. Comparison of CW2D and CWM1 components.

Cw2D CwM1
[Langergraber and Simunek, 2005] [Langergraber et al., 2009]
Components Soluble components, S?
1. SO: Dissolved oxygen, O2. 1. SO: Dissolved oxygen, O2.
2. CR: Readily biodegradable soluble 2. SF: Fermentable, readily biodegradable soluble
COD. COD.
3. CS: Slowly biodegradable soluble 3. SA: Fermentation products as acetate.
COD. 4. Sl: Inert soluble COD.
4. CI: Inert soluble COD. 5. SNH: Ammonium and ammonia nitrogen.
5. XH: Heterotrophic bacteria 6. SNO: Nitrate and nitrite nitrogen.
6. XANSs: Autotrophic ammonia oxidizing 7. SSO4: Sulphate sulphur.
bacteria (Nitrosomonas spp.) 8. SH2S: Dihydrogensulphide sulphur.
7. XANb: Autotrophic nitrite oxidizing Particulate components, X?
bacteria (Nitrobacter spp.) 9. XS: Slowly biodegradable particulate COD.
8.  NH4N: Ammonium and ammonia 10. XI: Inert particulate COD.
nitrogen. 11. XH: Heterotrophic bacteria.
9. NOZ2N: Nitrite nitrogen. 12. XA: Autotrophic nitrifying bacteria.
10. NOB3N: Nitrate nitrogen. 13. XFB: Fermenting bacteria.
11. N2: Elemental nitrogen. 14. XAMB: Acetotrophic methanogenic bacteria.
12. POA4P: Phosphate phosphorus 15. E(ASR_B: Acetotrophic sulphate reducing
acteria.

Organic nitrogen and organic phosphorus are | 16. XSOB: Sulphide oxidizing bacteria.
modeled as part of the COD.
Nitrification is modeled as to-step process. | Organic nitrogen and organic phosphorus are modeled
Bacteria are assumed to be immobile. as part of the COD.
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Table 12. Comparison of CW2D and CWM1 processes.

cw2D

CcwmM1

[Langergraber and Simunek, 2005]

[Langergraber et al., 2009]

Heterotrophic bacteria:

1.

2.

3.

4,

5.

Hydrolysis: conversion of CS into
CR.

Aerobic growth of XH on CR
(mineralization of organic matter).
Anoxic growth of XH on CR
(denitrification on NO2N).

Anoxic growth of XH on CR
(denitrification on NO3N).
Lysis of XH.

Autotrophic bacteria:

6.

7.
8.

Aerobic growth of XANs on SNH
(ammonium oxidation).

Lysis of XANs.

Aerobic growth of XANb on SNH
(nitrite oxidation).

Lysis of XAND.

Heterotrophic bacteria:

1. Hydrolysis: conversion of XS into SF.

2. Aerobic growth of XH on SF (mineralization of
organic matter).

3. Aerobic growth of XH on SA (mineralization of
organic matter).

4. Anoxic growth of XH on SF (denitrification).

5. Anoxic growth of XH on SA (denitrification).

6. Lysis of XH.

Autotrophic bacteria:
7. Aerobic growth of XA on SNH (nitrification).
8. Lysis of XA.

Fermenting bacteria:
9. Growth of XFB (fermentation).
10. Lysis of XFB.

Acetotrophic methanogenic bacteria:

11. Growth of XAMB: Anaerobic growth of acetotrophic,
methanogenic bacteria XAMB on acetate SA.

12. Lysis of XAMB.

Acetotrophic sulphate reducing bacteria:

13. Growth of XASRB: Anaerobic growth of acetotrophic,
sulphate reducing bacteria.

14. Lysis of XASRB.

Sulphide oxidizing bacteria:

15. Aerobic growth of XSOB on SH2S: The opposite
process to process 13, the oxidation of SH2S to SSO4.

16. Anoxic growth of XSOB on SH2S: Similar to process
15 but under anoxic conditions.

17. Lysis of XSOB.
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Solute Transport - Constructed Wetland Model (CW2D) Parameters |

Hydrolysis Rate Constant: Sat. Anh. Coeff. for Hydralysis:
Hel
Heterotrophic Organizmz: kineralization [L]
Max. Aerobic Growth Rate: |01 Sat Anh. Coeff. for Substr: |2
Fiate Constant for Lysiz; | 0.0025 Sat./lnk, Coeff. for MH4; [0.05
Sat.Anh. Coeff, for 02 |02 Sat.Anh. Coeff, for P; |0.01
Heterotrophic Organizms: Denitification
Max. Denitrification Fate; | 0.02 Sat./lnh. Coeff, for NOZ; (0.5
Sat.Alnh, Coeff. for02: |02 Sat./lnh. Coeff. for Substr.: |2
Sat./nh. Coeff. for HOZ: |05 Sat./nh. Coeff, for NH4; | 0.05
Sat.Anh, Cosff. for P, | 0.07
Autatraphic Bactena: Mitrosonamas
Max. derobic Growth Rate;  [0.015 Sat./lnh. Cosff, for NH4; (0.5
Fiate Constant for Lysiz; | 0.0015 Sat Ak, Coeff. for P |[0.071
Sat./nh. Coeff. for 02 |1
Autotrophic Bactena: Mitrobacter
Max. Aerobic Growth Rate:  |0.0167 Sat./nh. Coeff, for NO2: |01
Fiate Constant for Lysis:  |0.0015 Sat. /. Coeff. for NH4: |0.05  Mest..
SatAlnh, Coeff. for 02 |01 Sat Ak, Coeff. for P; |00 [ﬁ
Previous ..

Figure 38. The Constructed Wetland Model (CW2D) Parameter | dialog window.
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Table 13. Kinetic parameters in the CW2D biokinetic model [Langergraber and Simznek, 2005].

Description [unit] Value
Hydrolysis for 20°C (10°C)
Kn hydrolysis rate constant [1/d] 3(2)
Kx saturation/inhibition coefficient for hydrolysis [§ COD¢s/g CODgy] 0.1 (0.22)
Heterotrophic bacteria (aerobic growth)
L maximum aerobic growth rate on CR [1/d] 6 (3)
by rate constant for lysis [1/d] 0.4 (0.2)
Khet 02 saturation/inhibition coefficient for Sq [mg O,/L] 0.2
Khet.cr saturation/inhibition coefficient for substrate [mg CODcg/L] 2
Khet NH4N saturation/inhibition coefficient for NH4 (nutrient) [mg N/L] 0.05
Khet 1p saturation/inhibition coefficient for P [mg N/L] 0.01
Heterotrophic bacteria (denitrification)
DN maximum aerobic growth rate on CR [1/d] 4.8 (2.4)
Khet 02 saturation/inhibition coefficient for Sq [mg O,/L] 0.2
Khet NoO3N saturation/inhibition coefficient for NO3 [mg N/L] 0.5
Khet No2N saturation/inhibition coefficient for NO2 [mg N/L] 0.5
Khetcr saturation/inhibition coefficient for substrate [mg CODcg/L] 4
Khet NH4N saturation/inhibition coefficient for NH4 (nutrient) [mg N/L] 0.05
Khet.1p saturation/inhibition coefficient for P [mg N/L] 0.01
Ammonia oxidising bacteria (Nitrosomonas spp.)
Hans maximum aerobic growth rate on Syy [1/d] 0.9 (0.3)
bans rate constant for lysis [1/d] 0.15 (0.05)
Kans,02 saturation/inhibition coefficient for So [mg O,/L] 1
K ANs,NH4N saturation/inhibition coefficient for NH4 [mg N/L] 0.5
Kans,ip saturation/inhibition coefficient for P [mg N/L] 0.01
Nitrite oxidising bacteria (Nitrobacter spp.)
HAND maximum aerobic growth rate on Syy [1/d] 1(0.35)
banp rate constant for lysis [1/d] 0.15 (0.05)
K anb 02 saturation/inhibition coefficient for Sq [mg O,/L] 0.1
K ANb,NO2N saturation/inhibition coefficient for NO2 [mg N/L] 0.1
K AND,NH4N saturation/inhibition coefficient for NH4 (nutrient) [mg N/L] 0.05
Kanb,ip saturation/inhibition coefficient for P [mg N/L] 0.01

87



Table 14. Kinetic parameters in the CWM1 biokinetic model [Langergraber et al., 2009].

Parameter Description [unit] Value
Hydrolysis for 20°C (10°C)
Kn hydrolysis rate constant [1/d] 3(2)
Kx saturation/inhibition coefficient for hydrolysis [ CODsr/g CODgy] 0.1 (0.22)
M correction factor for hydrolysis by fermenting bacteria [-] 0.1
Heterotrophic bacteria (aerobic growth and denitrification)

L maximum aerobic growth rate on Sg and S, [1/d] 6 (3)

Mg correction factor for denitrification by XH [-] 0.8

by rate constant for lysis [1/d] 0.4(0.2)
Kon saturation/inhibition coefficient for Sq [mg O,/L] 0.2

Kse saturation/inhibition coefficient for S [mg CODg¢/L] 2

Ksa saturation/inhibition coefficient for Sy [mg CODsa/L] 4

KnoH saturation/inhibition coefficient for Syo [mg N/L] 0.5
KNHH saturation/inhibition coefficient for Syy (nutrient) [mg N/L] 0.05
Khzsh saturation/inhibition coefficient for Sy, [mg S/L] 140
Autotrophic bacteria

N maximum aerobic growth rate on Syy [1/d] 1(0.35)
ba rate constant for lysis [1/d] 0.15 (0.05)
Koa saturation/inhibition coefficient for Sq [mg O,/L] 1

KNHA saturation/inhibition coefficient for Syy [mg N/L] 0.5 (5)
Khzsa saturation/inhibition coefficient for Sy,s [mg S/L] 140
Fermenting bacteria

yres maximum aerobic growth rate for Xgg [1/d] 3(1.5)
brg rate constant for lysis [1/d] 0.02
Kors saturation/inhibition coefficient for Sq [mg O,/L] 0.2
Ksrg saturation/inhibition coefficient for S [mg CODg¢/L] 28
Knoes saturation/inhibition coefficient for Syo [mg N/L] 0.5
KNHes saturation/inhibition coefficient for Syy (nutrient) [mg N/L] 0.01
Khzsre saturation/inhibition coefficient for Sy,s [mg S/L] 140
Acetotrophic methanogenic bacteria

HamB maximum aerobic growth rate on for Xavg [1/d] 0.085
bame rate constant for lysis [1/d] 0.008
Koame saturation/inhibition coefficient for So [mg O,/L] 0.0002
Ksame saturation/inhibition coefficient for S, [mg CODsa/L] 56
Knoams saturation/inhibition coefficient for Syo [mg N/L] 0.0005
KNHAMB saturation/inhibition coefficient for Syy (nutrient) [mg N/L] 0.01
Kh2same saturation/inhibition coefficient for Sy,s [mg S/L] 140
Acetotrophic sulphate reducing bacteria

LASRE maximum aerobic growth rate for Xasgg [1/d] 0.18
basre rate constant for lysis [1/d] 0.012
Koasrs saturation/inhibition coefficient for Sq [mg O,/L] 0.0002
Ksasrs saturation/inhibition coefficient for S, [mg CODsa/L] 24
KNoAsre saturation/inhibition coefficient for Syo [mg N/L] 0.0005
KNHASRB saturation/inhibition coefficient for Syy (nutrient) [mg N/L] 0.01
Ksoasrs saturation/inhibition coefficient for Sgo, [Mg S/L] 19
Khzsasre saturation/inhibition coefficient for Sy,s [mg S/L] 140
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Sulphide oxidising bacteria

HsoB maximum aerobic growth rate for Xsog [1/d] 5
TsoB correction factor for anoxic growth of Xsog [-] 0.
bsos rate constant for lysis [1/d] 0
Kosos saturation/inhibition coefficient for Sp [mg O./L] 0.
Knosos saturation/inhibition coefficient for Syo [mg N/L] 0.
KnHsos saturation/inhibition coefficient for Syy (nutrient) [mg N/L] 0
Kssos saturation/inhibition coefficient for Sy, [mg S/L] 0

.28
8
15
2
5
.05
24

Solute Transport - Constructed Wetland Model No1 (CWM1) Parameters |
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Sat.flnh. Coef. for S&:

Sat.Anh. Coef. for SMO:
Sat. Anh. Coef. for SMH:
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Fermenting B acteria
taw. Growth Rate ®FB: |0.125 Sat./nh. Coef. for SF: Sat.Anh. Cosf. for SMH: (001
Rate Constant for Lysiz: |0.000833333 Sat /Inh. Coef. for SMO; Sat.lnh, Coef. for SH2S: | 140
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ok ]
(el ]
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Max. Growth ate }AMB: Sat/Inh. Coef. for SA: |56 Sat./Inh. Cosf. for SNH:
Riate Constant for Lysis: |0.000333333 | Sat/Inh. Coef. for SNO: [0.0005 Sat./Inh. Coef, for SH2S:
Sat./nh. Coeff. for 50: |0.0002

Acetotrophic Sulfate Reducing Bacteria
Max. Growth Rate *45RE; |0.0075 Sat./lnh. Coef. for S&: |24 Sat./Inh. Coef. for 5504: |19
Rate Constant for Lysiz: |0.0005 Sat./lnh. Coef. for SNO: | 0.0005 Sat/lnk. Cosf. for SH25: | 140
Sat./Inh. Coeff. for 50: Sat./Inh. Coef. for SNH4: | 0.01
Sulphide Oxidizing B acteria
Max. derobic Growth Rate: 0.2 Sat./Inh, Coef. for 50: (02 Sat./nh, Coef. fr SNH: (005 |

Anasic Corection Factor. |18 Sat./lnh. Coef. for SNO: |05 Sat/lnh Cosf. frSH25: (024 |

Rate Constant for Lysiz: | 0.00625

Previous ..

Figure 39. The Constructed Wetland Model (CWMZ1) Parameter | dialog window.
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Solute Transport - Constructed Wetland Model [CW2D) Parameters Il
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=
-

Heterotrophic Organisms: | 47800 Hydrolysis: | 28000 [ Cancel ]
Autatrophic Organismg: | 63000 Factor K= for Hydrolpzis:  |[-53000
Factor KHHA for Mitrification: | -180000 =
Stoichiometric Parameterss
Production of Cl in Hpdrolpsiz: |0 Fraction of Cl in biom. Lyziz:
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ield Coefficients
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Temp. Dep. 02 Saturation:  |-15000 [ﬁ
Previous ...

Figure 40. The Constructed Wetland Model (CW2D) Parameter Il dialog window.
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Table 15. Temperature dependences, stoichiometric parameters, composition parameters and
parameters describing oxygen transfer in the CW2D biokinetic model [Langergraber and

Simunek, 2005].

Parameter Description [unit] Value
Temperature dependences (activation energy [J/mol] for Arrhenius equation)

Tdep_het activation energy for processes caused by XH [J/mol] 47800
Tdep_aut activation energy for processes caused by XA [J/mol] 69000
Tdep_Kh activation energy Hydrolyses [J/mol] 28000
Tdep_KX activation energy factor KX for hydrolyses [J/mol] -53000
Tdep_ KNHA activation energy for factor KNHA for nitrification [J/mol] -160000
Stoichiometric parameters

frya.ci production of CI in hydrolysis 0.0
famcr fraction of CR generated in biomass lysis 0.1
fam.ci fraction of Cl generated in biomass lysis 0.02

Y et yield coefficient for XH 0.63

Y ans yield coefficient for XANs 0.24

Y anb yield coefficient for XANb 0.24
Composition parameters

incR N content of CR [g N/g CODcg] 0.03
incs N content of CS [g N/g CODcs] 0.04
inci N content of Cl [g N/g COD¢] 0.01
inBM N content of biomass [g N/g CODgy] 0.07
ipcr P content of CR [g P/g CODc¢g] 0.01
ipcs P content of CS [g P/g CODcs] 0.01
ipci P content of Cl [g P/g COD¢|] 0.01
ip.BMm P content of biomass [g P/g CODgy] 0.02
Oxygen

cO2_sat 20 saturation concentration of oxygen [g/m?] 9.18
Tdep_cO2 _sat  activation energy for saturation concentration of oxygen [J/mol] -15000
rate_ 02 re-aeration rate [1/d] 240
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Figure 41. The Constructed Wetland Model (CWMZ1) Parameter Il dialog window.
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Table 16. Temperature dependences, stoichiometric parameters, composition parameters and
parameters describing oxygen transfer in the CWML1 biokinetic model [Langergraber et al.,

2009].
Parameter Description [unit] Value
Temperature dependences (activation energy [J/mol] for Arrhenius equation)
Tdep_HyKh activation energy Hydrolyses [J/mol] 28000
Tdep_HyKX activation energy factor KX for hydrolyses [J/mol] -54400
Tdep H activation energy for processes caused by XH [J/mol] 47800
Tdep_A activation energy for processes caused by XA [J/mol] 75800
Tdep_ KNHA activation energy for factor KNHA for nitrification [J/mol] -160000
Tdep_mueFB activation energy for XFB growth [J/mol] 47800
Tdep_bFB activation energy for XFB lysis [J/mol] 0
Tdep_ AMB activation energy for processes caused by XAMB [J/mol] 0
Tdep_ASRB activation energy for processes caused by XASRB [J/mol] 0
Tdep_SOB activation energy for processes caused by XSOB [J/mol] 0
Stoichiometric parameters
frya,si production of S, in hydrolysis 0.0
fam.sk fraction of Sg generated in biomass lysis 0.05
fam.xi fraction of X, generated in biomass lysis 0.1
Yy yield coefficient for XH 0.63
Ya yield coefficient for XA 0.24
Yes yield coefficient for XFB 0.053
Y ame yield coefficient for XAMB 0.032
Y asrs yield coefficient for XASRB 0.05
Ysog yield coefficient for XSOB 0.12
Composition parameters
insF N content of Sg [g N/g CODg] 0.03
insI N content of S| [g N/g CODg)] 0.01
inxs N content of X5 [g N/g CODys] 0.04
inxI N content of X, [g N/g CODy] 0.03
inBM N content of biomass [g N/g CODgy] 0.07
Oxygen
cO2_sat_20 saturation concentration of oxygen [g/m?3] 9.18
Tdep_cO2_sat activation energy for saturation concentration of oxygen [J/mol] -15000
rate_ 02 re-aeration rate [1/d] 240
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4. Geometry of the Transport Domain

The transport domain may be defined using relatively simple two-dimensional rectangular (Fig.
10) or three-dimensional hexahedral (Fig. 11) objects. In that case, the dimensions and other
parameters of the transport domain are specified numerically using either the Rectangular (Fig.
10) or Hexahedral Domain Definition (Fig. 11) dialog windows. In both of these cases the transport
domain is discretized into a structured finite element mesh. Alternatively, a more general two-
dimensional geometry can be defined from basic boundary objects, such as points, lines, splines,
polylines, arcs and/or circles. Boundary curves can consist of any combination of polylines, arcs,
circles or cubical splines. The program permits one to specify internal boundaries (e.g., drains, wells,
impermeable objects), as well as internal curves. A user can define from these boundary objects
either a two-dimensional transport domain, the base plane (base surface) of the three-
dimensional layered domain, or multiple surfaces that can then define the three-dimensional
general domain. In the former two cases, the two-dimensional transport domain or the base plane
of the three-dimensional domain is discretized into an unstructured finite element mesh.

4.1. Boundary Objects

The computational domain (the two-dimensional transport domain or the base surface of the
three-dimensional domain) is formed by an arbitrary number of mutually nonintersecting curves.
Each curve can be formed by connecting an arbitrary number of objects. Objects are defined by
nodes, the positions of which can be specified either graphically with the mouse with
possibilities to use grid alignment (Fig. 137) or by numerically defining their coordinates X, Y,
and Z. It is also possible to read in the objects with a large number of nodes (spline, polyline)
from a file containing the x-(, y-,) and z-coordinates for each node using the command Insert-
>Domain Geometry->Points->Read from File .... The order of inputting particular objects is
arbitrary; the code automatically forms the desired curves. In order to have a physically realistic
domain, only one closed outer curve can exists (for multicomponent domains such a curve must
exist for each component of the domain). The domain can have an arbitrary number of holes or
internal curves. The consistency of the geometry can be verified at any time using the command
Check Data Consistency (Tools Menu). Any change in geometry can be undone using the
undo command (up to ten levels backward in time) or redone using the redo command (again up
to 10 levels).

An object type (e.g., polyline, spline, arc, or circle) must be selected first when designing a new
object from the Edit Bar on the right side of the view window, or from menu (e.g., Insert-
>Domain Geometry->Nodes). Then points defining a particular object should be entered. The
manner in which nodes are entered depends on the selected input style. When entering data
graphically, an appropriate Work Plane (x-y y-z, x-z) and a grid with appropriately set
parameters (Fig. 137 and Section 8.1.2) can be used to facilitate the input, while the coordinates
X, Y, and Z of the cursor are continuously displayed in the bottom right corner of the window.

It is possible to edit existing objects by double-clicking on a particular object. The current

selection, displayed in yellow, may be modified (edited) using the following operations: delete,
copy (Fig. 52), move (Fig. 52), rotate (Fig. 53, left) and mirror (Fig. 53, right). Note that, in
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addition to objects, particular nodes of an object can belong to a selected set as well, in which
case the edit operations are carried out also for these points. Editing of selected objects (e.g.,
moving objects) also depends on the currently selected input style. The objects are moved with
the cursor when the graphical mode is selected, while in numerical mode a vector of translation
(X, Y, and Z) must be specified. It is possible to directly edit nodes of objects with the commands
insert point (Fig. 44), delete point, and/or move point.

Before saving the data, an option is always displayed whether or not to verify the consistency of

the geometry. We strongly recommend to regularly perform this test in order to prevent errors in
subsequent calculations, e.g., during mesh generation.

Table 17. Definition of terms related to geometry design.

Objects
Objects are basic elements for building a geometric model of the computational domain and for
defining other properties of the computational problem. Objects are divided into several
categories (e.g., Geometry, FE-mesh, or Auxiliary), with each category containing several fields
of objects of the same type. The shape (boundary) of the computational domain is defined using
Geometric objects. Basic types of geometric objects are:

- points

- curves (polylines, arcs, circles, splines)
- surfaces

- openings

- thickness vectors

- solids

Points
A point is a basic geometric object which is used to define Curves and other objects. A point
location is defined using two or three coordinates depending on dimensions of a particular
problem.

Curves
A curve is a set consisting of a finite number of objects connected by boundary nodes. Except at
point nodes, objects cannot intersect each other or themselves. A curve can be open or closed.

Outer Boundary Curves
An outer boundary curve is a boundary curve with the following properties: the curve is closed,
positively oriented (i.e., in a counter-clockwise direction), does not intersect any other curve or
itself, and has the computational domain (surface) located on its left side (in the sense of positive
orientation), while the right side is not part of a computational domain.

Internal Curves

An internal curve must be located entirely within the computational domain. It can touch (but not
intersect) the outside boundary of the computational domain at its definition points. An internal
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curve can be open or closed, and can intersect itself, provided the intersect occurs at a definition
point of the internal curve.

Openings
An opening is defined by one or more boundary curves that form a closed boundary.

Lines
Lines and polylines are the most commonly used objects for describing boundaries of a domain
or internal curves. Lines are defined by two points specifying their beginning and end. Several
lines can be connected to form “polylines” by connecting the beginning and end of two
neighboring lines. Nodes can not coincide, while lines can not intersect each other.

Arcs
An arc can be defined either by a) three points on its circumference, b) a center, a radius, two
angles (starting and final angle) and its orientation, and c) two points, a center, and a radius.

Circles
A circle can be defined either by a center and a radius, or by three different points.

Surface

A surface (the computational domain of two-dimensional applications) is defined by a finite
number of continuous disjunctive bounded two-dimensional subdomains (Fig. 42). This means
that the domain can be multicomponent, but that each of its components must have only one
outer boundary curve. The domain can contain any finite number of internal holes or internal
curves. Surfaces can be either planar surfaces (defined in a single plane) or curved surfaces
(e.g., Quadrangle, Rotary, Pipe, or B-Spline). The base surface is a two-dimensional planar
surface that can be extended into a three-dimensional solid (the computational domain of
three-dimensional applications) using thickness vectors.

Thickness Vectors
The term thickness vector is used for a vector perpendicular to the base surface that extends the
Base Surface to form a solid (three-dimensional computational domain).

Solids

The term solid represents a three dimensional computational domain that is formed either by
the base surface and thickness vectors (3D-Layered Solids), or boundary surfaces (3D-
General Solids), which can be either planar or curved (e.g., Quadrangle, Rotary, Pipe, or B-
Spline).

Computational Domain

A Computational Domain is a continuous part of a two- or three-dimensional space for which
water flow or solute transport is simulated. The Domain Geometry term relates to the shape of
this space. The Domain Geometry can be defined for simple cases using parameters (using a
Generalized Rectangle in 2D projects or a Generalized Hexahedral in 3D projects) and for
general cases using boundaries (boundary curves for two-dimensional domains and boundary
surfaces for three-dimensional domains).
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In the 3D-Standard version, the Geometry is defined using the Base Surface, which is a 2D
domain of an arbitrary shape, and a set of Thickness Vectors, that define the variable thickness
of the 3D domain or thicknesses of an arbitrary number of Geo-Layers (the term Sublayers was
used in version 1, and is used alternatively in the text below). Such domain is then called the 3D-
Layered domain. Although such domains cannot be fully general, they allow definition of a
majority of realistic 3D problems. In the 3D-Professional version, the Geometry is defined
using three-dimensional objects (Solids, bodies) of general shapes, which are formed by
boundary surfaces, which can be either planar or curved.

A Computation domain can be formed using several surfaces that can touch each other, but can
not overlap (Fig. 42). It is possible to create an opening in the base surface and then enter another
surface into it. Division of the transport domain into individual surfaces enables easier work with
it, since the program creates for each surface its own section and users can then specify different
domain properties and initial and boundary conditions on these sections.

Surfacel

Internal Point

DOpening Surface?

Internal Curve

Figure 42. A base surface showing several basic geometric objects.

4.1.1. Points

Points can be either used to define Boundary Objects or can be located inside of the Surface
(computational domain) and not be associated with any boundary object (Single Points). Points
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can be entered either graphically using a cursor (most common) or using the New Point dialog
window (identical to the General Tab of the New Point dialog, Fig. 44). To enter a new point
graphically, select the command Insert->Domain Geometry->Point->Graphically from the
menu, or Points from the Insert Object part of the Domain Geometry version of the Tool Bar
at the right side of the View Window, and then enter the points using a cursor.

Once a command for defining a new point graphically is selected, a cursor in the View window
will become a cross with a small empty circle in the middle. The coordinates of the location of
the cursor will be displayed next to the cursor and on the Edit Bar, which will automatically
change to the one displayed in Figure 43 (left). The Edit Bar will also show, which point (its
number) is being defined and what reference coordinate system (the current coordinate system or
the grid origin) is used. The process of defining new points is ended by pressing the Esc
keyboard button, the right mouse button (see the Help part of the Edit Bar), or clicking the Stop
button on the Edit Bar.

x] x|
é] Domain Geometry |
Set new Line ES
== MHumbers for new
é] Domain Geometry | G [4
Set new Point ES Paint: 5
Hurnber for new
Paint: Coordinates
e 31940 [cm]
Coordinates
z 52015 [cm]
e 568,66 [cm]
z 335.08| [cm] Fief. Coord. Spstem
O Curent CS
Fief. Coord. Spstem @ Grid Drigin
() Current C5 () Last Paint
(® Grid Origin
[ Apply ]
[ Apply ] [ Stop ]
[ Stop ]
Help 3
Help 3 g Step 1 of 2
B Gt rew Point. Eiitefirst paint of the new
¥ Press Esc or right mouge ) .
button to end the tool ¥ Press Esc or right mouse
button to end the toal.

Figure 43. The Edit Bar during the process of defining graphically a new point (left) and a new
line (right).

Double-clicking on an existing point will recall the Edit Point dialog window (Fig. 44). In
addition to the General Tab (Fig. 44, left) in the New Point dialog window, the Edit Point
dialog window has also the FE-Mesh Tab (Fig. 44, right). Coordinates of a point and its number
are entered in the General Tab, while the FE-Mesh Refinement at a given point can be defined
in the FE-Mesh Tab.
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Figure 44. The Edit Point dialog window.

Although Cartesian Coordinates are usually used, it is possible to use also other coordinate
systems:

Coordinate Systems in 3D Projects Coordinate Systems in 2D Projects
e Cartesian e Cartesian

e X-cylindrical e Polar

e Y-cylindrical

e Z-cylindrical

e Spherical

Reference Point: Point coordinates are usually related to the defined origin of the coordinate
system. They can nevertheless be also related to another existing point, whose index is specified
in the box Reference Point No. Locations of all related points are automatically adjusted when
the location of the reference point is changed. The dependence of points on the Reference Point
is, however, canceled during more complex operations, such as Copy, Rotate, or Drag and Drop.
The coordinates of such points are then recalculated using absolute Cartesian coordinate system.

Point Type: Current version of HYDRUS recognizes two types of points:
e Standard — These are regular points defined using two or three coordinates.

e Parametric — These points are located on a curve and their location is calculated
using a specified parameter from the interval (0.1), where O and 1 represent the
beginning and end of the curve, respectively. For example, a point with a parametric
coordinate t=0.5 is located exactly in the middle of the curve. A parametric point is
not a defining point of a curve, i.e., it does not define its shape. On the contrary, a
shape of a curve defines the location of a parametric point. A Parametric Point can
be redefined as a Standard Point in the Edit Point dialog window (Fig. 44).
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Parametric Points can be added on a curve using the command Insert Points on
Line on the Edit Bar, using the menu command Tools ->Insert Points On Line-
>Graphically, or by clicking on a curve with the right mouse button and selecting the
Insert Points On Line->Graphically from the popup menu (Fig. 45). Either the
parametric coordinate of a point or its distance from boundary points (L) of a curve is
displayed on the Edit Bar when specifying a Parametric Point.
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Figure 45. Different ways of adding Parametric Points on a curve.

4.1.2. Lines and Polylines

Lines and Polylines are the most commonly used objects for describing the boundaries of a two-
dimensional domain and its internal curves. Similarly as above for Points, Lines and Polylines
can be entered either graphically using a cursor (most common) or using the New Line dialog
window (identical to the General Tab of the Edit Line dialog, Fig. 46). When entering a new
line graphically, users can select the command Insert->Domain Geometry->Line(Polyline)-
>Graphically from the menu, or Line - Abscissa or Line - Polyline from the Insert Object part
of the Domain Geometry version of the Tool Bar at the right side of the View Window and
then enter the lines using a cursor.

Once a command for defining a New Line (a single abscissa) or a New Polyline is selected, a
cursor in the View window will become a cross with a small empty circle in the middle. The
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coordinates of the location of the cursor will be displayed next to the cursor and on the Edit Bar,
which will automatically change to the one displayed in Figure 43 (right). The Edit Bar will also
show, which point and curve (their numbers) are being defined and what reference coordinate
system (the current coordinate system, the grid origin, or the last inserted point) is used. Once a
single Line is specified (for a new line), one can immediately continue in specifying the second
one, while the last point of the first line will be the beginning point of the second line. Each
abscissa is considered to be a single curve. When a New Polyline is being created, the entire
polyline is considered to be a single curve. The process of defining new lines is ended by
pressing the Esc keyboard button, the right mouse button (see the Help part of the Edit Bar), or
clicking the Stop button on the Edit Bar.

Double-clicking on an existing line will recall the Edit Line dialog window (Fig. 46). Before
using the New Line dialog window, a user needs to first define points which are then used to
define the line. In addition to the General Tab (Fig. 46, left) in the New Line dialog window,
the Edit Curve dialog window has also the FE-Mesh Tab (Fig. 46, right). Points defining the
line are entered in the General Tab, while the FE-Mesh Refinement along a given line can be
defined in the FE-Mesh Tab.

Edit Curve [X] | Edit Curve 3
General | FE-Mesh General | FE-Mesh
Curve Mo, Ao Mo
E 1
P1
Curve Type FE-Mezh Fefinement
Polline v . [ivatabia
Lizt of Points YAl
34 VA
P2 P3 s .
Comment f
Glotal FE-Size = 5 cm
ok | [ cancel | [ appy | [ Hep | [ ok [ Ccancel

Figure 46. The Edit Curve dialog window.

4.1.3. Arcs and Circles

An arc is part of a circle. An object arc is always internally defined using three definition points.
However, to simplify its specification, it is possible to define an arc graphically in multiple ways
using: a) three points on its circumference, b) a center, a radius, two angles (starting and final
angle) and its orientation, or c) by two points, a center, and a radius. Again, arcs can be entered
either graphically using a cursor (most common) or using the New Line dialog window (Fig. 48).
When entering a new arc or circle graphically, a user must select the command Insert->Domain
Geometry->Arc->Graphically from the menu, or one of the following commands (a) Arc by 3
Points, b) Arc by 2 Points and R, or ¢) Arc by Center, R and Angle) from the Insert Object
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part of the Domain Geometry version of the Tool Bar at the right side of the View Window
and then enters arc using a cursor.

Graphical definition of Arcs and Circles is rather similar to the definition of Points and Lines.
Differences occur when Radii or Angles are used to define these objects. For example, when
user defines Arc by 2 Points and Radius, he/she first needs to define the two points, after which
both the cursor and the Edit Bar change (Fig. 47, left) for the definition of the third type of
information defining the arc. This can be a radius, an internal angle, or a height. The selection
can be made on the Edit Bar that also displays the magnitude of this variable (R, A) and a step
(dR, dA) in which it can be increased.
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Figure 47. The Edit Bar during the process of defining graphically a radius for a new arc (left) or
a new circle (right).

In addition to the General Tab (Fig. 48, left) in the New Line dialog window, the Edit Line
dialog window has also the Arc Tab (Fig. 48, right). A list of points defining the arc are given in
the General Tab, while coordinates of points defining the arc, its center and other parameters
are entered in the Arc Tab. Double-clicking on an existing line will recall the Edit Curve dialog
window (Fig. 48). The Edit Curve dialog window (Fig. 48) has an additional FE-Mesh Tab
(similarly as for a line in Fig. 46; not shown here) where a user can refine the FE-Mesh along a
given arc.
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Figure 48. The New Line (Arc) dialog window.

An object circle is always defined internally using three definition points. However, to simplify
its specification, it is possible to define a circle also using a center and a radius. Three
definition points are then created automatically. Again, circles can be entered either graphically
using the cursor (most common) or using the New Line dialog window (Fig. 48). A new circle
can be entered graphically, by selecting the command Insert->Domain Geometry->Arc(Circle)-
>Graphically from the menu, or by using one of the following commands (a) Circle by 3 Points,
or b) Circle by Center and Radius) from the Insert Object part of the Domain Geometry
version of the Tool Bar at the right side of the View Window, and then entering lines using the
cursor. The list of points defining the circle must be entered in the General Tab (Fig. 49, left),
while coordinates of points defining the circle, its center and radius are entered in the Circle Tab
(Fig. 49, right). When a Circle is defined by Center and Radius graphically, then the first
definition point is created at the mouse click, while the other two are at the circle circumference
at -90 and -180 degrees.

Adjustable Point: When a radius or the center of an arc is modified, it is usually also necessary to

modify the location of one of the arc definition points. An adjustable point enables one to choose
a point whose coordinates are to be changed.
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Figure 49. The New Line (Circle) dialog window.

4.1.4. Curves and Splines

The term “Curve” is used in the program and its documentation in two ways, while the meaning
depends on where it is used.

1/ The term Curve is a general term for objects Line, Polyline, Arc, Circle, Spline.
2/ The term Curve can also refer to multiple objects (ad 1/) connected in their boundary points.

This meaning of the term Curve is mainly used in connection with “Boundary Curve”,
“Internal Curve”, and so on.

There are several rules that need to be followed during the definition of a Curve.

e Curves cannot intersect each other or themselves except at their definition nodes.
e No point that is not either its definition or Parametric Point can lie on a Curve.

Curves are always defined using their definition points (their indexes). The list of indexes can be
checked or changed using the Edit Curve dialog (the first Tab “General”).

A Spline is a set of more than 2 points connected smoothly by cubic arcs. Splines are general
smoothed curves defined using points in the 2D or 3D space. Three-dimensional splines do not
generally have to lie in the same plane. However, if a spline is used to define a boundary of a
surface, then all its definition points need to lie in this surface. A spline can be defined either
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graphically using a command on the Edit Bar or in the dialog where we select a particular type
of spline. HYDRUS allows three types of splines:

- cubic spline, i.e., a curve defined by multiple polynomials of the third order. It passes smoothly
through all points.

- Bezier’s curve — a smooth curve that passes through boundary points, but does not have to pass
through internal points .

- B-spline — a general Bezier’s curve.

More information can be found at
http://mathworld.wolfram.com/BezierCurve.html
http://mathworld.wolfram.com/B-Spline.html

Once a command for defining a new spline graphically is selected, a cursor in the View window
will become a cross with a small empty circle in the middle. The coordinates of the location of
the cursor will be displayed next to the cursor and on the Edit Bar, which will automatically
change to the one displayed in Figure 50. The Edit Bar will also show, which point and curve
(their numbers) are being defined and what reference coordinate system (the current coordinate
system, the grid origin, or the last inserted point) is used. One node is specified after the other. A
user can also select on the Edit Bar the type of the spline (standard spline, B-spline, or Bezier
curve). The process of defining a new spline is ended by pressing the Esc keyboard button, the
right mouse button (see the Help part of the Edit Bar), or clicking the Stop button on the Edit
Bar.
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Figure 50. The Edit Bar during the process of defining graphically a spline.
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4.1.5. Common Information for a Graphical Input of Objects

A/ A Numerical Input of Values. Edit controls displayed on the Edit Bar can be used to enter
some values that are difficult to enter graphically as follows. Using a mouse one defines an
approximate shape of an object. Then using a keyboard one enters selected values numerically.
While entering values using a keyboard one can not move a mouse, or entered values will be lost.
One needs to use the ,,Tab* key or ,,Shift + Tab“ keys at the keyboard to move forward of
backward from one edit controls to another one, respectively. A control of Combo Boxes and
Radio buttons is done using a standard way as in dialog windows, i.e., using keys Arrow Up or
Arrow Down, etc. After all values are entered one pushes the Enter key to finish the actual step
of the running tool.

B/ Adjusting View. When graphically entering objects, one often needs to move or turn the
scene, or to enlarge or reduce a selected detail. This can be done without interrupting the input of
a particular object. The fastest way is to press the center mouse button (a wheel) and then a)
dragging the scene with the mouse move, b) moving forward or backward an object by scrolling
the wheel, or c) rotating the scene by simultaneously also pushing the right mouse button. After
releasing the center mouse button, one can continue in the graphical input of an object. Similar
operations can also be performed using button on the View Toolbar:

HEEECQE ® & ¥ 5

A majority of buttons on the View Toolbar do not interrupt the graphical input of an object, i.e.,
after the adjustment of the View Window on can continue in the graphical input of an object.

C/ Snapping. When entering Points graphically (points created when entering curves or
surfaces), a process called Snapping is taking place. This means that a cursor snaps to points of
a Grid (Fig. 51, left) or to existing points. Snapping can be disabled using a button Snap to
Grid on the Tools Toolbar. Snapping on existing points or curves can not be disabled.
Snapping occurs when a center of a cursor comes close to an existing point and when this point
is redrawn with a yellow color (or any pre-select color assuming that redrawing of preselected
points is not switched off). One can simultaneously observe on the Edit Bar that an index of a
preselected point and its coordinates are displayed in edit controls. These controls are disabled
since displayed values can not be changed. Snapping on curves (Fig. 51, right) occurs in
addition to Snapping on existing points. An automatic calculation of coordinates of a point on a
curve and snapping to this point occurs when a center of a cursor comes close to an existing
curve. A location of this point is marked using a yellow cross which indicates that after this point
is entered it becomes a definition point of a curve. This is important, since entering a point on a
curve that is not its definition point leads to the wrongful definition of a domain. A Check of a
Geometry discovers such errors and the Repair Geometry function will automatically correct it.

Figure 51. Snap to a point (left) and snap to a curve (right).
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4.1.6. Translate, Copy, Rotate, Mirror, Stretch, and Skew Operations

All boundary objects can be manipulated using the Translate, Copy, Rotate, Mirror, Stretch,
or Skew operations in the Translate — Copy (Fig. 52), Rotate (Fig. 53, left), Mirror (Fig. 53,
right), Stretch (Fig. 54, left), and Skew (Fig. 54, right) dialog windows. These commands can be
access either from the Tools Menu or from the Transform Object part of the Domain
Geometry version of the Tool Bar at the right side of the View Window. Users first select an
object to be manipulated, then click on the command, and specify the Vector of Translation for
the Translate or Copy operations, or the Angle of Rotation for a Rotation, or define the
Mirroring Plane/Axis for a Mirroring operation.

Transzlate - Cop A | S|
Wector of Translation MHurnbering
e 0ol m Fick Set first number for numbering of nes
- [l objects that will be created during copying:
g 0,000 [m] .
Paints: &vtomatic
dz: 0.000  [m] .
Lines: &vtomatic
Copy Surfaces Autamatic
Murmber of Copies: B Solids: [¥] Auatomatic

Connections between Copies [Lines, Sufaces, Solids]

[7] Generate connecting objects between copies
[ ak. ] [ Cancel ] [ Help ]

Figure 52. The Translate - Copy dialog window.

Rather than simply Translating or Rotating a given object, one can choose to use this operation
(e.g., Translate/Move or Rotate) to create one or multiple copies of a given object by specifying
the Number of Copies (see Figs. 52 and 53, left). Once one or more copies of a given object are
to be created, one can also choose to Generate Connecting Objects Between Copies (e.g., Fig.
52). What types of connecting objects are to be created is selected in the Manipulation Options
window (Figs. 55). HYDRUS can generate a) lines between selected nodes and their copies, b)
surfaces between selected lines and their copies, and c) solids between selected surfaces and their
copies). Lines can be either straight or curved when a copy is created using the Rotate operation.
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Figure 53. The Rotate (left) and Mirror (right) dialog windows.
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4.1.7. Additional Operations

Additional operations that can be used to manipulate boundary objects are Intersect Lines, Insert
Points on Line, and Split Line. All three commands again can be accessed either from the Tools
menu or from the Transform Object part of the Domain Geometry version of the Tool Bar on
the right side of the View Window. The first command (Intersect Lines) finds the Intersect of
two lines, whereas the second command Inserts Points on a Line. This can be done either
graphically or numerically by specifying the number of nodes to be inserted on the line or distance
of the point from the beginning of the line (Fig. 56). The third (Split Line) command can be used
to split a line into two or more parts.
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Figure 56. The Insert Point on Curve dialog window.
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4.2. Surfaces
4.2.1. General Definitions

An object Surface refers to, depending on the problem type and the selection made in the
Domain Type and Units dialog window:

e 2D-General: For two-dimensional problems, a Surface serves to define the shape of
the computational domain or its parts. See also Geometry Information.

e 3D-Layered: In this case, the term Surface is used to define the Base Surface for
Solid - 3D-Layered domains. This type of Solids is available in the 3D-Standard
version.

e 3D-General: The term Surface serves to define boundary surfaces of a general 3D
solid. This type of Solids is available only in the 3D-Professional version. More
detailed information can be found in the section about Solid — General (Section 4.4).

In the 3D-Standard version, the only available type of a Surface is a Planar Surface. This type
of the Surface is defined by its boundary curves that must all lie in the same plane and cannot
cross each other. In the 3D-Professional version, also the Curved Surfaces (Quadrangle,
Rotary, Pipe, or B-Spline) are available.

A surface is a closed two-dimensional domain that is either the computational domain for two-
dimensional applications or the base surface that can be extended into a solid for three-
dimensional applications. A surface is defined by the List of Boundary Curves. It can be
created using either the Insert->Domain Geometry->Surfaces->Graphically or Insert->Domain
Geometry->Surfaces->Graphically Rectangle commands. Alternative commands on the Insert
Object part of the Domain Geometry version of the Tool Bar are Planar Surface via
Rectangle and Planar Surface via Boundaries. In the first case, a cursor appears and users can
create a rectangular surface using the mouse. The Edit Bar displayed during this operation is
similar to the one displayed in Figure 43 (right). The Edit Bar will also show, which point, curve,
and surface (their number) are being defined. In the second case, users can create a surface by
clicking on a closed curve (one or more boundary objects forming a close curve). The Edit Bar
displayed during the operation will list Boundary Curves defining the Surface (Fig. 58, left). A
surface can be edited using the Edit Surface dialog window (Fig. 58, right), which specifies
surface type, the number of boundary curves defining the surface, its number, and had a box for
possible comments or a description. A surface must be created before one can do finite element
discretization.

A Surface can also be created automatically by using the menu command Tools->Generate
Domain Surfaces or the Edit Bar command Planar Surfaces - Generate. After this command is
clicked on, the program analyses existing boundary curves and attempts to generate planar
surfaces automatically, i.e., without the user being required to define its boundaries. This
operation is usually successful when there is a single uninterrupted boundary curve. The
operation may fail when there are some ambiguities, such as when there are multiple curves or
when boundary curves are not closed. If this operation fails, the following warning is displayed
(Fig. 57) and the user needs to define Surfaces manually.
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The prograrm was not able to create surface(s) autornatically.

Possible reasons:

1/ Boundary curves are not closed

2/ The boundary contains a point connecting three or more
curves, The pregram is not able to resolve this ambiguity
i.e. it is not able to select a curve that should be used

as the surface boundary,

Solution:

Please use the tool "Surface via Boundaries” to define
boundary curves of the surface manually.

Figure 57. The warning issued when Surfaces cannot be created automatically and must be
defined manually.
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Figure 58. The Edit Bar during the process of defining graphically a surface (left) and the
General tab of the Edit Surface dialog window (right).
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4.2.1.1. Planar Surfaces

A base surface is formed by a planar surface of arbitrary shape. The base surface can contain
openings, internal curves, and internal points (Fig. 59). In the current version of HYDRUS, a
base surface can be formed by a single surface. Future versions will permit multiple surfaces to
form one single base surface.

Figure 59. A solid showing the base surface.

If the solid needs to be divided into vertical columns, then these columns must be defined using
internal curves in the base surface. The FE-mesh then follows exactly the specified shape of
these internal curves (Fig. 60):

Figure 60. Solid showing separate vertical columns.
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A base surface can be defined by a plane other than the horizontal plane, while thickness vectors
can be defined in other than the vertical direction. Figures 61 and 62 show an example of a solid
that has a base surface in the XZ plane and thickness vectors in the Y direction.

Figure 61. A solid with its base surface in the XZ plane and thickness vectors in the Y direction.

Figure 62. FE-Mesh for a solid with its base surface in the XZ plane and thickness vectors in the
Y direction.

4.2.1.2. Curved Surfaces

There are currently four types of Curved Surfaces (Fig. 63) available in the 3D-Professional
version: Quadrangle, Rotary, Pipe, and B-Spline. While the boundary of a Planar Surface
must be formed by multiple different Curves, the boundary of a Curved Surface can contain
one curve two times. An example is a Pipe Surface (Fig. 63), in which the curve along a pipe
occurs twice, each time with a different orientation. Note that the list of curves defining Pipe and
Rotary Surfaces is generated automatically and cannot be edited, contrary to the list of curves
defining Quadrangle or B-Spline, for which curves are selected by a user.

Quadrangle is a Surface defined by its boundary curves of an arbitrary type (except a circle).
Curves do not have to be placed in a single plane, that is, in general, a Quadrangle can be a
curved surface. This type of surface corresponds to a general surface with four corners, i.e., it is
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typically defined by four boundary curves (although this is not a necessary condition). If there is
another number of boundary curves than four, it is necessary to define corner nodes of a
Quadrangle.

A B-Spline Surface is a Surface defined using Boundary Curves (similarly as a Quadrangle).
However, for this type of Surface, one needs to also define additional matrix of N*N internal
nodes, which allows one to curve the inside of a Surface. One needs to define a number of
internal nodes N and an order of the Surface Spline. Internal nodes are created automatically
when a B-Spline Surface is defined. Their coordinates can be subsequently edited. An order of
the Surface Spline is an order of the polynomial, which is used for modeling the surface (either
quadratic or cubic).

A Rotary Surface is defined by an Axis of Rotation (defined using two nodes), a Rotated
Curve (of arbitrary type, as long as the created surface make sense), and an Angle of Rotation
(from O to 360 degrees).

A Pipe Surface is defined by an Axis Curve (a smooth curve of an arbitrary type — only a
polyline does not have to be smooth) and a radius.

Rotary Curved Surface:

Quadrangles

Figure 63. Examples of Curved Surfaces (Rotary, Pipe, B-Spline, and Quadrangle Surfaces).
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4.2.1.3. Partial Surfaces

A Partial (or Component) Surface (Fig. 81) is created by an Intersection of Surfaces or
Solids (see Section 4.6), which divides an original Surface into smaller Sub-Surfaces, or the
so-called Component Surfaces. Although this Surface has its own number and can be used to
define, for example, a Solid, its shape and boundaries are defined (generated) by the shape of
its original Surface and a given Intersection. A list of Components resulting from division of
the original Surface by an Intersection can be found on the Tab Components of the Edit
Surface dialog window. Since Partial Surfaces are generated objects, they cannot be deleted
or their shape cannot be edited (only the parental Surfaces can be edited). When a parental
Surface is divided into Components, it still exists (is listed in the Navigator), but is not
displayed in the View anymore; only its Components can be displayed.

One can define for each Component its activity (using commands Activate Partial Surface
and Deactivate Partial Surface), i.e., whether it should be a part of the domain and whether a
FE-Mesh should be generated on it or not. In this way one can cut from the original Surface
unneeded parts. When an option ,,Display components as independent surfaces” is selected,
Components are displayed in the Navigator Data Tree as independent Surfaces and it is
possible to select them graphically and use them for a definition of Solids. A selected
Component is displayed in a view, in order to facilitate visual identification of Components.

4.2.2. Steps to Define a Two-Dimensional Domain

1/ Definition of Boundary Curves of Particular Surfaces

Boundary Curves are formed using basic geometric objects, such as Points and Curves. These
objects can be specified in three different ways:

1. Graphically. One selects on the Edit Bar an appropriate tool and specifies new objects
graphically in the View Window. This is usually done by specifying coordinates of
points while using the Grid Alignment or snapping to already existing objects (points).

2. Numerically. Objects can be entered numerically by defining their X, Y, and Z
coordinates and indexes in a dialog window. The dialog is obtained by using the Menu
command Insert —> Domain Geometry or the Navigator Bar command Data Tab —>
Domain Geometry and selecting the desired object type with a click of the right mouse
button and the New command ...

3. Import from a File. Particular objects (with a large number of nodes (spline, polyline)
or the entire Geometry can be read from the text file using several formats. More
detailed information is at Read points from a text file and Import Geometry from a
Text File.

The order of inputting particular objects is arbitrary.

2/ Definition a Surfaces
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Boundary Curves do not yet form the Computational Domain. The Computational Domain
is formed using one or more Surfaces that need to be defined. A Surface is defined using a list
of Curves that form a closed external boundary. A Surface can be defined Graphically by
sequentially clicking on particular Boundary Curves or Numerically in a dialog where one can
define a list of indexes of Boundary Curves.

3/ Internal Objects
Any surface can have an arbitrary number of Openings (Holes), Internal Curves or Internal
Points. Additional information can be found at Internal Objects.

4/ Openings

Each surface can have an arbitrary number of Openings (Holes). An Opening is defined by an
closed internal boundary (one or more Internal Curves), which entirely lies inside of a Surface.
An Opening can be formed by clicking with the right mouse button in the View Window on the
closed internal boundary and selecting from the popup menu the "Create Opening” command.
Additional information can be found at Openings.

5/ Geometry Check
The consistency of the geometry can be verified at any time using the command Check Data
Consistency (Tools Menu).

6/ Remarks

e Any change in geometry can be undone using the undo command or redone using the
redo command. A number of undo or redo step is limited by the buffer memory, which
can be set in the Program Options dialog window (Tab Options and Directories).

e When the Computation Domain is formed by several subdomains with different
properties (e.g., different materials and so on), one can form this domain from multiple
Surfaces corresponding to these subdomain. An advantage is that after the FE-Mesh is
generated, it is possible to automatically form Mesh Sections for particular Surfaces
and use them to easily define materials and other properties or initial and boundary
conditions. Additional information can be found at FE-Mesh Sections (Section 5.7).

4.2.3. Several Notes on Rules for Correct Definition of Surfaces

1. Contrary to the old HYDRUS-2D program, internal curves can touch or cross other internal
curves and can touch boundary curves. A point where two curves intersect (or touch) must be
a definition point of both curves (must be a part of the Geometry). This point can be found
automatically using commands Intersect Lines (Tools->Intersect Lines or Intersect Lines
from the Edit Bar) or Repair Geometry (Tools->Repair Geometry).

Curves cannot lie upon each other.

Multiple points can not be defined at the same location. A frequent error is when initial and
final points of a curve are defined at the same location. The curve is then not closed and a
surface can not be defined using this curve. Initial and final points of a closed curve must be
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defined using the same point.
4. A point cannot lie on a curve without being its definition point.

5. All above mentioned errors in definition of the Geometry can be automatically solved using
the command Repair Geometry (Tools->Repair Geometry).

6. Contrary to the old HYDRUS-2D program, the number of Surfaces is virtually unlimited (up
to 30,000). Surfaces can touch each other (in a point or on a boundary line), or one Surface
can lie inside of the other Surface. In this case one needs to first create an internal Hole in the
first Surface and then insert the second Surface into this hole. This process can be recursive,
I.e., it is possible to crease a Hole in the internal Surface and insert an additional Surface
there). When defining a new Surface graphically (e.g., using a rectangle), HYDRUS
recognizes when the new Surface is located inside of the existing Surface and automatically
offers their integration.

7. Surfaces cannot partially cover each other (see also 6).

8. Points located outside of Surfaces are ignored when generating FE-Mesh.

4.2.4. Internal Objects

Internal Objects are objects of the type Point, Curve, or Opening, integrated in the Surface
object. Objects are by default integrated into the Surface automatically (see Option “Autodetect”
in Figure 1). It is possible to edit objects manually when the “Autodetect” option is turned off.
{bmct Internal_Object_DIg.bmp}
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Figure 64. The Integrated Tab of the Edit Surface dialog window.
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Main reasons for integrating objects into a Surface:

Objects integrated in a Surface are respected when the FE Mesh is generated. On the
other hand, objects that lie in a Surface but are not integrated in it are ignored during

the FE Mesh generation.

Internal Points allow users to precisely define location of Observation Points and

other objects.

Internal Curves allow users to precisely define geometric boundaries inside of the
transport domain. They can be used for many different purposes (e.g., Mesh Lines,

Material Boundaries, etc).

Curves integrated in a Surface that is used as a Base Surface for the 3D-Layered
Solid are projected also at the Upper Surface and enable thus more precise modeling of
its shape (see Figs. 65 and 66).
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Figure 65. An example of internal objects.
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Figure 66. An example of an Upper Surface definition using Internal Curves and Thickness
Vectors.
There are several rules that must be followed when defining Internal Objects:
e An Internal Curve must be entirely within a Computational Domain.

e An Internal Curve can touch (but can not intersect) the outside boundary of a parent
Surface at its definition points (definition points of its boundary curves).

e An Internal Curve can be open or closed, and can intersect itself, provided that the
intersect occurs at a definition point of an Internal Curve.

An Internal Curve or an Opening must lie entirely inside of the parent Surface. Common
reasons why a Curve or an Opening are not automatically integrated into a Surface is that there
exist small deviations between them and a Surface that are not visible, but are larger than
allowed tolerance (usually 0.1 mm).
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4.2.5. Check and Repair Geometry

The Check Data Consistency command performs a consistency test of the domain boundaries.
It checks especially whether each domain component is bounded by an outer boundary curve and
whether or not the curves are intersecting each other. When the geometry is not correct, the code
sends a warning and select those curves which do not fulfill the rules for a correct definition of
boundaries. The command Repair Geometry may then be used to fix existing problems.

The Repair Geometry command attempts to fix errors in the ill-defined Geometry that were
found using the command Check Data Consistency. This command calls the Repair Domain
Definition dialog window (Fig. 67). The List of Corrections section of this dialog lists various
operations that can be used automatically by the program when attempting to correct the ill-
defined Geometry. Some of these corrections depend on the model precisions, which are defined
in the Model Precision and Precision of Corrections section. Users can define these precision
criteria or use those suggested by HYDRUS.

Repair Domain Definition L'

todel Precizion and Precizsion of Corectionz 0k

todel precizsion Epzl = 00047 [em) Aptomatic
Corections precizion Eps2 = 0.4700| [zm] Automatic

Lizt of Caorections

Replace arcs with length L<Epz2 and incomectly defined arcs by abscizzas
FRemove overlapping points, i.e. pointz with diztance D<Epsl

Remove curves with length L<Epz1 and incarectly defined curves

Create interzections of lines

Remove incarectly defined openings Check &l
Clear &l
Apply

Figure 67. The Repair Domain Definition dialog window.

HYDRUS automatically analyzes defined Geometry and if it is not consistently defined, it
displays a warning at the Edit Bar in its Help section: Errors in Domain Definition. After
double-clicking on this warning, HYDRUS displays a message informing what is wrong
(incorrect), similarly as when using the Check Data Consistency command.
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4.3. Opening

An opening is an internal hole defined by a boundary curve having the following properties:
the curve is closed, positively oriented (in a counter-clockwise direction), does not intersect any
other curve or itself, and has the computational domain located on its right-hand side (in the
sense of positive orientation), while the left side is not part of a computational domain. An
opening is not part of the computational domain or surface. An opening is created graphically as
follows: One first defines boundary objects that create a closed boundary curve. One then uses
the command Insert->Domain Geometry->Opening->Graphically from the menu, or
alternatively the command Opening via Boundaries on the Insert Object part of the Domain
Geometry version of the Tool Bar. A user creates an opening by clicking on the closed curve
(one or more boundary objects forming a closed curve). The Edit Bar displayed during the
operation will list Boundary Curves defining the Opening (similar to Fig. 58, left).
Alternatively, an opening can be created using the New Opening dialog window (Fig. 68) by
clicking on the command Insert->Domain Geometry->Opening->Dialog from the menu. An
opening can be edited using the Edit Curve dialog window (Fig. 46), which specifies the
number boundary curves defining the opening, its number, and has a box for possible comments
or a description.

Mew Opening E

Opening Mo, i Surface Mo,
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Comment

Opening representing vwell
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Figure 68. The New Opening dialog window.
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4.4. Solids

Solids are three-dimensional objects defined by the base surface and one or more thickness
vectors (See also Section 2 - Projects Geometry Information). There are three types of Solids
depending upon the selection made in the Domain Type and Units dialog window (Figs. 6 and
7):

e 3D-Layered — Hexahedral: This type of solid has a Hexahedral Shape and is defined
by its basic dimensions (Figs. 6 and 9). The base can have a certain slope in the X and
Y dimensions.

e 3D-Layered — General: This type of solid is defined by the Base Surface and one or
more Thickness Vectors.

e 3D-General: This type of solid is defined using a set of surfaces (either Planar or
Curved Surfaces) that form its boundaries. This selection is available only in the 3D-
Professional version of HYDRUS.

4.4.1. 3D-Layered — Hexahedral Solids
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Figure 69. The Edit Bar during the process of graphically defining a Hexahedral Solid.
Definition of a Base Surface on the left and a Thickness on the right.

A simple Hexahedral Solid can be created graphically using the menu command Insert-

>Domain Geometry->Solid->Graphically or alternatively the command Solid - Extruded on the
Insert Object part of the Domain Geometry version of the Tool Bar. Once a command for
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defining a new Hexahedral Solid is selected, a cursor in the View window will become a cross
with a small empty circle in the middle. The coordinates of the location of the cursor will be
displayed next to the cursor and on the Edit Bar, which will automatically change to the one
displayed in Figure 69 left. The Edit Bar will also show, which point, curve, and surface (their
numbers) are being defined and what reference coordinate system (the current coordinate system,
the grid origin, or the last inserted point) is used. After two points defining a surface are
specified, both the cursor and the Edit Bar change (Fig. 69 right) for the definition of the
Thickness Vector. The selection can be made on the Edit Bar that also displays the height of the
Thickness Vector (L) and a step (dL) in which it can be increased. The Thickness Vector can be
created (a) Perpendicular to the Base Surface, b) in X-direction, c) in Y-direction, or d) in Z-
direction). The process of defining a new Hexahedral solid is ended after the Thickness Vector is
defined.

4.4.2. 3D-Layered — General Solids
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Figure 70. The Edit Bar during the process of graphically defining a Solid by extruding a Base
Surface. Selection of a Surface (left) and definition of a Thickness Vector (right).

A Solid can be created graphically (Insert->Domain Geometry->Solid->Graphically from the
menu or alternatively the command Solid - Extruded on the Insert Object part of the Domain
Geometry version of the Tool Bar) by clicking on one point defining the Base Surface and
extruding the base to form a three-dimensional solid. During the first part of the operation the
Edit bar (Fig. 70 left) displays numbers for a Solid, a Thickness Vector, a Point, and a Surface,
while during the second part it (Fig. 70, right) displays the Thickness Vector length (and
increment) and in which direction it is created (a) Perpendicular to the Base Surface, b) in X-
direction, ¢) in Y-direction, or d) in Z-direction). A user should during the first step select (click
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on) the Base Surface that is to be used to define the Solid. It is also possible to click on any
Point that defines the Base Surface. The second step depends on whether Thickness Vectors
are already defined in Points of the Base Surface. If they are, they are used to define the Solid
and the second step is not done. If they are not, the thickness of the solid needs to be defined
during the second step. The length and direction of the Thickness Vector is defined using a
mouse in the Point on the Base Surface closest to the mouse click which selected it.

How to create a Solid once the Base Surface and multiple Thickness Vectors are defined?

1. Graphically: Use the “Solid Extruded” tool and click on the Base Surface. A Solid is
created using existing Thickness Vectors.

2. Numerically: By using a command from the Insert menu or by clicking with the right
mouse button on Solids in the Data tree of the Navigator Bar. From the popup menu
select the New Solid command. In the New 3D-Layered Solid dialog select the Base
Surface and Thickness Vectors. Since the Autodetect function is automatically on, the
Base Surface and Thickness Vectors will likely be detected automatically.

Thickness vectors do not have to be perpendicular to the base surface. A Solid, i.e., its base
surface and thickness vectors, is defined and can be edited in the Edit Solid dialog window
(Fig. 71) that has four tabs: General, Sub-Layers, Thickness Profiles, and FE-Mesh. The
General Tab provides information on which base surface and which thickness vectors define
the solid. The Sub-Layers Tab informs whether the solid is divided into one or more Layers.
Layers are other objects that can be used to subdivide a single solid. These layers can be used,
for example, to keep constant thicknesses of selected horizons or constant discretization close to
the soil surface (to get good estimates of evaporation) across the entire transport domain (solid).
Layers can have different Thickness Profiles (the Thickness Profiles Tab). One profile is
created by the code automatically. Users can then define one or more Thickness Profiles that are
associated with different Thickness Vectors. These profiles can then be subdivided into multiple
layers that can have either constant or variable thickness (T) across the transport domain.
Thicknesses and the mode (constant or variable) of particular layers are specified in a table.
Thickness Sum (TS) is then calculated by adding thicknesses of particular layers. At least one
layer thickness must be variable. The finite element discretization then follows these layers.
Finally, the FE-Mesh Tab (Fig. 72) specifies how many horizontal FE-Layers are used to
discretize the solid. When only one layer exists then users can specify relative finite element
spacing (spacing of vertical discretization layers) on the vertical side (FE-Mesh Layer Spacing)
using the RS1 (relative size at the top) and RS2 (relative size at the bottom) factors below
Generate Mesh Layer Spacing. The element sizes are then proportionally distributed. The
preview part of the dialog window shows the main terms used on each Tab. When multiple
layers exist then users can specify relative sizes of elements for each layer (FE-Mesh Density in
Layers).
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Figure 71. The Edit Solid dialog window; the General, Geo-Layers, and Thickness Profiles Tabs.
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Figure 72. The Edit Solid dialog window; the FE-Mesh Tab for a single and multiple layers.
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4.4.2.1. Division of a Solid into Columns

Notice that the Base Surface must be defined using several Surfaces (see Fig. 59). Parts of the
Solid above each Surface are called Columns and serve to geometrically divide the Solid in the
vertical direction. All Surfaces defining the Base Surface must lie in a single plane. A list of
these Surfaces can be defined manually using indexes or can be Autodetected by the program
(the “Autodetect” option). A division of a Solid into Columns leads to an automatic creation of
Mesh Sections that correspond with Columns after the generation of the FE-Mesh. These Mesh
Sections can be used to define various properties (e.g., materials distribution) or initial and
boundary conditions.

4.4.2.2. Division of a Solid into Geo-Layers

Geo-Layers (alternative term Sublayers, which was used in Version 1 is used alternatively
below) are used to divide a Solid in the horizontal direction (Fig. 71).

It is possible in the Edit Solid dialog to define number of Layers and their Thicknesses. A Solid
has always one Master Thickness Vector, which is one of Thickness Vectors of a Solid, that
has a special meaning as described below.

A thickness of a Layer is calculated as follows:

e Thicknesses of Layers given in the Table are calculated on the Master Thickness
Vector

e The sum of Thicknesses of all Layers should be equal to the length of the Master
Thickness Vector. If it is not so, a program will issue a warning and recalculate
Thicknesses of Layers automatically.

A Solid can have more Thickness Vectors of different lengths so that specified Thicknesses of
Layers cannot be maintained. The program then does the following: For Geo-Layers with the
Constant Thickness Type, the specified thickness is maintained at all Thickness Vectors, i.e.,
over the entire computational domain. For Geo-Layers with the Variable Thickness Type, their
thicknesses are linearly increased or decreased so that the sum of Thicknesses of all Layers
corresponds with the length of a particular Thickness Vector.

4.4.2.3. Individual specification of different Thicknesses of Geo-Layers at different Thickness
Vectors.

In the preceding paragraph we have described how to define Thicknesses of Layers on the
Master Thickness Vector using a table (Fig. 71). This table represents the so called Profile, i.e.,
a particular distribution of thicknesses. If one wants to define precisely the division of
thicknesses also on other vectors than the Master Thickness Vector, then it is necessary to
create additional Special Profiles and use then on corresponding Thickness Vectors. There is
always a Default Profile, which corresponds to the table described in 4.4.2 above. One can
create new profiles, change their thicknesses or delete them. One can simultaneously also see a
list of Thickness Vectors where the selected Profile is used.
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A desired Profile can be associated with a particular Thickness Vector after opening a dialog
with its properties (e.g., by double clicking on a vector) and selecting a Profile from a Combo
Box “Thickness Profile No.” (see Fig. 75). This operation can even be carried out globally by
first selecting desired Thickness Vectors, then opening a dialog with their properties (Alt +
Enter), and finally repeating the above described process. Note that one Profile can be associated
with many Thickness Vectors, which enables one to change easily Thicknesses of Layers on
all Thickness Vectors by changing a single Profile.

4.4.2.4. Steps to Define a 3D-Layered Domain

1/ Definition of the Base Surface

The Base Surface is a 2D domain of an arbitrary shape. How to specify the Base Surface is
described in Building a Two-Dimensional Domain.

2/ Definition of Thickness Vectors

One inserts one or more Thickness Vectors in points that lie in the Base Surface, so that the
shape of a Solid is defined as needed.

3/ Definition of a Solid

On the Edit Bar (or the Menu command Insert —> Domain Geometry) one clicks on the Solid —>
Extruded command and selects (clicks on) one of the Surfaces defining the Base Surface. This
operation creates the 3D-Layered Solid. One can do this even when no Thickness Vectors are
defined. In such case after clicking on the Base Surface a graphical tool is started, using which
one can extrude the Solid into the space. A Thickness Vector is simultaneously created in the
Point on the Base Surface that is closest to the location of the click.

4/ Formation of a Solid

A Solid can be further formed using additional Thickness Vectors and Internal Lines.

5/ Definition of Geo-Layers

A Solid can be vertically divided into Layers.

4.4.3. 3D-General Solids

Solids in the 3D-Professional version are defined using boundary Surfaces (either Planar (see
Section 4.2.1.1) or Curved (see Section 4.2.1.2)) and identified as 3D-General Solids. In one
project, one cannot use at the same time 3D-General Solids and 3D-Layered Solids (created in
the 3D-Standard Version) or the parametric blocks (created in the 3D-Lite Version). It is,
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however, possible to convert 3D-Layered Solids into 3D-General Solids by changing the
project type from 3D-Layered to 3D-General.

Boundary Surfaces of a Solid must enclose a closed space and cannot intersect each other.
Interior of a Solid must form a three-dimensional “simply continuous space”, i.e., it must be
possible to connect any two internal points using a polyline that is entirely located inside of a
Solid. Boundaries of a Solid thus can be formed by any number of either Planar or Curved
Surfaces. Figure 73 shows two examples of 3D-General solids. While the Solid at the top is
formed using 8 Planar Surfaces and 4 Quadrangles, the Solid at the bottom is formed by
multiple Curved Surfaces.

Figure 73. Examples of 3D-General Solids. Top - formed by Planar Surfaces, bottom — formed
by Curved Surfaces.
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General Solids can be created in the following ways:
1. Using a standard dialog, from which Boundary Surfaces can be picked graphically
(individually, or using a Quadrilateral or Rhomboid Selection Tool).
2. Creating a Simple Block (Brick).
3. Extruding a Solid from a Surface (one or multiple simultaneously).

Process of Extruding:

Approach 1: Start a tool and click on a given Surface, which is to be extruded. It is important
where a click occurs. The program finds a closest Node on a Surface Boundary
and the extruding distance (height) is measured in this node. The extruding height
is measured on a line passing through this node.

Approach 2: When you want to extrude multiple surfaces at the same time, you need to press
the Left Shift keyboard button before selecting desired Surfaces (you can add or
remove Surfaces). After a selection is made, release the Left Shift button and
start extruding selected surfaces.

Approach 3: First select desired Surfaces and then click the Edit Bar command “Solid —
Extruded”. This will start the extruding process for all selected surfaces.

One can extrude Surface in the direction of X, Y, and Z axis, or in the direction perpendicular to
an extruded Surface. When a Surface is not in a plane (e.g., is curved) and perpendicular
extruding is selected, extruding is done in directions of local perpendicular lines to an extruded
Surface.

During extruding one can select on the Edit Bar the length step (dL) or enter numerically desired
length of extruding (L).

Note that the command Extrude can be used only for Planar, Quad, and B-Spline Surfaces and

it cannot be used for Partial Surfaces and for Surfaces containing a zero Curve (i.e., a curve
with a zero length from point P to point P).
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4.5. Thickness Vectors

The term Thickness Vector is used for a vector (usually but not always perpendicular to the
Base Surface) that extends the Base Surface to form a solid (the three-dimensional
computational domain). A new Thickness Vector can be defined either graphically or
numerically (Fig. 75).

There are several ways in which a Thickness Vector can be specified graphically and these are
displayed at the Edit Bar (Fig. 74), which appears once a command for defining a Thickness
Vector is selected.

a)

b)

d)

Point and Length: A user specifies the length of the Thickness Vector on the Edit Bar
(Vector Length) and with the mouse selects the point to which the Thickness vector is
assigned.

Point and Coordinate: A user specifies the End Coordinate of the Thickness vVctor on
the Edit Bar (End Coordinate) and with the mouse selects the point to which the
Thickness vector is assigned. This method is suitable especially in case, when points
located at the upper surface of the domain already exist (see Tutorial 2.07). In this case we
need to specify Thickness Vectors whose upper points were read in from a GIS file and
we need to create the lower (beginning) points that would be located in the plane of the
Base Surface. Note (in the Tutorial) that the Reverse Points option was automatically
checked on the Edit Bar. This is because the thickness Vectors have to originate from the
Base Surface and not from the upper surface. If the Reverse Points option was not
checked, Thickness Vectors would originate from the upper surface and end at the Base
Surface.

Two Points: A user selects graphically two existing Points to form the Thickness Vector.
In this case an Anchoring (beginning) Point of a Thickness Vector is the first selected
point. It is therefore important to select points defining a Thickness Vector in the right
order, i.e., to first select a point at the Base Surface and only then a point at the upper
surface of the domain.

Three Points: A Thickness Vector is in general defined by three points: an Anchoring
Point, a Beginning Point, and an End Point (Fig. 75). The Anchoring Point must be
located in the Base Surface. The Anchoring Point is usually the same as the Beginning
Point (i.e., both Point indices are the same) and one does not have to pay attention to it.
However, in general, the Anchoring Point can be different than the Beginning Point,
which leads to the so called “offset”. This option allows to define Domains that have both
upper and lower surfaces deformed, i.e., not a plane.

Vector Direction can be specified to be a) Perpendicular to the Base Surface, b) in X-direction,
c) in Y-direction, or d) in Z-direction.

Thickness Vectors can be defined by:

- clicking on individual Points

- selecting points with a rectangle (rhomboid, circle, polygon)

- clicking on a curve — Thickness Vectors will be added to all points of a curve.
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Figure 74. The Edit Bar during the process of graphically defining a Thickness Vector.

A definition of the Thickness Vector (i.e., its Boundary Points), is given and can be edited in
the Thickness dialog window (Fig. 75).
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Figure 75. The Thickness dialog window.
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The height of a solid is defined using one or more Thickness vectors. Each thickness vector is
defined by an Anchor Point P and two Boundary Points N1 and N2. The anchor point P must
be part of the base surface, i.e., it must be either a defining point of the external boundary or the
internal curve, or an internal point in the base surface. Boundary points N1 and N2 are arbitrary
points in 3D space. Coordinates of these points can be edited, thus allowing one to specify the
thickness vector in an arbitrary direction (i.e., not necessarily perpendicular to the base surface).
Usually the anchor point P is the same as boundary point N1 so that one can use the same index
for both P and N1. If, for whatever reason, we do not want to have the base surface on the
bottom of the transport domain (Solid) (e.g., when the bottom of the transport domain is not in
the same plane), users can make the N1 node be different from P (the red part in Fig. 76).

Figure 76. A solid with several thickness vectors.
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Figure 77. FE-Mesh for the solid in Figure 76.

The height of a solid is constant when less than three thickness vectors are used. Three thickness
vectors define a linear plane (with generally an inclined surface). More than three thickness
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vectors with different lengths then define the top surface that is formed by triangles, whose
coordinates are calculated from the thickness vectors using linear interpolation or extrapolation.

When breaks in the slope of the top surface are to be defined exactly, then it is necessary to
define internal curves in the base surface. Figures 78 and 79 show the importance of having
internal curves (or not having them) in the Y direction for proper definition of the solid (compare
Figures 76 and 78 Figures 77 and 79).

Figure 78. Missing internal curves in the base surface.

7

Figure 79. Consequence of missing an internal curve in the base surface on the FE-Mesh of the
top surface.

Note: Three Thickness Vectors needs to be specified to define a Domain with a linearly
changing thickness. As long as only two Thickness Vectors are specified, the thickness of the
Domain is constant and defined using the first Thickness Vector (with lower index) (since three
points are needed to define a plane).
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4.6. Intersections of Surface and Solids

Intersections of Surfaces and Solids (Fig. 80) can be created using the following approaches:

A. Intersection of Surfaces: Select two or more Surfaces, click with the right mouse button
on these selected Surfaces, and select the command “Create Intersection”. When more
types of different objects are selected (e.g., nodes, lines, or surfaces), which can, for
example, occur when selection is made by a Rectangle (or a Rhomboid), then the
command is located in the submenu “Surfaces”.

B. Intersection of Solids (this option not yet available): Select two or more Solids, click
with the right mouse button on these selected Solids, and select the command “Create
Intersection”. When more types of different objects are selected (e.g., nodes, lines, or
surfaces), which can, for example, occur when selection is made by a Rectangle (or a
Rhomboid), then the command is located in the submenu “Solids”. For the Intersection
»Solids A-B” (Fig. 80), the Solid A will remain in its original shape and the Solid B will
be cut off. For the Intersection ,Solids B-A”, the Solid B will remain in its original
shape and the Solid A will be cut off.

C. Intersection of Surfaces and Solids (this option not yet available): It is possible to
create this intersection using the menu command Insert->Domain Geometry-
>|ntersection or by clicking with the right mouse button on the item “Intersections” in
the data tree of the Navigator bar and selecting “Insert Intersections” from the
displayed popup menu. In the dialog, select desired type of Intersection (e.g., surfaces or
solids).
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Intersection of |
Surfaces 51 x 82

Intersection Nao.

Interzaction Type

Intersection Type Partial Surfacs
(surf. component) (Jucofirien Solid B
N @ @Twn Solids 4B
A\ niersachon Lury
\ [ ) Twao Solids: B - &
Intersecting Objects el e
Surface & - Mo [1] Sodid & - Mo n ’ \
Surface B -Na.: 2| | Pick Soiid B - Mo r 5. Fick
Lines generated by the intersection Line:s generated by the intersection i
Surface2 - Pipe | *
Surfaces generated by the intersection Surfaces gensraled by the interzection Solid A
Cornment Surface1 - Planar Cornnient
[ ok [ comcel |[ Heb | [ ok [ camel ][ Heb ]

Figure 80. The Edit Intersection dialog window (for two Surfaces (left) and two Solids (right).
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A Partial (or Component) Surface (Fig. 81) is created by an Intersection of Surfaces or Solids,
which divides an original Surface into smaller Sub-Surfaces, or the so-called Component
Surfaces. Although this Surface has its own number and can be used to define, for example, a
Solid, its shape and boundaries are defined (generated) by the shape of its original Surface and a
given Intersection. A list of Components resulting from division of the original Surface by an
Intersection can be found on the Tab Components.

Ints ore cimm of SURFACES

Figure 81. An example of an Intersection of two Surfaces and a resulting Partial Surface and
Intersection Curve.
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4.7. Auxiliary Objects

In addition to objects that define the computational domain, the HYDRUS GUI allows users to
employ several Auxiliary Objects that can be used to, for example, add Dimensions to the
computational domain, include various Labels, or define permanent Cross Sections or Mesh-
Lines.

4.7.1. Dimensions

Dimensions can be added to describe spatial properties of the computational domain in the View
window using the Insert->Auxiliary Objects->Dimensions command or the Dimensions
command from the Insert Object part of the Domain Geometry version of the Edit Bar. Then
one needs to click on two points defining the computational domain and drag Dimensions to the
required position. Figure 100 shows an example of how Dimensions can be used.

After a command for defining a Dimension is selected, a user needs to first select by a cursor
two existing points, the distance of which is to be labeled. The Edit Bar lists during this
operation the two definition points and the Dimension number (Fig. 82 left). After the second
point is selected, a cursor in the View window and the Edit Bar (Fig. 82 right) change and allow
a user to define where a Dimension is to be displayed. In which plane a Dimension is to be
displayed can be done on the Edit Bar (Fig. 82 right).

E
E= é] Domain Geometry |
4] Domain Geomety | Set new Dimension ES
- - Hurnber for new
Set new Dimension * . "
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Hurnber for new
Dimensian: Diimension Type
Definition Paints ®Length
[OT:F+
Faint 1: 1
Faint 2: 0 Odz
[ Apply ] [ Apply ]
[ Stop ] [ Stop ]
Help # Help 2
¥ Step 2of 3 e Step 3of 3
Set second point of the new et pasition of the new
Dimension. Dimension..
2 Press Esc of right mouse ¥ Press Esc or right mouse
button to end the toal. button to end the toal.

Figure 82. The Edit Bar during the process of graphically defining a Dimension. Selection of two
definition points, the distance of which is to be labeled (left) and the dimension type (right).
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4.7.2. Labels

Labels can add any desired text to the computational domain in the View window using the
Insert->Auxiliary Objects->Dimensions command or the Comments command from the Insert
Object part of the Domain Geometry version of the Edit Bar. One then clicks simply anywhere
in the View window and write the desired text. The text itself, its color, frame, and its offset can
be specified in the Edit Comment dialog window (Fig. 83). Figure 100 shows an example of
how the “Furrow” Label is used.

Edit Comment E]
M. Text
Thiz iz a well
O ptions Offzet
[ Fart... | e [pimelz]
[ Frame dr [pixelz]
[ ok ] [ Canicel ] [ Help ]

Figure 83. The Edit Comment dialog window.

After a command for defining a Comment is selected, a user needs to first select a location to
which the comment will point using a cursor. The Edit Bar lists during this operation the
coordinates of a cursor (Position), the color to be used for a comment, and the comment text
(Text) (Fig. 84 left). A user can also select the Font to be used for the comment text.. After the
position is selected, a user defines an Offset of the Comment text. The comment text, the
comment font and color, and offset are displayed at the Edit Bar (Fig. 84 right).

4.7.3. Bitmaps (Textures)

Bitmaps (Textures) serve to use scanned figures (maps) as means to define the computational
domain in the View window. Bitmaps can be added using the Insert->Auxiliary Objects-
>Textures command. Corners of the Bitmap must be anchored at 4 points, coordinates of which
must be selected such that the scale of the Bitmap corresponds with the scale of the View
window. Anchor points can be selected one at a time using either a Listbox (containing list of all
defined nodes) or using a command Pick and selecting nodes using a cursor. All anchor points
can be also selected simultaneously using a command Pick ABCD. The Edit Bitmap dialog
window then provide information about the selected Bitmap, such as its Size in pixels and kB.
One can then simply trace the bitmap to specify the computational domain.
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Figure 84. The Edit Bar during the process of graphically defining a Comment. Selection of the
Comment Position, Comment Text, Font and Color (left) and Offset (right).
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Figure 85. The Edit Bitmap dialog window.
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4.7.4. Cross-Sections

In the HYDRUS-2D software package one could click at any two points of the transport domain
to display results of selected variables between those two points, i.e., along a specified cross-
section. The exact location of these cross-sections was not saved and they had to be redefined
whenever a new graph was required. In HYDRUS one can define the cross-sections and save
their locations so that graphs along the cross-sections can be recalled at any time by simply
clicking at them. Graphs along pre-defined cross-sections can be display for both the initial
conditions and the output results. For example, if a plot of the pressure head along a predefined
cross-section at a particular time is needed, one needs to display the pressure head outputs, find a
particular time, and then click on the predefined cross-section. The graph is displayed
instantaneously. Specifying the cross-section within a two-dimensional domain is
straightforward. For three-dimensional domains one can use the Cross-Section dialog window
(Fig. 86) for this purpose.
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Figure 86. The Cross-Section dialog window.

4.7.5. Mesh-Lines

Mesh-Lines are very similar to Cross-Sections, except that Mesh-Lines follow edges of the
finite elements and do not have to be straight. They are used, similarly to Cross-Sections, to
display selected variables along defined Mesh-Lines. Similarly to Cross-Sections, the locations
of Mesh-Lines are saved and can be recalled at any time.
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Figure 87. The Mesh-Line dialog window.

A description of the Mesh-Line is given in the Mesh-Line dialog window (Fig. 87), which
contains the Mesh-Line number, its description, a list of nodes defining the Mesh-Line, and
whether or not the computational module should calculate (actual and cumulative) water and
solute fluxes across this Mesh-Line. The fluxes across the Mesh-Line are then displayed using
the Fluxes across Mesh-Lines dialog window (Fig. 88) after using the Results->Fluxes across
Mesh-Lines command. This dialog displays actual and cumulative, water and solute fluxes across
individual Mesh-L.ines.
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Figure 88. The Fluxes across Mesh-Line dialog window.
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Information for this graph is read from the CrossSect.out file that contains data organized into
the following columns:

Variable Description Units

Time Time [T]

Flux(i) Water flux across the ith cross-section [L%/T] or [L3/T]

CumFlux(i) | Cumulative water flux across the ith cross-section | [L°] or [L°]"

SolFlux(i) | Solute flux across the i-th cross-section [M/L**L%/T = M/L/T] or
[M/L3*L3T = M/T]'

CumSFIx(i) | Cumulative solute flux across the i-th cross-section | [M/L**L* = M/L] or
[M/L3*L3 = M]"

"for 2D and three-dimensional axisymmetrical problems, respectively.

Water fluxes across internal lines (mesh-lines) are calculated in HYDRUS similarly as fluxes
through the boundary nodes with prescribed Dirichlet boundary conditions (see the Technical
Manual). Nodal fluxes are calculated from the finite element matrix equation that is obtained by
discretization of the Richards equation and assembled for all elements on one side of the selected
internal line. The finite element matrix equation for internal fluxes is calculated at the last
iteration after convergence for given time level had been achieved. Fluxes calculated directly
from the Richards equation are much more accurate than fluxes calculated using Darcy’s law and
have the same accuracy as the overall solution.

4.7.6. Background Layers

Background Layers are geometric objects that can serve as a template for defining the transport
domain. A Background Layer consists of nodes and curves that are not part of the transport
domain, but its components can be used to define the transport domain. A Background Layer is
usually read from the DXF file (AutoCAD) (Figure 91), but may be also read from another
HYDRUS project (h3d or h3d2), or from STL (stereolithography), TIN (Triangular Irregular
Network), or BMT (bitmap) formats (Figure 90). An example of a very complex Background
Layer (unrelated to hydrology) read from the DXF file is given in Figure 89.

In the New Background Layer dialog window (Figure 90), one selects a) the format of the
imported file (i.e., either HYDRUS formats h3d and h3d2, or DXF, STL, TIN, or BMT formats),
b) units of the imported file, c) whether or not to place the Background Layer so that its bottom-
left corner is located in the origin of the coordinate system, d) whether or not to make the
Background Layer visible in the View window, and e) whether or not the Grid and Workspace
settings should be adjusted according to the Background Layer dimensions.
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STL is a file format native to the stereolithography CAD software created by 3D Systems. This
file format is supported by many other software packages; it is widely used for rapid prototyping
and computer-aided manufacturing. STL files describe only the surface geometry of a three
dimensional object without any representation of color, texture or other common CAD model
attributes. The STL format specifies both ASCII and binary representations. Binary files are
more common, since they are more compact. An STL file describes a raw unstructured
triangulated surface by the unit normal and vertices of the triangles using a three-dimensional
Cartesian coordinate system. The STL file specifications are at:
http://en.wikipedia.org/wiki/STL_(file_format).

TIN files are used for storing triangulated irregular networks using a simple set of xyz
coordinates. The TIN file specifications are at:
http://www.ems-i.com/wmshelp/Files/File_Formats/TIN_Files.htm.

The project may have at the same time multiple Background Layers (virtually any number) and
their visibility can be turned on and off using the View Tab at the Navigator Bar (Auxiliary
Objects->Background Layers). Background Layers are displayed in the View window using
suppressed (less intense) colors, so that they do not visually disturb when objects of the geometry
are being defined. The intensity of display and other parameters can be set (intensity of their
display can be set between 0 and 1) in the Display Options dialog window (the Menu command
Options->Display Options->Edit) (Fig. 128). If the location of the template (background layer)
is not satisfactory, it can be Moved (Fig. 52), Rotated (Fig. 53, left), Mirrored (Fig. 53, right),
Stretched (Fig. 54, left), and/or Skewed (Fig. 54, right) as needed.
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4.8. Other Notes on Objects

Objects Mesh Refinement define a local density of the FE-Mesh in the vicinity of a particular
object. Possible types of Mesh Refinement are:

e Mesh Refinement at Point

e Mesh Refinement on Curve given by number of points
e Mesh Refinement on Curve given by FE size

e Mesh Refinement on Surface

4.8.1. Object Numbering

Each object has its own number (index) that serves for unique identification of an object for
operations such as Edit, Delete, or Find. Object numbering is fully controlled by the user (a user
specifies the object index) and does not have to be continuous (indexes do not have to
sequentially increase).

4.8.2. Relations among Objects

More complex objects are defined using simpler objects. For example, a surface is defined by
indices of its boundary curves, and a boundary curve is defined by indices of its points. The
curve, however, does not own its points, since these points can also be used to define other
curves. This is especially true for points at the beginning and end of a curve, since these points
are usually used also by neighboring curves. A relation ,,Parent — Descendent” exists among
objects. In case of a curve, points are ,,Parent” objects and a Surface is its ,,Descendent*.

4.8.3. References among Objects and Convention for Writing a List of Indices

Objects are referenced using a list of indices. A list of indices is written using a text format,
where individual indices are separated by a comma and dash (-) between two indices indicates a
range “from — to” (e.g., 1,5-10,35-30,8,11). After inserting new indices, the list is always
reformatted to minimize the length of the text. Depending on circumstances, the list of indices
respects/does not respect sequence, in which objects were defined.

4.9. Import Geometry from a Text File

It is possible to Import definition of objects defining the Geometry of the transport domain
from a text file using a command “Import Geometry from a Text File”. It is possible to import
(export) points, curves (polylines, circles, arcs, and splines), surfaces, openings and thickness
Vectors.

a) Definition of each object starts with the word OBJECT=KEY_WORD, followed by
coordinates of points defining given object. Two or three coordinates (for two- and three-
dimensional problems) of a single point are given on a single line. Numbers can be
delimited using a space, a semicolon, or a tabulator.
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b) Points associated with higher objects, i.e., lines, openings or surfaces, are listed as part of
this object. Similarly, lines associated with higher objects, i.e., openings or surfaces, are
listed as part of this object. Only points that are not part of any higher object should thus
be listed under the object POINTS, and only lines that are not part of any higher object
(e.g., that do not form boundaries of surfaces) should thus be listed under the object
LINES.

c) Lines with a semicolon at the beginning are ignored as ,,Comments".

d) It is possible that exported Geometry once imported back into HYDRUS can have
different numbering, i.e., the project may not be identical.

e) Below is a list (KEY_WORD) of all possible objects. "POLYLINE" is a single line
defined by multiple nodes, while "LINES" is a series of lines (multiple objects). Surfaces
or Openings must be defined by a single closed curve, the type of which is given in the
name of the object (e.g. SURFACE_CIRCLE). When this rule is not fulfilled (e.g., for a
surface with complex boundary), this complex boundary will be saved as a series of lines,
i.e., SURFACE_LINES.

f) The THICKNESS ARR3Z NLAYERS command allows importing multiple Thickness
Vectors to define variable thickness of a Solid. On each Thickness Vector one can define
multiple z-coordinates that are used to divide a Solid automatically into Layers with
variable thicknesses. The number of Layers is arbitrary (min=1, max=100) and their
number is given by the number of columns in the file.

KEY_WORD for Import/Export:
POINTS
LINES
POLYLINE
SPLINE
CIRCLE
ARC
SURFACE_LINES
SURFACE_POLYLINE
SURFACE_SPLINE
SURFACE_CIRCLE
OPENING_LINES
OPENING_POLYLINE
OPENING_SPLINE
OPENING_CIRCLE
THICKNESS
THICKNESS_ARR3Z
THICKNESS ARR3Z_ NLAYERS

Notes on the THICKNESS_ARR3Z_NLAYERS command (the THICKNESS _ARR3Z command
has only the first five columns):

Particular columns in the input file have the following meaning:
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X coordinate.
Y coordinate.

Z coordinate of the Definition Point of the Thickness Vector (Anchor Point, see Figure
75 of the User Manual with the Edit Thickness Vector dialog and the point denoted "P").
The Definition (Anchor) Point must lie in the plane of the Base surface. The Z-coordinate
in the third column will thus likely be constant for all Thickness Vectors, unless the Base
Surface is inclined.

Z coordinate of the lower point of the first layer of the Thickness Vector (a point denoted
"N1" in Figure 75 of the User Manual). When P=N1, this coordinates is the same as the
3" coordinate.

Z coordinate of the upper point of the first layer of the Thickness Vector.
Z coordinate of the upper point of the second layer of the Thickness Vector.

Z coordinate of the upper point of the last layer of the Thickness Vector, i.e., the
coordinate of the surface of the solid.

Here is an example of the file for the import of a Solid divided into three Geo-Layers:

OBJECT=THICKNESS_ARR3Z_NLAYERS

4.500000e+000  4.000000e+000  0.000000e+000  0.000000e+000
5.500000e+000  2.500000e+000  0.000000e+000  0.000000e+000
7.000000e+000  4.500000e+000  0.000000e+000  0.000000e+000
7.000000e+000  2.500000e+000  0.000000e+000  0.000000e+000
6.500000e+000  9.999999e-001  0.000000e+000  0.000000e+000
5.000000e+000  2.000000e+000  0.000000e+000  0.000000e+000
4.500000e+000  2.000000e+000  0.000000e+000  0.000000e+000
5.000000e+000  9.999999e-001  0.000000e+000  0.000000e+000
5.500000e+000  9.999999e-001  0.000000e+000  0.000000e+000

-300000e+000  2.100000e+000  3.300000e+000
-300000e+000  2.200000e+000  3.400000e+000
.400000e+000  2.300000e+000  3.000000e+000
.200000e+000  2.600000e+000  3.500000e+000
.600000e+000  2.400000e+000  3.600000e+000
.200000e+000  2.500000e+000  3.700000e+000
.400000e+000  2.400000e+000  3.400000e+000
-500000e+000  2.500000e+000  3.300000e+000
-100000e+000  2.100000e+000  3.200000e+000

RPRRRRRRERR

bther notes:

9.

10.

11.

12.

The minimum number of columns is 5 (this corresponds to a single layer).

Z coordinates must be entered in the correct sequence, i.e., from the bottom (Base
Surface) up towards the end of the Thickness Vector.

If layers are to be defined in a different direction than Z (e.g., when the Base Surface lie
in the XZ plane), one needs to first carry out the standard import in the Z direction and
then to rotate the entire domain using the Rotate function.

When the “THICKNESS _ARR3Z _NLAYERS” is used, i.e., the input file includes data
of thickness vectors with multiple geo-layers, this key word can be processed fully only if
the domain already contains a 3D-Layered Solid. If there is no Solid defined yet, then
HYDRUS is not able to create a Solid automatically from imported points because its
Base Surface can have a very complex shape. There are two ways how to proceed:

a) Press “OK” to continue. HYDRUS will import first only thickness vectors without
geo-layers. Then define a 3D-Layered Solid using imported points and import the
same file again. Geo-layers will be added to the Solid during this second import.

b) Press “Cancel” to cancel this import. First define a 3D-Layered Solid and then import
this file again. Thickness vectors with layers will be added to the Solid.
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4.10. Import Geometry from a DXF File

It is possible to Import the definition of objects defining the Geometry of the transport domain
from a file in the DXF format. AutoCAD DXF (Drawing Interchange Format, or Drawing
Exchange Format) is a CAD data file format developed by Autodesk for enabling data
interoperability between AutoCAD and other programs. Autodesk now publishes the DXF
specifications on its website for versions of DXF dating from AutoCAD Release 13 to AutoCAD
2010. The menu command Import Geometry from a DXF File calls the dialog window (Fig.
91) of the same name that allows users to select (or browse for) the DXF file with the description
of the transport domain, and to specify units that are used in this file.

Import Geometry from a DX |3 .-I

[F File
Large zcale domain. dasf Browsze
Unitz of Length uszed in the [F file: m -

Template Position and Tranzformations

kowe Imparted Geometry o that ite bottam-left cormer iz pozsitioned at the Origin [0,0,0]
Update Grid and *Workspace according to the imported Geometry

REMARE:
Y'ou can Move, Raotate ar Stretch imparted objects later by commandz available in the main
menu o in the popup menu in Mawvigator Data Tree.

[ ]9 ]I Cancel I

Figure 91. The Import Geometry from a DXF File dialog window.

Since local coordinates defining the transport domain in the coordinate system used in the DXF
files may include very large numbers, users can ask the HYDRUS GUI to convert these
coordinates so that the bottom-left corner of the transport domain is located in the origin of the
computational coordinate system. This will likely lead to much smaller values of local
coordinates. Finally, users can ask the HYDRUS GUI to automatically adjust the Grid and
Workspace variables to accommodate the imported geometry.

4.11. Import Geometry from a TIN File

It is possible to also Import the definition of objects defining the Geometry of the transport
domain from a file in the TIN format. TIN files are used for storing triangulated irregular
networks using a simple set of xyz coordinates. The TIN file specifications are at:
http://www.ems-i.com/wmshelp/Files/File_Formats/TIN_Files.htm.
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5. Finite Element Mesh
5.1. Finite Element Mesh Generator

The Finite Element Mesh Generator dialog window was used in earlier versions to select a
structured finite element mesh for relatively simple rectangular or hexahedral domain, or a more
general unstructured finite element mesh. The dialog provided a brief description of each mesh
generator and a simple bitmap with an explanation of the main terms involved. In later versions
(after 1.03) a decision which generator to use is made in the Domain Type and Units Window
(Fig. 6 and 7). While the structured finite element generator can be used only for simple
rectangular (i.e., the Geometry Type "2D-Simple (Parametric)” - see the Projects Geometry
Information Section 2) or hexahedral domains (3D-Simple (Parametric)), the unstructured finite
element generator is used for more complicated geometries (i.e., 2D-General (Boundary Rep.),
3D-Layered, and 3D-General (Boundary Rep.)). While the unstructured mesh generator
MeshGen2D is used to generate FE meshes for two-dimensional domains (2D-General
(Boundary Rep.)) and for the Base Surface of three-dimensional layered domains (3D-Layered),
the mesh generator Genex/T3D is used to generate three-dimensional FE meshes for the 3D-
General (Boundary Rep.) geometry.

5.2. Structured Finite Element Mesh Generator

As discussed in Section 2, two-dimensional transport domains can be defined using modified
rectangles. Simple rectangular domains are defined by three straight lines, one at the bottom of the
domain and two at the sides, while the upper boundary may or may not be straight (see examples in
Fig. 8). Nodes along the upper boundary may in that case have variable x- and z-coordinates, but the
lower boundary line must be straight (horizontal or with a specified slope), whereas the left and
right boundary lines must be vertical. The flow region can then be discretized into either a
structured or an unstructured triangular finite element mesh.

When the structured mesh is used one then needs to specify in the Rectangular Domain
Discretization dialog window the number of nodes (Count) on the horizontal (Horizontal
Discretization in X-Direction) and vertical (Vertical Discretization in Z-Direction) sides of the
rectangular region, including their nodal coordinates (Fig. 92). The relative size of finite elements
on the vertical side can be modified using the RS1 (relative size at the top) and RS2 (relative size
at the bottom) factors below General Vertical Coordinates. The element sizes are then
proportionally distributed. Smaller RS factor leads to smaller elements.

The upper boundary is by default parallel with the bottom boundary. Any possible vertical
deviations from this parallel line can be defined using dz values (in the Horizontal Discretization
in X-Direction part of the window). Relatively general domains can still be defined by properly
adjusting the dz values (see Fig. 8).
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Figure 92. The Rectangular Domain Discretization dialog window.

A similar approach can be used to discretize simple hexahedral domains in three dimensions.
Hexahedral domains must have similar properties as rectangular domains in that they are defined by
vertical planes at the sides, a horizontal plane (possibly with a certain slope) at the bottom boundary,
and with only the upper boundary not having to be a plane. The discretization of the hexahedral
domain is then defined in the Hexahedral Domain Discretization dialog window. Again, one
needs to specify the number of nodes (Count) on the horizontal (Horizontal Discretization in X,
Horizontal Discretization in Y) and vertical (Vertical Discretization in Z-Direction) sides of the
hexahedral region and their nodal coordinates (Fig. 93). The relative size of finite elements on the
vertical side can again be modified using RS1 (relative size at the top) and RS2 (relative size at
the bottom) factors (General Vertical Coordinates). The vertical final element sizes are then
proportionally distributed.

Any possible vertical deviations from the plane parallel with the bottom of the domain can be
defined using the dz values (in the Horizontal Discretization in X and Horizontal Discretization
in Y parts of the window). This feature still allows relatively general domains too be created (see
Fig. 9).
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Figure 93. The Hexahedral Domain Discretization dialog window.
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5.3. Unstructured Finite Element Mesh Parameters

Parameters for generating the Unstructured Finite Element Mesh are specified in the FE-Mesh
Parameters dialog window (Figs. 94 through 97). This dialog window has six and four Tabs for
the MeshGen2D and T3D generators, respectively, in which various parameters of the
unstructured finite element mesh can be specified.

The Main Tab

The Targeted FE size (i.e., the average size of the triangular elements in the generated finite
element mesh) is specified on the Main Tab (Figs. 94). The program selects by default a
Targeted FE Size. Users can change this value by deselecting the Automatic check box. The
finite element mesh with this Targeted FE size can be further modified using various tools, such
as Stretching in different directions (on the Stretching Tab, Fig. 95) to make the mesh
anisotropic, specifying the Maximum Number of Nodes on Boundary Curve (on the MG-Options
Tab, Fig. 96) and Minimum Number of Nodes on Boundary Curve (on the Options Tab, Fig. 97),
and using Finite Element Mesh Refinement (Fig. 99). While the Default command sets default
values on a particular tab of the FE-Mesh Parameters, the All Default command sets default
values on all four tabs. For three-dimensional applications (only for 3D-Layered geometries), a
user can specify on the Main Tab the No. of Horizontal Layers, which are layers parallel with
the Base Surface to add the third dimension to the problem and if the finite elements used to
discretize the three-dimensional domain are to be Tetrahedrals or Triangular Prisms for 3D-
Layered geometries, or Tetrahedrals or Mixed Elements (multiple types of elements) for 3D-
General geometries. It is recommended to use Triangular Prisms or Mixed Elements rather than
Tetrahedrals since then the number of finite elements is three or more times smaller and thus the
calculations are faster.

FE-Mesh Paramete "FE-Mesh Parameters 5
Main | Stretching | MG-Options I Options I Sections I Export| I ok I I ain | Stretching I Optiohs I Sections|
Taigeted FE size [ cance | Targeted FE siza
[ sutomatic Help Automatic
TS 10,00 [cm] 0630
Mumber of Mesh Layers Targeted FE-Size Type of 30 elements Targeted FE-Size
ML 21 15;0:-‘9!' _) Tetrahedral TS=0.10m
. @ Mised "
Details
esh Lirnits
Type of 30 elements q@ﬂ
@ Tetrahedral Max. number of nodes
1.00 m I m
) Triangular Prizm A o Nrmax = 200000 a 180 ’ Mext..
Previous... Previous...
Mesh Consistency Check
Appl Appl
&J Detect Collizions PPy
Default Default
[ alDegfaur | R [ alDegfaur |

Figure 94. The FE-Mesh Parameters dialog window (the Main Tab for 3D-Layered (left) and
3D-General (right) geometries).
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For 3D-General geometries, users also need to specify the Maximum Number of Nodes in the
FE mesh. This is the maximum number of finite element nodes in the entire three-dimensional
domain. Similarly as below for MeshGen when this is specified for a two-dimensional domain
(Fig. 96) when this maximum number is reached a warning will appear Achieved the maximum
number of nodes! This means that the maximum allowed number of nodes was reached during
the mesh generation process and the user needs to decide whether or not so many nodes are
needed for the envisioned FE mesh and either increase this number or adjust other parameters so
that less nodes (and FE elements) are generated.

For 3D-General geometries, there is in the Mesh Consistency Check section an additional check
box Detect Collisions. This check box is important only for complex 3D-General geometries
consisting of multiple solids. When this check box is on, the program checks "collisions™ of
different objects. The solids cannot intersect each other without having the intersections properly
defined using boundary curves. The program also detects if one Solid is entirely inside of
another Solid (i.e., its boundaries do not intersect). The former Solid has to be in such case
defined as an Opening (Hole, Cavity). The check box "Detect Collisions"” enables users to turn
off this check in cases, when they are absolutely sure that there are no such collisions and they
still receive warning about a collision of solids.

The Stretching Tab

Stretching of the finite element mesh (i.e., the degree of mesh anisotropy in a certain direction)
is defined using the Stretching Factor and Stretching Direction (Fig. 95). The finite elements
are made larger in the particular Stretching Direction if the Stretching Number is larger than
one, and smaller if smaller that one. The result of this transformation is a mesh deformed in the
given direction, which can be desirable for problems that, for example, require different spatial
steps (mesh sizes) in the X and Y directions. The Stretching Direction is defined by a vector
with two coordinates (Vx and Vz) for vertical two-dimensional domains. For three-dimensional
problems this vector requires three components (Vx, Vy, and Vz). An example of a mesh stretched
using a Stretching Factor of 3 in the x-direction is shown in Figure 105.

FE-Mesh Parameters @

Main | Stetching | Options 1 || Options 2 | Mesh Sections K
Stretching Factor Cancel
Fs: 1 Mesh stretched in Help

Fz=1- Mo Stietching X-dlreclt__lgn:\;l-%'l factor

Stretching Direction

Ox Oy 0z
() General Vectar W

Previous ..
Apply

Default

g ]

All Default

Figure 95. The FE-Mesh Parameters dialog window (Tab Stretching).
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The MG-Options Tab

Parameters for the unstructured triangular finite element generator are given in the MG-Options
(Meshgen) Tab of the FE-Mesh Parameters dialog window (Fig. 96). The parameters are
divided into FE-Mesh Limits (which limits the number of elements) and FE-Mesh Quality
(which affects the smoothness of the FE mesh) groups.

The following parameters are specified in the FE-Mesh Limits group:

Maximum Number of Nodes on Boundary Curves: This is the maximum total number of
nodes on all boundary curves for two-dimensional applications, or on all boundary curves
defining the bottom plane (base surface) for three-dimensional applications.

Maximum Number of FE-Mesh Nodes (2D Mesh): This is the maximum total number of finite
element nodes in two-dimensional domains, or on the bottom plane (base surface) of three-
dimensional domains.

Both parameters are mainly informative and may lead to an interruption of the FE-mesh
generation process. The mesh generation is interrupted by the message: Achieved the maximum
number of nodes! This means that the maximum allowed number of nodes (either on the
boundary curves or in the two-dimensional domain) was reached during the mesh generation
process. This is usually a consequence of having too many nodes along the boundaries (the
number of mesh nodes inside a domain increases approximately with the square of the number of
boundary nodes). It is then necessary to decide whether or not so many nodes are needed for the
envisioned triangular mesh. If the answer is “yes’ then the maximum number of nodes must be
increased in this dialog window. If the answer is ‘no’ then it is necessary to decrease the
Targeted FE Size (Figs. 94) or to increase the Smoothing Factor (in the FE-Mesh Quality
group discussed below).
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tax. number of FE-mesh nodes (20 mesh): 200000
FE-mesh quality
Max. number of overall remeshing iterations: 10
Murmber of intenzive smoothing steps: 1
Humber of intermal iterations for inkenzive smoothing: 20 %
Mumber of internal terations for standard smoothing: 20
Smoathing factar [>17: 13
Prewvious. . L
| Check. distances between neighboring FE-mezh T L
points on domain boundaries and refine the mesh SppY [
autarnatically if the ratio iz greater than F= 2 — ]
Detault
| alDefauk | |

Figur 96. The FE-Mesh Parameters dialog window (Tab MG-Options).
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The following parameters are specified in the FE-Mesh Quality group:

Maximum Number of Overall Remeshing Iterations:

This number defines the maximum number of iterations during finite element mesh remeshing.
In most cases the resulting mesh is obtained within fewer iterations than the default value of 10.
In some cases the repeated adding and removing of nodes can cause an infinite loop. In that case
(or when the mesh generation process converges very slowly) the code terminates after reaching
the maximum number of iterations as defined by this value.

Number of Intensive Smoothing Steps:

Intensive smoothing repeats the operations of Delaunay remeshing and smoothing until there are
no more changes during the Delaunay remeshing step. This parameter specifies the number of
intensive smoothing cycles in the beginning of the mesh generation process, which can
significantly influence the mesh smoothness. However, too many smoothing cycles can
significantly slow down the mesh generation process. The recommended value is between 1 (less
smoothing) and 3 (more smoothing).

Number of Internal Iterations for Intensive Smoothing:

This number defines the maximum number of iterations during one intensive smoothing step.
This number guaranties that intensive smoothing will stop after a specified number of iterations,
even when the prescribed criterion is not reached (i.e., some changes would still occur during
Delaunay remeshing).

Number of Internal Iterations for Standard Smoothing:

This number defines the maximum number of iterations while solving the elliptic equations, a
process needed during mesh smoothing; it significantly influences the final smoothness of the
mesh. A higher number of iterations improves the mesh smoothness. It serves little purpose to
increase the number above 20 since the mesh is then virtually constant anyway, while the whole
process of mesh generation would be slowed down significantly.

Smoothing Factor:

The smoothing factor is the ratio of the maximum and minimum height of a finite element
triangle. For a triangle with equal sizes this factor is equal to 1 (which is theoretically not
achievable for finite element meshes). The smoothing factor can be decreased to a value of about
1.1 when a highly smooth finite element mesh is required and, vice-versa, can be increased when
a course mesh can be tolerated. The smoothing factor significantly affects the final number of
elements.

In general, the default values in the FE-Mesh Parameters dialog window should be preserved;
only experienced users should modify the various parameters needed for the mesh generation
process.
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The Options Tab

Minimum Number of Points Boundary Curves is set by default equal to 15. This number can
be changed in the FE-Mesh Parameters dialog window of the Options Tab (Fig. 97). This
parameter is important when such objects as openings representing wells or drains are included
in the transport domain. These objects may be very small compared to the global finite element
mesh (i.e., smaller than the targeted finite element size). Having a minimum number of nodes on
boundary curves will then lead to local refinement of the finite element mesh around these
objects, thereby ensuring that relatively small objects are accurately represented in the numerical
solution.

FE-Mesh Parameters . |

%)

Default

Main | Stretching | Options 1| Optionz 2 | Mesh Sections
bdinimurn number of pointz on boundary curves
Check number of paints on each baundary “
curve and increase the number if it iz lezs thar; 15
Option Off Option On
i il
() =@

All Default

Figure 97. The FE-Mesh Parameters dialog window (Tab Options).

The Export Tab
In the Export Tab (not shown), users can select options for export of the FE-Mesh to a text file.

One can, for example choose, which points to export (including or excluding the intermediate
points on boundary curves) and whether or not to include in the export also internal curves.
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The Mesh Section Tab

The program can generate default FE-Mesh Sections (the Mesh Section Tab of the FE-Mesh
Parameters dialog window, Fig. 98) or FE-Mesh Sections (for detailed description, see Section
5.7) can be created by a user. Default FE-Mesh Sections depend on the geometry of the transport
domain. For examples, default section include: a) Entire FE Mesh, b) Vertical (horizontal) shell,
and c) Each horizontal (vertical) layer. Mesh Sections can also be generated for each Geo-
Section (see Section 8.1.8). The Mesh Sections are generated automatically when the FE-Mesh
is generated or anytime using the menu command Edit->Sections->Generate Sections (note that
the dialog window to Options for Generation of Geo-Sections and FE-Mesh Sections (Fig.
141) is similar to the Sections Tab of the FE-Mesh Parameters window (Fig. 98)).

I. E-Mesh Paramete | ——

| b ity | Shretching | kG -Options I I:Iptin:nns| Sections | E:-:pn:nrt|

Generate Mesh Sechons FE-Mesh Sections

[7] Boundary Shel
[] Mesh Layers

Mesh Sections for
generated
Geo-Sections

Mesh Sections for
uzer-defined
Geo-Sections

Previoug...
Apply

Default

Al Default

Figure 98. The FE-Mesh Parameters dialog window (Mesh Section Tab).
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5.4. Finite Element Mesh Refinement.

The Finite Element Mesh Refinement is carried out in two steps:

1. One must first define the desired type of FE Mesh Refinement using the dialog window
shown in Figure 99. Mesh refinement can be defined around Points, Lines, Number of
Points on the Line, Surfaces, or Solids.

2. Next, users must assign the refinement to particular Points, Lines or Surfaces, so the program
knows where the refinement should take place. After double clicking on a particular point,
line, arc, circle or spline, the corresponding dialog window will appear (the Edit Point dialog
window, Fig. 44; or the Edit Curve dialog window, Fig. 46), where users should select FE-
Mesh Refinement in the FE-Mesh Tab. The code will then create a list of nodes (or lines or
surfaces) for a particular refinement that can be further edited by a user. FE Mesh
Refinement is graphically displayed using red dots in green circles for nodes, green nodes
for lines, and a small square in the corner of a surface. By clicking on these colored items,
the FE Refinement can be deleted or edited. Editing of the FE mesh refinement will affect
all objects to which a particular refinement was assigned.

5.4.1. Finite Element Mesh Refinement for MeshGen2D

Figure 99 below shows the New FE-Mesh Refinement dialog windows that are used with the
MeshGen module for four different types of refinements. FE-Mesh Refinements can be applied
to a Point, a Line, and a Surface.

When the FE-Mesh Refinement is assigned to a Point (Figure 99 top left), users only need to
define the finite element size that is to be used at a given point. This FE-size will be used around
a given point, while sizes of neighboring FE will be gradually increased until the Targeted FE
Size is reached further away in the computational domain. Notice that the dialog window also
displays the Global Targeted FE Size. The same FE-Mesh Refinement, i.e., the same refined
FE size, can be assigned to multiple Points in the transport domain.

There are two ways how the FE-Mesh Refinement can be assigned to a Line (Figure 99 top
right and bottom left). Users can either specify the FE-Size (Line — FE-Size; Figure 99 top
right) or the Number of Points (Line — Number of Points; Figure 99 bottom left) to be used on
the entire line. Similarly as for points, the FE-Size (either given directly or calculated from the
number of points) will be used on the Line, while sizes of FE away from the Line will gradually
increased until the Targeted FE Size is reached further away in the computational domain.
Again, the same FE-Mesh Line Refinement, i.e., the same refined FE size, can be assigned to
multiple Lines in the computational domain.

The FE-Mesh Refinement can also be assigned to a selected Surface (Figure 99 bottom right).
In this case, users need to define FE-Size for a selected Surface. Note that this option is useful
only when multiple Surfaces are used in the computational domain. The refined FE-Size is then
used on the entire surface, including boundaries with other Surfaces, and the Targeted FE Size
is reached only further away in the other Surfaces of the computational domain.
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The Point or Surface with an assigned FE-Mesh Refinement are indicated using the following

marks: - and . respectively. FE-Mesh Refinement is marked on curves using green points.
visible in the edit mode site. Contrary to other green points on the curves, they can be selected.
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Figure 99. The FE-Mesh Refinement dialog window for the MeshGen2D module with four
different types of refinements (applied to a Point, a Line with a given FE-size or the number of
Points, and to a Surface).

As an example, Figure 100 shows the transport domain (700 * 650 cm) and the finite element

mesh of a problem with a furrow and a drain. The mesh was generated with a Targeted FE Size
of 50 cm and three FE-Mesh Refinements (Fig. 100, top). Refinement 1 (with a finite element
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size of 10 cm) was assigned to nodes 1, 2, 4 and 5, refinement 2 (5 cm) to node 3, and refinement
3 (15 cm) to nodes 8 and 9. There were 15 nodes on the drain boundary (due to the command
Minimum Number of Points on Each Closed Boundary Curve). The resulting finite element
mesh is shown in Figure 100 (bottom).

Figure 100. Example of FE-Mesh Refinements (top) and FE-Mesh (bottom).
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5.4.2. Finite Element Mesh Refinement for Genex/T3D

While the MeshGen2D module discretizes the computational domain into unstructured FE-mesh
using triangles (in 2D) and tetrahedrals (in 3D), the Genex/T3D module uses primarily
quadrilateral (in 2D) and hexahedral (in 3D) finite elements. Genex/T3D uses triangles only in
parts of the domain where needed, e.g., when it refines the grid. Although quadrilateral or
hegahedral elements may be generated by Genex/T3D, the computational module subdivides
these elements into triangles or tetrahedrals, respectively While the transition between domains
with refined FE-mesh and domains with global mesh size in MeshGen2D is relatively smooth
and gradual (see Figure 100), in Genex/T3D the extent of this transition zone is defined exactly
by users (see Figures below). Similarly as MeshGen2D, the same FE-Mesh Line Refinements
can be assigned to multiple Points, Lines, Surfaces, and Solids in the computational domain.

There are two ways how the FE-Mesh Refinement can be assigned to a Point (Figure 101).
Users can use either Circular or Rectangular refinement. For a Circular Refinement around a
point, a radial refinement area is defined around a node in all directions. Users need to specify
the Radius of the refinement area, the Inner Targeted FE-Size (i.e., a FE-size immediately
around a point), and the Outer Targeted FE-Size (i.e., a FE-size at the outer end of the radial
refinement area) (Fig. 104). The Outer Targeted FE-Size should be equal or slightly smaller
than the Global Targeted FE-Size. When generating the FE mesh, the mesh refinement is
carried out gradually towards the center because the FE length at the periphery of the refinement
area is usually identical with the global mesh width. For larger differences between the inner and
outer FE length, it is recommended to set the radius not too small in order to avoid acute-angled
triangular finite elements in the refinement area. For a Rectangular Refinement, a rectangular
refinement area is defined around a node in all directions. Users need to specify the Side Length
of the refinement area and the Inner Targeted FE-Size (i.e., a FE-size immediately around a
point) (Fig. 104).

Figure 101. Circular (left) and rectangular (right) refinements around a node.
FE-Mesh Refinements assigned to a Line are handled in Genex/T3D similarly as in

MeshGen2D. One can again define either the size (spacing; Line through FE-Length) or the
number (a specific number of equidistant sub-divisions; Line through Division) of finite
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elements along a line. In the former case one needs to define the Target FE Length, in the latter
case the Number of Division FE Nodes. However, while in MeshGen2D there was a gradual
increase in sizes of finite elements away from the Line, in Genex/T3D the refinement affects
only one row of finite elements (Figure 102).

VNN
ARAVATATATAE

Figure 102. Refinement on a line (by defining either the size or the number of finite elements
along a line).

It is also possible to define Fe-Mesh Refinements for Surfaces or Solids (Figure 103). In both
cases, users need to specify the Targeted FE-Size, which will be set as target size of the finite
elements for the entire surface or solid.

|

Figure 103. Refinements on a surface (left) or solid (right).
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Figure 104. The FE-Mesh Refinement dialog window for the Genex/T3D module with six
different types of refinements (applied to a Circular or a Rectangular Point, a Line with a
given FE-size or a number of points, to a Surface, and to a Solid).
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5.5. Unstructured Finite Element Mesh Generator MeshGen2D

The MeshGen2D module may be used to discretize a two-dimensional flow region (or a base plane
of the three-dimensional domain) into an unstructured triangular mesh. The algorithm used for this
purpose is general and can be applied to virtually any two-dimensional computational domain. The
first step of the mesh generation process discretizes the boundary curves, while the second step
generates the unstructured triangular mesh.

Generation of Boundary Points

The first step of the mesh generation process involves discretization of the boundary curves. During
this step boundary nodes are generated on all boundaries and internal curves by dividing them in
abscissas (i.e., short boundary edges). If no previous boundary nodes existed, the program
automatically generates a default equidistant point distribution. Boundary nodes can be edited by
users to optimize the lengths of the boundary edges using the FE-Mesh Parameters dialog
window (Figs. 94 through 97). The local density of the mesh can thereby be determined in any part
of the domain (also taking into account the use of internal curves). There are two ways to obtain
appropriate distributions of the boundary nodes, i.e., by (1) specifying the Targeted FE size (Figs.
94, the Main Tab), and (2) refining the FE-Mesh (the FE Mesh refinement dialog window, Fig.
99).

1) A global Targeted FE Size (Fig. 94) is the main variable of the FE-Mesh process.
Although a default Targeted FE-Size is specified by the program, this value should be
adjusted by users in most applications. The default value is used to generate at least a
reasonable initial mesh, even for inexperienced users.

2) The finite element mesh can be adjusted locally in the domain by using FE-Mesh
Stretching (Fig. 95 and 105) or FE-Mesh Refinement (Figs. 44, 35, and 99). FE-Mesh
Refinement can be implemented for various geometric objects, including Points, Lines or
Surfaces (Fig. 99). When several FE-Mesh Refinements overlap in one location (such as
when the FE-Mesh Refinement is defined for both a point and a line), then the FE-Mesh
Refinement specified for the lower level objects (i.e., a point rather than a line) is used.

The boundary nodal distribution determines in a very substantial manner the ultimate quality and
size of the unstructured finite element mesh. Optimally distributing nodes along the boundaries of
relatively complicated domains (e.g., a very irregular anisotropic domain) can be a very difficult
problem, and may require some experience.

Table 18. Definition of terms related to the boundary discretization.

Boundary Nodes Boundary nodes are points, marked by green squares, which discretize
boundary curves. These nodes are generated along every boundary curve
and are ordered in a counter-clockwise direction (on closed curves).
Boundary nodes determine the local densities of the triangular mesh that is
being generated for a given boundary nodal distribution, and are part of the
triangular mesh.
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Boundary Edges Boundary edges are abscissas discretizing boundary curves. They connect
generated boundary nodes, are oriented in a counter-clockwise direction,
and are located on the edge of the mesh.

Fixed Points Fixed points are points on boundary curves marked by red squares. These
points may be used to adjust the local density of boundary nodes (using FE
Mesh refinement). By default, fixed points are placed on all nodes of
polylines and on all object boundary points describing the boundary, but
they can be also inserted or deleted at any other point on boundary curves.

Generation of the Unstructured Triangular Mesh

The unstructured triangular mesh is generated by means of five operations:
(1) discretization of the flow domain into triangles with vertices at given boundary nodes
(Fundamental Triangulation),
(2) inserting new points in all triangles which do not fulfill a certain smoothness criterion
(Mesh Refinement),
(3) implementation of Delaunay's retriangulation for the purpose of eliminating all nodes
surrounded by more than six triangles, as well as to avoid extreme angles (Remeshing),
(4) smoothing of the mesh by solving a set of coupled elliptic equations in a recursive manner
(Smoothing), and
(5) correction of possible errors which may appear during smoothing of the finite element
mesh (Convexity Check).
Operations 2 through 5 are repeated until a prescribed smoothness of the mesh has been achieved.

An unstructured triangular mesh for a given boundary nodal distribution can be generated in two
different ways: a step-by-step approach (Calculation->Advanced FE-Mesh Generation-
>Fundamental Triangulation and subsequent commands, or by clicking on the Fundamental
Triangulation command of the FE-Mesh Advanced part of the FE-Mesh version of the Tool
Sidebar), or by using automatic mesh generation (Calculation->Generate FE-Mesh or the
Generate FE-Mesh command on the Edit FE-Mesh part of the FE-Mesh version of the Tool
Sidebar). The step-by-step approach should be used only for special cases, and then only by
experienced users. Automatic generation (recommended) is a much faster and easier approach. The
mesh generation parameters must be specified before the mesh generation process is started. By
modifying the mesh generation parameters, users can influence the smoothness of the mesh
(Smoothing Factor, Fig. 96), its anisotropy (Figs. 95 and 105), computational time, and the
possible display of intermediate results, among other features. The most important mesh generation
parameter is the "smoothing factor", which can significantly affect the final number of elements.
The smoothing factor is defined as the ratio of the minimum and maximum dimensions of a triangle.
When a very smooth finite element mesh is required, the smoothing factor should be decreased to
about 1.1; when a coarser mesh is possible, the smoothing factor can be increased.

The code saves mesh data, by default, in a binary format (the file MESHTRIA.000). However, users

have the option to also save mesh data into a file (MESHTRIA.TXT) in ASCII format (the Program
Option dialog window, Fig. 152), and then use possibly the data later for other calculations.
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When users do not have authorization to use the MeshGen2D module, they can employ the internal

mesh generator for relatively simple rectangular or hexahedral transport domains.
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Figure 105. Example of mesh stretching using a stretching factor of 3 in the x-direction.
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5.6. Finite Element Mesh Statistics

FE-Mesh Information
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Figure 106. The FE-Mesh Information dialog window for a two-dimensional problem (top) and a
three-dimensional problem (bottom).

Figure 106 shows dialog windows that provide information about the finite element mesh for
two- and three-dimensional applications. For two-dimensional grids the window shows the
number of finite element Nodes, the number of boundary 1D-Elements (boundary edges between
boundary nodes), and the number of 2D-Elements (triangles). For three-dimensional grids the
window shows again the number of finite element Nodes (in the entire 3D domain), the number
of boundary 1D-Elements (boundary edges between boundary nodes on the bottom plane, i.e.,
the 2D base surface of the transport domain), the number of 2D-Elements (the number of
triangles on the bottom plane of the domain), and the number of 3D-Elements (tetrahedrals) in
the entire transport domain.
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5.7. Finite Element Mesh Sections

FE-Mesh Sections are parts of the FE-Mesh used to specify input variables and to display results of
calculations. By default, two-dimensional problems have only one section consisting of the entire
transport domain. For three-dimensional problems one section by default is formed by the Whole
FE-Mesh (Section DO_000 in Fig. 107), whereas each horizontal (vertical for some applications)
layer forms one additional section (Sections ML_001 through ML_010 — Mesh Layer in Fig. 107),
while the last section is made up by the vertical surface (Section ML_000 Shell Fig. 107). For
example, the bottom Mesh Layer can be displayed when the bottom boundary conditions are
specified, while the top Mesh Layer (Section) can be displayed when the surface boundary
conditions are provided. One can similarly display results at different depths using different
horizontal sections (Mesh Layers). The Mesh Sections are generated automatically when the FE-
Mesh is generated or anytime using the menu command Edit->Sections->Generate FE-Mesh
Sections. Automatically generated FE-Mesh Sections in different HYDRUS versions are listed in
Table 19. Mesh Sections can also be generated for each Geo-Section (see Section 8.1.8).

Additional sections can be created using commands from the FE-Mesh Sections part of the FE-
Mesh version of the Edit Bar. One can display any existing section (or set of sections) and modify
them using the Cut with Rectangle command, and then create a new section using the New Section
from View command. This new section will then appear in the list of sections in the Section Tab of
the Navigator Bar and can be recalled at any time. Existing sections can be manipulated (Display,
Hide, Select, Unselect, Rename, Delete, Move Up, and Move Down) using the Edit Section
command from the Edit Bar, or using Edit->Sections->Edit Sections.

Table 19. Finite element mesh sections generated in different HYDRUS versions.

HYDRUS Version Generated FE-Mesh Sections

2D-Lite Nothing

2D-Standard For each Surface (of more than one) and each Geo-Section
(see Section 8.1.8) defined by user.

3D-Lite For each layer of the FE-Mesh

3D-Standard For each FE layer, each geometric layer, and for each
Column

3D-Professional For each Geo-Section as defined in Section 8.1.8.
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FE-Mesh Sections
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Figure 107. The FE-Mesh Sections dialog window.
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6. Domain Properties, Initial and Boundary Conditions

Initial and boundary conditions for both water flow and solute (heat) transport, and the spatial
distribution of other parameters characterizing the flow domain (e.g., the spatial distribution of soil
materials, hydraulic scaling factors, root-water uptake parameters, and possible hydraulic
anisotropy) and/or observation nodes are specified in a graphical environment with the help of a
mouse. The program automatically controls the logical correspondence between the water flow and
solute transport boundary conditions.

Various spatially variable properties (e.g., material distribution, initial and boundary conditions)
can be specified in Version 2.0 of HYDRUS (Standard and Professional, not Lite) either

a) directly on the finite element mesh (as done in Version 1.0), or

b) on geometric objects (e.g., boundary curves, rectangles, circles, surfaces, volumes).
The main advantage of the latter approach is that when the FEM is changed, these properties are
not automatically lost, but can be recalculated to the new FEM from their definition on
Geometric Objects. Which option is used depends on the menu command Edit->Properties and

Conditions on FE-Mesh. A similar button switch is also available at the end of the tool bar ( @),
next to the Results button, and at the Edit Bar. The latter approach (i.e., on Geometric Objects) is
described in detail below in Section 6.5.

6.1. Default Domain Properties

For rectangular two-dimensional domains and for layered three-dimensional domains,
immediately after the finite element mesh is generated, one can specify the initial Default
Domain Properties in the dialog window shown in Figure 108. Values listed in this window are
initially assigned to each horizontal layer of the transport domain, but can later be modified
graphically. The following variables are involved:

Code Code of the boundary condition (0 for no flow, -1 for constant flux, +1 for constant
head, -2 for unsaturated seepage face, +2 for saturated seepage face, -3 (-7, -8, -9) for
variable flux, +3 (+7, +8, +9) for variable head, -4 for atmospheric, - 5 for tile drain, -
6 for free drainage)

h Initial value of the pressure head [L]. The initial pressure head changes linearly
between the first and last layer if one clicks on the command at the bottom of the
dialog (Linear interpolation of the pressure heads between the first and last layer).

Q Recharge flux, [L?T™] and [L3T™] for 2D and 3D applications, respectively

Mater Material number

Roots Root distribution

Axz Scaling factor for the pressure head

Bxz Scaling factor for the hydraulic conductivity

Dxz Scaling factor for the water content

Temp Initial temperature [K]

Conc Initial concentration (of the equilibrium phase) [ML™]

Sorb Initial concentration of the nonequilibrium phase (kinetically sorbed [MM™] or of the

immobile region [ML?])
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Values from each line are assigned to the entire layer within the FE-Mesh with the exception of
Code (the boundary condition code), which is assigned only to boundary nodes. When multiple
values are encountered within the single layer when initiating the table, the cell is left empty
instead of displaying any particular value. Unless changed, this variable will not be assigned in a
particular layer (after closing the dialog with OK) and original values will remain unchanged.
The three commands (Copy Sel., Copy All, and Paste, MS Excel Import/Export) facilitate the
transfer of data from this HYDRUS dialog window to the Excel (or other) spreadsheet. The
command “Set Boundary Conditions for Solute Transport and Heat Transport for changed
Codes:” leads to assigning Cauchy boundary conditions for solute and heat transport to nodes
where the Code was changed.

Default Domain Properties E|
Froperties af Harizontal Layers
Layer | 2[cm] | Code h ] Mater | Roots Buz Buz Duz Temp cl ~
1 1 20000 -1 -300 1 1] 1 1 1 20 1]
2 219000 1] -240 1] 1 1] 1 1 1 20 1]
3 3 1an.on 1] -2a0 1] 1 1] 1 1 1 20 1]
4 4 17000 0 270 0 1 1] 1 1 1 20 0 ME Encel
] 5 1R0.00 1] -2R0 i 1 1] 1 1 1 20 i Impart/Export
G B 15000 1] -250 1] 1 1] 1 1 1 20 1]
7 714000 1] -240 1] 1 1] 1 1 1 20 1]
g 2 13000 1] -230 1] 1 1] 1 1 1 20 1] Copy Al
9 9 12000 0 220 0 1 1] 1 1 1 20 0
10 10 110,00 1] 210 1] 1 1] 1 1 1 20 1]
11 11 100.00 1] -200 1] 1 1] 1 1 1 20 1] Editin
12 12 4000 1] 140 1] 1 1] 1 1 1 20 1] Resizeable
13 13 80.00 o 180 0 1 0 1 1 1 20 0 indow
14 14 7000 0 170 0 1 0 1 1 1 20 0
15 15 E0.00 1] -1&0 1] 1 1] 1 1 1 20 1]
16 16 &0.00 1] -150 1] 1 1] 1 1 1 20 1]
17 17 4000 1] 140 1] 1 1] 1 1 1 20 0 % Q@q
4 ¥
| Bt e s o S e L. ]
a:d Hueuar: ﬁgmggnlfl.grnzhg:-.geu;ggd;nspm [ Linear Interpolation of Pressure Heads between the firzt and last laper l Provious ..

Figure 108. The Default Domain Properties dialog window.

6.2. Initial Conditions

After selecting nodes (graphically with the mouse) for which the initial condition is to be
specified, and clicking on the command Set Values at the Edit Bar (on the right side of the view
window), the Water Flow Initial Condition dialog window (Fig. 109) appears. Using this
command one can specify the initial conditions for water flow by defining the initial spatial
distribution of the pressure head or water content over the flow domain. The decision whether to
use the pressure head or the water content initial distribution is made in the main module of the
Iteration Criteria dialog window (Fig. 17). One can specify a) the same value to all selected
nodes (Same value for all nodes), b) a distribution versus depth that is in equilibrium with the
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pressure head of the lowest point in the selected region (Equilibrium from the lowest located
nodal point), and c¢) a Linear distribution with depth. When options a) or b) are selected, only
one value of the pressure head needs to be specified. For option ¢) one needs to provide values of
the pressure head (or water content) for the top and bottom of the selected domain.

Water Flow Initial Condition X

Diigtribution Walues in selected nodes
(®) Same value for &l nodes Selected Modes: 400

Mirirmurn value: -100
(O Linear distribution with depth b amirniarn alue: 00
Frezzure Head Other Options
Top Water Content W alue: 0143

[ s ] [ Cancel ]

Figure 109. The Water Flow Initial Condition dialog window.

To simplify definition of the initial condition for problems that involve slopes, an option is
provided to have pressure heads decrease in the x- and y- (the latter only for three dimensional
problems) directions (Slope in X- direction and Slope in Y- direction).

The right top part of the dialog window (Values in selected nodes) in Figure 109 provides
information about the selected nodes, i.e., the number of selected nodes and the minimum and
maximum values of the pressure head or water content.

If a certain node is selected that is not located on the boundary, this node can be declared an
Internal Pressure Head Sink/Source. The pressure head at that node will then be kept constant
during the simulation.

Similar, but simpler, dialog windows are used to specify initial values of the temperature and the
liquid and adsorbed concentrations (e.g., Temperature Distribution dialog window, Fig. 110).
The dialog window will then again provide information about the selected nodes (Values in
selected nodes), i.e., the number of selected nodes and their minimum and maximum
temperatures (concentrations). One can specify either constant value for all selected nodes, or
have the values change linearly with depth. When the box Use top value for the entire selected
region is checked, the value in the Top box is assigned to all selected nodes.
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Temperature distribution E|

Waluesz in zelected nodes

Mumber of Selected Nodes: 2
Minimum value: 20

b airnuim walue:; 20

Mew values [linear/constant distribution]

Top: 20

I1ze top walue for the entire selected region

[ oK |[ Cancel ]

Figure 110. The Temperature distribution dialog window.

The initial condition can be imported from the results of previous calculations using the Import
command (Edit->Initial Condition->Import, or Insert->Initial Condition->Import). After clicking
on any of these two commands, an Open dialog window appears with Files of type preselected
for HYDRUS applications (i.e.,*.h3d2). One then needs to browse for the HYDRUS project
from which the initial condition is to be imported. After selecting a particular project, the Import
Initial Conditions dialog window appears (Fig. 111). This window provides information from
which project the initial conditions will be imported (Import data from Hydrus project) and
offers quantities that can be imported as initial conditions (Select quantities to import). Users
must then also decide in the Select Time Layer part of the dialog if values for The Last (Final)
Time Layer or for any intermediate time layer (using Time Layer No.: from the lower list box)
are to be imported. Time Layers correspond with Print Times (Fig. 16) for which the output in
the existing project was calculated.

Warning: Import of results of previous calculations as initial conditions for the new simulation

can be done only from a project that has an identical FE-Mesh discretization as the actual
project!
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Import Initial Conditions

Import data from Hydrus-30 project

CALSELHYDRLUSIOND_Tests\Furrow.h3d

select quantities to impart

Temperature

Concentration 1
Concentration 2
Concentration 3

oelect Time Layer

() The Last (Final) Time Layer
(®) Time Layer No.: ime 24 -100.00 days w

Ok | | Cancel

Figure 111. The Import Initial Condition dialog window.

6.3. Boundary Conditions

Specification of the boundary conditions is relatively straightforward. Users must first select from
the Navigator Bar particular Boundary Conditions (i.e., water flow, solute transport, or heat
transport) and then click on the Edit Bar on the particular boundary condition (e.g., constant head).
They subsequently need to move the mouse to the selected position and click the left mouse button.
Implementation of the boundary condition terminates with a repeated click of the left mouse button.
The boundary nodes will acquire the same color as the corresponding type of the boundary
condition. See the rules for specifying boundary conditions as described in Chapter 8 of the
Technical Manual [Simzinek et al., 2010]. Alternatively, users can first select boundary nodes and
then assign desired boundary conditions by clicking at a particular boundary condition at the
Edit Bar. Note that the Free Drainage and Deep Drainage boundary conditions cannot be
specified simultaneously in one project. Similarly, when the Gradient Boundary Conditions is
specified (see description below), the Time-Variable Flux 4 Boundary Condition is disabled.
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In addition to system-dependent boundary conditions available in version 2.x of HYDRUS-2D,
several new options are available in HYDRUS. These new options are specified in the
Boundary Condition Options dialog window (Fig. 112) that is called using the menu command
Edit->Boundary Conditions->Boundary Conditions Options or from the Edit Bar for Water
Flow Boundary Conditions version using the BDRC Options command. This dialog window
has three tabs: a) Time-Variable Head/Flux 1 BCs, b) Special Boundary Conditions, and c)
Triggered Irrigation.

6.3.1. Time-Variable Head/Flux 1 BCs

The options that are available on the first tab (Time-Variable Head/Flux 1 BCs, Fig. 112) apply
to the first Time-Variable Head/Flux boundary condition. The following new options are
available here:

a)

b)

d)

While in version 2.0 of HYDRUS-2D, all boundary conditions (i.e., fluxes or pressure
heads) changed in abrupt steps, the new version allows boundary pressure heads to
change smoothly with time. Abrupt changes in the pressure heads lead to sudden changes
in fluxes, while smoothly changing pressure heads provide smoothly changing fluxes. An
example of such a boundary condition is the water level in a stream or furrow.

While version 2.0 of HYDRUS-2D only allowed either time-variable pressure heads or
time-variable fluxes on a particular part of the boundary, the new version allows
boundary conditions to change from variable pressure heads to a zero flux and vice-versa.
This boundary condition can be used for example for a disc permeameter where the
specified head changes to a zero flux during time periods when the permeameter is re-
supplied with water. The zero flux is initiated by specifying a value larger than 999999.

When a time-variable pressure head boundary condition is specified along a boundary,
then the specified value is assigned to the lowest nodal point of a particular boundary,
while pressure heads at other nodes are adjusted based on the z-coordinate. When this
option is selected, then nodes with calculated negative pressure heads are not associated
with a Dirichlet boundary condition, but rather with a zero flux. A fluctuating water level
in a stream or furrow is an example of this type of boundary condition. While positive
pressure head values are below the water table, negative values occur above the water
table.

This is similar to ¢) except that an atmospheric boundary condition is assigned to nodes
with negative calculated pressure heads.

This is similar to ¢) except that a seepage face boundary condition is assigned to nodes
with negative calculated pressure heads.

When this type of system-dependent boundary condition is selected, then HYDRUS
treats the time-variable flux boundary conditions similarly as atmospheric fluxes. This
means that pressure heads have two limiting values, with the maximum pressure head
equal to hCritS and the minimum pressure head equal to hCritA.
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g) While in version 2.x of the code, the flux across the nonactive part of the seepage face
was always equal to zero, the new version can apply atmospheric boundary conditions on
a nonactive seepage face.

h) When heat transport is simulated simultaneously with water flow and atmospheric
boundary conditions, then snow accumulation on top of the soil surface can be simulated.
The code then assumes that when the air temperature is below -2 C all precipitation is in
the form of snow. When the air temperature is above +2 C all precipitation is in the form
of liquid, while a linear transition is used between the two limiting temperatures (-2,2).
The code further assumes that when the air temperature is above zero, the existing snow
layer (if it exists) melts proportionally to the air temperature.

Boundary condition options a) through g) can be used only with the first time-variable head
condition.

Boundary Conditions Options g]

Time-Yariable Head/Flux 1 BCz | Special Boundary Conditions | Triggered |migation

[ linterpolate vanable preszure head and Flox (11 Boundam conditions in time

[] Switch the boundary condition from variable prezzure head to zero fux when
Ghw/L>395939

[ ] Switch the boundary condition from time-variable pressure head to zero fux when the
specified nodal pressure head is negative

[ ] Switch the boundary condition from time-variable head to atmozpheric when the
specified nodal pressure head is negative

[] Switch the boundary condition from time-variable head to seepage face when the
gpecified nodal preszure head iz negative

[] Treat the time-variable fux boundary condition as atmaospheric, i.e.. with linited
prezzure heads

] &pply atmospheric boundary conditions to nonactive seepage face
Other Boundary Conditions Options

[ ] Consider snow accumulation at the soil suiface when temperatures are negative

[ ] Cansider Only Horizontal Projections of Boundary Elements for Time-Y ariable Flus BCs

[ k. H Cancel ][ Help ]

Figure 112. The Time-Variable Head/Flux 1 BCs tab of the Boundary Condition Options dialog
window.

6.3.2. Special Boundary Conditions

The following Special Boundary Conditions (Fig. 113) can be selected from the second tab of
the Boundary Condition Options dialog window:
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Gradient Boundary Conditions

Subsurface Drip Characteristic Function

Surface Drip Irrigation with a Dynamic Evaluation of the Wetted Area
Seepage Face with a Specified Pressure Head

APwnhE

Gradient Type Boundary Condition

Version 1 of HYDRUS implements the Gradient Type Boundary Condition only as the Free
Drainage boundary condition, or the unit gradient boundary condition. However, in many
situations one needs a non-unit gradient BC. For example, it is difficult to select appropriate
boundary conditions for vertical boundaries for flow in a hill slope where the side-gradient is
more or less parallel with the direction of the slope. In version 2 of HYDRUS, users can specify
a gradient other than one (unit gradient). This option, i.e., non-unit gradient boundary condition,
needs to be selected from the Special Boundary Conditions tab of the Boundary Conditions
Options dialog window. Gradients are positive for flow against a particular axis, i.e., from right
to left (in the x-direction) and from back to front (in the y-direction), and should be used only (or
mainly) on sides of the transport domain. In 3D, the gradient BC can be specified only in one
direction (i.e., either in x- or y-direction).

Subsurface Drip Characteristic Function

Infiltration rate of water from a subsurface cavity (dripper) is affected by many factors, including
the pressure in the cavity, its size and geometry, and the hydraulic properties of the surrounding
soil [Lazarovitch et al., 2005]. When a predetermined discharge of a subsurface source (e.g., a
subsurface emitter) is larger than the soil infiltration capacity, the pressure head in the source
outlet increases and becomes positive. The built up pressure may significantly reduce the source
discharge rate. A special system-dependent boundary condition for flow from subsurface sources
that uses the drip characteristic function was implemented in HYDRUS (see the Technical
manual). This function has two variables, i.e., the nominal discharge (Optimal Flux in Fig. 113)
of the source for the reference inlet pressure hi, (usually being 10 m) and the back pressure equal
to zero, and an empirical constant (Exponent in Fig. 113) that reflects the flow characteristics of
the emitter. Normally, ¢ = 0.5 corresponds to a turbulent flow emitter and ¢ = 1 to a laminar one.

Implementation: User needs to specify the “Time-Variable Flux 1” boundary condition along
the dripper boundary and h;, in the “Var.H-1” column of the “Time Variable Boundary
Conditions” dialog window. A positive pressure indicates an irrigation period and a negative
pressure indicates a non-irrigation period.

Surface Drip Irrigation — Dynamic Evaluation of the Wetted Area

The radius of the wetted area for drip irrigation for transient conditions can be calculated in
Hydrus as follows. The irrigation flux Q is applied to the single boundary node that represents
the dripper with the Neumann (flux) boundary condition. If the pressure head required to
accommodate the specified flux Q is larger than zero, the boundary condition in this particular
node is changed into the Dirichlet (head) boundary condition with zero pressure head value and
the actual infiltration flux Q, through this node is calculated. The excess flux (Q - Qa) is then
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applied to the neighboring node, again with the specified Neumann boundary condition. This
procedure is iteratively repeated until the entire irrigation flux Q is accounted for and the radius
of the wetted area is obtained. Since the infiltration flux into the dry soil is larger for early times,
the wetted area continuously increases as irrigation proceeds.

Implementation: User needs to specify the “Time-Variable Flux 1” boundary condition at the
surface boundary. The length of this boundary needs to be sufficient to accommodate the entire
wetting zone. The drip discharge flux, Q, needs to be entered in the “Var.FI-1” column of the
“Time Variable Boundary Conditions” dialog window. User also needs to specify from which
node of the Time-Variable Flux 1 boundary irrigation starts. Irrigation can start in the left node
of the boundary and then the wetting zone will be spreading to the right (From left to right), it
can also starts in the right node of the boundary and then the wetting zone will be spreading to
the left (From right to left), or it can start in the arbitrary middle node of the boundary (Center
Node) and spread in both direction (From the center).

Seepage Face with a Specified Pressure Head

This type of boundary condition is often applied to laboratory soil columns when the bottom of
the soil column is exposed to the atmosphere (gravity drainage of a finite soil column). The
condition assumes that the boundary flux will remain zero as long as the pressure head is
negative. However, when the lower end of the soil profile becomes saturated, a zero pressure
head is imposed at the lower boundary and the outflow calculated accordingly. This type of
boundary condition is often used for lysimeters.

User can specify a pressure head value other than zero (Pressure Head) for triggering flux

across the seepage face (in several experimental settings, a negative pressure can be applied at
the bottom of laboratory columns or lysimeters).
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Boundary Conditions Options

Time-arisble Head/Flux 1 BCs | Special Boundary Conditions | Triggered |migation

Gradient Boundary Conditions [instead of Free Drainage BC)

Gradient in the =-direction [pozsitive against the =-axiz)] Gradient: |1

Subzurface Dnip Charactenztic Function [far Tirme- ariable Flux 1 BC]

[+] Dripper Characteristic Function Opt. Elus: 0 Exponent; |0.5

Surface Drip Boundary Condition [for Time-ariable Flus 1 BC)

Seespage Face with Specified Prezzure Head Pressure Head [cm]: |-100

[ k. l[ Cancel ][ Help ]

Figure 113. The Special Boundary Conditions tab of the Boundary Condition Options dialog
window.

6.3.3. Triggered Irrigation

Triggered Irrigation can be specified on the third tab of the Boundary Condition Options
dialog window (Fig. 114). Irrigation can be triggered by a user-specified “Pressure Head
Triggering Irrigation” (input) reached in the selected “Observation Node Triggering
Irrigation”. The irrigation starts after a user-specified Lag Time (input) at a user-specified
Irrigation Rate or Pressure Head (input). The Duration of Irrigation has to be also specified.
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Boundary Conditions Options

Time-Yarisble Head/Flux 1 BCs || Special Boundary Ennditinnsl Triggered lrrigation
Triggered Irigation [by Specified Preszure Head in a Obzervation Mode)

Triggered lrigation

Obzervation Mode Triggering rrigation:
Preszure Head Triggering Irigation [om]; 000

Boundary where imgation will be appled:
[rrigation B ate [cmdday):

)8 anable Fiux Boundan
)W ariable Head Boundary Irigation Duration [days) (0.5

() Atrmosphernic Boundary Lag Time [days]: 0.1

[ k. l[ Cancel ][ Help ]

Figure 114. The Triggered Irrigation tab of the Boundary Condition Options dialog window.

183



6.4. Domain Properties

Other parameters characterizing the flow domain (initial condition, material distribution) are defined
in a similar way. Users must first select that part of the transport domain to which he/she wants to
assign a particular value of the selected variable. It is possible to select the entire transport domain,
part of it, or only individual nodes or elements. A particular part of the transport domain can be
selected as follows: first move the mouse to a selected position. The beginning and end of the
selection operation is framed by clicking the left mouse button. The selected area is the rectangle
defined by the two mouse positions when the left mouse button was clicked. Selection can
alternatively (instead of using the rectangular selection) be made using a rhomboid (with the
Edit->Select->Select by Rhomboid command), circle (Edit->Select->Select by Circle) or polygon
(Edit->Select->Select by Polygon). When the selection is completed, users must click the Set
values button and specify the value of a particular variable. The given value will then be assigned to
the selected area. When material numbers are to be specified, users can do this directly by clicking
on the color representing a particular material (at the Edit Bar). All variables are assigned to nodal
points, except for those defining anisotropy angles, the first and second components of anisotropy,
and subregion numbers, which are all assigned to elements.

Scaling Factors can be generated for two-dimensional applications using a random generator by
clicking on the command Edit->Domain Properties->Stochastic Distribution of S.F. that calls the
Stochastic Distribution of Scaling Factors dialog window (Fig. 115). Each scaling factor can be
generated either independently of the other scaling factors, or by assuming Miller-Miller
similitude. In that case the program generates hydraulic conductivity scaling factors and
automatically calculates from their values the pressure head scaling factors.

Stochastic Distribution of Scaling Factors

stochastic Distribution of Scaling Factars

4

[V] Hydraulic Canductivity Scaling Factar Cancel

[V] Pressure Head Scaling Factar Help

[ ]wWater Content Scaling Factor

Cther Options

I bl

Becalculate

[Vdiller-tiller Similitude:

| Parameters

Figure 115. The Stochastic Distribution of Scaling Factors dialog window.

Parameters for random generation of the scaling factors are specified in the Stochastic
Parameters dialog window (Fig. 116). In this dialog users need to specify whether the scaling
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factors are normally or log-normally distributed using the check box Log-Normal Distribution),
and provide values for the standard deviation of a particular scaling factor, and correlation
lengths in the x- and z-directions (if the scaling factors are spatially correlated).

Stochastic Parameters R|

Hydraulic Conductivity Scaling Factor | 0K |
Standard Dew. of log1 06y .25

Carrelation Length inx 1]

Correlation Length in z a

Log-Mormal Distribution

Fressure Head Scaling Factor

standard Dew. of log1 03

Correlation Length in x

Correlation Length in 2

Water Content Scaling Factor

standard Dew. of log1 00

Correlation Length in x

Corrglation Length in 2

Figure 116. The Stochastic Parameters dialog window.
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6.5. Defining Properties on Geometric Objects

As described above, various spatially variable properties (e.g., material distribution, initial
conditions, etc) can be specified in Version 2.0 of HYDRUS (Standard and Professional, not
Lite) either:

a) directly on the Finite Element Mesh (FEM) (as done in Version 1.0), or
b) on Geometric Objects (e.g., boundary curves, rectangles, circles, surfaces, solids) or
Geo Sections (only in Version 2.0 and the Professional Version).

To be able to define properties on Geometric Objects, one needs to first enable this option (Edit
domain properties, initial and boundary conditions on Geometric Objects) in the Domain Type
and Units dialog window (see Figs. 6 or 7).

Which option is used depends on the menu command Edit->Properties and Conditions on FE-
Mesh (disabled when the FE-Mesh does not exist). A similar button switch is also available at

the end of the tool bar ( @), next to the Results button, and at the Edit Bar.
However, to be able to use this option (to specify properties on Geo Sections), the Transport
Domain must be defined using (or divided into) a set of Geometric Objects, on which various

properties can then be specified. An example of the transport domain divided onto three
components (or Surfaces) S2, S2, or S3 is shown in Figure 117.

e

52

51

¥

|___ L =2000 ___‘

Figure 117. An example of the transport domain defined using three components S1, S2, and S3.

While for two-dimensional problems the Geo Sections (displayed at the Navigator Bar at the
Section Tab) need to be defined manually, for three-dimensional problems they can also be
generated automatically (see Section 8.1.8 what and how are these Sections generated). At the
same time when HYDRUS generates 3D objects, it also generates Surfaces belonging to each of
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these objects. Some of these Surfaces are Horizontal and some are Vertical (although these
terms are only approximate). Surfaces can then be used to specify Boundary Conditions.

Vertical Surfaces are always created over the entire curve, which forms the boundary of the Base
Surface. When the boundary of the Base Surface consists of several curves, then an independent
Vertical Surface is created above each curve. Since the curves of the Base Surface can be
arbitrarily divided, Vertical Surfaces can be created relatively freely.

While the text above in Section 6 refers to the first approach (specifying properties at FE-Mesh),
the second approach (on Geo Objects) is briefly described below. While this latter approach can
be used for all Domain Properties, and Initial and Boundary Conditions, we will demonstrate its
use below on Material Distribution, for which it seems to be the most relevant. There are
multiple commands that are common for most properties when defining Domain Properties,
Boundary Conditions, and Initial Conditions on Geometric Objects. These commands are listed
in the Commands part of the Edit Bar and are listed in Table 20.

Table 20. Definition of commands used to manipulate Property Objects.

New Property” Creates a new Property Object. For some Properties, there is a list of
available options and user needs to select from this list (e.g., water flow
boundary conditions) or can extend this list (e.g., Materials). For others,
user needs to define values (e.g., scaling factors) or functional forms (e.g.,
initial conditions) of new Property Objects.

Set Property Selects one particular Property from a list or Property Objects and assigns
it to a selected Geo Obiject(s).
Clear Property Clears a particular Property from selected Geometric Points. This

command is used only for Properties that do not have a default Property
(e.g., Nodal Recharge, Observation Nodes).

Clear All Properties Clears all assigned Properties from geometric objects and assigns default
properties where required (e.g., Materials) to the entire transport domain.
Note that this command does not delete definitions of Properties (as done
by the Delete All Properties command), which thus remain available in the
data tree of the Navigator Bar.

Delete Property Deletes a Property Object selected in the data tree of the Navigator Bar.
This command is not used for Materials or Subregions, the number of
which is specified elsewhere.

Delete All Properties Deletes all Property Objects defined for a particular Property, except for a
default Property (which is defined for those Properties where a default
Property is needed). Similarly as for the Delete Property commands, this
command does not exist for Materials and Subregions.
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Sort Properties Calls a dialog window "Sort Property Objects”, which displays all
available Property Objects. Here, (the sequence of) the Property Objects
can be arbitrarily rearranged.

Transfer to FE-Mesh Transfers information about a particular Property defined on Geo Objects
to the FE-Mesh. Note that this command is available only when
information about a particular Property on Geo Objects and FE-Mesh does
not correspond. This can occur, for example, when Property is defined (or
refined) on FE-Mesh.

Edit Property Recalls a dialog window with parameters of a particular Property to edit.

“Note that the word Property is used in place of a particular Property Object, such as Domain Property (e.g.,
Material, Observation Node), Boundary Condition, or Initial Condition.

6.5.1. Materials on Geometric Objects

Let's assign three different materials to three Surfaces in Figure 117. When only one material is
defined (which is a default option in each new project), one needs to first define multiple
materials (and/or their soil hydraulic properties). This can be done as usual using the Menu
command Edit->Flow and Transport Parameters->Water Flow Parameters->Soil Hydraulic
Parameters. The same dialog window (Fig. 19) can be also displayed by clicking on the New
Material or Edit Materials commands on the Edit Bar (Fig. 118). Note that in Version 2.0 of
HYDRUS, one can name materials.

k] Domain Properties |

Materials G
M 1-5and

[ 2- Loam

[ 3- Sit modified

Commands G
':f@ Mew Material

¥5 Set Material

41 Sort Materials

;g; Transfer to FE-mesh

@ Edit Materals

Options =
] Mumbering

k& Edit Properties on FE-mesh

Figure 118. The upper part of the Edit Bar, which displays defined materials and commands for
various actions with materials.

There are three different ways of assigning materials to particular geometric objects (Surfaces):

a) Click on a particular Surface (Geo Object) (to select it) and then on a Material (1, 2, or
3) in the Materials section of the Edit Bar to assign it.
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b) Click on a Material (1, 2, or 3) in the Materials section (to select it) of the Edit Bar and
then on a particular Surface (to assign it).

c) Click on the command Set Material in the Commands section of the Edit Bar, from the
list box of the Set Materials window (Fig. 119) Select Material to set, click Assign to
close the window, and click on a particular Surface to assign the selected material.

Ayailable b aterialz

Select Material to zet; H : ggiﬂ v'

2 - Loam

gssif'_S"f Lrru:u:lifieci .

Figure 119. The Set Materials dialog window.
Note that nodes that are at the curve shared by two surfaces will be assigned a material with a

higher number. Color squares at nodes defining the Geometry (Fig. 120) indicate, which
material will be assigned to curves shared by two Surfaces.

L =350

L = 2000 |

=}
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Figure 120. The transport domain with materials specified on geometric objects.

The sequence of materials (as well as other objects, such as Initial Conditions) can be reordered
or sorted using the Sort Materials command on the Edit Bar and the Sort Property Objects
dialog window (Fig. 121). In this dialog, the order of materials can be sorted using the Top, Up,
Down, and Bottom command. While the sequence of materials can be sorted, colors
representing the first, second, and other materials will remain the same.
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Sorting can be done in two modes. When the Auto-apply check box is checked, any change
done in the Sort Property Object window is immediately transferred to the transport domain
and to the rest of the program. When this checkbox is unchecked, changes made in this dialog
are transferred to the rest of the program only when the Apply command is clicked or after the
window is closed using the OK button.

The command Renumber All can be used to renumber the Property Objects. This is useful,
when some previously defined Properties were deleted and the numbering is no longer sequential.

Sort Property Objects lﬁ

Froperty Objectz b ove

EM 1 - Loam Top
O] 2 - 5and Up

O 3 - Silt modified

ther Commarids

R enumber All
[ fpply |

[ Awsto-apply

[ ok ” Cancel ” Help ]

Figure 121. The Sort Property Objects dialog window.

A single click on any Surface will select this surface. A double click on any Surface will open a
dialog for a Property assigned to a particular surface that is currently displayed, e.g., the Edit
Materials dialog window (Fig. 122). In this dialog, one can change the Name of the material, its
Color (the Default check box indicates whether the Color has been changed), Assign it to
different Surfaces (indicated by their numbers), and register brief Remarks characterizing a
particular material.
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Figure 122. The Edit Materials dialog window.

Once the FE-Mesh exists, assigned properties (e.g., Materials) can be transferred on the FE
Nodes (if it exist) using the Edit Properties on FE-Mesh (when FEM exists and a particular

Property has not been yet edited on FEM) or the Transfer to FE-Mesh (s Trnsferto FEmesh )
(when a particular Property has already been edited on FEM) commands located on the Edit Bar
(Fig. 118). Here the assignment of materials can be further edited, refined, and finalized.
However, these changes cannot be transferred back on the Geometric Objects. After changes
have been made on FEM and thus Properties assigned on FEM and Geo Objects no longer
correspond, the command Transfer to FE-Mesh can be used to synchronize again the
information in the two modes (from Geometric Objects to FEM).

The Edit Bar commands Edit Properties on FE-Mesh and Edit Properties on Geo Objects
switches from one way of assigning properties (on Geo Objects) to another (on FEM).

Similar approach and similar commands can be used to assign other Domain Properties, and
Initial and Boundary Conditions.

6.5.2. Observation Nodes on Geometric Objects

Observation Nodes are entered on Geometric Objects using either the Menu command Insert-
>Domain Properties->0bservation Nodes or the New Observation Node command on the Edit
Bar. The New Observation Node command can be used in the Edit Properties on Geo Objects
mode to define observation nodes only on Points defining the Geometry (i.e., Points defining
boundary curves). Observation nodes for any other location have to be specified on the FE-Mesh
directly. The same is true also for Drains and Flowing Particles.
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The Edit Observation Node window (Fig. 123) is displayed when double-clicking on an
observation node in the View window (when working in the Properties on Geometric Objects
mode) or an Observation Node item in the Navigator Bar. This window displays
a) the Name of the observation node (note that the observation node can be renamed using a
brief text, such as drain, tensiometer, TDR, etc),
b) indication whether it is Defined at Geometric Node or FE-Mesh Node, and
c) abrief Remark (note).

Edit Observation Noc .,.L.J

Mo,

1 Obsersation Mode 1

Defined at

Defined at geomentrical node Ma: |0
i@ Defined at FE-Mesh Node

Fiemark,

[ ]9 ] [ Cancel ]

Figure 123. The Observation Node dialog window.

6.5.3. Initial Conditions at Geometric Objects

Property Objects for Initial Conditions are defined or edited using the New or Edit Pressure
Head (Concentration) Initial Condition dialog windows shown in Figure 124. Note that
parameters and values that are entered in these dialogs are the same as those entered in Figure
109, when defining Initial Conditions directly at the FE-Mesh. Here, one can additionally define
the Name of the Initial Condition, the Color which represents it (either Default or selected),
register a brief Remark, and select to which surfaces it is assigned to (Assigned to Surfaces
No:).
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Figure 124. The Edit Pressure Head (left) and Concentration (right) Initial Conditions dialog
window.

6.5.4. Boundary Conditions at Geometric Objects

New Property Objects for Boundary Conditions must be selected from existing boundary
conditions used in HYDRUS. For example, for Water Flow Boundary Conditions, new Objects
are selected from the list box Boundary Condition Type displayed in Figure 125. Similarly as
for other Properties, in this dialog one can define Name, Color, register a Remark, assigned
Boundary Condition at selected Boundary Curves, and, if needed, specify required parameters
(e.g., for Deep Drainage BC).

Notes:

1. When the same pressure head initial (or boundary) condition involving either
"Equilibrium from the lowest located point” or "A linear distribution" is chosen for
multiple surfaces (or curves), then this condition is applied globally to all selected
surfaces (e.g., a single point with the lowest z-coordinate is found for all selected
surfaces).

2. The default solute and heat transport boundary conditions are the Third-Type BCs,
which are listed right after the No Flux BC. This BC is by default assigned to all
boundaries, to which the water flow BCs have been defined. Note that if you redefine this
BC (e.g., change the Third-Type BC into the First-Type BC), the newly defined BC will
be used as a default BC for solute and or heat transport.
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Figure 125. The Edit Water Flow Boundary Condition dialog window.

6.5.5. Additional Notes on Properties at Geometric Objects

a)

b)

When the same pressure head initial (or boundary) condition involving either
"Equilibrium from the lowest located point™ or "A linear distribution™ is chosen for
multiple surfaces (or curves), then this condition is applied globally to all selected
surfaces (e.g., a single point with the lowest z-coordinate is found for all selected
surfaces).

Nodes that are at the boundary line shared by two surfaces (or at the surface shared by
two volumes) are assigned the property value with a higher number. The sequence in the
list of properties can be adjusted using the command Sort Property (where Property is
either Material, Scaling Factor, etc) at the Edit Bar (Fig. 121).

The option to assign Properties at Geometric Objects is not available for simple
parametric (i.e., Rectangular or Hexahedral) Geometries available in the Lite Version
of HYDRUS.

Name: One can provide a Name for each newly defined Property Object. When user does
not define a Name for a Property Object, the GUI will automatically generate a generic
name that is then used throughout the project (e.g., on the Navigator and Edit Bars).

When different values are specified on Geometric Objects and FE-mesh, a warning
Different Values on FE-Mesh is displayed in the Help section of the Edit Bar. A similar
warning is also issued in such case before calculations are started.

All properties can be transferred from Geometric Objects to FE-Mesh using the menu
command Edit->Transfer all Properties to FE-Mesh.
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7. Graphical Output

Graphical output is divided into two main parts. In the first part, variables which change spatially
throughout the transport domain are displayed by means of contour maps, isolines, isosurfaces,
or isobands (Results — Graphical Display on the Data Tab of the Navigator Bar, or Options-
>Graph Type). Additional information such as boundary fluxes and/or soil hydraulic properties
are displayed using x-y graphs (Results — Other Information on the Data Tab of the Navigator
Bar, or using the Results Menu).

7.1. Results — Graphical Display

Results of a simulation can be displayed by means of contour maps, isolines, isobands, isosurfaces,
color points, color edges, spectral maps, and/or velocity vectors (Graph Type at the View Tab of the
Navigator Bar or Options->Graph Type->Isolines), and/or by animation using both contour and
spectral maps. The number of colors in the color spectrum, as well as the numerical increment
between isolines, can be selected using the Edit Isoband Value and Color Spectra dialog
window (Fig. 129). Contour and spectral maps may be drawn for the pressure head, water content,
temperature, solute concentration (in the equilibrium or nonequilibrium phase), and/or velocity.
Animation of these four variables is also possible (Flow Animation on the Results version of the
Edit Bar, or using Results->Time Layer->Animation). Graphs of all variables along the boundaries
(Boundary-Line Chart on the Results version of the Edit Bar, or using Results->Charts->Boundary
Line), as well as those along any selected cross-section (Cross-Section Chart on the Results version
of the Edit Bar or Results->Charts->Cross-Section) can be readily obtained.

The entire finite element mesh, the boundary nodes, and the numbering of nodes, elements and/or
edges, can be displayed also (using the Display Options dialog window (Fig. 128), or Options-
>Display Options->Edit), together with isolines and spectral graphs. Users may zoom into a certain
part of the transport domain, and can enlarge or reduce the transport domain, among other features.

Flow animation is an alternative to displaying results at one particular time. Distributions during
flow animation are displayed continuously at consecutive times, thereby visualizing the flow and
transport process. Note, however, that display times are defined by the print time intervals specified
in the input data file. This means that the print times must be at constant intervals so that the time
scale of the flow animation will not be distorted. In other words, undistorted flow animation
requires that the print time intervals be constant. The speed of the flow animation depends on the
hardware being used, i.e., the speed of the microprocessor and graphical card.

195



7.1.1. Displayed Variables

Multiple variables can be displayed in the View window. A comprehensive list of standard and
alternative variables that can be displayed in the View window are summarized in Tables 21 and

22, respectively.

Table 21. Standard variables displayed in the View Window of the Results tab (Results -

Pressure Head
Water Content

Velocity
Velocity Vectors
Root Water Uptake

Concentration i

Sorbed Noneg. Conc. i

Immobile Conc. i

Temperature
Unsatchem Variables

Wetland Variables

Graphical Display).

Pressure head h [L]; displayed always

Water content 4 [-] (or &, when dual-porosity model is used); displayed
always

Values of the Darcy's flux g [LT™?]; displayed always

Darcy's flux vectors q [LT]; displayed always

Root water uptake S [T7]; displayed when root water uptake is
considered

Liquid phase concentration ¢ [McLy]; displayed when solute transport
in the standard module is simulated.

Concentration of kinetically sorbed solute s [McMs™]"; displayed when
solute transport in the standard module is simulated and when the two-
site sorption model is considered.

Concentration in the immobile water cim [McLy™]; displayed when solute
transport in the standard module is simulated and mobile-immobile
water or dual-porosity models are considered.

Temperature T [°C]; displayed when heat transport is simulated.

Major ions (Ca, Mg, Na, K, HCO3, S04, ClI, tracer, sorbed Ca, sorbed
Mg, sorbed Na, sorbed K, calcite, gypsum, dolomite, nesquohonite,
hydromagnesite, sepiolite; displayed when the Unsatchem module is
used.

Various variables used in the two constructed wetlands modules CW2D
and CWML (see the Wetlands module manual for details).

* Subscripts ¢, s, and w refer to contaminant, soil, and water.
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Table 22. Alternative variables that can be displayed in the View Window of the Results tab.

Variable Description

Pressure Head Standard display

Total Pressure Head Total Pressure Head H (=h+z) [L]; alternative display

Water Content Standard display

Mobile Water Content Water content in the mobile phase @ or 6, [-]; default display

Immobile Water Content Water content in the immobile phase qin [-]; displayed when dual-
porosity model is used.

Total Water Content Total water content 8 (=6n+6n); displayed when dual-porosity
model is used.

Velocity Standard display

Total Value Darcy's flux [LT™]; default display

X-component x-component of the Darcy's flux q [LT™]

y-component y-component of the Darcy's flux g [LT]

z-component z-component of the Darcy's flux q [LT™]

Concentration Options

Liquid Equil. Phase Conc.  Liquid phase concentration ¢ [McL,*]*; default display.
Sorbed Equilibrium Conc.  Concentration of instantaneously sorbed solute s® [McMs™].
Sorbed Total Concentration Sorbed concentration s= s° + s* [McM;™].

Gas Phase Concentration Gas phase concentration g (=Knc) [McLa ]

Total Concentration Total concentration mass S [McLs ]

Sorbed Concentration Options

Sorption Sites 1 Sorbed concentration on first kinetic sorption sites s;* [McMs™]
Sorption Sites 2 Sorbed concentration on second kinetic sorption sites s, [McMs™]
Total Sorbed Conc. Total sorbed concentration s* = s, + s, [McM;?]

* Subscripts ¢, s, a, and w refer to contaminant, soil, air, and water.
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Table 23. Definition of various concentration modes (for linear sorption model).

Equilibrium | Mobile-immobile Two-site Two-kinetic
model model sorption model | sites model
Sorbed Equilibrium | K c K, fc, f.KoC KoC
Concentration
[M:M/]
Sorbed Nonequil. | - Ko (@- f)c,, s* S +s5
Concentration
[MM]
Sorbed Total | K¢ Ko [ fc, +@-f)e,] | fKpc+s® KoC+Ss) +5
Concentration
[MM]
Gas phase | K, c Kyc K,c K,c
concentration
[M,L]
Solute mass in the|cé@ Cnbn + Cinim co co
liquid phase,
Si [M,L]
Solute mass in the solid | pKc PKD[me +(1- f)cim] ,o( feKDc+Sk) p(slk +52k)
phase, Ss [M_L?]
Solute mass in the gas | K, ca K, ca K,ca K,ca
phase, Sq [M.L?]
Total Concentration, S | Sj+Ss+Sq SI+Ss+S, Si+Ss+S5y Si+Ss+Sy
[M,L]
a air content [L3 L]
c liquid phase concentration [M_L? ]
Cm liquid phase concentration in the mobile phase[M_L? ]
Cim liquid phase concentration in the immobile phase[M_L? ]
0 water content [L> L]

& water content in the mobile phase [L3 L?]

&m  water content in the immobile phase [L} L]

Kb distribution (sorption) coefficient [L> M_']
Kn Henry's law constant [-]
S solute mass in the liquid phase [M_L?]

Ss solute mass in the solid phase [M_L?]

Sy solute mass in the gas phase [M_L?]
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&

total concentration (solute mass), S=S;+Ss+Sq [M L]

solid phase concentration [M_M']

solid phase concentration on kinetic sorption sites [M_M;']

solid phase concentration on first kinetic sorption sites [M_M_']

Results - Graphical Display
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000 Velocity

M0 Velocity Vectors
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..... 00 Temperature
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----- 00 L4 - Inert Soluble COD
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Figure 126. The "Results - Graphical Display" part of Data Tab of the Navigator Bar for the
standard (left), Unsatchem (centre), and Wetland (right) modules.
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Figure 127. The "Results" part of the View Tab of the Navigator Bar with the display of various
alternative variables.
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7.1.2. Display Options

The Display Options dialog window (Fig. 128) allows users to select

a) how different objects from the Category list are to be displayed,

b) what colors are to be used (colors can be redefined by clicking on the Edit Color
command button),

c) whether lines are displayed as solid, dotted, dashed or dash-dotted (Line Type), and what
Thickness should be used, and

d) the position of numbers for various types of numberings, fonts for the numbers, and
whether or not numbers are Transparent.

Display Options E|

Categony Parameters

+- Geometry S
= FE-Mezh
FE-eszh Modes
FE-tesh Elements
Surface Approx. Mesh
Refinernent at Points
Refinement on Lines
Refinerment on Surfaces
Dramain Properties
Foints - Handles
Obzervation Hodes
Drains
Flowing FParticles

O treTwe
() Solid Thickness; 18
() Datted

+- Boundary Conditions (O Dashed
= Resultz () Dash-dotted
Particle Trajectories O | ! .mbering
Isolines O]
Welocity Wectors O 888 [ Transparent

F

ey Ottt = 000
|- Colors o Edit Calar

[ ak. H Cancel ” Help ]

Figure 128. The Display Options dialog window.
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7.1.3. Edit Isoband Value and Color Spectra

The Edit Isoband Value and Color Spectra dialog window (Fig. 129) (called by left-clicking
the color scale display options of the Results version of the Edit Bar) allows users to define
colors for display of isobands isosurfaces, and color spectra, and values of particular isolines.
The default scale has always 11 values, which corresponds to 11 colors for color contours and 12
colors for isolines. Values at the scale are calculated by evenly dividing the interval between the
minimum and maximum of a particular variable. Numbers are formatted depending on units used
to display a particular variable. When the number of displayed digits is insufficient, it is possible
to use a scientific format (E-format). The E-format is then used also on the Edit Bar and for
printing (only for a particular variable).

Note that switching from a regular format to the E-format represents also switching from the
Standard Scale to the Custom Scale (see below), which is then kept for the display of the same
variable at other times. Returning to the Standard Scale may be required to adjust the scale as
needed to display a given variable at the new time.

Edit Isoband Values and Color Spectra W|
| Scales
-lao.ooal |0
43261 Default
-186.521 Py
-229.782
Fill bax/Min
-273.043
-316.304
. -359.564
402 825 Palettes
446 066 Standard
4pe347
-532.607
(575 868 1| Murkber of Intermediate |salines
[]E-Format
When drawing lsolines:
Double-click on the color panel When drawing Color Contours: 2
to change colors. E
[ oK ] l Cancel l

Figure 129. The Edit Isoband Value and Color Spectra dialog window.

Users can also define the Isoline scales. This can be done by simply changing numbers in the
edit boxes next to the colors. If the numbers are not in an increasing or decreasing order, a
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warning will be issued. Newly created Isoline scales can be saved (again locally or globally) and
used later. Users need to specify only the maximum and minimum values (the top and bottom
edit boxes); after clicking the Fill command, the program will calculate and fill (complete) the
intermediate numbers by interpolation. A specified Number of Intermediate Isolines can be
drawn between the main isolines using When drawing Isolines or When drawing Color Contours.
This number is by default equal to zero. Five intermediate isolines are used in Figure 130.
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Figure 130. The use of intermediate isolines.

Minimum and maximum numbers of the scale are automatically adjusted to a particular problem
and for a particular variable. By default, HYDRUS searches all output time levels of a particular
project for the minimum and maximum values of a particular variable, and then leaves the scale
invariant in time between these two values. The scale, however, can also be automatically
adjusted for each time level by specifying the minimum and maximum values for a particular
variable and a particular print time when the option Min/Max glob. in time from the Color Scale
View Options of the View Tab of the Navigator Bar is deselected. Similarly, the scale can be
automatically adjusted for a particular layer of the FE-mesh (a section) (the minimum and
maximum values for a particular variable and a particular section) when the option Min/Max
glob. in space from the Color Scale View Options of the View Tab of the Navigator Bar is
unselected.
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After clicking on the color panel with the left mouse button, the Color dialog window (Fig. 131)
appears, in which one can redefine colors to be used in displays. By default a Standard Palette
is used. If a Custom Scale exists for a displayed variable, colors for this scale will be displayed
even when Standard Scale was currently used (since the Standard Scale can not be edited).
Palettes with newly defined colors can be saved (Save Palette) under a new name and used for
different purposes. The new palette can be saved locally and used with the given application, or
globally and used for all HYDRUS applications. Users hence can in this way define different
palettes for displaying water contents, pressure heads, concentrations, or temperatures. Since the
Standard Palette can not be changed, once any color is changed, the program will request to save
a new scale under a new name. The changed colors will be used for all displayed variables (not
only the actual one).

Baszic colors:

Hl TEEEN N

HENEENNEN
HENEEEEEN
EEEEEEEN
HEEEN N

Custom colors:

1 I T O O P

Hug: Red: | 252
. Sat[240] e

I~
[y ]
-

Define Custom Colars 33 Lolorfalid oy Elue:

[ k. l [ Cancel ] [ Add to Cuztomn Colors ]

Figure 131. The Color dialog window.

Custom Scale

A user can define his/her own scale that is then remembered by the software and used for a
particular variable in a given project. When one wants to use a certain scale also in other projects,
he/she needs to save it using the Save command.

Other commands:

o Default — Sets the number of intervals to 11 and automatically fills values for the default
scale
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e Empty — Deletes all values (used with commands Fill and Fill Max/Min)
e Fill — Fills empty spaces between specified upper and lower values using linear
interpolation
e Fill Max-Min — Similar to Default, except that this command does not set the number of
values to 11 (it uses the number of values selected by a user)
e Save — Saves the Scale for use with other projects
e Delete — Deletes a selected Custom Scale

The number of values at the Scale can not be increased, it can only be lowered (from 11) using a
“slider”. By drawing a slider, one can also generate values at a Scale (see Figure 132):

Edit Isoband Values and Color Spectra rg| Edit Isoband Values and Color Spectra rg|
- 5000 Scales 5.000] £ Scales
wm| | | B P
E0.000 FHZ = E0.000 FHZ =
| = |Standard 5000 Standard
—
30,000
Fill b a/Min Fill b a/Min
I:I Palettes 3000 Palettes
I:I Standard 25000 Standard
] #0000
| MNumber of Intermediate |solines D 80080 |7y | Number of Intermediate lsolines
[1E-Farmat [1E-Farmat
Wwhen drawing lzolines: l:l Wwhen drawing leolines: l:l
Double-click on the color When drawing Color Contours: Double-click on the color When drawing Color Contours:
panel to change colors. g EI panel to change colors. g EI
[ [1]8 l [ Cancel ] [ [1]8 l [ Cancel ]

Figure 132. Adjusting scale in the Edit Isoband Value and Color Spectra dialog window.

When using a Custom Scale, the actual minimum or maximum of a displayed variable can be
outside of the interval of the scale. Values outside of the interval of the scale are not displayed in
the View window, resulting in empty spaces as shown in the upper part of see Figure 133.
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Figure 133. The use of the Custom Scale.

A right mouse button click on the Color Scale at the Edit Bar displays the menu for a fast
change of various options related to scale.

e Color Smoothing — colors will change smoothly between particular iso-spectra
corresponding to changes of the displayed variable (upper View at Figure 134).

e Min/Max global in Time - the scale of a certain variable is defined by the minimum and
maximum of all values from all time levels

e Min/Max global in Space - the scale of a certain variable is defined by the minimum and
maximum of all values over the entire transport domain

e Standard Scale — uses the Standard Scale, while the Custom Scale for a given variable
(if it exists) is remembered

e Custom Scale — uses the Custom Scale if it exists. If it does not exist (default), this
button is disabled. If one wants to use the Custom Scale, he/she needs to first create it in
the Edit Scale and Colors dialog.

e Edit Scale and Colors
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Figure 134. The color smoothing.
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7.2. Results — Other Information

Additional information, such as boundary fluxes and/or soil hydraulic properties can be
displayed using x-y graphs (Results — Other Information on the Data Tab of the Navigator
Bar, or Results Menu, Fig. 135). Figure 135 shows the x-y graph dialog window that displays
pressure heads in observation nodes.). Table 24 gives an overview of the different graph options
that are possible. Two list boxes at the top of the x-y graph dialog window provide various
combinations of graphs that are possible to display (Table 24). Browsing through various graphs
is additionally also enabled using the Previous and Next command. Double-clicking at various
objects of the x-y graph (e.g., axis, title, captions, legend) will allow users to redefine them, i.e.,
to change their text, colors, or fonts. When the right mouse button is clicked above the graph a
pop-up menu will appear that will also allow users to redefine various objects of the x-y graph.
One can for example change the text of both vertical and horizontal axis (Axis->Title) captions
and titles (Title), their fonts, and colors, one can copy the content of the graph to the clipboard
(Copy) for later paste in various other windows applications (e.g., MS Word, PowerPoint, or
Excel), or one can change the thickness and colors of displayed lines. Many other modifications
of the displayed x-y graph are possible. Data displayed in the x-y graph can be exported into an
ASCII file using the Export command. The x-y graph settings can be saved using the Save
command. Selected variable can be displayed either for all or for selected observation nodes.

Observation Modes El
Chart Observation Modes
Horizontal Wariable: | Time R
nelp
Wertical Wariable: Pressure head b
Observation Nodes: Pressure Heads
200 —
100+ \/\J\/\
0 t t t S
E 00 4 Graph:
=
=200 +
'ADD T T T T 1 .
&0 100 150 200 260 300 Settings:
-
[] 5 hows &l BeriE

Figure 135. The x-y graph dialog window displaying pressure heads in observation nodes.
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Table 24. Graph options in the HYDRUS interface.

Command Horizontal Axis Vertical Axis

Observation Points Time Pressure Head
Water Content
Temperature

Concentration — x*
Sorbed Concentration - x*

Pressure Heads Time Atmospheric Boundary Head
Root Zone Head
Variable Boundary Head 1
Constant Boundary Head
Seepage Face Head
Drainage Boundary Head
Free and Deep Drainage Boundary Head
Variable Boundary Head 2
Variable Boundary Head 3
Variable Boundary Head 4
All Boundaries

Water Boundary Fluxes Time Potential Atmospheric Flux
Potential Root Water Uptake Rate
Actual Atmospheric Flux
Actual Root Water Uptake Rate
Variable Boundary Flux 1
Constant Boundary Flux
Seepage Face Flux
Drainage Boundary Flux
Free and Deep Drainage Boundary Flux
Variable Boundary Flux 2
Variable Boundary Flux 3
Variable Boundary Flux 4
All Atmospheric Fluxes
All non-Atmospheric Fluxes

Cumulative Water Boundary Fluxes  Time Potential Atmospheric Flux
Potential Root Water Uptake Rate
Actual Atmospheric Flux
Actual Root Water Uptake Rate
Variable Boundary Flux 1
Constant Boundary Flux
Seepage Face Flux
Drainage Boundary Flux
Free and Deep Drainage Boundary Flux
Variable Boundary Flux 2
Variable Boundary Flux 3
Variable Boundary Flux 4
All Boundaries Fluxes

Solute Fluxes® Time Cumulative Zero-Order Reaction
Cumulative First-Order Reaction
Cumulative Root Solute Uptake
Cumulative Non-Equil. Mass Transfer
Cumulative Constant Boundary Solute Flux
Cumulative Seepage Face Solute Flux
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Cumulative Variable Boundary 1 Solute Flux
Cumulative Atmospheric Solute Flux
Cumulative Drain Boundary Solute Flux
Cum. Free/Deep Drainage Bound. Solute Flux
Cumulative Variable Boundary 2 Solute Flux
Cumulative Variable Boundary 3 Solute Flux
Cumulative Variable Boundary 4 Solute Flux
Constant Boundary Flux

Seepage Face Flux

Variable Boundary Flux 1

Actual Atmospheric Flux

Drain Boundary Flux

Free and Deep Drainage Boundary Flux
Variable Boundary Flux 2

Variable Boundary Flux 3

Variable Boundary Flux 4

All Solute Cumulative Fluxes

All Solute Fluxes

Soil Hydraulic Properties Pressure Head Water Content
Log Pressure Head Soil Water Capacity
Water Content Hydraulic Conductivity
Log Hydraulic Conductivity
Effective Water Content

Pressure Head
Log Pressure Head

Run-Time Information Time Level Time Step
Time Number of Iterations
Cumulative Number of Iterations
Peclet Number
Courant Number
Number of Solute Iterations

* This graph is given for each solute

The x-y graphs have only a limited capacity and can display at most 6,000 data points and 20
lines. If a dataset to be displayed has more data points then allowed, then automatic selection is
made by the program (only each n data point is displayed) and a warning (File is too big to be
displayed entirely! Automatic selection has been made.) is issued. If the number of observation
nodes is larger than 20, only the first 20 observation nodes are displayed.

Additional text output is provided under the command Mass Balance Information on the Data Tab
of the Navigator Bar (also at the Results Menu). This output gives the total amount of water,
heat and solute inside each specified subregion, and the inflow/outflow rates to/from that subregion,
together with the mean pressure head (hMean), mean temperature (TMean) and the mean
concentration (cMean) over each subregion (see Table 11.6 of the Technical Manual). Absolute
and relative errors in the water and solute mass balances are also printed to this file. Output related
to the inverse problem is provided under the command Inverse Solution Results on the Data Tab
of the Navigator Bar. The Chemical Mass Balance information (on the Data Tab of the Navigator
Bar or at the Results Menu) is provided for the Unsatchem module. This file gives mass balances
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in different phases (liquid, sorbed, solid) for all major ions (i.e., Ca, Mg, Na, K, HCO3, SO4, and
Ch.

The text dialog displaying Mass Balance Information or Inverse Solution Results had only a
limited capacity in Version 1.x of HYDRUS. If the file to be displayed wass larger than this
capacity (when there is too many print times or large number of data points in the inverse
problem), a warning “File is too big to be displayed entirely! Open it in any text editor.” was
given. Users in such case needed to display the Balance.out or Fit.out files, respectively, directly
using any text editor, such as Notepad or WordPad. Both files are located in the Temporary
Working Directory (see Section 1). This capacity problem was overcome in Version 2 and the
dialog windows now displays the button Next (or Previous), which allows browsing through
larger text files.

7.2.1. Convert to ASCII

The output files H.OUT, TH.OUT, CONCx.OUT, SORBx.OUT, TEMP.OUT, and VV.OUT provide
binary output of specific variables. The user interface can convert these binary files into the ASCII
files H.TXT, TH.TXT, CONCx.TXT, SORBX.TXT, TEMP.TXT, and V.TXT using the Convert to
ASCII dialog window (Fig. 136) (Results — Other Information on the Data Tab of the
Navigator Bar, or Results->Convert Output to ASCI). The ASCII (text) files (e.g., h.txt, th.txt,
v.txt) simply provide Print Time followed by a sequential list of values of a particular variable.
These values are listed in the same order as Finite Element nodes. Coordinates for each FE node
can be found in the MeshTria.txt file.

Convert to ASCII

Convertta ASCH the following files:

DEMesh Information (Meshiria 0007 Cancel

[ |Pressure Heads th.out)

[ ]water Contents (th.ouf)
[ ]welocities fv.ouf)

[ ] Concenrations (conc.out and sork.out)

1.

Help

[ ] Temperatures (temp.out)

Figure 136. The Convert to ASCII dialog window.
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8. Graphical User Interface Components
8.1. View Window
8.1.1. Scene and Viewing Commands

We will use here the term “Scene” for the content of the View window. Four types of commands
are available to change the display of the Scene in the View window.

a) Commands to define a required Display of the Scene.

Detailed information about particular commands is given in Section 8.4. In addition to those
commands, it is always possible to adjust the Display of the Scene using the “mouse scroll
wheel* as follows:

e Simultaneously holding the mouse scroll wheel and moving the mouse will move the
Scene in the same direction as the mouse, i.e., to the left, right, up, or down.

e Simultaneously holding the Ctrl keyboard button and the mouse scroll wheel, while
moving the mouse, rotates the Scene around the center of the displayed object (available
only for three-dimensional objects).

e Simultaneously holding the Shift keyboard button and the mouse scroll wheel, while
moving the mouse, leads to zooming in or out of the Scene from the center of the View
window.

e Rotating the scroll wheel (up or down) while pointing the mouse to a particular point in
the View window results in zooming (in or out) the Scene from this point.

e Simultaneously holding the right mouse button and the mouse scroll wheel, while moving
the mouse, rotates the Scene around the center of the displayed object (available only for
three-dimensional projects).

The above described operations are available not only during selection (on existing transport
domain), but also when defining basic geometric objects. This allows users to adjust the View
window as needed without interrupting the process of graphically defining objects of the
transport domain.

b) Commands to define the Content of the Scene.

In every view one can independently specify what is to be displayed, e.g., a variable, the type of
graph, or the numbering of objects. All possible options related to the Content of the Scene are
located on the Navigator Bar of the View Tab (Section 8.2).

c) Displaying and/or hiding parts of complicated objects.

One often needs to display only some part of a complicated object while hiding the rest. For this
purpose one can use commands related to Sections (i.e., parts of the computational domain or
FE-Mesh). Detailed information is given in Chapter 8.1.8 on Sections.

d) Colors, fonts, and type of lines.
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One can define colors, the style and thickness of lines, fonts for numbering, and other displaying
options for almost all displayed/used objects. Separate default sets exist for the display for the
screen and the printer. Users can create and save additional combinations of display options.
Detailed information is provided in Chapter 7.1.1 on Display Options.

8.1.2. Grid and Work Plane

The Grid and Work Plane dialog window (Fig. 137) allows users to

a) select a Work Plane (i.e., a plane in which users can specify various boundary objects,
initial and boundary conditions, or other information),

b) define the Origin of the coordinate system, and

c) define the Alignment Grid. The Grid is defined by its Origin, the type (Grid Type) of
coordinate system involved (either Cartesian or Polar), and the Grid Spacing. The Grid
can also be rotated to facilitate work, for example when defining the domain for a hill
slope problem.

Grid and Work Plane [‘S__<|
Wwiork Plane Origin
(O 7 Faint Mo wh || Pick | | Mew
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~ x e
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Snap (%) Cartesian [+] [

Shiaw O Palar Ciirection 1:
Diirection 2;

P [] Dyharic update
¥ - . C . . .
t+_ . gt Grid Paint Spacing
J—L e | Distance b: 50.001 [em]

v = » R Distance h; 5000/ [ern]
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Figure 137. The Grid and Work Plane dialog window.
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8.1.3. Stretching Factors

In many applications one direction of the transport domain dominates the other direction (or the
other two directions). To facilitate work in the graphical environment, HYDRUS allows stretching
of the domain in one (or two) direction(s) using Stretching Factors. This is done using the View
Stretching Factors dialog window (Fig. 138) that is called with the command View->View
Stretching.

View Stretching Factors E|
Stretching Factors
Apply
I -direction: 1
I *r'-direction; 1 Calculate
Fachors
In Z-direction: 0.021739
' . Mo
Adjust Grid Stretching

tethod for Calculation of Stretching Factors

3 Strict - &l non-uniform dimengions will be stretched,
Fu = Dirnin/ D

(%) Mild - Only extremal dimenzions will be stretched.
if [Dw <= D] Fx =1 elze Fr = Dmin*M A0 or
if [Dw »=Drnax/M] Fu =1 elze Fx = Dmaw/MADx

I ak. ” Cancel ” Help ]

Figure 138. The View Stretching Factors dialog window.

Two options of View Stretching are available:

a) Strict Stretching when all transport domain dimensions will be displayed as being the
same. For example a hexahedral of any dimensions will be displayed as a cube.

b) Mild Stretching, which adjust view stretching only when large differences in dimensions
in different directions exist. By default there will be no view stretching when the larges
dimension is 5 times larger than the smallest dimension.

A user should first select the Method for Calculation of Stretching Factors (either Strict or
Mild), then click the command Calculate Factors (which will calculate stretching factors based
on the method of stretching selected), and finally click the Apply command to update the View
Window.
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8.1.4. Rendering Model

Rendering serves to rapidly switching between displays of surfaces and solids. One can select the
Wire and Full Rendering options. An advantage of Wire Rendering is mainly the speed of the
display, while Full Rendering provides a more realistic display of three-dimensional objects.

=3 [ Ful
=] @ Surfaces
@ @ Outline
) @ Tranzparent
O @ Filed
- @ Solids
O @ Outline
- @ Tranzsparent
3 @ Filed
+ IZI% Graph Type
+ IZI?‘ Lighting
+- [C1BE Color Scale

[%= Data | Gd" View I £F Sections I

Figure 139. The Rendering part of the View Tab of the Navigator Bar.

8.1.5. Selection and Edit Commands

The selection of graphical objects is based on standards used in MS Office. An object is selected
by clicking the left mouse button; a multiple selection is made by simultaneously holding the
Shift button. A selection can be made using a rectangle (by clicking with the left mouse button
outside of objects and holding the left mouse button while moving the mouse), rhomboid (see
Chapter 8.4. on Toolbars and Tools, with the Edit->Select->Select by Rhomboid command),
circle (Edit->Select->Select by Circle) or polygon (Edit->Select->Select by Polygon).

In the Standard Selection Mode (Edit->Select->Standard Selection Mode) the status of the
selected object is changed (selected or unselected) after its selection, i.e., the selection is toggled.
If we want to only add or remove objects to or from existing selection (i.e., we want to prevent
switching the status of selected objects (toggling)), respectively, it is possible to choose two
special selection modes: “Add to Selection” (Edit->Select->Add to Selection) or “Remove from
Selection”. (Edit->Select-> Remove from Selection). Both commands are accessible from the
submenu Edit->Select or from the toolbar under the button “Tools for Selection”. Two special
Selection Modes can also be activated by holding the “Left Ctrl” (Add to Selection) or “Right
Ctrl” (Remove from Selection) keyboard buttons.

When the cursor (mouse) is moved above an object, information about that object appears on the
status bar and the object is temporarily highlighted; this process is referred to as pre-selection.
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Apart from selecting objects graphically, they can also be selected using their Indices or by
means of Sections.

Double-clicking on selected objects or simultaneous holding the Alt+Enter buttons recalls
dialogs for editing properties of particular objects. Most dialogs support multiple editing, i.e., if
edit boxes with different values remain empty, the original values will not change. This feature
allows for example Z-coordinates of multiple selected points to be changed, while leaving the X-
and Y-coordinates unchanged.

When different objects are selected simultaneously (e.g., points and curves), double clicking
causes a dialog window to appear from which objects can be selected for editing.

8.1.6. Pop-up Menus

Context-sensitive menus with useful commands for a particular object can be called from the
View window when clicking the right mouse button. While the commands are accessible also
from the main menu, right-clicking the mouse is much faster. Menus for multiple selections that
may contain different types of objects operate in the same way. When the right mouse button is
clicked a default menu will appear when no object is close to the cursor.

When one clicks with the right mouse button on the view window, the pop-up menu of Figure
140 will appear. This menu will allow users to
a) select different views (View), i.e., Isometric, in X-direction, in Y-direction, in Z-direction,
Reverse X-direction, Reverse Y-direction, Reverse Z-direction, or a perspective view.
b) select Numbering (turns on and off the display of numbering for objects selected under
Numbering Options on the Navigator Bar).
c) go quickly to various Numbering Options (this command will bring the Navigator Bar to
the View Tab on Numbering).
d) switch Full Rendering/Wire Rendering (see 8.1.4).
e) start the Autorotate function that will rotate the transport domain in the View window
f) call the Show Work Plane, i.e., to show the axis and the origin of the Work Plane
g) call the Set Grid and Work Plane dialog window (Fig. 137) (Set Grid and Work Plane)
h) select the Coordinate System (call the List of Available Coordinate Systems dialog
window), and
i) call the Display Options dialog window (Fig. 128).
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Figure 140. The Pop-up Menu from the View window.

8.1.7. Drag and Drop

By clicking and holding the left mouse button on selected objects in the View window, the Drag
and Drop operation is started. This operation allows selected objects to be moved to a new
location. Simultaneous holding the Ctrl keyboard button leads to the creation of a copy of the
selected object. The copy can be moved into a different view, or in a different open project. The
operation terminates by holding the Esc button or by clicking the right mouse button. Drag and
Drop can be used for most geometric objects, but also for auxiliary objects such as comments,
labels, and bitmaps.

Holding the Shift button during the Drag and Drop operation leads to movement of selected
objects in a direction perpendicular to the current Working Plane (available only for three-
dimensional objects).

8.1.8. Sections

Sections serve do divide complex objects (models) into simpler parts. Only the simpler parts are
then displayed in the View window while the remaining parts are hidden. Two types of sections
exists: those for geometric objects (Geo Sections) and those for the FE-Mesh (FE-Mesh
Sections) (see also Section 5.7 and Table 19). New sections for both types can be created and
named, a list of which is displayed on the Section Tab of the Navigator Bar. Clicking on the
Section of the Navigator Bar causes the Section to be displayed in the View window. Multiple
Sections can be displayed simultaneously by holding the “Shift” button during the selection.
Undesired (to be displayed) parts can be cut off and hidden from the View window using the Cut
with Rectangle command. This leads to a temporary section that is remembered by the program
and renewed after the project is closed and reopened. New sections can be named and listed in
the Navigator Bar by using commands to create new sections. The simplest menu command is
the New Section from the View command (alternatively, one can use the Create New Section
from Current View command from the Edit Menu of the Sections Tab of the Navigator Bar),
which creates a newly named section from currently displayed objects in the View window. The
New Section from Selection menu command (alternatively, one can use the Create New
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Section from Selected Objects command from the Edit Menu of the Sections Tab of the
Navigator Bar) creates a newly named section from currently selected objects or the FE-Mesh.
The Display Whole Domain (View All) and Display Whole FE-mesh commands causes the
entire computational domain or FE-Mesh to be displayed.

Geometric Sections can be created manually (as described above) or automatically. The
automatically generated Geo Sections are generated as follows. An object above each part of the
Base Surface (in the 3D-Layered Domain) forms a Column, which is divided into Layers,
depending on how many vertical layers the domain is divided into. Each such Layer of each
such Column then forms one Object (a Domain Section). When we have N Columns (that is, N
parts in the Base Surface) and the domain is divided into M horizontal Layers, then the number
of generated objects is N*M. At the same time, Surfaces belonging to each of these objects are
also generated. Some of these Surfaces are Horizontal and some are Vertical (although these
terms are only approximate). Surfaces can then be used to specify Boundary Conditions.

Options for generation L'

Geo-Sections FE-Mesh Sections
[V]iae0 Sechons for Sutaces
= .
orly if Msurf ¢ 50 -

only boundary Surfaces
Geo Sections for Solids

FE-tezh Sections

[] Boundary Shel
keszh Lavers Generate
) Sections
Meszh Sections for generated — .
Geo-Sections o Set
Mesh Sectians for Diefsull
uzer-defined Geo-Sections Sy
Default
Hint: Y'ou can create custom Mesh-Sections or Geo-Sections uzing the "Cut
with Rectangle' tool and ather commands available in the "Edit - Sections" Fragram
TRERL, Default

Figure 141. Options for Generation of Geo-Sections and FE-Mesh Sections dialog
window.

Selected Geo-Sections and/or FE-Mesh Sections can be generated using the command
Generate Sections in this dialog window (Fig. 141) obtained using the menu command Edit-
>Sections->Generate Sections. Geo-Sections can be generated either only for Solids or also for
(Boundary and/or internal) Surfaces. Since working with Geo-Sections can be rather tedious
when the number of Surfaces exceeds a certain limit, users can select this limit. The default
setting (Program Default) is to generate Geo-Sections for up to 50 Surfaces. Note that the
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number of Surfaces can be prohibitively large for certain 3D-Layered Domains with multiple
internal lines and/or layers. Users can therefore choose to generate FE-Mesh Section only for
Boundary Surfaces, which are useful when specifying the boundary conditions, and not for
internal Surfaces. User can change the default setting (Program Default), save it using the
button Save as Default, and then recall it using the button Set Default. Note that different
default setting can be saved for different types of domains.

Different FE-Mesh Sections are generated depending on the type of Domain. For the 3D-
Layered Domains, FE-Mesh Sections can be generated for the Boundary Shell, for each Mesh
Layer, and for both automatically Generated and User-Defined Geo-Sections. For the 3D-
General Domains, FE-Mesh Sections can be generated for the Boundary Shell, and, again, for
both automatically Generated and User-Defined Geo-Sections.

The Partial View is the status of the display (in the View window) when only part of the
transport domain is displayed (i.e., only one or few, but not all, Sections are displayed). The parts
that are not displayed are still visible in the background (gray thin lines and/or surfaces), but are
inactive and cannot be selected for various operations. The Partial View can be cancelled (and
the entire domain displayed) using the menu command Cancel Partial View or the popup menu
command Display Whole Domain.
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8.2. Navigator Bars

The Navigator Bar (Fig. 142) is by default located on the left side of the HYDRUS main
window. A user can, however, move the Navigator bar to other positions. The Navigator Bar
has three Tabs:

a) A Data Tab to allow quick access to all input and output data. Input data include Domain
Geometry, Flow Parameters, FE-Mesh, Domain Properties, Initial and Boundary
Conditions, and Auxiliary Objects. Output data include various Results. Data are
organized in a tree-like structure. Figure 142 shows Data with expanded Domain
Properties on the left and Results in the middle.

b) A View Tab (on the right of Figure 142) to specify what and how information will be
displayed in the View window, and

c) A Sections Tab to show various Sections (not shown here and defined elsewhere).

View Options on the View Tab of the Navigator Bar at first mirror more or less the Project
Data, i.e., View Options exists for Domain Geometry, FE-Mesh, Domain Properties, Initial and
Boundary Conditions, and Results. Users can then select which objects (Domain Geometry
objects, Domain Properties objects, FE-Mesh objects, such as nodes, edges, triangles, and
tetrahedrals) are to be numbered (Numbering), display Auxiliary Objects, and initiate Rendering
(Outline, transparent, filled). Users can also select the Graph Type (lIsolines, Isosurfaces,
Contours with or without Separation Lines, and Color Edges, Color Points, and Velocity
Vectors) and Color Scale (either with or without Min/Max glob. in time or Min/Max glob. in
space). Finally, Lighting can be turned on or off; the location of light sources can be shown
(Show Light Sources), and the location of lights can be selected (Light Switches).
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8.3. Edit Bars

The Edit Bar is by default located on the right side of the HYDRUS main window. A user can,
however, move the Edit Bar to other positions. The Edit Bar is very dynamic since it changes
depending upon the process being carried out. Figure 143 shows the Edit Bars for different
processes, i.e., for the Material Distribution in the Domain Properties, the Water Flow Boundary
Conditions, the Pressure Head Initial Conditions, and the Water Content Results.
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Figure 143. Selected Edit Bars (from left to right) for Material Distribution in Domain Properties,
Water Flow Boundary Conditions, Pressure Head Initial Conditions, and Water Content Results.
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As an example, the Edit Bar for Domain Properties and Material Distribution displays
materials that can be assigned to selected nodes (in this case Materials 1, 2, and 3), the Command
Edit Materials (which calls the Water Flow Parameters dialog window, Fig. 19), the
command Values by Pointer (which displays the material number for a node closest to the
cursor), and Help. The Help part of the Edit Bar usually contains help on a particular process
(How to ...), and the direction of the data inputting process (next or backwards).

The Edit Bar for Boundary Conditions and Water Flow displays the various boundary
conditions that can be specified along boundaries of the transport domain, as well the command
Display Codes (which displays boundary codes for all boundary nodes in the View window), the
command Codes by Pointer (which displays boundary codes only for the node closest to the
cursor), Numbering Options (which changes the Navigator Bar to the View Tab and
Numbering option), Boundary Conditions Options (which allows additional system-dependent
boundary conditions for water flow, see the Technical manual and Fig. 112), and Help (which is
similar as discussed above).

The Edit Bar for Initial Conditions and Pressure Head - h displays a color spectrum that is
used to draw the initial conditions, and lists the minimum and maximum values that are used in
the entire domain. This Edit Bar also includes:

a) Edit Commands: Set Values and Values by Pointer. When nodes for which the initial
conditions are to be specified are already selected, then the Set Values command calls
the Water Flow Initial Condition dialog window (Fig. 109). When no nodes are
selected, then clicking on the Set Values command causes a square cursor to appear,
which may be used to select particular nodes, after which the Water Flow Initial
Condition dialog window appears. The command Values by Pointer again displays the
initial pressure head of the node closest to the cursor.

b) Two Chart Tools commands: The Cross-Section Chart and the Boundary-Line Chart.
The Cross-Section Chart command allows users to display a particular variable between
any two points of the transport domain. The Boundary-Line Chart command allows
users to display a particular variable between any two points on the boundary of the
transport domain, or along any line that is drawn along edges of finite elements within the
transport domain. This line hence does not have to be straight, but can turn in any
direction along finite element edges.

c) The Help commands as before.

The Edit Bar for Results and Water Content displays, similarly as for the initial conditions, a
spectrum that is used to draw results, and the minimum and maximum values for the entire
domain. This bar further includes:

a) A Time Layer command to specify which time layers (corresponding to print times
specified in the Output Information dialog window, Fig. 16) are to be displayed. Time
layers can be chosen either from the list box, or from a scroll bar. It is also possible to
perform animation of results by clicking on the Flow Animation check box.

b) Two Chart Tools commands (Cross-Section Chart and Boundary-Line Chart), which
have the same purpose as above for the initial condition. The last command (i.e., Display
Values at Nodes) again causes the value of a particular variable (e.g., water content) of
the node closest to the cursor do be displayed.
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c) The Help command. One useful feature of the Help command here is the Right click on
the Color Scale displays options (a right-click displays the Edit Isoband Value and
Color Spectra dialog window, Fig. 129). Right-clicking results in the display of the pop-
up menu (Fig. 144) that allows users to choose different display options, such as Color
Smoothing, Isolines, and Isobands. These options are defined in more detail below.

Color Smoothing

Min/Max Global in Time
Min/Max Glebal in Space

Standard Scale

Edit Scale and Colors...

Isolines
Colormap
Isosurfaces
Color Points
Color Edges
Velocity Vectors

RN AWES

Figure 144. The Color Scale Display Options menu.

Color Smoothing

Min/Max Global in Time

Min/Max Global in Space

Standard Scale
Custom Scale
Edit Scale and Colors

Isolines
Colormap
Isosurfaces
Color Points
Color Edges
Velocity Vectors

Colors are by default constant between isolines, but change
abruptly at the isoline. Colors change gradually when this option is
checked.

The minimum and maximum values for the color spectrum are
selected based on minimum and maximum values of a certain
variable during the entire simulation.

The minimum and maximum values for the color spectrum are
selected based on minimum and maximum values of a certain
variable in the entire transport domain (even when only part of the
domain is displayed, e.g., one horizontal layer).

Users can select between a standard or user-defined scale.

Users can select between a standard or user-defined scale.

Calls the Edit Isoband Value and Color Spectra dialog window
(Fig. 129).

Displays a selected variable using isolines.

Displays a selected variable using isobands (color spectrum).
Displays a selected variable using isosurfaces.

Displays a selected variable using color points.

Displays a selected variable using color edges.

Displays velocities using velocity vectors.

Figure 145 shows two more Edit Bars, i.e., those for Domain Geometry and FE-Mesh. The
Insert Object of the Domain Geometry Edit Bar allows users to Insert Objects with which a
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transport domain is defined (i.e., points, lines, arcs, circles, splines, surfaces), as well as auxiliary
objects such as dimensions and comments. The Edit Objects part allows objects to be edited
using various actions, such as Move, Copy, Rotate, and Mirror. This Edit Bar also provides
Help on how to Edit Domain Geometry, and to Check Domain Definition.

The FE-Mesh Edit Bar allows quick access to various commands needed for editing and
generating the finite element mesh (Edit FE-Mesh), such as the FE-Mesh Generator (Fig.
Error! Bookmark not defined.), FE-Mesh Parameters (Figs. 94 through 97), Insert Mesh
Refinement (Fig. 99), Delete All Refinements, Generate FE-Mesh, Delete FE-Mesh, and FE-
Mesh Information (Fig. 106). The FE-Mesh Edit Bar also allows users to generate the finite
element mesh step by step (FE-Mesh Advanced), i.e., using individual steps such as
Fundamental Triangulation, Mesh Refinement, Delaunay Retriangulation, Convex
Retriangulation, and Mesh Smoothing. This Edit Bar additionally provides tools to work with
FE-Mesh Sections, allows users to select how to make selections (FE-Mesh Sections) and Help.
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% Point % FE-Mesh Generator...
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?EJ' Arc via 3 Points % Generate FE-Mesh
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hil Dimension &3 Mesh Smoothing
“* Comment

Transform Object

Mesh Refinement

FE-Mesh Sections
%" Cutwith Rectangle

»
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:~D Translate... % Edit Sections

1% Rgtate... & New Section from View
Ak Mirror.. ## Default Sections

J Intersect Lines E& Display whole FE-Mesh
Y& Insert Points on Line %¢# Hide whole FE-Mesh

s itLi
2% SplitLine % Display Previous State

Help & B¥ Toggle Visibility

2 How to Edit Domain... FE-Mesh Selection &
¥ Check Domain Definition Select Mesh Nodes

= Next FE-Mesh [] Select Mesh Elements

Help

¥ How to make FE-Mesh..
= Mext Domain Properties
<2 Back: Domain Definition

»

T 4B Tools T B Tools

Figure 145. Selected Edit Bars (for Domain Geometry and FE-Mesh).
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8.4. Toolbars

Users can use various toolbars that allow an easy access to the most frequently used commands.
These commands are grouped into five toolbars that can be displayed using the command View-
>Toolbars (Fig. 146). Users can also create their own toolbars and customize them in various
ways using the Customize dialog window (Fig. 147).

Toolbars E'
Toolbars:
Standard -
[w] T ol Mew...
o] 1
[ GLI Custornize. ..
[w] Tirne Layer

Bezet

Help

Show Tooltips
[] Large Buttons

Figure 146. The Toolbars dialog window.

Customize

Toolbars| Commands |

Categories: Buttons

File WoMe e WYy HD W T 88
Edit
View 9899w
e bt E = EEEE
Window
Calculation

X

Select a category, then click a button to see its description. Drag the button to
any toolbar

Description

[ oK l l Cancel l l Help ]

Figure 147. The Customize Toolbars dialog window.
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The default toolbars (i.e., Standard Toolbar, Tools Toolbar, View Toolbar, GUI Toolbar, and
Time Layer Toolbar) are briefly summarized below (definitions in each case are from left to
right).

a) Standard Toolbar:

DEEE

New Project Creates a new project.

Open a Project Opens an existing project (represented by the project_name.h3d2
file)

Save Project Saves the input data of the current project specified in the main

program module if the data were either newly created or changed
during an application run.

Project Data Manager Calls the project manager to manage data of existing projects; helps
to locate, open, copy, delete or rename the desired projects and their
data (Figs. 2 and 3).

Print (Ctrl+P) Prints the content of the View window.
Navigator Window Displays or hides the Navigator Window.
Edit Bar Displays or hides the Edit Bar.

b) Tools Toolbar:

S ] @) o
Undo Reverses the last edit actions.
Redo Repeats the last edit actions.
Tools for Selection Select by Rhomboid Selects objects using rhomboid.
Select by Circle Selects objects using circle.
Select by Polygon  Selects objects using polygon.
Add to Selection Add additional objects to existing selection.

Remove from Selection Remove objects from existing selection.
Standard Selection Mode
Grid and Work Plane Settings Calls the Grid and Work Plane dialog window (Fig 137).

Show Grid Shows a Work Plane (axis and origin of the grid) in the View
window.

Set Grid Origin Redefines the origin of the grid.

Snap to Grid Mouse moves in steps given by the grid.

Set XY-Work Plane Sets Work Plane to the XY plane.

Set YZ-Work Plane Sets Work Plane to the YZ plane.

Set XZ-Work Plane Sets Work Plane to the XZ plane.

¢) View Toolbar:

EEECa®R §FIFEF w4

229



Rotate View

Scroll View

Zoom View

Allows objects in the View windows to be rotated using the mouse
while holding the left mouse button.

Allows moving (scrolling) of objects in the View window using
the mouse while holding the left mouse button.

Allows zooming of objects in the View window using the mouse
while holding the left mouse button.

Similar functions can be achieved by pressing various buttons on the keyboard. Rotating is
achieved by holding simultaneously the Ctrl button on the keyboard and the left mouse button.
Scrolling occurs by holding simultaneously the Shift button on the keyboard and the left mouse
button. And finally, zooming is achieved by holding simultaneously the Alt button on the
keyboard and the left mouse button.

Zoom by Rectangle
View All

Previous view

In Reverse Z-direction
View Commands

Isometric View
Perspective View

View Stretching Factors
Rendering Commands

Full Model

Transparent Model

Wire Model
Sections Commands

Cut with Rectangle

Cut with Indexes

Zooms in on a certain part of the View window using a rectangle.
Shows the default view of the View window.
Shows the previous view of a certain part of the View window.
Sets the view of the transport domain in the reverse Z-direction.
Shows a pop-up menu with the following commands:

Isometric

In X-direction

In Y-direction

In Z-direction

In Reverse X-direction

In Reverse Y-direction

In Reverse Z-direction

Perspective

Default View
Specifies the isometric view.
Specifies the perspective view.
Calls the View Stretching Factors dialog window (Fig 138).
Displays a menu with three commands on how to display the
transport domain (see 8.1.4):
Displays the transport domain as a full object.
Displays the transport domain as a transparent object.
Displays the transport domain as a wired object.
Displays a menu with nine commands for editing sections:

Create New Section from Selection
Create New Section from Current View

Display All
Display Previous
Hide Selection

Display only Selection

Display Reverse
Edit Section
Graph Type Commands

Displays a menu with five commands.
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Isolines
Colormap
Isosurfaces
Color Points
Color Edges
Velocity Vectors
Color Scale Options

Color Smoothing
Surface Lighting

Displays the spatial distribution of a certain variable by means of
isolines.

Displays the spatial distribution of a certain variable by means of
color contours.

Displays the spatial distribution of a certain variable by means of
isosurfaces.

Displays the spatial distribution of a certain variable by means of
color points.

Displays the spatial distribution of a certain variable by means of
color edges.

Displays Darcy velocity vectors.

Displays menu with seven commands:

Min/Max Values Global in Time
Min/Max Values Global in Space

Standard Scale
Custom Scale
Edit Scale and Colors

d) GUI Toolbar:
4@ a ars m

View/Edit Domain Geometry
View/Edit FE-Mesh
View/Edit Domain Properties

View/Edit Initial Conditions

Sets the View window to View/Edit Domain Geometry mode.
Sets the View window to View/Edit FE-Mesh mode.

Sets the View window to View/Edit Domain Properties mode,
to edit materials.

Sets the View window to View/Edit Initial Conditions mode, to
edit pressure head initial conditions.

View/Edit Boundary Conditions Sets the View window to View/Edit Boundary Conditions

Execute Calculation
View Results

e) Time Layer Toolbar:

Tirne 1 - 0020 daps v MW

List box of Time Layers
First Time Layer
Previous Time Layer
Next Time Layer

Last Time Layer

Flow Animation

mode, to edit water flow boundary conditions.

Executes a HYDRUS version 3.0 FORTRAN application.

Sets the View window to View Results mode, to view the
pressure head distribution.

Displays a list box with Time Layers with available results.
Displays the first time layer.

Displays the previous time layer.

Displays the next time layer.

Displays the last time layer.

Displays time layers of a particular variable consecutively and
continuously.
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8.5. HYDRUS Menus

The main window of HYDRUS contains a menu that has ten submenus, i.e., File, Edit, View
(Fig. 148), Insert, Calculations, Results (Fig. 149), Tools, Options, Windows, and Help (Fig.
150). Table 25 lists the main groups, the main menu items, as well as the main submenu and sub-
submenu commands. Table 26 then provides brief descriptions of all menu commands.

mEdﬂ: View Insert Calculation RE View Insert Calculation Resul View | Insert Calculation Results Tools C

10 New 4l Geornetry
= Open £7] EE Mesh
l Close Copy Ctrl+C [#] Domain Properties
: Save ¢ Initial Conditions
save As Select : % Boundary Condions
& Save Al =

Save Specil » B Find.. Ctrl+F % E;_\tfisator

I ar

Import and Export " 4§ Delete Al Tabs in View
&5 Print... Ctrl+P ._ Status bar

Print Preview Domain Geometry ’ 2% Toolbars

) ] Flow and Transport Parameters ¥

Print to the Clipboard Ctrl+C FE-Mesh R an ArrangE_toolbars

Print Options... Domain Properties R 2% Customize toolbars..,

Printer Setup... nitial condition y | &L Standard View

Project Information... Boundary Conditions 4 l?‘i i?;m‘qﬁy EED
Project Manager... Sections b @ Erwinuswew

1 C:\USSL\...\3D_Tests\Test2.H3D Cross-Sections * | % Dynamic View (Scroll, Zoom , Rotate)

2 C:\USSL\...\Furrow.H3D Aundliary Objects Y45 View Stretching...

3 C:\USSL\...\3D_Tests\Dike.H3D TR TIIL) T * | I Perspective

4 C:\USSL\...\Dike_1.H3D %" Auto-Rotate

5 C:\USSL\...\3D_Tests\Test8.H3D Wiew in Direction +

6 C:\USSL\...\3D_Tests\Test6.H3D
7 C:\ussly... \ANNEMIEK\00 1.H3D
8 C:\USSL\...\ANNEMIEK\OOO.H3D

Exit Ctrl+F4

Figure 148. The HYDRUS Menus | (File, Edit, and View).
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Calculatinn Results [ Calculation | Results Tools Options  Results | Tools  Options  Window  Help

Domain Geometry L4 E& FE-Mesh Parameters... Display Quantity

FE-Mesh Refinement ¥ Beundary Infermation

?E.l:?in Er;serties : i Delete FE-Mesh Observation Points...
nitial condition ; icti
él:uundar Conditions » TR Soil Hydraulic Properties...
E . ¥ ' \ Advanced FE-Mesh Generation r Run Time Information...
ross-Sections )
Mesh Line y B3 Calculate Current Project... Mass Balance Information...
Li K _
Auxliary Obiecks , Fij Calculate All Open Projects...
=5 Select Projects to Calculate... Convert Qutput to ASCIL..
Tirne Layer
Charts

Flowing Particles

ﬁﬂ Delete Results...

Figure 149. The HYDRUS Menus Il (Insert, Calculations, and Results).
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snap to Grid ] &raph Type ¥ | B0 Arrange Symbals
B Grid and Work Plane | v | & -:I 1
Display Options Main and Secondar
Define Work Plane . N Ry Lp B 4
. _5& Pragram Opkions. .. = Tile Horizontally
¥ Coordinate System...
T Tile Vertically
Color Scale k % Cascade
%, Translate.. B Close al
"% Rotate..,
o 1 0001*, Domain Properties, Material Diskribution
Ab Mirror...
o
«o+  Stretch..,
e Skew.. K? Context Sensitive Help... Shift+FL
J Intersect Lines @&’ Help - Contents and Index...  F1
5plit Lines ’ @ Hydrus User Manual...

Hydrus Technical Manual...
Check Geometry... &L Hydrus Online...

& §

Bepair Geometry Troubleshooting..,

Hydrus License and Activation...

= Create Video File... About Hydrus...
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Figure 150. The HYDRUS Menus Il (Tools, Options, Windows, and Help).
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Table 25. HYDRUS menu commands.

Group Menu Submenu Sub-Submenu

A File New
Open
Close

Save
Save As
Save All

Import and Export Import Hydrus-2D Project
Import Input Data from *.IN Files
Import Input Data from another HYDRUS Project
Export Data for Hydrus Solver in Text Format
Export Data to ParSWMS
Read Points from a Text File
Import Geometry from a Text File
Import Geometry from a DXF File
Import Geometry from a TIN File
Export Geometry to a Text File
Export only Selected Objects
Import Data from ParSWMS

Print

Print Preview

Print to the Clipboard
Print Options

Print Setup

Project Information
Project Manager

Recent Files
Exit

B Edit Undo
Redo

Copy
Paste

Select Select by Rhomboid
Select by Circle
Select by Polygon
Add to Selection
Remove from Selection
Standard Selection Mode

Properties

Find

Delete

Delete All

Domain Geometry Domain Type and Units
Simple Domain
3D-Layered Domain
Delete 3D-Layered Domain
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Flow Parameters

FE-Mesh

Domain Properties

Points

Lines

Surfaces
Openings
Thickness Vectors
Solids

Main Processes

Inverse Solution

Time Information
Output Information
Water Flow Parameters

Solute Transport Parameters

Heat Transport Parameters
Root Water Uptake

Variable Boundary Condition

Data for Inverse Solution

FE-Mesh Parameters
Generate FE-Mesh
Delete FE-Mesh

Remove Selected FE-Elements

FE-Mesh Statistics

Iteration Criteria

Hydraulic Properties Model
Soil Hydraulic Parameters
Anisotropy Tensors
General Information

Solute Transport Parameters
Solution Composition
Solute Reaction Parameters
Wetlands Parameters |
Wetlands Parameters |1
Temperature Dependence
Water Content Dependence
Chemical Parameters
Fumigant Application

Root Water Uptake Models
Pressure Head Reduction
Osmotic Head Reduction

Advanced FE-Mesh Generation Fundamental Triangulation

Select Mesh Nodes
Select Mesh Elements
Material Distribution
Root Distribution
Nodal Recharge
Scaling Factor

Local Anisotropy

Subregions
Observation Nodes
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Mesh Refinement
Homogeneous Triangulation
Check of Convexity

Mesh Smoothing

Hydraulic Conductivity
Pressure Head

Water Content

Angle

First Component
Second Component
Index

Edit in View
Delete



Initial Conditions

Boundary Conditions

Clear All
Drains Edit in View
Delete
Clear All
Drain Parameters
Flowing Particles Edit in View
Delete
Clear All
Stochastic Distribution of S.F.
Subregions = Material Distribution
Nonequilibrium Conc. = a * Equil. Conc.
Parameters for Root Distribution
Delete All Domain Properties
Default Domain Parameters

Pressure Head/Water Content
Concentration
Nonequilibrium Concentration
Temperature

Import

Delete All Initial Conditions

Water Flow

Solute Transport

Heat Transport

Boundary Conditions Options
Delete All Boundary Conditions

Edit Properties and Conditions on FE-Mesh
Edit Properties and Conditions on Geometric Objects
Transfer all Properties to FE-Mesh

Model Sections

Cross-Sections

Auxiliary Objects

Background Layers

Edit Sections

Generate Sections

New Section from Selection
New Section from View
Display Whole Domain
Display Previous

Hide Selection

Display only Selection
Display Reverse

Cut with Rectangle

Cut with Indexes

Import FE-Mesh Sections

Edit

Delete Selected

Delete All

Auto-Adjust Work Plane

Dimensions Delete Selected
Delete All

Comments Edit
Delete Selected
Delete All

Edit

Move

Rotate

Mirror
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C View

D

Insert

Stretch
Skew
Delete All

Geometry

FE Mesh

Domain Properties
Initial Conditions
Boundary Conditions
Results

Navigator
Edit Bar
Tabs in View
Status Bar

Toolbars
Arrange Toolbars
Customize Toolbars

Standard View

Zoom by Rectangle

View All

Previous View

Dynamic View (Scroll, Zoom, Rotate)
View Stretching

Perspective

Auto-Rotate

Cancel Partial View

View in Direction Isometric
In X-direction
In Y-direction
In Z-direction
Reverse X-direction
Reverse Y-direction
Reverse Z-direction

List Boxes for Inverse Data

Domain Geometry Points Graphically
Dialog
Read from File
Lines Line
Polyline
Arc
Circle
Spline
Surfaces Rectangle Graphically
Planar
Quadrangle
Rotary
Pipe
B-Spline
Openings Graphically
Dialog
Thicknesses Graphically
Dialog
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E Calculation

FE-Mesh Refinement

Domain Properties

Initial Conditions

Boundary Conditions

Cross-Sections
Mesh Line

Auxiliary Objects

FE-Mesh Parameters
Generate FE-Mesh

Delete FE-Mesh

FE-Mesh Statistics

Advance FE-Mesh Generation

Solids

Graphically

Dialog

Material Distribution
Root Distribution
Nodal Recharge
Scaling Factor

Local Anisotropy

Subregions

Observation Nodes

Drains

Flowing Particles

Pressure Head/Water Content
Concentration
Nonequilibrium Concentration
Temperature

Import

Water Flow

Solute Transport

Heat Transport

Graphically
Dialog
Graphically
Dialog

Dimension
Comment

Bitmap
Background Layer

Fundamental Triangulation
Mesh Refinement
Retriangulation

Check of Convexity

Mesh Smoothing
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Graphically - Block
Layered Solid
General Solid

Hydraulic Conductivity
Pressure Head

Water Content

Angle

First Component
Second Component
Index

No Flux

Constant Head
Constant Flux
Seepage Face
Variable Head 1-4
Variable Flux 1-4
Free Drainage
Deep Drainage
Atmospheric Boundary
First-Type
Third-Type
Volatile Type
First-Type
Third-Type



F Results

G Tools

Calculate Current Project
Calculate All Open Projects
Select Projects to Calculate

Display Quantity Pressure Heads
Water Content
Concentration
Nonequilibrium Concentration
Temperature
Velocity

Boundary Information Pressure Heads
Boundary Fluxes
Cumulative Fluxes
Solute Fluxes

Observation Points

Soil Hydraulic Properties

Run Time Information

Mass Balance Information

Chemical Mass Balance Information

Convert Output to ASCII

Inverse Solution Results

Fluxes across Mesh Lines

Time Layer First
Last
Previous
Next
Animation

Charts Cross-Section
Boundary Line
Mesh-Line

Flowing Particles Draw Particles Positions
Draw Particles Trajectories

Delete Results

Show Grid

Shap to Grid

Grid and Work Plane

Define Work Plane Set Origin
Define XY
Define YZ
Define XZ

Coordinate System

Color Scale Color Smoothing
Min/Max Values Global in Time
Min/Max Values Global in Space
Standard Scale
Custom Scale
Edit Scale

Translate

Rotate

Mirror

Stretch

Skew

Intersect Lines

Intersect Surfaces

Split Lines Graphically
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H Options
I Windows
J Help

Insert Points on Line

Check Data Consistency

Repair Geometry

Generate Domain Surfaces

Create Video File

Rendering Mode

Graph Type

Display Options

Program Options

New Window
Arrange Symbols
Main and Secondary
Tile Horizontally
Tile Vertically
Cascade

Close All

Context Sensitive Help
Help — Contents and Index
Hydrus User Manual
Hydrus Technical Manual

Hydrus Online
Troubleshooting

Hydrus License and Activation

About Hydrus

n Points
Distance
Graphically
n Points
Distance

Solid Model
Transparent Model
Wire Frame Model
Isolines
Colormaps
Isosurfaces

Color Points
Color Edges
Velocity Vectors
Edit

Default

Read

Save As
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Table 26. Brief description of HYDRUS menu commands.

Group Command

Brief description of the command

A

File

New

Open

Close

Save

Save As

Save All

Creates a new project after user provides required information (hame
and description) in the New Project dialog window (Fig. 4). Project

will be located in the current Project Group.

Opens an existing project (represented by the project_name.h3d2
file) using the Open dialog window, which a user uses to browse for

the HYDRUS project.
Closes an open project.

Saves the input data of an actual project specified in the main
program module if the data were either newly created or changed

during an application run.

Saves data of a particular project under a new project name using

Save As dialog window.
Saves data of all projects.

Import and Export

Import Hydrus-2D Project
Import Input Data from *.IN Files

Import Input Data from another HYDRUS Project Imports data from another project and interpolates

Export Data for Hydrus Solver

Export Data to ParSWMS

Read Points from a Text File
Import Geometry from a Text File
Import Geometry from a DXF File
Import Geometry from a TIN File
Export Geometry from a Text File
Export only Selected Objects
Imports Data from ParSWMS

Print
Print Preview

Print to the Clipboard

Print Options

Print Setup

Project Information

Project Manager

Imports Hydrus-2D projects from Version 2.0.
manually outside of the HYDRUS GUI.

properties when FE-Mesh grids are different.

writes outputs.

ParSWMS from the HYDRUS project.
Reads single point coordinates from a text file.

Prints the content of the View window.

Previews the content of the View window before printing.

Copies the content of the View window to the clipboard for
subsequent pasting into other software packages.

Select various print options, such as print quality, text size, frame,

and text content (Fig. 172).
Selects a printer and printer connection.

dialog window (Fig. 4)).

desired projects and their data.
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Imports input data from *.in files that may have been modified

Exports data for the HYDRUS solver into the working directory
from which the computational module reads inputs and into which it

ParSWMS is a parallelized version of SWMS-3D, which can be run
on clusters or supercomputers. This commands creates input files for

Reads definition of the entire geometry from a text file.

Reads definition of the entire geometry from a DXF file.

Reads definition of the entire geometry from a TIN file.

Writes definition of the entire geometry to a text file.

Writes definition of the selected objects to a text file.

Imports output data created by ParSWMS on a supercomputer or
cluster of computers and display them in HYDRUS GUI.

Displays information about the current project (in the General Data

Calls the Project Manager (Figs. 2 and 3) to manage data of
existing projects; helps to locate, open, copy, delete or rename the



Recent Files
Exit

Edit

Undo
Redo

Copy
Paste

Select

Select by Rhomboid
Select by Circle

Select by Polygon

Add to Selection
Remove from Selection
Standart Selection Mode

Properties
Find

Delete
Delete All

Domain Geometry
Domain Type and Units

Simple Domain

3D-Layered Domain
Delete 3D-Layered Domain
Points

Lines

Surfaces

Openings

Thickness Vectors

Solids

Flow Parameters
Main Processes

Inverse Solution

Time Information

Displays recently opened projects.

Closes open projects and leaves the program. This command
informs users before exiting the application whether or not the input
data of open projects were changed during the application run. If
changes did occur, users are given an option to save data before
exiting the application.

Reverses the last edit action.
Repeats the last edit action.

Copies a selected object.
Pastes a selected object.

Selects objects by means of a rhomboid.
Selects objects by means of a circle.
Selects objects by means of a polygon.
Add new object to existing selection
Remove objects from existing selection
Selects objects by means of a qvadrilateral.

Displays properties of a selected object.
Finds an object.

Deletes a selected object.
Deletes all objects.

Specifies whether the flow and transport problem occurs in a two-
or three-dimensional transport domain, and whether the domain is
simple or complex using the Domain Type and Units dialog
window (Fig. 6).

Specifies parameters (dimensions and slopes) for simple rectangular
or hexahedral transport domains using the Rectangular (Fig. 10) or
Hexahedral Domain Definition (Fig. 11) dialog windows.

Calls Edit 3D-Layered Domain dialog window for editing the object.
Deletes 3D-Layered Domain.

Edits selected points.

Edits selected lines using the Edit Curve dialog window (Fig. 46).
Edits selected surfaces.

Edits selected openings.

Edits selected thickness vectors.

Edits solids.

Selects the processes to be simulated, i.e., water flow, multiple
solute transport, heat transport, and/or root water uptake (the Main
Processes dialog window (Fig. 12)).

Selects type of weighting of measured data, and whether soil
hydraulic parameters, solute transport parameters, and/or heat
transport parameters, are to be fitted (the Inverse Solution dialog
window (Fig. 13)).

Selects time units, and gives the time discretization information (the
Time Information dialog window (Fig. 15)).
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Output Information

Water Flow Parameters
Iteration Criteria

Hydraulic Properties Model

Soil Hydraulic Parameters

Anisotropy Tensors

Solute Transport Parameters
General Information

Solute Transport Parameters

Solution Composition

Solute Reaction Parameters
Constructed Wetlands Parameters |
Constructed Wetlands Parameters |1

Temperature Dependence

Water Content Dependence

Chemical Parameters

Fumigant Application

Heat Transport Parameters

Root Water Uptake
Root Water Uptake Models

Pressure Head Reduction

Osmotic Head Reduction

Specifies print options (The Output Information dialog window
(Fig. 16)).

Specifies iteration criteria for the solution precision and parameters
for the time step control (The Iteration Criteria dialog window
(Fig. 17)).

Selects the type of model used for the soil hydraulic properties, and
decides whether hysteresis is to be considered (the Soil Hydraulic
Model dialog window (Fig. 18)).

Specifies parameters in the soil hydraulic model (the Water Flow
Parameters dialog window (Fig. 19)).

Defines anisotropy tensors for three-dimensional applications (the
Tensors of Anisotropy dialog window (Fig. 22)).

Selects the time and spatial weighting schemes for numerical
solution of the solute transport equation; specifies the number of
solutes to be considered (the Solute Transport dialog window (Fig.
23)).

Specifies solute transport parameters (the Solute Transport
Parameters dialog window (Fig. 25)).

Specifies solution, adsorbed, and precipitated concentration
combinations for the UNSATCHEM module (the Solution
Compositions dialog window (Fig. 30)).

Specifies solute reaction parameters (the Solute Reaction
Parameters dialog window (Fig. 26)).

Specifies parameters for constructed wetlands (the Constructed
Wetland Model Parameters I dialog windows (Fig. 38)).
Specifies parameters for constructed wetlands (the Constructed
Wetland Model Parameters Il dialog windows (Fig. 40)).
Specifies parameters defining the temperature dependence of
reaction and transport parameters (the Temperature Dependent
Solute Transport and Reaction Parameters dialog window shown in
Figure 28).

Specifies parameters defining the water content dependence of
reaction parameters (the Water Content Dependent Solute Reaction
Parameters dialog window shown in Figure 29).

Specifies various chemical parameters and selections for the
UNSATCHEM module (the Chemical Parameters dialog window
(Fig. 31)).

Allows additional application of a specified mass of a chemical
into the transport domain (a specified location) at specified time.

Specifies heat transport parameters (the Heat Transport dialog
window; Fig. 32).

Selects the root water uptake stress response models for both salinity
and water stress (the Root Water Uptake Model dialog window,
Fig. 33).

Specifies parameters in the root water uptake water stress response
model (the Root Water Uptake Parameters dialog window; Fig.
34).

Specifies parameters in the root water uptake salinity stress response
model (the Root Water Uptake Parameters dialog window; Fig.
35).
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Variable Boundary Condition

Data for Inverse Solution

FE-Mesh
FE-Mesh Generator

FE-Mesh Parameters

Generate FE-Mesh
Delete FE-Mesh
Remove Selected FE-Elements

FE-Mesh Statistics

Select Mesh Nodes

Select Mesh Elements

Advanced FE-Mesh Generation
Fundamental Triangulation

Mesh Refinement

Retriangulation
Check of Convexity

Mesh Smoothing

Domain Properties
Material Distribution
Root Distribution
Nodal Recharge

Scaling Factor
Hydraulic Conductivity

Pressure Head
Water Content

Local Anisotropy
Angle
First Component

Second Component

Specifies time-dependent boundary conditions for all transport
processes (the Time Variable Boundary Conditions dialog
window; Fig. 37).

Specifies data for the inverse solution, their type, location and
associated weight (the Data for Inverse Solution dialog window;
Fig. 14).

Selects the structured or unstructured finite element mesh generator
(the Finite Element Mesh Generator dialog window; Fig. Error!
Bookmark not defined.).

Specifies either parameters of the Unstructured Finite Element
Mesh Generator (the FE-Mesh Parameters dialog window; Figs.
94 through 97) or parameters of the structured mesh (the
Rectangular Domain Discretization dialog window (Fig. 92) or
the Hexahedral Domain Discretization dialog window (Fig. 93)).
Generates unstructured finite element mesh.

Deletes unstructured finite element mesh.

Removes selected finite elements from the finite element mesh. Note
that this operation should not be performed when properties are
specified on Geometric Objects.

Provides information about finite element mesh (the FE-Mesh
Information dialog window (Fig. 106).

Selects FE-Mesh nodes. This command is usually used to select
nodes that are then either used to define the new FE-Mesh Section or
removed from the FE-Mesh.

Selects FE-Mesh elements (to perform similar operations as for
selected mesh nodes).

Performs triangulation of boundary nodes based on the Delaunay
criterion.

Inserts a new point in the center of all triangles that do not fulfill the
smoothness criterion.

Retriangulates mesh according to Delaunay criterion.

Corrects possible errors which may appear during smoothing and
retriangulating.

Smoothes the mesh by solving a set of coupled elliptic equations
using a recursive algorithm.

Specifies the spatial distribution of soil materials.
Specifies the spatial distribution of root water uptake.
Specifies the spatial distribution of nodal recharge.

Specifies the spatial distribution of hydraulic conductivity scaling
factors.

Specifies the spatial distribution of pressure head scaling factors.
Specifies the spatial distribution of water content scaling factors.

Specifies the spatial distribution of the angle of local anisotropy.
Specifies the spatial distribution of the first component of local
anisotropy.

Specifies the spatial distribution of the second component of local
anisotropy.
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Index

Subregions

Observation Nodes
Edit

Delete
Clear All

Drains

Edit

Delete

Clear All

Drain Parameters

Flowing Particles
Edit

Delete

Clear All

Stochastic Distribution of S.F.
Subregions = Material Distribution

Specifies the spatial distribution of the index that represents the local
anisotropy tensor.

Specifies the spatial distribution of subregions for the mass balance
calculations.

Specifies observation nodes for output of the pressure head, water
content, temperature, and concentration at each time step.

Deletes selected observation nodes.

Deletes all observation nodes.

Specifies nodal points representing tile drains.
Deletes selected tile drains.

Deletes all tile drains.

Specifies drain parameters.

Specifies nodal points representing flowing particles.
Deletes selected flowing particles.
Deletes all flowing particles.

Generates a stochastic distribution of scaling factors.
Makes the subregions for mass balance calculations similar to those
for the soil materials.

Nonequilibrium Conc. = a * Equil. Conc. Specifies that nonequilibrium concentrations (i.e., kinetically sorbed

Parameters for Root Distribution
Delete All Domain Properties

Default Domain Parameters

Initial Conditions
Pressure Head/Water Content
Concentration

Nonequilibrium Concentration

Temperature
Import

Delete All Initial Conditions

Boundary Conditions
Water Flow

Solute Transport

Heat Transport

Boundary Conditions Options

Deletes All Boundary Conditions

concentrations or concentrations in the immobile water) are a
multiple of the liquid phase concentrations.

Specifies parameters for the spatial distribution of root water uptake.
Command used when defining properties on Geometric Objects.
Deletes all defined domain properties and assigns default values.
Specifies default domain properties that are constant for the same
depths (the Default Domain Properties dialog window; Fig. 108).

Specifies the initial condition for water flow.

Specifies the initial condition for solute transport (equilibrium
concentrations).

Specifies the initial condition for solute transport (nonequilibrium
concentrations).

Specifies the initial condition for heat transport.

Imports the initial condition from previous simulations for water
flow, and solute and heat transport.

Command used when defining Initial Conditions on Geometric
Objects. Deletes all defined Initial Conditions and assigns default
values.

Specifies boundary conditions for water flow.

Specifies boundary conditions for solute transport.

Specifies boundary conditions for heat transport.

Specified additional system-dependent water flow boundary
conditions.

Clears all boundary conditions and assigns a No Flow boundary
condition on all boundaries
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Edit Properties and Conditions on FE-Mesh  Selects that spatially variable properties (e.g., materials, initial

conditions) are assigned directly to the FE-Mesh rather than to
Geometric Objects

Edit Properties and Conditions on Geometric Objects Selects that spatially variable properties (e.g., materials,

Transfer all Properties to FE-Mesh

Model Sections
Edit Sections

Generate Sections

New Section from Selection
New Section from View
Display Whole Domain
Display Previous Partial View
Hide Selection

Display only Selection
Display Reverse

Cut with Rectangle

Cut with Indexes
Import FE-Mesh Sections

Cross-Sections

Edit

Delete Selected

Delete All

Auto-Adjust Work Plane

Auxiliary Objects
Dimensions

Delete Selected
Delete All

Comments
Edit

Delete Selected
Delete All

Background Layers

Edit
Move
Rotate
Mirror
Stretch
Skew
Delete All

View

Geometry
FE Mesh

initial conditions) are assigned to Geometric Objects
Transfer all properties (e.g., materials, initial conditions) from
Geometric Objects to FE-Mesh

Calls the FE-Mesh Section dialog (Fig. 107). HYDRUS recognizes
two different definitions of Sections — one for geometric objects and
one for the FE-mesh. A different dialog appears when called from
the “Domain Geometry” part of the program. In all other cases, the
FE-mesh Section dialog appears.

Generates Geo-Sections and FE-Mesh Sections.

Creates a new section from currently selected objects/FE-Mesh
Creates a new section from currently displayed objects/FE-Mesh
Displays all objects or entire FE-Mesh

Displays a previously displayed view (sections)

Hides selected elements.

Displays only currently selected objects/FE-Mesh

Hides currently displayed objects/FE-Mesh and displays currently
hidden objects/FE-Mesh

Displays objects/FE-mesh nodes within a certain rectangle or
rhomboid and hides all the others

Displays objects with given indexes and hides all the others

Import FE-Mesh Sections

Edits a cross-section

Deletes selected cross-sections
Deletes all cross-sections
Adjust Work Plane

Deletes selected dimensions
Deletes all dimensions

Edits a comment
Deletes selected comments
Deletes all comments

Geometric objects that are imported to HYDRUS and are used as
templates for defining HYDRUS geometries

Edits a selected Background Layer

Moves a selected Background Layer

Rotates a selected Background Layer

Mirrors a selected Background Layer

Stretches a selected Background Layer

Skews a selected Background Layer

Deletes all Background Layers

Sets the View window to View/Edit Domain Geometry mode.
Sets the View window to View/Edit FE-Mesh mode.
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Domain Properties
Initial Conditions
Boundary Conditions

Results

Navigator
Edit Bar
Tabs in View
Status Bar

Toolbars

Arrange Toolbars
Customize Toolbars

Standard View

Zoom by Rectangle
View All

Previous View
Dynamic View (Scroll, Zoom, Rotate)

View Stretching

Perspective
Auto-Rotate

Cancel Partial View

View in Direction
Isometric

In X-direction

In Y-direction

In Z-direction
Reverse X-direction
Reverse Y-direction
Reverse Z-direction

List Boxes for Inverse Data

Insert

Domain Geometry
Points

Graphically

Dialog

Sets the View window to View/Edit Domain Properties mode, to
edit materials.

Sets the View window to View/Edit Initial Conditions mode, to
edit pressure head initial conditions.

Sets the View window to View/Edit Boundary Conditions mode, to
edit water flow boundary conditions.

Sets the View window to View Results mode, to view pressure
head distribution.

Displays or hides the Navigator window.
Displays or hides the Edit Bar.

Displays or hides Tabs in the View window.
Displays or hides the Status Bar.

Selects which toolbars are to be displayed (the Toolbars dialog
window, Fig. 146).

Arranges toolbars.

Customizes toolbars (the Customize Toolbars dialog window, Fig.
Fig. 147).

Sets a default viewing direction (in 3D) and performs the “View
All” command

Zooms in on a certain part of the View window using a rectangle.
Changes a scroll position and a zoom factor so that all currently
displayed objects are visible in the View Window. This command
does not change the viewing direction.

Shows the previous view on a certain part of the View window.

Sets the View windows so that dynamic actions can be carried out
with a cursor. Moving the cursor while holding the left mouse
button allows the object to be displayed in a different part of the
View window. Pressing the Shift button on the keyboard allow
zooming actions around the cursor.

Calls the View Stretching Factors dialog window (Fig. 138) and
adjust stretching factors.

Sets perspective view.

Starts Autorotate function that will rotate the transport domain in
the View window.

Cancels the Partial View displays the entire transport domain.

Sets isometric view.

Sets the view of the transport domain in the X-direction.

Sets the view of the transport domain in the Y-direction.

Sets the view of the transport domain in the Z-direction.

Sets the view of the transport domain in the reverse X-direction.
Sets the view of the transport domain in the reverse Y-direction.
Sets the view of the transport domain in the reverse Z-direction.

Shows text information in the inverse data list (the Data for Inverse
Solution dialog window; Fig. 14).

Inserts single points graphically.
Inserts single points numerically (the Edit Point dialog window
without the FE-Mesh tab; Fig. 44).
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Lines
Line

Polyline

Arc
Circle
Spline

Surfaces

Planar Surface
Quadrangle Surface
Rotary Surface
Pipe Surface
B-Spline Surface
Openings
Thicknesses
Solids

Layered Solid
General Solid

FE-Mesh Refinement
Graphically

Dialog

Domain Properties
Material Distribution
Root Distribution
Nodal Recharge

Scaling Factor
Hydraulic Conductivity

Pressure Head
Water Content

Local Anisotropy
Angle

First Component
Second Component

Index

Subregions
Observation Nodes

Drains
Flowing Particles

Initial Conditions
Pressure Head/Water Content

Inserts a line either graphically or numerically (the Edit Curve
dialog window without the FE-Mesh tab; Fig. 46).

Inserts a polyline either graphically or numerically (the Edit Curve
dialog window without the FE-Mesh tab; Fig. 46).

Inserts an arc either graphically or numerically.

Inserts a circle either graphically or numerically.

Inserts a spline either graphically or numerically (the Edit Curve
dialog window without the FE-Mesh tab; Fig. 46).

Inserts a surface either graphically or numerically.

Inserts a planar surface either graphically or numerically.
Inserts a Quadrangle surface either graphically or numerically.
Inserts a Rotary surface either graphically or numerically.
Inserts a Pipe surface either graphically or numerically.
Inserts a B-Spline surface either graphically or numerically.
Inserts an opening either graphically or numerically.

Inserts thicknesses either graphically or numerically.
Inserts solids either graphically or numerically.

Inserts Layered solids either graphically or numerically.
Inserts General solids either graphically or numerically.

Inserts new FE-mesh refinement graphically (the FE-Mesh
refinement dialog window; Fig. 99).
Defines new FE-mesh refinement graphically (the FE-Mesh
refinement dialog window; Fig. 99).

Specifies the spatial distribution of soil materials.
Specifies the spatial distribution of root water uptake.
Specifies the spatial distribution of nodal recharge.

Specifies the spatial distribution of the hydraulic conductivity
scaling factors.

Specifies the spatial distribution of the pressure head scaling factors.
Specifies the spatial distribution of the water content scaling factors.

Specifies the spatial distribution of the angle of local anisotropy (for
two-dimensional applications).

Specifies the spatial distribution of the first component of local
anisotropy (for two-dimensional applications).

Specifies the spatial distribution of the second component of local
anisotropy (for two-dimensional applications).

Specifies the spatial distribution of anisotropy tensors (for three-
dimensional applications).

Specifies the spatial distribution of subregions for mass balance
calculations.

Specifies observation nodes for output of the pressure head, water
content, temperature, and concentration at each time step.

Specifies nodal points representing tile drains.

Specifies nodal points representing flowing particles.

Specifies the initial condition for water flow.
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Concentration

Nonequilibrium Concentration

Temperature
Import

Boundary Conditions
Water Flow
No Flux

Constant Head
Constant Flux
Seepage Face
Variable Head 1-4
Variable Flux 1-4
Free Drainage
Deep Drainage

Atmospheric Boundary

Solute Transport
First-Type

Third-Type

Volatile Type

Heat Transport
First-Type

Third-Type

Cross-Sections
Graphically
Dialog

Mesh Line
Graphically
Dialog

Auxiliary Objects
Dimension
Comment

Bitmap

Background Layer

Calculation

FE-Mesh Parameters

Specifies the initial condition for solute transport.

Specifies the initial condition for nonequilibrium solute transport.
Specifies the initial condition for heat transport.

Imports initial conditions for water flow, solute transport, and/or
heat transport.

Specifies a no-flux boundary condition along a selected part of the
boundary.

Specifies a constant pressure head boundary condition along a
selected part of the boundary.

Specifies a constant flux boundary condition along a selected part of
the boundary.

Specifies a seepage face boundary condition along a selected part of
the boundary.

Specifies a variable pressure head boundary condition along a
selected part of the boundary.

Specifies a variable flux boundary condition along a selected part of
the boundary.

Specifies a free drainage boundary condition along a selected part of
the boundary.

Specifies a deep drainage boundary condition along a selected part
of the boundary.

Specifies an atmospheric boundary condition along a selected part of
the boundary.

Specifies a first-type boundary condition for solute transport along a
selected part of the boundary.

Specifies a third-type boundary condition for solute transport along a
selected part of the boundary.

Specifies a volatile-type boundary condition for solute transport
along a selected part of the boundary.

Specifies a first-type boundary condition for heat transport along a
selected part of the boundary.
Specifies a third-type boundary condition for heat transport along a
selected part of the boundary.

Inserts a cross-section graphically.
Inserts a cross-section using the dialog window.

Inserts a mesh line graphically.
Inserts a mesh line using the dialog window.

Inserts auxiliary object (dimensions).
Inserts auxiliary object (comment).

Inserts auxiliary object (bitmap).

Inserts auxiliary object (background layer).

Specifies either parameters of the Unstructured Finite Element
Mesh Generator (the FE-Mesh Parameters dialog window; Figs.
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Generate FE-Mesh
Delete FE-Mesh
FE-Mesh Statistics

Advanced FE-Mesh Generation
Fundamental Triangulation

Mesh Refinement

Retriangulation
Check of Convexity

Mesh Smoothing

Calculate Current Project
Calculate Current Project
Select Projects to Calculate

Results

Display Quantity

Pressure Head

Water Content

Velocity

Concentration

Nonequilibrium Concentration

Temperature

Boundary Information
Pressure Heads

Boundary Fluxes
Cumulative Fluxes

Solute Fluxes

Observation Points

Soil Hydraulic Properties
Run Time Information

Mass Balance Information

Chemical Mass Balance Information

Convert Output to ASCII
Inverse Solution Results
Fluxes across Mesh Lines

Time Layer
First

94 through 97) or parameters of the structured mesh (the
Rectangular Domain Discretization dialog window (Fig. 92) or
the Hexahedral Domain Discretization dialog window (Fig. 93)).
Generates the unstructured finite element mesh.

Deletes the unstructured finite element mesh.

Provides information about the finite element mesh (the FE-Mesh
Information dialog window (Fig. 106).

Performs triangulation of boundary nodes based on the Delaunay
criterion.

Inserts a new point in the center of all triangles that do not fulfill the
smoothness criterion.

Retriangulates mesh according to Delaunay criterion.

Corrects possible errors which may appear during smoothing and
retriangulating.

Smoothes the mesh by solving a set of coupled elliptic equations
using a recursive algorithm.

Carries out calculations for the currently active project.
Carries out calculations for all currently open projects.
Opens the Project Manager to select projects to be calculated.

Displays results in terms of pressure heads.

Displays results in terms of water contents.

Displays results in terms of velocities.

Displays results in terms of concentrations

Displays results in terms of nonequilibrium concentrations
(kinetically sorbed or in the immobile water)

Displays results in terms of temperatures

Graphical presentation of pressure heads at different boundaries and
in the root zone.

Graphical presentation of potential and actual boundary water fluxes
at different boundaries.

Graphical presentation of potential and actual cumulative boundary
water fluxes.

Graphical presentation of actual and cumulative boundary solute
fluxes.

Graphical presentation of changes in water content, pressure head,
temperature, and/or solute and sorbed concentration at specified
observation nodes.

Graphical presentation of the soil hydraulic properties.

Graphical presentation of information about the number of iterations,
time step, and Peclet and Courant numbers.

Displays mass balance information and mean profile properties.
Displays chemical mass balance information.

Convert binary input and output files into ASCII files.

Displays information about the inverse solution.

Displays actual and cumulative, water and solute fluxes across
selected mesh lines.

Displays a particular variable at the first time layer.
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Last
Previous
Next
Animation

Charts
Cross-Section

Boundary Line

Mesh Line

Flowing Particles
Draw Particles Positions
Draw Particles Trajectories

Delete Results

Tools

Show Grid
Shap to Grid

Grid and Work Plane

Define Work Plane
Set Origin
Define XY
Define YZ
Define XZ

Coordinate System

Color Scale
Color Smoothing

Min/Max Values Global in Time

Min/Max Values Global in Space

Standard Scale
Custom Scale
Edit Scale

Translate
Rotate
Mirror
Stretch
Skew

Intersect Lines

Intersect Surfaces
Split Lines
Insert Points on Line

Check Geometry
Repair Geometry
Generate Domain Surfaces

Displays a particular variable at the last time layer.

Displays a particular variable at the previous time layer.

Displays a particular variable at the next time layer.

Displays time layers of a particular variable consecutively and
continuously.

Displays values of a particular variable along an arbitrary cross-
section.

Displays values of a particular variable along a certain part of a
boundary.

Displays values of a particular variable along a selected mesh line.

Draws positions of flowing particles.
Draws trajectories of flowing particles.

Deletes all output results.

Shows or hides the grid.

Specifies whether or not the mouse should move in steps defined
by the grid.

Calls the Grid and Work Plane dialog window (Fig 137).

Redefines origin of the grid.

Sets Work Plane to the XY plane.
Sets Work Plane to the YZ plane.
Sets Work Plane to the XZ plane.

Selects coordinate system

Changes color from abrupt to gradual at isolines.

Selects minimal and maximal values for the color scale either for the
entire time duration or only for a selected time layer.

Selects minimal and maximal values for the color scale either for the
entire transport domain or only for displayed part of the domain.
Selects a standard color scale for the display of a particular variable.
Selects a custom color scale for the display of a particular variable.
Calls the Edit Isoband Value and Color Spectra dialog window
(Fig 129).

Moves or copies a selected object.
Rotates a selected object.

Mirrors a selected object.
Stretches a selected object.

Skews a selected object.

Finds the intercept of two lines and insert an interception point on
the lines.

Finds the curve that is created by the intercept of two surfaces.

Splits lines.

Inserts points on a line.

Checks geometry for consistency.
Repairs geometry if inconsistent
Attempts to generate Domain Surface if they were not specified.
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Create Video File
Options

Rendering Mode
Solid Model
Transparent Model
Wire Frame Model

Graph Type
Isolines

Colormaps

Isolines

Color Edges

Velocity Vectors

Display Options
Edit

Default
Read
Save As

Program Options

Windows

New Window
Arrange Symbols

Main and Secondary
Tile Horizontally
Tile Vertically
Cascade

Close All

Help

Context Sensitive Help
Help — Contents and Index
Hydrus User Manual
Hydrus Technical Manual
Hydrus Online

Troubleshooting
Hydrus License and Activation

About Hydrus

Allows users to save flow animation in a video file.

Displays the transport domain as a solid object.
Displays the transport domain as a transparent object.
Displays the transport domain as a wired object.

Displays the spatial distribution of a particular variable by means of
isolines.

Displays the spatial distribution of a particular variable by means of
isobands.

Displays the spatial distribution of a particular variable by means of
isosurface.

Color Points Displays the spatial distribution of a particular variable
by means of color points.

Displays the spatial distribution of a particular variable by means of
color edges.

Displays Darcy velocity vectors.

Edits display options in the Display Options dialog window (Fig
128).

Sets display options to their default values.

Reads display options from a file.

Saves display options to a file.

Displays program options information (the Program Options
dialog window has two tabs, one related to Graphics (Fig. 151)
and one to Program itself (Fig. 152)).

Open a new View window.

Arranges minimized windows as icons at the bottom of the View
window.

Displays open View windows as main and secondary windows.
Tiles open View windows horizontally.

Tiles open View windows vertically.

Cascades open View windows.

Closes all open View windows.

Help for various objects of GUI.

Displays help information.

Displays a PDF version of the HYDRUS User Manual

Displays a PDF version of the HYDRUS Technical Manual
Launches Internet Explorer Browser and opens the HYDRUS web
page

Launches Internet Explorer Browser and opens the
Troubleshooting page of the HYDRUS web page

Displays the Hydrus license and activation information (the
HYDRUS License and Activation dialog window; Fig. 155).
Displays the version and authors of the HYDRUS application.
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9. Miscellaneous Information
9.1. Program Options

The Program Options dialog window has four tabs, one related to Graphics (Fig. 151), one to
Program Options (Fig. 152), one to FE-Mesh (Fig. 153), and one to Files and Directories (Fig.
154).

On the left side of the Graphics Tab (OpenGL) one can turn on or off the OpenGL Hardware
Acceleration (OpenGL is a library of functions developed by Silicon Graphics Inc. for handling
graphical objects), and select the speed for OpenGL optimization.

On the right side of the Graphics Tab (Options) one can select

a) Simplified display in Move modus

b) whether or not an object is selected when the cursor hovers above it (Pre-selection (Mark
object while hovering above it with cursor)),

c) whether or not values and properties are displayed numerically when the cursor is close
to a selected object (Display values/properties at pre-selected objects),

d) a different background (Gradient Background) (visually more effective background is
displayed, which may be useful for presentations), and

e) minimum time for one frame during flow animation.

Program Options S
Graphics | Program I FE-Mesh | Files and Diredoriesl
OpenGL Options

OpenGL Hardware 1 0n Simplfied display in Mave modus (Mave,
Acceleration @ Zoom, Rotate)
Mate: S The simplified display will be activated
Changes to the settings become when there are less than Bl=
active only after the program has refreshments per second
been ended and restarted!

Pre-selection (Mark object while hovering
Performance Optimization above it with cursor)

Digplay values/properties at preselected

] ohjects
Stable Max. Speed Synchronize selection in Navigator and
Views

Otimization is to be set to "Stable”f
problems with graphic occur [F] Gradient Background

Flow Animation - <

Minimum Time for One Frame: 500 = [ms]

[ ok || cance || Hep |

Figure 151. The Program Options dialog window (the Graphics Tab).
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Simplified Display Mode: When the graphics (View Window update) is too slow, this option
accelerates it during dynamic rotating, moving or zooming. When rotating the model, only its
simplified version is drawn, which results into faster display of the model. When rotating is
finished, the full model is displayed again. This option is initiated only when the number of
“refreshments” per second falls below the specified number.

When the checkbox "Synchronize selection in the Navigator and Views" is checked, clicking
on any object on the Navigator Bar leads to its automatic selection in Views. When this
checkbox is not checked, one can select an object by clicking on it with the right mouse button at
the Navigator Bar and using the Select command from the popup menu.

In the Undo and Autosave part of the Program Options Tab (Options) one can
a) select a time interval for Auto-save
b) specify Memory size for the Undo buffer, and

In the General Options part of the Program Options Tab (Options) one can
a) specify whether or not the program Reloads last opened projects at startup
b) specify whether or not the program should Save automatically windows settings on close
project

In the Calculation and Results part of the Program Options Tab (Options) one can
a) specify whether the results are to be kept in an external directory (By default keep results
in external directory),
b) select whether the FE-Mesh is to be saved in text format (Save FE-Mesh in text format),
c) select whether or not Domain Properties are to be saved in text format (Save Domain
Properties in text format).

Program Options g]
Graphics | Program | FE-Mesh | Files and Directaries

Undo and Autosave

Femam zize for the Unda-buffer : 5125 [kE]

Auto-zave input data to a temporary file every E 2| [min]
[enter 0F pou don't veant bo run auto-zave)

General Options

Reload last opened projects at startup

Save automatically windows settings on close project

Calculation and Results

[] By default keep results in external directory (for new projects)
[ Save FE-Mesh in test format (for calculation]

[[] Sawe Damain Properties in text farmat (for calculation)

I 0K H Cancel ” Help ]

Figure 152. The Program Options dialog window (the Program Options Tab).
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In the Mesh Limits part of the FE-Mesh Tab (Options) one can
a) specify the Recommended maximum number of finite elements for 2D projects,
b) specify the Recommended maximum number of finite elements for 3D projects.

Program Options [‘$_<|

Graphics || Program | FE-Mesh | Filez and Directories

b esh Limits

R ecommended mas. number of finite elements for 20 Projects:

Recammended mas. nurmber of finite elements far 30 Projects: A00000

Export Dptions

E wpart intermediate pointz on boundary curves

[ Include internal curves in the BOUNDARY IMFORMATION table

REMARE: These two options are only intended for new projects.
0ld projectz can be changed individually in “'FE-tezh Parameters'.

Wirite Dezcription of Tables

[ k. l[ Cancel ][ Help ]

Figure 153. The FE-Mesh Options dialog window (the Program Options Tab).

In the Files and Directories Tab (Options) one can specify locations of various HYDRUS files
and the file having information about display options:

e Directory for HYDRUS Settings and Authorization Files

e Working Directory for Temporary Files

e Default Directory for HYDRUS Projects

e Configuration file for display options
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Program Options

| Graphics | Program Options | Files and Directories |

Filez and Directaries

Directary for HYDRUS Settings and Authorization files:
| wApplication D ata \PC-Progress\HYDRLUS 1.4

Woorking directory for Temparary files:
| C:ADocuments and Settings bl U zershD ocumentsPC-ProgresstHYDRUS 1 .:-::-:"-.T| E]

bz and Settingzhall Use

Default directory for HYDRUS Projects:
| C:ADocumentz and Settingzhall U zershDocumentz W PC-ProgresshHYD RIS 1.wehF | E]

Configuration file far Dizplay Optionz:
| C:ADocuments and Settingstall U sershbpplication DatavPC-Progress\HYDRUS 1 | E]

[ k. H Cancel H Help ]

Figure 154. The Program Options dialog window (the Program Directories Tab).
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9.2. HYDRUS License and Activation

HYDRUS is protected by a software lock that is based on information about the hardware on
which it is run. Without activation HYDRUS works as a demo version - you can run it but you
will not be able to run calculations and save your data. A customer can choose to Activate
HYDRUS by E-mail with the help of the HYDRUS support or directly On-line (an internet
connection is required). Using the Online activation system, customers can themselves manage
their HYDRUS license, i.e., installation, de-installation, and/or reinstallation of HYDRUS. The
HYDRUS software package is activated using the HYDRUS Authorization Status dialog
window (Fig. 155) that is called using the command Help->Hydrus License and Activation.

9.2.1. Brief Description of HYDRUS Activation

A. On-Line Activation (recommended)

- To activate online you need to know your License Number (four digits) and the Activation
Key (hexadecimal, 32 characters). You should receive both numbers from the HYDRUS
distributor, from whom you purchased the license for HYDRUS or from HYDRUS
customer support support@pc-progress.cz.

- Enter both numbers into the Online Activation dialogue window (Fig. 159).

- After clicking the Activate Now command, HYDRUS establishes a connection over the
Internet with the license server and performs its activation.

B. Activation by E-Mail (when encountering problems with on-line activation)
The activation process by email consists of generating two request codes that need to be sent to
the HYDRUS distributor together with information about the license, customer, and workplace.
Based on this information, the HYDRUS distributor will generate a corresponding activation
code and send them back to the HYDRUS user. Different HYDRUS functions will be activated
after inserting the activation code depending upon the type of purchased license.
- In the dialog window Activation by E-mail (Fig. 173) generate Request Codes.
- Send the Request Codes by email to support@pc-progress.cz or to the HYDRUS distributor,
from whom you purchased the license for HYDRUS.
- After that you will receive by email the Activation Code, which you enter into the dialog
window Activation by E-mail (the Step 3 Tab, Fig. 165), and activate HYDRUS.

9.2.2. Detailed Description of HYDRUS Activation

The HYDRUS Authorization Status dialog window (Fig. 155) displays information about
Authorization Status, Last Activation, and License Information, such as License Number,
Computer ID, Workplace, and License Owner. Authorization Status information includes
information about
a) Status, which can be either Not Authorized or Authorization OK,
b) Level of authorization, which can be either 2D-Lite, 2D-Standard, 3D-Lite, 3D-Standard,
or 3D-Professional,
c) whether or not the Authorization is Time-Limited (if yes, then the Expiration Time is
given), and
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d) whether or not the Network Installation is active (if yes, then the Number of Clients is
given)
All this information is displayed as read-only text that is filled in during the first activation of the
software. The button “Send Authorization Report” is used when resolving problems with
software activation.

"HYDRUS 2.01.0080 Auth [0

Status | History of Activations |

Authorization Status

Status: Mot Authorized Level: Demo Version

Timedimited Authorization Metworlc Installation

Last Deactivation

Deactivation Date:  1/1/2011 Send Authorization Report

Deactivation Code:  SBEB-3EGC-AD2E-BDIB-2F53-50B3-4866-231B

License Information

License Mumber: 1001 Worlkplace:
Computer 1D 106300052 Description:  Home PC

License Owner: PC-Progress

Activate or Deactivate HYDRUS

(Request or Enter Activation Codes) (Intemet Connection Required)

Activate by E-mail ‘ ‘ Activate ondine

Figure 155. The HYDRUS Authorization Status dialog window (Tab Status).

For the commands in this dialog window to be active (e.g., Activate by E-mail or Activate on-
line), HYDRUS needs to be run with administrator privileges. That means, that you need to be
logged as an Administrator (or as a user belonging to "Administrators” group) when making
changes to the authorization. To run HYDRUS as administrator under Windows Vista or Windows
7 operating systems, click on the HYDRUS icon on your desktop using the right mouse button and
select "Run as Administrator” from the popup menu. Warning displayed in Figure 156 is issued
when attempting to make changes to the Authorization Status while not running HYDRUS

with administrator privileges.
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[ HvDRUS 2200 F - [

. HYDRUS activation requires administrator privileges.
_l_}. You must be logged as an Administrator (or as a user belonging
to "Administrators” group) when making changes to the authorization.

Under Windows Vista and Windows 7 you should run HYDRUS
"as administrator” (click on the HYDRUS icon on your desktop

using the right mouse button and select "Run as administrator”).

Please restart HYDRUS with administrator priviledges or contact your
systemn administrator,

Figure 156. Warning issued when attempting to make changes to the Authorization Status while
not running HYDRUS with administrator privileges.

The second Tab of the HYDRUS Authorization Status window, i.e., the Add-in Modules Tab

list additional HYDRUS modules (e.g., Unsatchem or Wetland) that are currently available and
activated.

- Add-on Modules | History of Activations

Module Name Status =
WETLAND 2D Enabled

m

Maodule Description

The geochemical UNSATCHEM module simulates the transport of majorionsin »
varably-saturated porous media, including major ion equilibrium and kinetic non-
equilibium chemistry. The resulting code is intended for prediction of major ian
chemistry and water and solute fles in scils during transient flow. The major
varables of the chemical system in UNSATCHEM-2D are Ca, Mg, Na, K, S04, C1,
NC3, H45i104, alkalinity, and CO2. The model accourts for various equilibrium
chemical reactions between these components, such as complexation, cation
exchange and precipitation-dissolution.

[ oKk || Cancel || Hep |

Figure 157. The HYDRUS Authorization Status dialog window (Tab Add-on Modules).
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The third Tab of the HYDRUS Authorization Status window, i.e., the History of Activation
Tab reports recent actions related to HYDRUS activation.

HYDRUS 2.01.0080 Authorization Status ot o]

History of Activations

Server response: F-
Online operation emar: (113} There is no Single user type of the requested produc
<<« Online Activation finished

»»» (Generating of the Request Codes started at 2011-01-01 12:17-05
HYDRUS version: 2.01.0080

Level to activate: 3D-Professional

MNetwork Licence: Mo

Time-imited License: Yes

Expiry Date: 2011-07-01

Request Code 1: 311157152

Request Code 2: 106300092

Licence Number: 1001

Computer Description: Home PC

Customer: PC-Progress

<<= (Generating of the Request Codes finished at 2011-01-01 12:17:05

=% Activation attempt made at 2011-01-01 12:15:51
With:

Request Code 1: 311157152

Request Code 2: 106300092

Activation Code 1: 218309801

Activation Code 2: 0

Activation Code 3: 0

Licence Mo.: 1001

Attempt Mo.: 1

Workplace Name: PCX

Expiry Date: 2011-07-01
<< Activation attempt ended with status: Successful activation

[ ok || Cancel |[ Hep |

Figure 158. The HYDRUS Authorization Status dialog window (Tab History of Activation).

9.2.2.1. On-Line Activation

Online activation is the fastest and most convenient way to activate HYDRUS. The Online
Activation window (Fig. 159) appears after clicking on the Activate on-line button on the
HYDRUS Activation Status window. Here you need to enter information about the License
Number and the appropriate Activation Key that you received together with an invoice from the
HYDRUS Customer Support. This Activation Key is used for all Workplaces of a particular
license. For special purposes, different Activation Keys can be generated for individual
Workplaces (e.g., when a particular Workplace has an authorization for a different HYDRUS
Level or a specific HYDRUS module).

In the section Specify the required authorization level select the required HYDRUS Level to

Activate (i.e., 2D-Lite, 2D-Standard, 3D-Lite, 3D-Standard, or 3D-Professional; please note that
this Level has to correspond with the purchased Level) and the Type of License to activate (e.g.,
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Time-Limited Authorization with the Expiration Date, or the Network Installation with the
Number of Clients). If no checkbox is selected, a Time-Unlimited Single User License is
authorized. With regard to a possible loss of authorization due to failure of hardware, it is
recommended to choose a shorter period of validity (default is 0.5 years). An item Computer
Description serves for the future identification of a particular computer in the electronic

licensing system and is usually characterized by a user or its location (e.g., John - Laptop, Harry
- Lab 001).

il |
Online Activation |

Infarmation abaout yau and vaur license

License Mumber; 10M

Activation Fey:

Specify the required autharization level

Select HYDRUS Level to activate: 3A0-Profeszional -
Timne-limited Authornzation Metwork, Inztallation
Ewpiry Date: 7/ 12011 1]

Computer Dezcription [bo identify thiz computer in the futune]

Computer Description:  Home PC

[ Activate Mow ] I Cloze I I Help

9 =

Figure 159. The Online Activation dialog window.

After clicking on the Activate Now button, you will be asked to confirm all specified parameters
(Fig. 160) (note that you may be prompted by your firewall to allow communication between
your computer and the license server of PC Progress). At this point, all specified information will
be verified against the data of our electronic licensing system and if confirmed the actual
activation of HYDRUS will occur. This communication applies only to data entered in the
Online Activation window, and no other information stored on your PC is transferred. In case of
unsuccessful activation, an error message is displayed explaining the problem. After correcting
the problem, you can use again the Activate Now command.
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HYDRUS 2.0 S

Please review the parameters for the required activation:

License Murmnber: 1001

Level to activate; 30-Professional
Tirme-limited License: Yes

Expiry Date: 7/1/2011

Computer Description: Home PC

Press OK if you are satisfied with the displayed parameters
and want to generate request codes,

Press Cancel if you wish to make any changes to the activation
parameters,

[ Ok ] | Cancel

Figure 160. Window requesting confirmation of entered parameters.

Prior to the expiration (Expiry Day) of the Time-Limited Authorization, user will be alerted
about it, and the license can be easily repeatedly extended using the Extend Activation function.

9.2.2.2. Activation by E-mail

For this option, the user is guided through a three-step form (three Tabs of the Activation by E-
mail dialog window, Fig. 173). During the first two steps he/she prepares information needed to
obtain HYDRUS Authorization and emails it to the HYDRUS distributor. In the third step, user
enters the Activation Code that he receives by e-mail on the third Tab (Step 3) of the
Activation by E-mail and activates HYDRUS.

The first step is to fill in information about the license (License Number), the name of the
license owner (Customer), and description of the Workspace (WP Description). This last item
(i.e., WP Description) serves for future identification of a particular computer in the electronic
licensing system and is usually characterized by a user or its location (e.g., John - Laptop, Harry
- Lab 001).

In the section Required Authorization select the required HYDRUS Level to Activate (i.e.,
2D-Lite, 2D-Standard, 3D-Lite, 3D-Standard, or 3D-Professional; please note that this Level has
to correspond with the purchased Level) and the Type of License to activate (e.g., Time-Limited
Authorization with the Expiration Date, or the Network Installation with the Number of
Clients). If no checkbox is selected, a Time-Unlimited Single User License is authorized. With
regard to a possible loss of authorization due to failure of hardware, it is recommended to choose
a shorter period of validity (default is 0.5 years).
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Activation by E-mail
.

Step 1

License Information

e —

License Mumber: 1001

Customer: PC-Progress

Erter your HYDRUS license number and/or name and address of the institution that
purchased the license.

Waorkplace Description

WP Description:  Home PC
Erter a tesd to identify this workplace or computer

Required Authaorization

Select HYDRUS Level to activate: | 3D-Professional -
Timedimited Authorization Metwork Installation
Expiry Date: B/ 172011 E- Mumber of Clients: |0
Meat Step
Regenerate Request Codes [ Generate Request Codes ]

- W =— T

Figure 161. The Activation by E-mail dialog window (Tab Step 1).
After clicking on the Generate Request Codes button on Tab Step 1 of the Activation by E-

mail window (Fig. 173), user is prompted to confirm all entered information (Fig. 160) and then
the Tab Step 2 (Fig. 162) appears.
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e 55—
Activation by E-mail

Step 2 | Step 3

Authorization Request Codes

HYDRUS version: 2.01.0080
Level to activate: 30-Professional
Metworl Licence: Mo
Timedimited License: Yes

Expiry Date: 2011-07-01

Request Code 1: 311157152
Request Code 2: 106300052
Licence Number: 1001

Computer Description: Home PC
Customer: PC-Progress

Copy to Clipboard ] [ Send Request Codes by E-mail

Meat Step

1. Send the authorzation request (@l information abowve) by e-mail to your HYDRUS
reseller or to support @pc-progress.cz

2. ou can close this dialog and HYDRLUS. After receiving the activation code. nun
HYDRLS and insert the code on the next page of this dialog (Step3).

Previous Step Mext Step
({Licence Information) (Enter Activation Codes)
[ Cancel ] [
. B - il .

Figure 162. The Activation by E-mail dialog window (Tab Step 2).

Information entered during Step 1 (on Tab Step 1) is summarized in the Authorization Request
Codes section of the Step 2 Tab. This information can be copied to the clipboard using the Copy
to Clipboard button and then sent by email to the HYDRUS support or other HYDRUS
distributors. The command Send Request Codes by E-mail will attempt to start emailing
program (e.g., Microsoft Outlook) directly and copy there automatically an email address of the
HYDRUS support (support@pc-progress.cz) and all required information (see an example of
such email displayed in Outlook in Fig. 163).
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/— 0 HYDRUS Activation Requests Mes... " (5[5l

—'.. :
_ Messgge | Inse Options Format Text  Adobe PDF &)
2B Al el @ jlif * f?
Send Paste _ || Basic | Mames |[Include Options Spellim"
- \; Textv - - - -
send || Clipbo.., ™ Proofin
T T RN W I [
support®pc-progress.cz
=1
Cc...
cong | L e |
Subject: HYDRUS Activation Request

| » EF0

HYDRUS version: 2.01.0080
Level to activate: 3D-Professional
Network Licence: No
Time-limited License: No
Request Code 1: 316923815
Request Code 2: 106300092
Licence Number: 1001
Computer Description: Home PC
Customer: PC—Progre55|

4 m | »

b

Figure 163. Email with the HYDRUS Activation Request in Outlook.

On the basis of this information, the HYDRUS support or other resellers will promptly email
back the Activation Code.

Notes on Request Codes

1. Request Code 1 is a randomly generated number that can be used for a single activation.
After the activation (either successful or unsuccessful), this number is changed and therefore
the same number cannot be used repeatedly even for the same computer.

Request Code 2 (Computer ID) is a number that uniquely characterizes the hardware of a
computer or a computer network (for the network license). This number should be constant
for a particular computer, unless there is a change of hardware. If this number changes, the
authorization system will evaluate the license as invalid. It is thus necessary before the
change of hardware (e.g., a change of the motherboard) or reinstallation of the operational
system (Windows) to deactivate HYDRUS, since HYDRUS will need to be reactivated after
hardware changes are completed.

There are only three attempts available to activate HYDRUS with particular request and
activation codes. If wrong activation codes are inserted during the first three attempts,
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HYDRUS issues a warning. After the third attempt with wrong activation codes, the Request
Code 1 is changed and new activation codes need to be requested.

4. We recommend using standard functions Copy & Paste when inserting activation codes to
minimize risk of inserting wrong numbers.

When starting unauthorized HYDRUS again, user is informed that request codes have recently
been generated and if he/she wants to enter the Activation Code and activate HYDRUS (Fig.
164). It is important not to regenerate request codes at this time as the Activation Code would
then not be active any more, since one of the request codes would be changed.

[ HYDRUS 2.x )

Recently you generated Request Codes for activation of HYDRUS
l % by e-mail. Would you like to enter the Activation Code now?

Press "OK" to enter the Activation Code now,
Press "Cancel” to enter the Activation Code later.

| Ok | | Cancel

Figure 164. Window inquiring if the user wants to enter the Activation Code.
After receiving the Activation Code, enter this code on the Step 3 Tab of the Activation by E-

mail dialog window (Fig. 165) and click on the Activate Now button. You should receive a
confirmation that the authorization process was successful (Fig. 166).
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Activation by E-mail .

Step 1 | Step 2 | Step 3

Last Generated Request Codes I

Request Code: 327534488
Computer 10: 106300052

Erter Activation Codes

Enterthe activation code exactly as you received it from your HYDRUS distrbutor.
For example: 265361646-1246553217-1107656501-1001-PC2-627454765-128755578

Activation Code:
Enter Activation Code Here

[ Activate MNow ]

Caution: You have three attempts to enter comect activation code. f you enter a wrong
activation code three times, the request codes will change and you will have to ask for
new activation code.

Mumber of remaining attempts: 3

Previous Step - Request Codes

[ Cancel || Hep |

b 3 E_— 4§ _—

Figure 165. The Activation by E-mail dialog window (Tab Step 3).

T Y
HYDRUS 2. [

Authorization process succeded!

A

Activation complete!

IMPORTAMT MOTICE:

Before any hardware changes or reinstallation of Windows
or if you want to mowve your license to ancther computer
you should deactivate HYDRUS on this computer.

See Help how to deactivate HYDRUS properly.

Figure 166. Window confirming successful HYDRUS authorization.
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Note that the Request Code and a Computer ID are displayed in the upper part of the Step 3
Tab. Remember that your Request Code and Computer ID are hardware-dependent. After
upgrading your hardware (e.g., BIOS, hard drives), you will very likely have to request new
Activation Code. You are eligible to obtain those codes for free (although subject to some
limitations - ask for details).

When the activation fails three times (likely due to incorrectly entered information), the request
keys will change and windows shown in Figure 167 will be displayed, providing instructions on
how to proceed further. User will be requested to send a report to the HYDRUS support, so that
the cause of the problem can be analyzed.

HYDRUS 2.xx ]

T The activation Failed, request codes have been changed and HYDRUS
! has created an error report, IF wou are sure that wou entered
the correct activation code, please save the error report
and send the File to the HYDRUS customer suppork
(supporb@pc-progress, cz) for analysis,

IMPORTAMNT MOTICE:
You MUST send us the error report before applying For
a new ackivation code,

Lo wou want to save the error repork?

Press "fes" to save the errar repark,
Press "Mo" ko cancel the activation if wou know that vou used
an incorrect ackivation code.

B

'T Weould wou like to send the report by e-mail or ko save it to a File?
Press "es" ko e-mail the report as an attachment to vour HYDRUS reseller andfor ko supporti@pc-progress.cz

Press "Mo" to save the report,

Mo | Zancel |

Figure 167. Window reporting a failure of HYDRUS authorization.

9.2.3. Reinstallation, Moving to another Computer

With a "single user"” license you are eligible to install and use HYDRUS on two computers (for
example a computer in your office and your notebook). If you reinstall HYDRUS on an activated
computer or if you install a newer HYDRUS version then your previous authorization will
remain active.
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Deactivation of HYDRUS and/or Reinstallation to another computer

Users should deactivate HYDRUS before a) any hardware change (motherboard, hard-drives,
graphic card, BIOS, etc), b) reinstallation of the Windows OS, c) reformatting the hard-drive
with HYDRUS, d) changing the network path to HYDRUS (applies to the network installation),
and e) moving HYDRUS license to another computer. The HYDRUS software package is
deactivated using the HYDRUS Authorization Status dialog window (Fig. 155) that is called
using the command Help->Hydrus License and Activation. Similarly as for HYDRUS activation,
you can deactivate HYDRUS either by email (the command Deactivate by E-mail) or online (the
command Deactivate on-line).

9.2.3.1. On-Line Deactivation

After clicking on the command Deactivate on-line in the HYDRUS Authorization Status
dialog window (Fig. 155), in the Online Deactivation window (Fig. 168) enter the Activation
Key and press the button Deactivate Now. You should receive a warning that this action will
deactivate HYDRUS, and after clicking Yes the confirmation that HYDRUS has been
successfully deactivated on your computer (Fig. 169).

: |
Cnline Deactivation Iél

Current Licenze

Licenze Mumber; 10M
Workplace Marne: PCx

Computer Dezcriplion: . Hame PC

Enter Pazzword

Achivation Key: Enteri Activation Key here

[ Deactivate How ] I Cloze I I Help I

Figure 168. The Online Deactivation dialog window.

[ HvDRUS 2.0x === HYDRUS 2.0 &Jﬂ

l This action will deactivate Hydrus.
" - -
Warning: After deactivation Hydrus will run as a demo version. l k. Hydrus has been deactivated on this computer!

Do you want to continue?

[ ve || mo |

——— = b

Figure 169. Window confirming successful online deactivation of HYDRUS.
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9.2.3.2. Deactivation by Email

After clicking on the command Deactivate by E-mail in the HYDRUS Authorization Status
dialog window (Fig. 155), in the HYDRUS Deactivation window (Fig. 170) press the button
Deactivate HYDRUS Now. You should receive a series of warnings that this action will
deactivate HYDRUS, and after clicking Yes the confirmation that HYDRUS has been
successfully deactivated on your computer (Fig. 171). The Deactivation Code will then appear
in the HYDRUS Deactivation window (Fig. 170). This code can be copied to the clipboard
using the Copy to Clipboard button and then sent by email to the HYDRUS support or other
HYDRUS distributors. The command Send Deactivation Code by E-mail will attempt to start
emailing program (e.g., Microsoft Outlook) directly and copy there automatically an email
address of the HYDRUS support (support@pc-progress.cz) and all required information (see an
example of such email displayed in Outlook in Fig. 163).

HYDRUS Deactivation -

Deactivate HYDRLS

Thiz action will deactivate HYDRUS. Deactivation will create a zpecial
code that can be later used for venfication that HYDRUS has been
deactivated on thiz computer. Please zave thiz code and zend it to
your HYDRUS reszeller andor to support®pe-progress. cz.

WARMIMG: After deactivation HYDRUS will run as a demo verzion.

Deactivate HYDRUS Mow

Deactivation code

Deactivation code iz not available.

Copy to Clipboard Send Deactivation Code by e-mail

I Cloze I I Help I

Figure 170. The HYDRUS Deactivation dialog window.
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HYDRUS 2 -

This action will deactivate Hydrus.

l.\'

Deactivation will create a special key (deactivation code)

that should be sent to hydrus@pc-progress.cz as a proof that
HYDRUS was really deactivated on this computer. Please keep
the deactivation code safe, without it you may not be able

to reactivate HYDRUS again.

Warning: After deactivation HYDRUS will run as a derno version,
Do you want to continue?

HYDRUS 2o

l Hydrus has been deactivated on this computer!
You will be presented with a code which serves as a proof, that you
have deactivated HYDRUS on this computer,

Warning: If you fail to present the code you will not be able to activate
HYDRUS on an ancther computer!

J—

Figure 171. Window confirming successful deactivation of HYDRUS by email.

9.2.4. Extending Activation

Prior to the expiration (Expiry Day) of the Time-Limited Authorization, user will be alerted
about it, and the license can be easily repeatedly extended using the Extend Activation On-Line
button. This button will appear instead of the Activate on-line button on the Status Tab of the
HYDRUS Authorization Status window (Fig. 155). To extend the activation, you will need
again the Activation Key (either for the entire license or for a particular Workspace).
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9.3. Print Options Dialog Window

The Print Options dialog window contains three tabs (Fig. 172). In the General Tab a user
selects whether the content of the View window (Picture) is to be printed with or without a
Legend, Page Orientation (Portrait or Landscape), and Page Margins. In the Picture Tab,
users further select Print Quality (the Standard print quality, which can be changed by users, is
5,000*5,000 pixels), whether the Frame is to be printed in black or color (Colors and Frame),
and Text Size. Finally, in the Legend Tab, users select what texts (Legend Rows) are to be
printed, with what Font, and how far from the picture. Users can use a predefined text or can

write their own.

Print Options R‘ Print Options R‘
General | Picture | Legend General | Picture | Legend
Print Page Crientation Print Quality Colors and Frame
T ®Porat LT — () Lines and TextBlack
O Landscape {Max_ 5000 x 5000 pixels) @ All Colored
[V Legend (") User Defined
Page Margins l:l (V] Draw Frame
5 2000/ 3
et [} Text Size Symbol Size and Line Width
jioc: 200054 [mm (") Proportional to Picture Size (@) Proportional to Picture Size
Right: 2000 3 [mm] (@) Constant (O Constant
Default Default
0K } I Cancel ] ’ Help ] [ 0K l ’ Cancel ] ’ Help ]
Print Options W

General Picture| Legend |

Legend Rows

Row Text

Content

i [ |Project 000

‘ |Project|nfo. v |

2 [ [FE-Mesh

‘ Picture Desc. v

3 O] |
4 ] |
TextSize Offset
Height: [mm] dx: [mm]
dy: 30002 | [mm]
’ Font ] ’ Default l
[ OK l ’ Cancel ] ’ Help ]

Figure 172. The General, Picture, and Legend tabs of the Print Options dialog window.
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9.4. Print Preview and Copy to the Clipboard Commands

Result of commands Print Preview and Copy to the Clipboard is shown in Figure 173. The
Print Preview command displays the content of the View Window on the screen as it would
appear in printed formed, while the Copy to the Clipboard command copies the same content to
a metafile (enhanced metafile, EMF, http://en.wikipedia.org/wiki/Windows_Metafile) in the
Clipboard for subsequent pasting into other software packages, such as Word, PowerPoint, etc.
Additional content of the metafile (in addition to the content in the View Window, such as the
text of the legend) is defined using the Print Options window. The metafile contains the bitmap
(the resolution of this bitmap (max 6000x6000 pixels) can be specified in the Print Option
window) with the graphics displayed in the View Window and additional vector objects (e.g.,
texts and/or numbering).

0.000 0.004 0.008 0.012 0.016 0.020 0.024 0.028 0.033 0.037 0.041 0.045

HENTEEN ..

Concentration - c[mmol/cn*3], Mn=0.000, Max=0.045
Project 3DFUmig6 - 3D, Anite res., Heat Tr., Tarp, Tarp removal, part untarped
Resullts, Concentration, Time 6 - 1.50 days

Figure 173. Result of commands Print Preview or Copy to the Clipboard.
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9.5. Coordinate systems

The Coordinate System to be used for the transport domain definition can be selected from the
List of Available Coordinate Systems dialog window (Fig. 174, top) called by the Tools-
>Coordinate System command. Cartesian, Cylindrical, and Spherical systems are available. The
Cartesian coordinate system is selected by default. A New Coordinate System can be defined
using the dialog window of the same name (Fig. 174, bottom).

List of available Coordinate Systems f'5__<|
Exizting Coordinate Suztems C5 Type

Nm = : D escription L O Cartesian
1efaulk Abzolute coordinate spsten L.

efault Ly rdinate spstem () s-Cylindric

() -Cylindric

() Z-Cylindric
(%) Spherical

Polar

Mew System
Bemove

[ Ok H Cancel ” Help ]

]

New Coordinate System m|

MName Description

Definition of the Coardinate System

% [cm] Y [cm] Z [em]
C2-Origin: | ooo| | o0oof | 000 [ Pick |
Point an +x-Axis: 0.00 0.00 000 | Pick |
Point in +xZ-Plane: 0.00 0.00 000 | Pick |

| PickAl 3 Points |

[ oK l ’ Cancel I ’ Help I

Figure 174. The Coordinate Systems dialog windows.
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9.6. DOS Window During Calculations

During the calculations different type of information can be written to the screen. The following
information may be written to the screen depending upon the problem:

Time Time

T-Level Time level

Itw Number of iterations to solve the water flow problem at a certain time
step

ItC Number of iterations to solve the solute transport problem at a certain
time step

ItCum Cumulative number of iterations

CumAtmBC Cumulative flux across the atmospheric boundary

CumConst Cumulative flux across the boundary having a constant flux or pressure
head

CumDrain Cumulative flux across the boundary having a time-variable flux or
pressure head

CumRootUp Cumulative actual root water uptake

CumCh0 Cumulative zero-order production in domain (solute transport)

CumChl Cumulative first-order degradation in domain (solute transport)

CumChS Cumulative solute flux across the boundary having a time-variable flux
or pressure head

hAtm The average pressure head at the atmospheric boundary

hConst The average pressure head at the boundary having a constant flux or
pressure head

hDrain The average pressure head at the boundary having a time-variable flux
or pressure head

hRoot The average pressure head in the root zone

hSeep The average pressure head at the boundary with the seepage face

vConstBC Flux across the boundary having a constant flux or pressure head

vSeep Flux across the boundary having a seepage face
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9.7. Running Computational Modules Outside of GUI or in a Batch

Computational modules (e.g., h2d_calc.exe, h2d_clci.exe, h3d_calc.exe) can be run either
directly from GUI or by clicking on any of them in the folder, in which HYDRUS is installed.
When these modules are run from GUI, GUI will send them as a parameter the path to the folder,
in which the input and output files are located (the working folder, the path to which is displayed
in the project manager (h1d) or in the project information dialog (h3d)). When the program does
not receive a path as a parameter, it will look for the text file called Level_01.dir that needs to be
located in the same folder as the computational module. This file can be written using any text
editor, such as Notepad. This file must have one line, which provides the path to the folder, in
which the input and output files are located.

Example of the “Level_01.dir” file:
c:\program files\pc-progress\hydrus3d\mydirect\runl

For the input files to be available in the Working Folder, the Working Folder needs to be either
'Permanent’ (see the Project Information dialog) or the HYDRUS GUI needs to be opened when
the Working Folder is "Temporary'. In each case the text input files need to be created using the
menu command File->Import and Export->Export Data for HYDRUS Solver in Text Format.

HYDRUS (2D/3D) allows users to select multiple projects and run them simultaneously using
the “Calculate All Open Projects” or “Select Projects to Calculate”. To run several projects
sequentially is more complex. One needs to prepare abatch file (e.g., run.bat) and files
describing paths (e.g., pathl, path2, etc) to project folders (to be run) in advance. One needs to
copy these files into the program folder (e.g., c:\program files\ussl\hydrus3d). Additionally, the
check box "Hit Enter at the End?" in the Output Information window has to be unchecked for all
projects to be run sequentially.

Example of the “run.bat” file:

copy pathl level 01.dir
h2d_calc
copy path2 level _01.dir
h2d calc

Example of the “Path1” file:
c:\program files\ussl\hydrus3d\mydirect\runl

Example of the “Path2” file:
c:\program files\uss\hydrus3d\mydirect\run2
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9.8. Video Files

Users can save the flow animation using the Create Video File command (Tools->Create Video
File). This command calls the Create Video File dialog window (Fig. 175), in which a user
needs to specify where the Video File should be saved and under what name, type of the video
file [a) Cinepac Codec by Radius, b) Microsoft Video 1, c) Intel Indeo Video 4.5, d) Intel Indeo
Video 5.10, e) Microsoft MPEG-4 Video Codec V1, and f) Microsoft MPEG-4 Video Codec V2]
and its Quality, and finally whether recording is carried out at Real Time (i.e., video will run at
the same speed as HYDRUS animation) or only when frames in the View Window change (only
changes in View Window are recorded). Additional options (such as Smoothness, Data Rate (i.e.,
kilobits per second)) are available for each particular video format. OpenGL acceleration should
be disabled when problems occur when creating Video File.

Create Video File E|
Yiden File
C:AFlowdnimation. avi

Yideo Codec Tepe

Miciosoft MPEG-4 Videa Codec 2w

Duality: | 1004 | %]
Recording Frequency

(%) Beal Time

() Changed Erames Orily

Figure 175. The Create Video File dialog window.
Notes on Video Editing:

1. Video records only changes in View. Thus, if nothing changes in the View window, only
the first picture is recorded. When one records animation of flow or transport, then while
the View window is redrawn, each change is recorded. Similarly, one could record video
for any other manipulation of the View, which requires its redrawing (e.g., rotation of the
model).

2. If the option "Real-Time" is on, each recorded View has an assigned time, which elapsed

between redrawing of the View window. This means that the video is then played at
approximately the same rate as redrawing of the View window.
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3.

If the option "Changed Frames Only" is on, then changes in the View window are stored
regardless of the actual time elapsed in redrawing the View. For example, if some
changes in redrawing of view take place quickly, followed by a pause, and again fast
changes, in the resulting video, all changes will be played back with a constant time delay.
The current version of HYDRUS does not have an option allowing to set a time interval
between recorded frames. It is entirely possible that one can edit Video recordings
created by HYDRUS using some public domain programs for editing videos. We
currently do not have any experience with that and can not make any recommendations.
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9.9. About HYDRUS

This window displays the program version (the Program Tab), authors of the HYDRUS
application (the Authors Tab), and the License agreement (the License Agreement Tab). The
Program Tab additionally displays other software products (such as mesh generators) that are
used in HYDRUS.

About HYD
" | [ \ 1) l J g Pragrann |Authors|License.&greemenl
I' f .vJ I J
. P : HYDRUS
2D/3D Version 2.x fodiam name

Frogram wersion; 2.07.0450
Release date: 107.201
WEB site: ww hydruz3D . com
Support; support(@pc-progress. cz
Copyright: 2006-2011 PC-Progress s.r.o.

Al rights rezerved

Thiz product uges:

GEMEX, Copyright [) FEM Consulting z.r.o. -
T30, Copyright () Daniel Rypl. C¥UT Prague

About HYD
i v \ IFD . | F'n:uglaml Authars |License.&greement
I | { L)W l J )
. Authors: -
2D/3D Version 2.x Dr. M.Sejna and Prof. J. Simunek,

Dr. RienWan Genuchten

Copyright & 2006 - 2011;
PC-Progress s.r.o.
Anglicka 28, Prague
Czech Republic

All Rights Reserved

Support;
hydruz@pc-progress.cz
admin{@pe-progress. cz

WEB site:
wiw. hydrus 30 com
W, PC-progress, com

Figure 176. The About HYDRUS dialog window (the Program tab (top) and the Authors tab
(bottom).
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